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Software License Agreement: Terms and Conditions

The media and/or any online materials accompanying this book that
are available now or in the future contain programs and/or text files
(the “Software”) to be used in connection with the book. SYBEX
hereby grants to you a license to use the Software, subject to the terms
that follow. Your purchase, acceptance, or use of the Software will
constitute your acceptance of such terms.

The Software compilation is the property of SYBEX unless otherwise
indicated and is protected by copyright to SYBEX or other copyright
owner(s) as indicated in the media files (the “Owner(s)”). You are
hereby granted a single-user license to use the Software for your per-
sonal, noncommercial use only. You may not reproduce, sell, distribute,
publish, circulate, or commercially exploit the Software, or any portion
thereof, without the written consent of SYBEX and the speciﬁc copy-
right owner(s) of any component software included on this media.

In the event that the Software or components include specific license
requirements or end-user agreements, statements of condition, dis-
claimers, limitations or warranties (“End—User License"), those End-
User Licenses supersede the terms and conditions herein as to that
particular Software component. Your purchase, acceptance, or use of the
Software will constitute your acceptance of such End-User Licenses.

By purchase, use or acceptance of the Software you further agree to
comply with all export laws and regulations of the United States as
such laws and regulations may exist from time to time.

REUSABLE CODE IN THIS BOOK

The author created reusable code in this publication expressly for reuse
for readers. Sybex grants readers permission to reuse for any purpose
the code found in this publication or its accompanying CD-ROM so
long as the author is attributed in any application containing the
reusable code, and the code itself is never sold or commercially
exploited as a stand-alone product.

SOFTWARE SUPPORT

Components of the supplemental Software and any offers associated
with them may be supported by the speciﬁc Owner(s) of that material,
but they are not supported by SYBEX. Information regarding any
available support may be obtained from the Owner(s) using the
information provided in the appropriate read.me files or listed else-
where on the media.

Should the manufacturer(s) or other Owner(s) cease to offer support
or decline to honor any offer, SYBEX bears no responsibility. This
notice concerning support for the Software is provided for your
information only. SYBEX is not the agent or principal of the
Owner(s), and SYBEX is in no way responsible for providing any sup-
port for the Software, nor is it liable or responsible for any support

provided, or not provided, by the Owner(s).

‘WARRANTY

SYBEX warrants the enclosed media to be free of physical defects for a
period of ninety (90) days after purchase. The Software is not available
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posted to www.sybex.com. If you discover a defect in the media during
this warranty period, you may obtain a replacement of identical format
at no charge by sending the defective media, postage prepaid, with
proof of purchase to:

SYBEX Inc.

Product Support Department
1151 Marina Village Parkway
Alameda, CA 94501

Web: www.sybex.com

After the 90-day period, you can obtain replacement media of identi-
cal format by sending us the defective disk, proof of purchase, and a
check or money order for $10, payable to SYBEX.

DISCLAIMER

SYBEX makes no warranty or representation, either expressed or
implied, with respect to the Software or its contents, quality, per-
formance, merchantability, or fitness for a particular purpose. In no
event will SYBEX, its distributors, or dealers be liable to you or any
other party for direct, indirect, special, incidental, consequential,
or other damages arising out of the use of or inability to use the Soft-
ware or its contents even if advised of the possibility of such damage.
In the event that the Software includes an online update feature,
SYBEX further disclaims any obligation to provide this feature for any

specific duration other than the initial posting.

The exclusion of implied warranties is not permitted by some states.
Therefore, the above exclusion may not apply to you. This warranty
provides you with specific legal rights; there may be other rights that
you may have that vary from state to state. The pricing of the book with
the Software by SYBEX reflects the allocation of risk and limitations

on liability contained in this agreement of Terms and Conditions.

SHAREWARE DISTRIBUTION

This Software may contain various programs that are distributed as
Shareware. Copyrlgl'lt laWS apply to both Sl’\areware aﬂd Ordinary
commercial software, and the copyright Owner(s) retains all rights. If
you try a shareware program and continue using it, you are expected to
register it. Individual programs differ on details of trial periods, regis-
tration, and payment. Please observe the requirements stated in

appropriate files.

CoprY PROTECTION

The Software in whole or in part may or may not be copy-protected
or encrypted. However, in all cases, reselling or redistributing these
files without authorization is expressly forbidden except as specifically

provided for by the Owner(s) therein.
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Introduction

WEeLcoME To NET anD VisuaL Basic NET. As you already know, NET is a name for
a new strategy: a blueprint for building applications for the next decade. It’s actually even more
than that. It's Microsoft’s commitment to remain at the top of a rapidly changing world and give
us the tools to address the needs of tomorrow’s computing. Visual Basic NET is a language for
creating NET applications, like many others. It also happens that Visual Basic is the easiest to
learn, most productive language (but you already know that).

Visual Basic NET is released shortly after the tenth anniversary of the first version of VB.
The original language that changed the landscape of computing has lasted for 10 years and has
enabled more programmers to write Windows application than any other language. Programmers
who invested in Visual Basic 10 years ago are in demand today. In the world of computing, how-
ever, things change very fast, including languages. At some point, they either die, or they evolve
into something new. Visual Basic was a language designed primarily for developing Windows
applications. It was a simple language, because it managed to hide many of the low-level details
of the operating system. Those who wanted to do more with Visual Basic had to resort to Win-
dows APL In a way, earlier versions of Visual Basic were ‘sandboxed’ to protect developers from
scary details.

Microsoft had to redesign Visual Basic. The old language just didn’t belong in the NET pic-
ture (at least, it wouldn’t integrate very well into the picture). Visual Basic NET is not VB7; it's
a drastic departure from VB0, but a necessary departure. Visual Basic NET was designed to take
us through the next decade of computing, and if you want to stay ahead, you will have to invest
the time and effort to learn it.

The most fundamental component of the NET initiative is the NET Framework, or simply
the Framework. You can think of the Framework as an enormous collection of functions for just
about any programming task. All drawing methods, for example, are part of the System.Drawing
class. To draw a rectangle, you call the DrawRectangle method, passing the appropriate argu-
ments. To create a new folder, you call the CreateDirectory method of the Directory class; to
retrieve the files in a folder, you call the GetFiles method of the same object. The Framework
contains all the functionality of the operating system and makes it available to your application
through numerous methods.

VB was such a success because it was a very simple language. You didn’t have to learn a lot
before you could start using the language. Being able to access the Framework’s objects means
that you're no longer limited by the language. The new version of the language unlocks the full
potential of NET; now there’s hardly anything you can do with another language but can’t do
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with Visual Basic. This makes the language as powerful as any other language, but it also makes the
learning curve steeper. The good news is that, if you get started today, you'll get a head start, which
may well last for another decade.

Who Should Read This Book?

You don’t need to know Visual Basic to read Mastering Visual Basic NET, but you do need a basic
understanding of programming. You need to know the meaning of variables and functions and how
an If.Then structure works. This book is addressed to the typical programmer who wants to get the
most out of Visual Basic. It covers the topics I feel are of use to most VB programmers, and it does
so in depth. Visual Basic NET is an extremely rich programming environment, and I've had to
choose between superficial coverage of many topics and in-depth coverage of fewer topics. To make
room for more topics, I have avoided including a lot of reference material and lengthy listings. For
example, you won’t find complete project listings or Form descriptions. T'assume you can draw a few
controls on a Form and set their properties, and you don’t need long descriptions of the properties
of the control. I'm also assuming that you don’t want to read the trivial segments of each application.
Instead, the listings concentrate on the “meaty” part of the code: the procedures that explain the
topic at hand. If you want to see the complete listing, it’s all on the CD.

The topics covered in this book were chosen to provide a solid understanding of the principles
and techniques for developing applications with Visual Basic. Programming isn’t about new key-
words and functions. I chose the topics I felt every programmer should learn in order to master the
language. I was also motivated by my desire to present useful, practical examples. You will not find
all topics equally interesting or important. My hope is that everyone will find something interesting
and something of value to their daily work—whether it’s an application that maps the folders and
tiles of a drive to a TreeView control, an application that prints tabular data, or an application that
saves a collection of objects to a file.

Many books offer their readers long, numbered sequences of steps to accomplish something. Fol-
lowing instructions simplifies certain tasks, but programming isn’t about following instructions. It's
about being creative; it's about understanding principles and being able to apply the same techniques
in several practical situations. And the way to creatively exploit the power of a language such as
Visual Basic NET is to understand its principles and its programming model.

In many cases, I provide a detailed, step-by-step procedure that will help you accomplish a task,
such as designing a menu. But not all tasks are as simple as designing menus. I explain why things
must be done in a certain way, and I present alternatives and try to connect new topics to those
explained earlier in the book. In several chapters, I expand on applications developed in earlier chap-
ters. Associating new knowledge to something you have already mastered provides positive feedback
and a deeper understanding of the language.

This book isn’t about the hottest features of the language; it's about solid programming tech-
niques and practical examples. For example, I'm not going to show you how to write multithreaded
applications. The real challenge with multithreaded applications is their debugging, which requires
substantial experience. Once you master the basics of programming Windows applications with
Visual Basic NET and you feel comfortable with the more advanced examples of the book, you will
tind it easy to catch up with the topics that aren’t discussed.
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How About the Advanced Topics?

Some of the topics discussed in this book are non-trivial, and quite a few topics can be considered
advanced. The TreeView control, for example, is not a trivial control, like the Button or TextBox
control, but it's ideal for displaying hierarchical information (this is the control that displays the
hierarchy of folders in Windows Explorer). If you want to build an elaborate user interface, you
should be able to program controls like the TreeView control, which is discussed in Chapter 16.
(But you need not read that chapter before you decide to use this control in a project.)

You may also find some examples to be more difficult than you expected. I have tried to make
the text and the examples easy to read and understand, but not unrealistically simple. In Chapter 13,
you'll find information about the File and Directory objects. You can use these objects to access and
manipulate the file system from within your application, but this chapter wouldn’t be nearly as use-
tul without an application that shows you how to scan a folder recursively (scan the folder’s files
and then its subfolders, to any depth). To make each chapter as useful as I could, I've included com-
plex examples, which will provide a better understanding of the topics. In addition, many of these
examples can be easily incorporated into your applications.

You can do a lot with the TreeView control with very little programming, but in order to make
the most out of this control, you must be ready for some advanced programming. Nothing terribly
complicated, but some things just aren’t simple. Programming most of the operations of the Tree-
View control, for instance, is straightforward, but if your application calls for populating a TreeView
with an arbitrary number of branches (such as mapping a directory structure to a TreeView), the
code can get involved.

The reason I've included the more advanced examples is that the corresponding chapters would
be incomplete without them. If you find some material to be over your head at first reading, you can
skip it and come back to it after you have mastered other aspects of the language. But don’t let a few
advanced examples intimidate you. Most of the techniques are well within the reach of an average
VB programmer. The few advanced topics were included for the readers who are willing to take that
extra step and build elaborate interfaces using the latest tools and techniques.

There’s another good reason for including advanced topics. Explaining a simple topic, like how
to populate a collection with items, is very simple. But what good is it to populate a collection if you
don’t know how to save it to disk and read back its items in a later session? Likewise, what good 1s 1t
to learn how to print simple text files? In a business environment, you will most likely be asked to
print a tabular report, which is substantially more complicated than printing text. In Chapter 15 you
will learn how to print business reports with headers, footers, and page numbers, and even how to
draw grids around the rows and columns of the report. One of my goals in writing this book was to
exhaust the topics I've chosen to discuss and to present all the information you need to do some-
thing practical.

The Structure of the Book

Mastering Visual Basic NET isn’t meant to be read from cover to cover, and I know that most people
don’t read computer books this way. Each chapter is independent of the others, although all chapters
contain references to other chapters. Each topic is covered in depth; however, I make no assumptions
about the reader’s knowledge on the topic. As a result, you may find the introductory sections of a
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chapter too simple. The topics become progressively more advanced, and even experienced program-
mers will find some new information in each chapter. Even if you are familiar with the topics in a
chapter, take a look at the examples. I have tried to simplify many of the advanced topics and
demonstrate them with clear, practical examples.

VB6 "» VB.NET

Experienced Visual Basic programmers should pay attention to these special sidebars with the “VB6 to
VB.NET” icon, which calls your attention to changes in the language. These sections usually describe new
features in VB.NET or enhancements of VB6 features, but also VB6 features that are no longer supported
by VB.NET.

This book tries to teach through examples. Isolated topics are demonstrated with short examples,
and at the end of many chapters, you'll build a large, practical, real-world app that “puts together”
the topics and techniques discussed throughout the chapter. You may find some of the more
advanced applications a bit more difficult to understand, but you shouldn’t give up. Simpler applica—
tions would have made my job easier, but the book wouldn’t deserve the Mastering title and your
knowledge of Visual Basic wouldn’t be as complete.

In the first part of the book, we'll go through the fundamentals of Visual Basic NET. You'll
learn how to design visual interfaces with point-and-dick operations, and how to program a few
simple events, like the click of the mouse on a button. After reading the first two chapters, you’ﬂ
understand the structure of a Windows application. Then we'll explore the elements of the visual
interface (the basic Windows controls) and how to program them.

The second part of the book is about building and using objects. Visual Basic NET is a truly
object-oriented language, and objects are the recurring theme in every chapter. Part I is a formal
and more systematic treatment of objects. You will learn how to build custom classes and controls,
which will help you understand object-oriented programming a little better.

In the third part of the book, we'll discuss some of the most common classes of the Framework.
The Framework is the core of NET. It's your gateway to the functionality of the operating system
itself, and it’s going to be incorporated into the next version of Windows. In Part IIT we'll examine
collections (like ArrayLists and HashTables), the objects for manipulating files and folders, the
StringBuilder object that manipulates text, and a few more.

The fourth part of the book is a collection of intermediate to advanced topics. It includes chapters on
graphics and printing, an overview of the debugging tools, and a chapter on recursive programming—
a very powerful programming technique. You will also find a chapter on building Multiple Document
Interfaces—an interface that hosts multiple windows, each one displaying a different document.

The fifth part of the book is an overview of the data access tools. The emphasis is on the visual
tools, and you will learn how to query databases and present data to the user. You will also find
information on programming the basic objects of ADO.NET.

Part V1 is about Web applications. Here you will learn the basics of ASP NET, how to develop
Web applications, and how to write Web services. Web applications are written Visual Basic NET,
but they deploy a user interface that consists of HI ML pages and interact with the user through the
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browser. Web services are functions that can be called from anywhere, and they’re one of the most
promising features of the NET Platform.

Mastering Visual Basic NET does not cover all the topics you can think of. I hope T've chosen the
topics you’ﬂ encounter most often in your daﬂy tasks and I've covered them in enough detail,
to help you understand the basics and be able to look up more specific topics in the product
documentation.

How to Reach the Author

Despite our best efforts, a book this size is bound to contain errors. Although a printed medium
isn't as easy to update as a Web site, I will spare no effort to fix every problem you report (or I dis-
cover), The revised applications, along with any other material I think will be of use to the readers of
this book, will be posted on the Sybex Web site. If you have any problems with the text or the apph—
cations in this book, you can contact me directly at pevangelos@yahoo. com.

Although Tcan't promise a response to every question, I will fix any problems in the examples
and provide updated versions. I would also like to hear any comments you may have on the book,
about the topics you liked or did not like, and how useful the examples are. Your comments will be
taken into consideration in future editions.
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Part I

The Fundamentals

In this section:

Chapter 1: Getting Started with VB.NET
Chapter 2: Visual Basic Projects
Chapter 3: Visual Basic: The Language
Chapter 4: Writing and Using Procedures
Chapter 5: Working with Forms

Chapter 6: Basic Windows Controls
Chapter 7: More Windows Controls
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Chapter 1

Getting Started with VB.NET

WELCOME TO THE ENTERPRISE Edition of Visual Basic NET. I'm assuming you have installed
Visual Studio .NET, Enterprise Edition. You may have even already explored the new environ-
ment on your own, but this book doesn’t require any knowledge of Visual Basic 6. It doesn’t
require anything more than a familiarity with programming. As you already know, Visual Basic
NET is just one of the languages you can use to build applications with Visual Studio .NET. I
happen to be convinced that it is also the simplest, most convenient language, but this isn’t really
the issue. What you should keep in mind is that Visual Studio NET is an integrated environ-
ment for building, testing, and debugging a variety of applications: Windows applications, Web
applications, classes and custom controls, even console applications. It provides numerous tools
for automating the development process, visual tools to perform many common design and pro-
gramming tasks, and more features than any author would hope to cover.

The first thing you must learn is the environment you'll be working in from now on. In the
first chapter of this book, you'll familiarize yourself with the integrated development environment
(IDE) and how its tools allow you to quickly design the user interface of your application, as well
as how to program the application.

It will be a while before you explore all the items of the IDE. Visual Studio is an environment
for developing all types of applications, from a simple Windows application to a complete Web
app involving databases and XML files. I will explain the various items as needed in the course of
the book. In this chapter, we'll look at the basic components of the IDE needed to build simple
Windows applications.

The Integrated Development Environment
Visual Studio .NET is an environment for developing Windows and Web applications. Visual

Basic INET is just one of the languages you can use to program your applications. Actually,
Visual Studio NET was designed to host any language, and many companies are working on lan-
guages that will be integrated in Visual Studio .NET. Some people will develop Windows appli-
cations in Visual Studio NET with COBOL, or FORTRAN.
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4 CHAPTER1 GETTING STARTED WITH VB.NET

So, what's the distinction between Visual Studio NET and the language? Visual Studio NET is
the environment that provides all the necessary tools for developing applications. The language is
only one aspect of a Windows application. The visual interface of the application isn't tied to a spe-
cific language, and the same tools you'll use to develop your application’s interface will also be used
by all programmers, regardless of the language they'll use to code the application.

The tools you'll use to access databases are also independent of the language. Visual Studio pro-
vides tools that allow you to connect to a database, inspect its objects, retrieve the information you're
interested in, and even store it in objects that can be accessed from within any language.

There are many visual tools in the IDE, like the Menu Designer. This tool allows you to Visuaﬂy
design menus and to set their names and basic properties (such as checking, enabling, or disabling
certain options). Designing a menu doesn’t involve any code, and it’s carried out with point-and-
click operations. Of course, you will have to insert some code behind the commands of your menus,
and (again) you can use any language to program them.

To simplify the process of application development, Visual Studio NET provides an environment
that's common to all languages, which is known as integrated development environment (IDE). The purpose
of the IDE is to enable the developer to do as much as possible with visual tools, before writing code.
The IDE provides tools for designing, executing, and debugging your applications. It's your second

desktop, and you’ﬂ be spending most of your productive hours in this environment.

The Start Page

When you run Visual Studio for the first time, you will see the window shown in Figure 1.1. On the
My Profile tab, you will set your personal preferences by specifying your language. Select Visual
Basic Developer in the Profile box, and the other two boxes will be filled automatically. You can
leave the other fields to their default values. The ComboBox control at the bottom of the page, the
At Startup control, is where you define what you want Visual Studio NET to do when it starts.
The choices are the following:

Show Start Page Every time you start Visual Studio .NET, this page will appear.

Load Last Loaded Solution ~ Once you start working on a real project (a project that will take
you from a few days to a few months to complete), select this option so that the project will be
loaded automatically every time you start Visual Studio NET.

Show Open Project Dialog Box Every time you start Visual Studio NET, the Open Project

dialog box will appear, where you can select a project to open.

Show New Project Dialog Box  Every time you start Visual Studio .NET, the New Project

dialog box will appear, where you can specify the name of a new project—a setting to avoid.

Show Empty Environment This option instructs Visual Studio .NET to start a new empty
solution, and you're responsible for adding new or existing projects to the solution and new or
existing items to a project.

The actions are self-explanatory, and the most common setting is to show the Start Page. The
Start Page displays the four most recently opened projects, as well as the New Project and Open
Project buttons. To see the Start Page, select the Get Started option.
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The remaining options lead to Visual Studio sites with up—to—date information about the prod—
uct, such as news articles, updated documents, and service packs or patches. At the very least, you
should switch to the Downloads option from time to time to check for updates. The installation of
the updates should be automatic—after you confirm your intention to download and update any
new component, of course.

The Web Hosting option leads to a page with information about ISPs that support ASP.NET.
You will need the services of these ISPs to post an actual Web application or Web services to the
Internet. Web applications and Web services are two types of projects you can develop with Visual
Studio (they're discussed in the last part of the book). These projects aren’t distributed to users;

instead, they run on a Web server; users must connect to the URL of the Web server and run the
application in their browser.

NOTE  The official names of the products are Visual Studio NET and Visual Basic NET. Throughout the book I will
refer to the language as VB.NET and mostly as VB. When referring to the previous version of the language, I will use VB6.

STARTING A NEW PROJECT

At this point, you can create a new project and start working with Visual Basic NET. To best explain
the various items of the IDE, we are going to build a simple form—it’s not even an application. The
form is the window of your application—what users will see on their desktop when they run your
application.

Open the File menu and select New > Project. In the New Project dialog box (Figure 1.2), you
will see a list of project types you can create with Visual Studio. Select the Windows Application
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template, and Visual Studio will suggest the name WindowsApplication] as the project name. Change

it to MyTestApplication. Under the project’s name is another box, named Location. This is the folder
in which the new project will be created (every project is stored in its own folder). Visual Studio will
create a new folder under the one specified in the Location box and will name it after the project. You

can leave the default project folder and click the OK button.

FIGURE 1.2 New Project i x|
The New prOjeCt Praject Types: Templates: E =2
: — Visual Basic Projects -
dlalog box (] visual C# Projects [E] ': ‘U:'j _11:'1
1 Visual C++ Projects ) windows  Class Library  Windows
1 Setup and Deployment Projects Application Contral Library
+-[_] Other Projects
[ visual Studio Salutions 2 &
‘?Q" 5] <4 £Ebd
ASP.MET Wheb ASP.NET Web  Web Control
Application Service Library &
-
£ project for creating an application with a Windows user interface
Hame: | windewsapplication 1]
Location: | CiMy Documents|Yisual Studio Projects j Browse. ..
" Add to Solution * Close Solution

Froject will bs creatsd at C:\My DocumentsiVisual Studio ProjectslwindowsApplication].

FMore oK I Cancel ‘ Help |

VB6 " VB.NET

Unlike previous versions of Visual Basic, Visual Basic .NET creates a new folder for the project and saves
the project’s files there, even before you edit them. The IDE saves the changes to the project’s files by default
every time you run the project. To change this behavior, use the Tools > Options dialog box, which is
described later in this book.

What you see now is the Visual Studio IDE displaying the Form Designer for a new project
(Figure 1.3). The main window is the Form Designer, and the gray surface on it is the window of
your new application in design mode. Using the Form Designer, you'll be able to design the visible
interface of the application (place various components of the Windows interface on the form) and
then program the application.

The default environment is rather crowded, so let’s hide a few of the toolbars we’re not going to
use in the projects of the first few chapters. You can always show any of the toolbars at any time.
Open the View menu and select Toolbars. You will see a submenu with 28 commands, which are
toggles. Each command corresponds to a toolbar, and you can turn the corresponding toolbar on or
off by clicking one of the commands in the Toolbar submenu. Turn off all the toolbars except for
the Layout and Standard toolbars.

The last item in the Toolbars submenu is the Customize command, which leads to a dialog box
where you can specify which of the toolbars and which of the commands you want to see.
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USING THE WINDOWS FORM DESIGNER
To design the form, you must place on it all the controls you want to display to the user at runtime.
The controls are the components of the Windows interface (buttons, radio buttons, lists, and so on).
Open the Toolbox by moving the pointer over the Toolbox tab at the far left; the Toolbox will pull
out, as shown in Figure 1.4. This toolbox contains an icon for each control you can use on your form.

The controls are organized into tabs, each tab containing controls you can use with a specific type
of project. In the first part of the book, we’ll create simple Windows applications and we’ll use the
controls on the Windows Forms tab. When you develop a Web application, the icons of the controls
on the Windows Forms tab will become disabled and you will be allowed to place only Web con-
trols on the form (which will be a Web form, as opposed the Windows form you’re building in this
project). If you click the Web Forms tab now, all the icons on it will be disabled.

To place a control on the form, you can double-click the icon of the control. A new instance with
a default size will be placed on the form. Then you can position and resize it with the mouse. Or
you can select the control with the mouse, then move the mouse over the form and draw the outline
of the control. A new instance of the control will be placed on the form, and it will fill the rectangle
you speciﬁed with the mouse. Place a TextBox control on the form by double—dicking the TextBox
icon on the Toolbox.
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The control’s properties will be displayed in the Properties window (Figure 1.5). This window, at the
far left edge of the IDE, displays the properties of the selected control on the form. If the Properties win-
dow is not visible, select View > Properties Window, or press F4. If no control is selected, the proper-
ties of the selected item in the Solution Explorer will be displayed. Place another TextBox control on the
form. The new control will be placed almost on top of the previous one. Reposition the two controls on
the form with the mouse. Then right—click one of them and, from the context menu, select Properties.
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In the Properties window, also known as the Property Browser, you see the properties that deter-
mine the appearance of the control, and in some cases, its function. Locate the TextBox control’s
Text property and set it to "My TextBox Control” by entering the string (without the quotes) into
the box next to property name. Select the current setting, which is TextBox1, and type a new string.
The control’s Text property is the string that appears in the control.

Then locate its BackColor property and select it with the mouse. A button with an arrow will
appear next to the current setting of the property. Click this button and you will see a dialog box
with three tabs (Custom, Web, and System), as shown in Figure 1.6. On this dialog box, you can
select the color, from any of the three tabs, that will fill the control’s background. Set the control’s
background color to yellow and notice that the control’s appearance will change on the form.
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Then locate the control’s Font property. You can click the plus sign in front of the property
name and set the individual properties of the font, or you can click the button with the eﬂipsis to
invoke the Font dialog box. On this dialog box, you can set the font and its attributes and then click
OK to close the dialog box. Set the TextBox control’s Font property to Verdana, 14 points, bold.
As soon as you close the Font dialog box, the control on the form will be adjusted to the new
setting,

There’s a good chance that the string you assigned to the control's Text property won'’t fit in the
control’s width when rendered in the new font. Select the control on the form with the mouse, and
you will see eight handles along its perimeter. Rest the pointer over any of these handles, and it will
assume a shape indicating the direction in which you can resize the control. Make the control Iong
enough to fit the entire string. If you have to, resize the form as well. Click somewhere on the form
and when the handles along its perimeter appear, resize it with the mouse.

If you attempt to make the control tall enough to accommodate a few lines of text, you'll realize
that you can’t change the control’s height. By default, the TextBox control accepts a single line of
text. So far you've manipulated properties that determine the appearance of the control. Now you'll
change a property that determines not only the appearance, but the function of the control as well.
Locate the Multiline property. Its current setting is False. Expand the list of available settings and
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change it to True. (You can also change it by double-clicking the name of the property. This action
toggles the True/False settings.) Then switch to the form, select the TextBox control, and make it
taller.

The Multiline property determines whether the TextBox control can accept one (if Multiline =
False) or more (if Multiline = True) lines of text. Set this property to True, go back to the Text
property, and this time set it to a long string and press Enter. The control will break the long text
into multiple lines. If you resize the control, the lines will change, but the entire string will fit across
the control. That’s because the control's WordWrap property is True. Set it to False to see how the
string will be rendered on the control.

Multiline TextBox controls usually have a vertical scrollbar, so that users can quickly locate the
section of the text they’re interested in. Locate the control’s ScrollBars property and expand the list
of possible settings by clicking the button with the arrow. This property’s settings are None, Verti-
cal, Horizontal, and Both. Set it to vertical, assign a very long string to its Text property, and watch
how the control handles the text. At design time, you can’t scroll the text on the control. If you
attempt to move the scrollbar, the entire control will be moved. To examine the control’s behavior at
runtime, press FS. The application will be compiled, and a few moments later, the form with the two
TextBox controls will appear on the desktop (like the ones in Figure 1.7). This is what the users of
your application would see (if this were an application worth distributing, of course).
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Enter some text at runtime, select text on the control, and copy it to the Clipboard by pressing
Ctrl+C. You can also copy text in any other Windows application and paste it on the TextBox con-
trol. When you’re done, open the Debug menu and select Stop Debugging. This will terminate your
application’s execution, and you’ll be returned to the IDE.

One of the properties of the TextBox control that determines its function, rather than its appear-
ance, is the CharacterCasing property, whose settings are Normal, Upper, and Lower. In normal
mode, the characters appear as typed. In Lower mode, the characters are automatically converted to
lowercase before they are displayed on the control. The default setting of this property is Normal.
Set it to Upper or Lower, run the application again, and see how this property’s setting affects the
function of the control. Enter some lowercase text on the control, and the control itself will convert
it to uppercase (or vice versa).

The design of a new application starts with the design of the application’s form. The design of
the form determines the functionality of the application. In effect, the controls on the form deter-
mine how the application will interact with the user. The form itself is a prototype, and you can
demonstrate it to a customer before even adding a single line of code. As you understand, by placing
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controls on the form and setting their properties you're implementing a lot of functionality before
coding the application. The TextBox control with the settings discussed in this section is a func-
tional text editor.

Project Types

Before moving on, let me mention briefly all the types of projects you can build with Visual Studio
in addition to Windows applications. All the project types supported by Visual Studio are displayed
on the New Project dialog box, and they’re the following:

Class library A class library is a basic code-building component, which has no visible interface
and adds specific functionality to your project. Simply put, a class is a collection of functions that
will be used in other projects beyond the current one. With classes, however, you don’t have to
distribute source code. Class libraries are equivalent to ActiveX DLL and ActiveX EXE project
types of VB6.

Windows control library A Windows control (or simply control), such as a TextBox or Button,
is a basic element of the user interface. If the controls that come with Visual Basic (the ones that
appear in the Toolbox by default) don’t provide the functionality you need, you can build your
own custom controls. People design their own custom controls for very specific operations to
simplify the development of large applications in a team environment. If you have a good idea for
a custom control, you can market it—the pages of the computer trade magazines are full of ads
for advanced custom controls that complement the existing ones.

Console application A Console application is an application with a very limited user interface.
This type of application displays its output on a Command Prompt window and receives input
from the same window. You'll see an example of a simple Console application later in this chap-
ter, and that will be the last Console application in this book. The purpose of this book is to
show you how to build Windows and Web applications with rich interfaces, not DOS-like appli-
cations. However, the product’s documentation uses Console applications to demonstrate specific
topics, and this is why I've included a short section on Console applications in this chapter.

Windows service A Windows service is a new name for the old NT services, and they're long-
running applications that don’t have a visible interface. These services can be started automatically
when the computer is turned on, paused, and restarted. An application that monitors and reacts
to changes in the file system is a prime candidate for implementing as a Windows service. When
users upload files to a specific folder, the Windows service might initiate some processing (copy
the file, read its contents and update a database, and so on). We will not discuss Windows serv-
ices in this book.

ASP.NET Web application  Web applications are among the most exciting new features of
Visual Studio. A Web application is an app that resides on a Web server and services requests
made through a browser. An online bookstore, for example, is a Web application. The applica-
tion that runs on the Web server must accept requests made by a client (a remote computer with
a browser) and return its responses to the requests in the form of HTML pages. Web applica-
tions are not new, but ASP.NET hides many of details of building Web applications and makes
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the process surprisingly similar to the process of building Windows applications. Web applica-
tions and Web services are discussed in detail in the last part of the book.

ASP.NET Web service A Web service is not the equivalent of a Windows service. A Web
service is a program that resides on a Web server and services requests, just like a Web applica-
tion, but it doesn’t return an HTML page. Instead, it returns the result of a calculation or a data-
base lookup. Requests to Web services are usually made by another server, which is responsible
for processing the data. A Web application that accepts a query for all VB books published by Sybex
will return a page with the results. A Web service that accepts the same query will return an XML
tile with the results. The file will be used by the application that made the request to prepare a
new page and send it to the client, or to populate a Windows form.

Web control library  Just as you can build custom Windows controls to use with your
Windows forms, you can create custom Web controls to use with your Web pages. Web con-
trols are not discussed in this book, but once you've understood how ASP applications work
and how Web applications interact with clients, you'll be able to follow the examples in the
documentation.

The other three templates in the New Project dialog box—Empty Project, Empty Web Project,
and New Project In Existing Folder—are not project types, just a way to organize the new project
yourself. When you create a new project of any of the previous types, Visual Studio creates a new
folder named after the project and populates it with a few files that are necessary for the specitic
application type. A Windows application, for example, has a form, and the appropriate file is created
automatically in the project’s folder when a new Windows application is created. With the last three
types of projects, you're responsible for creating and adding all the required items yourself.

Your First VB Application

P In this section, we'll develop a very simple application to demonstrate not only the design of the

@ interface, but also how to code the application. We'll build an application that allows the user to
enter the name of their favorite programming language, and then we evaluate the choice. Objectively,
VB is a step ahead of all other languages and it will receive the best evaluation. All other languages
will get the same grade—good, but not VB.

Tip  The project you will build in this section is called WindowsApplimtion] , and you can fz’nd it in this fkapter’s folder
on the CD. Copy the WindowsApplication] folder from the CD to your hard disk, then clear the Read-Only attribute of
the files in the folder. All the files you copy from the CD are read-only. To change this attribute (so that you can save the
changes), select all the files in a project’s folder, right-click them, and select Properties. In the dialog box that appears, clear
the box Read-Only.

You can open the project on the CD and examine it, but I suggest you follow the steps outlined in
this paragraph to build the project from scratch. Start a new project, use the default name Windows-
Application], and place a TextBox and a Button control on the form. Use the mouse to position and
resize the controls on the form, as shown in Figure 1.8.
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FIGURE 1.8 = =Tk
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We have a winner!

Now we must insert some code to evaluate the user’s favorite language. Windows applications are
made up of small code segments, called event handlers, which react to specific actions. In the case of our
example, we want to program the action of clicking the button. When the user clicks the button, we
want to execute some code that will display a message.

To insert some code behind the Button control, double-click the control and you’ﬂ see the code
window of the application, which is shown in Figure 1.9. The line “Private ...” is too long to fit on
the printed page, so T've inserted a line-continuation character (an underscore) to break it into two lines.
When a line is too long, you can break it into two lines by inserting the line continuation character.
Alternatively, you can turn on the word wrap feature of the editor (you’ﬂ see shortly how to adjust
the editor’s properties). Notice that I've also inserted quite a bit of space before the second half
of the first code line. It's customary to indent continued lines so that they can be easily distinguished
from the other lines.

FIGURE 1.9 Ohbiject Browser | Start Page | Farml wb [Design]® Forml.vb"‘l E
. ##Form1 (WindowsApplication2 v | |W (Declarations h
The outline of a ¢ Formt { i ) = I ! =
. Fublic Class Forml =
subroutme that Inherits System.Windows.Forms.Form
handles the Click
event of a Button
Private Sub Buttonl Click [ByVal sender As System.Cbject, _
COntrOl EvVal e As Zystem.Eventlrgs) Handles Buttonl.Click
End Sub
End Class
‘4 A

The editor opened a subroutine, which is delimited by the foﬂowing statements:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
End Sub
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At the top of the main pane of the Designer, you will see two tabs named after the form: in
Figure 1.9, they’re the Form1.vb [Design] tab and the Form1.vb tab. The first tab is the Win-
dows Form Designer (where you build the interface of the application with visual tools) and the
second is the code editor, where you insert the code behind the interface. At the top of the code
editor, which is what you see in Figure 1.9, are two ComboBoxes. The one on the left contains
the names of the controls on the form. The other one contains the names of events each control
recognizes. When you select a control (or an object, in general) in the left list, the other list’s con-
tents are adjusted accordingly. To program a specific event of a specific control, select the name
of the control in the first list (the Objects list) and the name of the event in the right list (the
Events list).

The Click event happens to be the default event of the Button control, so when you double-
click a Button on the form, you're taken to the Button1_Click subroutine. This subroutine is an
event handler. An event handler is invoked automaticaﬂy every time an event takes place. The event
is the Click event of the Button1 control. Every time the Button1 control on the form is clicked, the
Button1_Click subroutine is activated. To react to the Click event of the button, you must insert the
appropriate code in this subroutine.

The name of the subroutine is made up of the name of the control, followed by an underscore
and the name of the event. This is just the default name, and you can change it to anything you like
(such as EvaluateLanguage, for this example, or StartCalculations). What makes this subroutine an
event handler is the keyword Handles at the end of the statement. The Handles keyword tells the
compiler what event this subroutine is supposed to handle. Button1.Click is the Click event of the
Button1 control. If there were another button on the form, the Button2 control, you’d have to write
code for a subroutine that would handle the Button2.Cl1ick event. Each control recognizes many
events; for each control and event combination, you can provide a different event handler. Of course,
we never program every possible event for every control.

NOTE  As you will soon realize, the controls have a default bebavior and handle the basic events on their own. The
TextBox control knows how to handle keystrokes. The CheckBox control (a small square with a check mark) changes state
by biding or displaying the checkmark every time it’s clicked. The ScrollBar control moves its indicator (the button in the
middle of the control) every time you click one of the arrows at the two ends. Because of this default bebavior of the controls,
you need not supply any code for the events of most controls on the form.

Rename Button1_Click subroutine to EvaluateLanguage. However, you shouldn’t change the
name of the event this subroutine handles. If you change the name of the control after you have
inserted some code in an event handler, the name of the event handled by the subroutine will be
automatically changed. The name of the subroutine, however, won't change.

Let’s add some code to the Click event handler of the Button1 control. When this button is
clicked, we want to examine the text on the control and, if it’s “Visual Basic”, display a message; if
not, we'll display a different message. Insert the lines of Listing 1.1 between the Private Sub and
End Sub statements. (I’m showing the entire Iisting here, but there’s no reason to retype the first and
last statements.)
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LISTING 1.1: PROCESSING A USER-SUPPLIED STRING

Private Sub EvaluatelLanguage_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim Tanguage As String
Tlanguage = TextBox1l.Text

If language = "Visual Basic" Then
MsgBox("We have a winner!")
Else
MsgBox(language & " is not a bad Tanguage.")
End If
End Sub

Here’s what this code does. First, it assigns the value of the TextBox1 control to the variable lan-
guage. A variable is a named location in memory, where a value is stored. This memory location can
be read later in the code or set to a different value. Variables are where we store the intermediate
results of our calculation when we write code. Then the program compares the value of the language
variable to the literal “Visual Basic”, and depending on the outcome of the comparison, it displays
one of two messages. The MsgBox() function displays the specified message in a small window with
the OK button. Users can view the message and then click the OK button to close the message box.

Even if you're not familiar with the syntax of the language, you should be able to understand
what this code does. Visual Basic is the simplest NET language, and we will discuss the various
aspects of the language in detail in the following chapters. In the meantime, you should try to under-
stand the process of developing a Windows application: how to build the visible interface of the
application, and how to program the events to which you want your application to react.

Making the Application More Robust

The code of our first application isn't very robust. If the user doesn’t enter the string with the exact
spelling shown in the listing, the comparison will fail. We can convert the string to uppercase and
then compare it to “VISUAL BASIC” to eliminate differences in case. To convert a string to upper-
case, use the ToUpper method of the string class. The foﬂowing expression returns the string stored
in the language variable, converted to uppercase:

Tlanguage.ToUpper

We should also assume that the user may enter “VB” or “VB.NET”, so let's modify our code as
shown in Listing 1.2.

LISTING 1.2: A MORE ROBUST STRING COMPARISON TECHNIQUE

Private Sub EvaluatelLanguage_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim Tanguage As String
Tanguage = TextBox1l.Text
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Tlanguage = Tanguage.ToUpper
If Tanguage = "VISUAL BASIC" Or _
language = "VB" Or _
Tanguage = "VB.NET" Then
MsgBox("We have a winner!")
Else
MsgBox(language & " is not a bad Tanguage")
End If
End Sub

The If statement is a long one, and for clarity T've inserted the underscore character to break it
mnto rnultiple text lines. As you enter the code, you will either enter an underscore character and then
press Enter to move to the following line, or ignore the underscore character and continue typing on
the same line. You will see later how you can instruct the code editor to automatically wrap long
lines of code.

Run the application, enter the name of your favorite language, and then click the Button to evalu-
ate your choice. It's an extremely simple project, but this is how you write Windows applications:
you design the interface and then enter code behind selected events.

In the following section, we'll improve our application‘ You never know what users may throw
at your application, so whenever possible we try to limit their response to the number of available
choices. In our case, we can display the names of certain languages (the ones we're interested in)
and force the user to select one of them. One way to display a limited number of choices is to use a
ComboBox control. In the following section, we'll revise our sample application so that the user
won't have to enter the name of the language. The user will be forced to select his or her favorite
language from a list, so that we won't have to validate the string supplied by the user.

Making the Application More User-Friendly

Start a new project, the WindowsApplication2 project. If there’s already a project by that name in
your VB projects folder, name it differently or specify a different location. Click the Browse button
on the New Project dialog box and select a new folder. You can also create a new folder like
“MyProjects” or “VB.NET Samples” and select this as the default folder for your next few projects.
Every time you create a new project, this folder will be suggested by default. When you're ready for
your own projects, specify a different location with the Browse button.

When the form of the project appears in the IDE, set the form’s Font property. Locate the Font
item in the Properties window and click the button with the ellipsis (three dots). The usual Font
dialog box will appear, and you can set the form’s font. This time, set it to Comic Sans MS, 11
points. All the controls you'll place on the form from will inherit this font.

Open the Toolbox and double-click the icon of the ComboBox tool. A ComboBox control will
be placed on your form. Now place a Button control on the form and position it so that your form
looks like the one shown in Figure 1.10. To see the properties of a specific control in the Properties
window, you must select the appropriate control on the form. Then set the button’s Text property
to “Evaluate my choice” (just enter this string without the quotes in the box of the Text property in
the control’s Properties window).
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control
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Evaluate my choice

YOUR FIRST VB APPLICATION

We must now populate the ComboBox control with the choices. Select the ComboBox control
on the form by clicking it with the mouse and locate its Items property in the Properties window.
The setting of this property is “Collection,” which means that the Items property doesn’t have a
single value; it’s a collection of items (strings, in our case). Click the ellipsis button and you'll see

the String Collection Editor dialog box, as shown in Figure 1.11.

FIGURE 1.11

Click the ellipsis
button next to the
Items property of a
ComboBox to see
the String Collection
Editor dialog box.

=

‘EnmboBoxl System.\Windows.Forms. ComboBox j
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ItemHeight 20

(Cotecton) ||
Location 14, 50

Locked False -
Items
The items in the combo box,
Properties 9 Dynamic Help

String Collection Editor

Enter the strings in the callection {one per line):

The main pane on the dialog box is a TextBox, where you can enter the items you want to appear
in the ComboBox control at runtime. Enter the following strings, one per row and in the order

shown here:
C++
CH
Java
Visual Basic
Cobol

Then click the OK button to close the dialog box. The items will not appear on the control at
design time, but you will see them when you run the project. Before running the project, set one
more property. Locate the ComboBox control’s Text property and set it to “Select your favorite
language.” This is not an item of the list; it’s the string that will initially appear on the control.
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You can run the project now and see how the ComboBox control behaves. Press F5 and wait for
a few seconds. The project will be compiled, and you'll see its form on your desktop, on top of the
Visual Studio window. This is the same form we've been designing so far, but in runtime (in effect,
what the users of the application will see if you decide to distribute it).

I'm sure you know how this control behaves in a typical Windows application, and our sample appli-
cation is no exception. You can select an item on the control either with the mouse or with the keyboard.
Click the button with the arrow to expand the list, and then select an item with the mouse. Or press the
arrow down and arrow up keys to scroll through the list of items. The control isn’t expanded, but each
time you click an arrow button, the next or previous item in the list appears on the control.

We haven't told the application what to do when the button is clicked, so let’s go back and add some
code to the project. Stop the application by clicking the Stop button on the toolbar (the solid black
square) or by selecting Debug > Stop Debugging from the main menu. When the form appears in
design mode, double-click the button and the code window will open, displaying an empty Click event

handler. Insert the statements shown in Listing 1.3 between the Private Sub and End Sub statements.

LISTING 1.3: THE REVISED APPLICATION

Private Sub EvaluatelLanguage_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim Tanguage As String
Tanguage = ComboBox1.Text

If Tanguage = "Visual Basic" Then
MsgBox("We have a winner!")
Else
MsgBox(language & " is not a bad language.")
End If
End Sub

‘When the form is first displayed, a string that doesn’t correspond toa Ianguage 1s displayed in the
ComboBox control. We must select one of the items from within our code when the form is first
loaded. When a form is loaded, the Load event of the Form object is raised. Double-click some-
where on the form, and the editor will open the form’s Load event handler:

Private Sub Forml_Load(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles MyBase.lLoad
End Sub
Enter the following code to select the item “Visual Basic” when the form is loaded:

Private Sub Forml_Load(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles MyBase.Load
ComboBox1.SelectedIndex = 3
End Sub

Now that we select an item from within our code, you can reset the ComboBox’s Text property
to an empty string.
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As you realize, the controls on the Toolbox are more than nice pictures. They encapsulate a lot
of functionality, and they expose properties that allow you to adjust their appearance and their func-
tionality. Most properties are usually set at design time.

The IDE Components

The IDE of Visual Studio.NET contains numerous components, and it will take you a while to
explore them. It’s practically impossible to explain what each tool, each window, and each menu
does. We'll discuss specific tools as we go along and as the topics we discuss get more and more
advanced. In this section, I will go through the basic items of the IDE, the ones we’ll use in the fol-
lowing few chapters to build simple Windows applications.

The IDE Menu

The IDE main menu provides the following commands, which lead to submenus. Notice that most
menus can also be displayed as toolbars. Also, not all options are available at all times. The options
that cannot possibly apply to the current state of the IDE are either invisible or disabled. The Edit
menu is a typical example. It's quite short when you’re designing the form and quite lengthy when
you edit code. The Data menu disappears altogether when you switch to the code editor—you can’t
use the options of this menu while editing code.

FILE MENU

The File menu contains commands for opening and saving projects, or project items, as well as the
commands for adding new or existing items to the current project.

EDIT MENU

The Edit menu contains the usual editing commands. Among the commands of the Edit menu are
the Advanced command and the IntelliSense command.

Advanced Submenu

The more interesting options of the Edit > Advanced submenu are the following. Notice that the
Advanced submenu is invisible while you design a form visually and appears when you switch to the
code editor.

View White Space  Space characters (necessary to indent lines of code and make it easy to

read) are replaced by periods.

Word Wrap When a code line’s length exceeds the length of the code window, it's automati-
cally wrapped.

Comment Selection/Uncomment Selection Comments are lines you insert between your
code’s statements to document your application. Sometimes, we want to disable a few lines from
our code, but not delete them (because we want to be able to restore them). A simple technique
to disable a line of code is to “comment it out” (insert the comment symbol in front of the line).
This command allows you to comment (or uncomment) large segments of code in a single move.
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IntelliSense Submenu

The Edit > IntelliSense menu item leads to a submenu with four options, which are described next.
IntelliSense is a feature of the editor (and of other Microsoft applications) that displays as much
information as possible, whenever possible. When you type the name of a function and the opening
parenthesis, for example, IntelliSense will display the syntax of the function—its arguments. The
IntelliSense submenu includes the following options.

List Members  When this option is on, the editor lists all the members (properties, methods,
events, and argument list) in a drop-down list. This list will appear when you enter the name of
an object or control followed by a period. Then you can select the desired member from the list
with the mouse or with the keyboard. Let’s say your form contains a control named TextBox1
and you're writing code for this form. When you enter the following string:

TextBox1.

a list with the members of the TextBox control will appear (as seen in Figure 1.12). Select the
Text property and then type the equal sign, followed by a string in quotes like the following:

TextBox1l.Text = "Your User Name"

FIGURE 1.12 Object Browser | List Members | Form1.wb [Design]* Forml.vh*‘ 4bx
: . ##Form1 (WindowsApplication1 = | |s®Button1_click -
Viewing the mem- [ Form1 ¢ i ) = s - Jj
bers Ofa control il’l Private Sub Buttonl Click(ByVal sender is System.Chject, =

. ByWal e is System.Eventirgs] Handle
an IntelliSense drop- bi Language is String
down list language = TextBoxl.Text
language = language.ToUpper
TextBoxl.
IE lan ¢ suspendiayout -
& TablIndex = "YB.NET" Then
Hs g TabStop
Else & Tag
End Tf E& TextAlian
End Sub EH' TextLength
End Class 5 Top
E& ToplewelContral J=|
& Tastring |

-
4 3

If you select a property that can accept a limited number of settings, you will see the names of the
appropriate constants in a drop-down list. If you enter the following statement:

TextBox1l.TextAlign =

you will see the constants you can assign to the property (as shown in Figure 1.13, they are the val-
ues HorizontalAlignment.Center, HorizontalAlignment.Right, and Hor“izonta'IA'I'ignment.Left)‘
Again, you can select the desired value with the mouse or the arrow keys.

The drop-down list with the members of a control or object (the Members List) remains open
until you type a terminator key (the Escape or End key) or switch to another window.

Parameter Info  While editing code, you can move the pointer over a variable, method, or prop-
erty and see its declaration in a yellow tooltip.
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Quick Info  This is another IntelliSense feature that displays information about commands and
functions. When you type the opening parenthesis following the name of a function, for example,
the function’s arguments will be displayed ma tooltip box (a yellow horizontal box). The first
argument appears in bold font; after entering a value for this argument, the next one will appear
in bold. If an argument accepts a fixed number of settings, these values will appear in a drop—
down list, as eXplained previously‘

Figure 1.14 shows the syntax of the DateDiff() function. This function calculates the difference
between two dates in a specified time interval. The first argument is the time interval, and its
value can be one of the constants shown in the list. The following two arguments are the two
dates. The remaining arguments are optional, and they specify options like the first day of the
week and the first day of the year. This function returns a Long value (an integer that represents
the number of the intervals between the two dates).

Complete Word The Complete Word feature enables you to complete the current word by
pressing Ctrl—l—spacebar. For example, if you type “TextB” and then press Ctrl+spacebar, you will
see a list of words that you’re most likely to type (TextBox, TextBox1, and so on).

VIEW MENU

This menu contains commands to display any toolbar or window of the IDE. You have already seen
the Toolbars menu (earlier, under “Starting a New Project”™). The Other Windows command leads to
submenu with the names of some standard windows, including the Output and Command windows.
The Output window is the console of the application. The compiler’s messages, for example, are dis-
played in the Output window. The Command window allows you to enter and execute statements.
When you debug an application, you can stop it and enter VB statements in the Command window.

PROJECT MENU
This menu contains commands for adding items to the current project (an item can be a form, a file,
a component, even another project). The last option in this menu is the Set As StartUp Project com-

mand, which lets you specify which of the projects in a multiproject solution is the startup project
(the one that will run when you press FS). The Add Reference and Add Web Reference commands
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allow you to add references to NET (or COM) components and Web components respectively.
We'll use both commands in later chapters.

BUILD MENU

The Build menu contains commands for building (compiling) your project. The two basic com-
mands in this menu are the Build and Rebuild All commands. The Build command compiles (builds
the executable) of the entire solution, but it doesn’t compile any components of the project that
haven't changed since the last build. The Rebuild All command does the same, but it clears any
existing files and builds the solution from scratch.

DEBUG MENU

This menu contains commands to start or end an application, as well as the basic debugging tools

(which are discussed in Chapter 17).

DATA MENU
This menu contains commands you will use with projects that access data. You'll see how to use this
short menu’s commands in sections that describe the visual database tools in Chapters 21 and 22 in

Part V of the book.

FORMAT MENU

The Format menu, which is visible only while you design a Windows or Web form, contains com-
mands for aligning the controls on the form. The commands of this menu will be discussed briefly
later in this chapter and in more detail in the following chapter.
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TOOLS MENU

This menu contains a list of tools, and most of them apply to C++. The Macros command of the
Tools menu leads to a submenu with commands for creating macros. Just as you can create macros
in an Office application to simplify many tasks, you can create macros to automate many of the
repetitive tasks you perform in the IDE. I'm not going to discuss macros in this book, but once you
familiarize yourself with the environment, you should look up the topic of writing macros in the
documentation.

WINDOW MENU

This is the typical Window menu of any Windows application. In addition to the list of open win-
dows, it also contains the Hide command, which hides all Toolboxes and devotes the entire window
of the IDE to the code editor or the Form Designer. The Toolboxes don’t disappear completely.
They’re all retracted, and you can see their tabs on the left and right edges of the IDE window. To

eXpand a TOO”DOX, just hover the mouse pointer over the corresponding tab.

HELP MENU

This menu contains the various help options. The Dynamic Help command opens the Dynamic
Help window, which is populated with topics that apply to the current operation. The Index com-
mand opens the Index window, where you can enter a topic and get help on the specific topic.

The Toolbox Window

Here you will find all the controls you can use to build your application’s interface. The Toolbox
window is usuaﬂy retracted, and you must move the pointer over it to view the Toolbox. This win-
dow contains these tabs:

Crystal Reports
Data

XML Schema
Dialog Editor
Web Forms
Components
Windows Forms
HTML
Clipboard Ring
General

The Windows Forms tab contains the icons of the controls you can place on a Windows form,
and we’'ll work exclusively with this tab in the course of the next few chapters. Likewise, the Web
Forms and HTML tabs contain the icons of the controls you can place on a Web form. The con-
trols on these tabs are examined in Part VI of the book.
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The Data tab contains the icons of the objects you will use to build data-driven applications, and
they’re explored in Part V of the book. The items on the Data tab are objects with no visible inter-
face. The XML Schema tab contains the tools you’ﬂ need to work with schema XML files. We'll
touch this topic in Part V of the book, but you don’t really need to understand XML to use it.
You'll see how to create XML files with visual tools.

The Solution Explorer

This window contains a list of the items in the current solution. A solution may contain multiple
projects, and each project may contain multiple items. The Solution Explorer displays a hierarchical
list of all the components, organized by project. You can right-click any component of the project
and select Properties in the context menu to see the selected component’s properties in the Proper-
ties window. If you select a project, you will see the Project Properties dialog box. You will find
more information on project properties in the following chapter.

If a project contains multiple forms, you can right-click the form you want to become the startup
form and select Set As StartUp Object. If the solution contains multiple projects, you can right-click
the project you want to become the startup form and select Set As StartUp Project. You can also add
items to a project with the Add Item command of the context menu, or remove a component from
the project with the Exclude From Project command. This command removes the selected compo-
nent from the project, but doesn’t affect the component’s file on the disk. The Remove command
removes the selected component from the project and also deletes the component’s file from the disk.

The Properties Window

This window (also known as the Property Browser) displays all the properties of the selected com-
ponent and their settings. Every time you place a control on a form, you switch to this window to
adjust the appearance of the control on the form, and you have already seen how to manipulate the
properties of a control through the Properties window.

Many properties are set to a single value, like a number or a string. If the possible settings of a
property are relatively few, they're displayed as meaningful constants in a drop-down list. Other
properties are set through a more elaborate interface. Color properties, for example, are set from
within a Color dialog box that’s displayed right in the Properties window. Font properties are set
through the usual Font dialog box. Collections are set in a Collection Editor dialog box, where you
can enter one string for each item of the collection.

If the Properties window is hidden or you have closed it, you can either select the View > Proper-
ties Window command or right-click a control on the form and select Properties. Or you can simply
press F4 to bring up this window. There will be occasions where a control may totaﬂy overlap another
control, and you won’t be able to select the hidden control and view its properties. In this case, you
can select the desired control in the ComboBox part of the Properties window. This box contains the
names of all the controls on the form, and you can select a control on the form by selecting its name
on this box. Use this technique to set the properties of a control that's covered by another control.

The Output Window

The Output window is where many of the tools, including the compiler, send their output. Every time
you start an application, a series of messages is displayed on the Output window. These messages are
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generated by the compiler, and you need not understand them at this point. If the Output window is
not visible, select the View > Other Windows > Output command from the menu.

You can also send output to this window from within your code with the Console.WriteLine
method. Actually, this is a widely used debugging technique—to print the values of certain variables
before entering a problematic area of the code. As you will learn in Chapter 17, there are more elab-
orate tools to help you debug your application, but printing a few values to the Output window is a
time-honored practice in programming with VB to test a function or display the results of interme-
diate calculations.

In many of the examples of this book, especially in the first few chapters, I use the Console.Write-
Line statement to print something to the Output window. To demonstrate the use of the DateDiff()
tunction, for example, I'll use a statement like the following:

Console.WriteLine(DateDiff(DateInterval.Day, #3/9/2001#, #5/15/2001#))

When this statement is executed, the value 67 will appear in the Output Window. This statement
demonstrates the syntax of the DateDiff() function, which returns the difference between the two
dates in days.

The Command Window

While testing a program, you can interrupt its execution by nserting a breakpoint. ‘When the break-
point is reached, the prograrn’s execution 1s suspended and you can execute a statement in the Com-
mand window. Any statement that can appear in your VB code can also be executed in the
Command window.

The Task List Window

This window is usually populated by the compiler with error messages, if the code can’t be success-
tully compiled. You can double-click an error message in this window, and the IDE will take you to
the line with the statement in error—which you should fix.

You can also add your own tasks to this window. Just click the first empty line and start typing.
A task can be anything, from comments and reminders, to URL:s to interesting sites. If you add tasks
to the list, you're responsible for removing them. Errors are removed automatically as soon as you fix
the statement that caused them.

Environment Options

The Visual Studio IDE is highly customizable. I will not discuss all the customization options here,
but I will show you how to change the default settings of the IDE. Open the Tools menu and select
Options (the last item in the menu). The Options dialog box will appear, where you can set all the
options regarding the environment. Figure 1.15 shows the options for the font of the various items
of the IDE. Here you can set the font for various categories of items, like the Text Editor, the
dialogs and toolboxes, and so on. Select an item in the Show Settings For list and then set the font
for this item in the box below.
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FIGURE 1.15 ]
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Figure 1.16 shows the Projects and Solutions options. The top box is the default location
for new projects. The three radio buttons in the lower half of the dialog box determine when
the changes to the project are saved. By default, changes are saved when you run a project. If you
activate the last option, then you must save your project from time to time with the File > Save All

Command.
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Most of the tabs on the Options dialog box are straightforward, and you should take a look at
them. If you don'’t like some of the default aspects of the IDE, this is the place to change them.

A Few Common Properties

In the next few sections, I will go through some of the properties, methods, and events that are com-
mon to many controls, so that I will not have to repeat them with every control in the foﬂowing
chapters. These are very simple members you’ﬂ be using in every apphcation from now on.

To manipulate a control you use its properties, either on the Property Browser at design time, or
though your code at runtime. To program a control, supply a handler for the appropriate events.
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Controls expose methods, too, which act on the control. The Hide method, for example, makes the
control invisible. Properties, methods, and events constitute the programmatic interface of the con-
trol and are collectively known as the control’s members.

All controls have a multitude of properties, which are displayed in the Properties window, and
you can easily set their values. Different controls expose different properties, but here are some that
are common to most:

Name The control’s name. This name appears at the top of the Properties window when a con-
trol is selected on the form and is also used in programming the control. To set the text on a
TextBox control from within your code, you will use a statement like the foﬂowing:

TextBox1l.Text = "My TextBox Control"
You will see how to program the controls shortly.

Font A Font object that determines how the text of the control will be rendered at both design
and runtime.

Enabled By default, all controls are enabled. To disable a control, set its Enabled property to
False. When a control is disabled, it appears in gray color and users can’t interact with it. Dis-
abling a control isn’t as rare as you may think, because many controls are not functional at all
times. If the user hasn’t entered a value in all required fields on the form, clicking the Process but-
ton isn’t going to do anything. After all fields have been set to a valid value, you can enable the
control, indicating to the user that the button can now be clicked.

Size  Sets, or returns, the control’s size. The Size property is a Size object, which exposes two
properties, the Width and Height properties. You can set the Size property to a string like “320,
80" or expand the Size property in the Properties window and set the Width and Height proper-
ties individually.

Tag Holds some data you want to associate with a specific control. For example, you can set the
Tag property to the control’s default value, so that you can restore the control’s default value if the
user supplies invalid data (a string in a TextBox control that expects a numeric value, or a date).

Text The text (a string) that appears on the control. The Label control’s caption can be set (or
read) through the Text property. A control that displays multiple items, like the ListBox or the

ComboBox control, returns the currently selected item in the Text property.

TabStop  As you know, only one control at a time can have the focus on a form. To move the
focus from one control to the other on the same form, you press the Tab key (and Shift+Tab to
move the focus in reverse order). The TabStop property determines whether the control belongs
to the so-called tab order. If True (which is the default value), you can move the focus to the con-
trol with the Tab key. If False, the control will be skipped in the tab order.

Tablndex A numeric value that determines the position of the control in the Tab order. The con-
trol with the smallest TabIndex value is the one that has the focus when the form is first loaded. If
you press Tab once, the focus will be moved to the control with the next larger TabIndex value.

Visible Sometimes we want to make a control invisible. We do so by setting its Visible prop-

erty to False (the default value of the property is True).
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A Few Common Events

As you have already seen, and will also see in the coming chapters, much of the code of a Windows
application manipulates the properties of the various controls on the form. The code of the applica-
tion resides in selected event handlers. Each control recognizes several events, but we rarely program
more than one event per control. In most cases, most of the controls on the form don’t have any
code behind them. The events that are most frequently used in programming Windows applications
are shown next.

Click This is the most common event in Windows programming, and it’s fired when a control

is clicked.
DoubleClick Fired when the control is double-clicked.
Enter Fired when the control received the focus.

Leave Fired when the control loses the focus. We usuaﬂy insert code to validate the control’s
content in this event’s handler.

MouseEnter Fired when the mouse pointer enters the area of the control. This event is fired once.
If you want to monitor the movement of the mouse over a control, use the MouseMove event.

MouseLeave This is the counterpart of the MouseEnter event, and it’s fired when the mouse
pointer moves out of the area of the control.

XXXChanged Some events are fired when a property changes value. These events include
BackColorChanged, FontChanged, VisibleChanged, and many more. The control’s properties can
also change through code, and it’s very common to do so. To set the text on a TextBox control
from within your code, you can execute a statement like the following:

TextBox1.Text = "a new caption"

You may wish to change the background color of a TextBox control if the numeric value dis-
played on it is negative:

If Val(TextBox.Text) < 0 Then
TextBox1l.BackColor = Color.Red
End If

A Few Common Methods

In addition to properties, controls also expose methods. A method acts upon the control by per-
forming a specific task. Windows controls don’t provide many methods, but the objects we’ll
explore in the following chapters provide many more methods. You have already seen the ToUpper
method, which converts a string to uppercase and returns it as a new string. In VB.INET, a string is
more than a series of characters: it’s an object, and so is just about everything in NET. Even a num-
ber is an object and exposes a few properties and methods of its own.

A String variable exposes the methods Length (it returns the string Iength>, ToUpper (it converts
the characters in the string to uppercase and returns a new string), and ToLower (it converts the
characters in the string to lowercase and returns a new string). To see these methods in action, create
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a new application, place a Button control on the form and enter the following statements in its Click
event handler:

Console.WriteLine("Visual Basic".Length)
Console.WriteLine("Visual Basic".ToUpper)
Console.WriteLine("Visual Basic".TolLower)

Then press FS to run the application, and you will see the following in the Output window (this
is where the Console.WriteLine statement sends its output):

12
VISUAL BASIC
visual basic

NOTE  If the Output window is bidden, select View > Other Windows > Output.

Here are a few methods that are common to most controls. In later chapters, where we'll explore
the Windows controls in detail, you'll learn about the methods that are unique to individual con-
trols. The following methods apply to most of the Windows controls.

Focus This method moves the focus to the control to which the method applies, regardless of
the control that has the focus at the time. Your validation routine could move the focus to the
control with an erroneous entry with the following statement:

TextBox1.Focus

It’s also possible to “trap” the focus to a specific TextBox control until the user enters a valid value,
by calling the Focus method from within the Leave event. The following code segment doesn't allow
users to move the focus to another control while TextBox1 doesn’t contain a valid numeric value:

Private Sub TextBoxl_ Leave(ByVal sender As Object, _
ByVal e As System.EventArgs) Handles TextBoxl.Leave
If Not IsNumeric(TextBoxl.Text) Then TextBoxl.Focus()
End Sub

The function lsNumericO returns True if its argument (the value in parentheses following the
function’s name) is a numeric value, like 35 or 244.01.

Clear Many controls provide a method to clear their contents, and this s the Clear method. When
you call the Clear method on a TextBox control, the control’'s Text property is set to an empty string.

Hide / Show The Hide and Show methods reveal or conceal the control. The two methods are
equivalent to setting the Visible property to True and False respectively.

PerformClick It’s rather common to invoke the Click event of a button from within our code.
To do so, call the PerformClick method of the Button control. There are no equivalent methods
for other events.

Scale This method scales the control by a value specified as argument. The following statement
scales the TextBox1 control down to 75 percent of its current size:

TextBox1.Scale(0.75)
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Building a Console Application

One of the new features of Visual Basic INET is that you can write applications that run in a Com-
mand Prompt window. The Command Prompt window isn’t really a DOS window, even though 1t
looks like one. It's a text window, and the only way to interact with an application is to enter lines of
text and read the output generated by the application, which is displayed on this text window, one
line at a time. This type of application is called a Console application, and we’re going to demon-
strate Console applications with a single example. We will not return to this type of application later
in the book, because it’s not what you’re supposed to do as a Windows developer.

The Console application you’ll build in this section, ConsoleApplicationl, prompts the user to
enter the name of his or her favorite language, and then it prints the appropriate message on a new
line, as shown in Figure 1.17.

FIGURE 1.17 ual Studio Projects

e language

A Console applica- ual hasic

hie have a winner?
tion uses the Com-
PRESS ANY KEY TO EXIT
mand Prompt
window to interact

with the user.

Start a new project and, in the New Project dialog box, select the template Console Application.
You can also change its default name from ConsoleApplicationl to a more descriptive name. For the
example of this section, don’t change the application’s name.

A Console application doesn’t have a user interface, so the first thing you’ll see is the code editor’s
window with the following statements:

ModuTe Modulel
Sub Main()
End Sub

End Module

Unlike a Windows application, which is a class, a Console application is a module. Maino is the
name of a subroutine that’s executed automatically when you run a Console application. The code
you want to execute must be placed between the statements Sub Main() and End Sub. Insert the
statements shown in Listing 1.4 in the application’s Main() subroutine.
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LISTING 1.4: A CONSOLE APPLICATION

Module Modulel
Sub Main()
Console.WriteLine("Enter your favorite language")
Dim Tanguage As String
Tlanguage = Console.ReadLine()
Tanguage = language.ToUpper
If language = "VISUAL BASIC' Or language = "VB" Or language = "VB.NET" Then
Console.WriteLine("We have a winner!")
Else
Console.WritelLine(language & " is not a bad Tanguage.")
End If
Console.WriteLine()
Console.WriteLine()
Console.WriteLine("PRESS ANY KEY TO EXIT")
Console.ReadLine()
End Sub
End Module

This code is quite similar to the code of the equivalent Windows applications we developed ear-
lier, except that it uses the Console.WriteLine statement to send its output to the Command
Prompt window instead of a message box.

A Console application doesn’t react to events, because it has no visible interface. However,
it's easy to add elements of the Windows interface to a Console application. If you change the
Console.WriteLine method calls into the MsgBox() function, the message will be displayed ona
message box.

The reason to build a Console application is to test a specific feature of the language without
having to build a user interface. Many of the examples in the documentation are Console applica—
tions; they demonstrate the topic at hand and nothing more. If you want to test the DateDiffO func-
tion, for example, you can create a new Console application and enter the lines of Listing 1.5 in its
Main() subroutine.

LISTING 1.5: TESTING THE DATEDIFF() FUNCTION WITH A CONSOLE APPLICATION

Sub Main()
Console.WriteLine(DateDiff(DateInterval.Day, #3/9/2000#, #5/15/2004#))
Console.WriteLine("PRESS ANY KEY TO EXIT")
Console.ReadlLine()

End Sub

The last two lines will be the same in every Console application you write. Without them, the
Command Prompt window will close as soon as the End Sub statement is reached, and you won't
have a chance to see the result.

Copyright ©2002 SYBEX, Inc., Alameda, CA www.sybex.com


http://www.sybex.com

32

CHAPTER1 GETTING STARTED WITH VB.NET

Console applications are convenient for testing short code segments, but Windows programming
is synonymous with designing functional user interfaces and you won'’t find any more Console appli-
cations in this book.

Summary

This chapter was a quick introduction to the environment you'll be using to design your applica-
tions. It’s a very rich environment, and it will take you a while to become quite comfortable with it.
Keep in mind that you won’t need most of the menus and toolbars in building simple Windows
applications.

What you must get accustomed to is how we design Windows applications. We start with the
application’s visual interface, which is designed with visual tools. This is done with the Windows
Form Designer. After completing the design of the interface, you must add some code to the appli—
cation. Windows applications are event driven. The user interacts with your application through the
mouse and keyboard. Every time the user does something with an element of the interface, an event
is raised. As a programmer, you must decide what events your application should react to and insert
the appropriate code in the handlers of these events.

In the following chapter, you're going to build more simple applications and drill into the con-
cepts of event-driven programming, which is at the core of programming with Visual Studio NET
and Visual Basic NET.
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Visual Basic Projects

THE PREVIOUS CHAPTER INTRODUCED Visual Studio’s IDE, the Toolbox, and the principles
of event-driven programming. In this chapter, we expand on that introduction to the language by
building some “real” applications. Among other topics, we'll look at how to write applications that
validate user input and how to write error-handling routines. We'll also look at several techniques
you'll need as you work through the applications we develop in the rest of the book. In the last
part of the chapter, you'll learn how to distribute your application with a proper Windows installer
(a program that installs your application to the target machine).

The bulk of the chapter demonstrates very basic programming techniques, such as building
user interfaces, event programming, validating user input, and handling errors. The goal is to
show you how to write simple applications using the most basic elements of the language. This
chapter will explain the methodology for building applications. While the code of the applica-
tions will be rather simple, it will demonstrate the basics of validating data and trapping errors.

If you're a beginner, you may be thinking, “All I want now is to write a simple application that
works—I'll worry about data validation later.” It’s never too early to start thinking about validat-
ing your code’s data and error trapping. As you'll see, making sure that your application doesn’t
crash may require more code than the actual operations it performs! If this isn’t quite what you
expected, welcome to the club. A well-behaved application must catch and handle every error
gracefully, including user errors.

Building a Loan Calculator

One easy-to-implement, practical application is a program that calculates loan parameters. Visual
Basic provides built-in functions for performing many types of financial calculations, and you
only need a single line of code to calculate the monthly payment given the loan amount, its dura-
tion, and the interest rate. Designing the user interface, however, takes much more effort.
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Regardless of the language you use, you must go through the following process to develop an
application:

1. Decide what the application will do and how it will interact with the user.
2. Design the application’s user interface according to the requirements of Step 1.

3. Write the actual code behind the events you want to handle.

How the Loan Application Works

Following the first step of the process outlined above, you decide that the user should be able to
specify the amount of the loan, the interest rate, and the duration of the loan in months. You must,
therefore, provide three text boxes where the user can enter these values.

Another parameter affecting the monthly payment is whether payments are made at the beginning
or at the end of each month, so you must also provide a way for the user to specify whether the pay-
ments will be early (first day of the month) or late (last day of the month). The most appropriate
type of control for entering Yes/No or True/False type of information is the CheckBox control.
This control is a toggle: If it’s checked, you can clear it by clicking it. If it’s cleared, you can check it
by clicking again. The user doesn’t enter any data in this control (which means you need not antici-
pate user errors with this control), and it’s the simplest method for specifying values with two possible
states. Figure 2.1 shows a user interface that matches our design specifications. This is the main form

of the LoanCalculator project, which you will find in this chapter’s folder on the CD.

FIGURE 2.1 S
LoanCalculator is a Lo Sy 25000
simple financial Duration (rmanths) ’487
application. Interest Rate e

Early Payment r

Monthly Payment 680.45

Show Payment Exit |

After the user enters all the information on the form, they can click the Show Payment button to
calculate the monthly payment. The program will calculate the monthly payment and display it in
the lower TextBox control. All the action takes place in the button’s Click subroutine. The function
for calculating monthly payments is called Pmt() and must be called as follows:

MonthlyPayment = Pmt(InterestRate, Periods, Amount, FutureValue, Due)

The interest rate (argument lntfrestRate> is speciﬁed as a monthly rate. If the interest rate is 16.5%,
the value entered by the user in the Interest Rate box should be 16.5, and the monthly rate will be
0.165 / 12. The duration of the loan (Periods) is specitied in number of months, and Amount is the
loan’s amount. The FutureValue of a loan is zero (it would be a positive value for an investment), and
the last parameter, Due, specifies when payments are due.

The value of Due can be one of the constants DueDate.BegOfPeriod and DueDate.EndOfPeriod.
These two constants are built into the language, and you can use them without knowing their exact
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value. In effect, this is the essence of using named constants: you type a self-descriptive name and
leave it to VB to convert it to a numeric value. As you will see, NET uses numerous constants, all of
which are categorized in groups called enumerations. The constants that apply to the Due argument of
the Pmt() function belong to the DueDate enumeration, which has two members, the Beg0fPeriod
and EndOfPeriod members.

The present value of the loan is the amount of the loan with a negative sign. It's negative because
you don’t have the money now. You're borrowing it; it’s money you owe to the bank. Future value
represents the value of something at a stated time—in this case, what the loan will be worth when
it's paid off. This is what one side owes the other at the end of the specified period. So the future
value of a loan is zero.

Pmt() is a built-in function that uses the five values in the parentheses to calculate the monthly
payment. The values passed to the function are called arguments. Arguments are the values needed by a
tunction (or subroutine) to carry out an action or calculation. By passing different values to the
tunction, the user can specify the parameters of any loan and calculate its monthly payment. The
Pmt() function and other financial functions of Visual Basic are described in the reference
“VB.NET Functions and Statements” on the CD that accompanies this book.

You don’t need to know how the Pmt() function calculates the monthly payment. The Pmt()
tunction does the calculations and returns the result. To calculate the monthly payment on a loan of
$25,000 with an interest rate of 14.5%, payable over 48 months, and due the last day of the pay-

ment period (which in our case is a month), you'd call the Pmt() function as follows:
Console.WriteLine(Pmt(0.145 / 12, 48, -25000, 0, DueDate.EndOfPeriod))
The value 689.448821287218 will be displayed in the Output window (you'll see later how you

can limit the digits after the decimal point to two, since this is all the accuracy you need for dollar
amounts). Notice the negative sign in front of the Amount argument in the statement. If you specify a
positive amount, the result will be a negative payment. The payment and the loan’s amount have dif-
ferent signs because they represent different cash flows. The loan’s amount is money you owe to the
bank, while the payment is money you pay to the bank.

The last two arguments of the Pmt() function are optional. If you omit them, Visual Basic uses
their default values, which are O for the FutureValue argument and DueDate.BegOfPeriod for the Due
argument. You can entirely omit these arguments and call the Pmt() function like this:

Console.WriteLine(Pmt(0.145 / 12, 48, -25000))

Calculating the amount of the monthly payment given the loan parameters is quite simple. What
you need to know or understand are the parameters of a loan and how to pass them to the Pmt()
function. You must also know how the interest rate is specified, to avoid invalid values. What you
don’t need to know is how the payment is calculated—Visual Basic does it for you. This is the
essence of functions: they are “black boxes” that perform complicated calculations on their argu-
ments and return the result. You don’t have to know how they work, just how to supply the values
required for the calculations.

Designing the User Interface

Now that you know how to calculate the monthly payment, you can design the user interface. To do
so, start a new project, name it LoanCalculator, and rename its form to LoanForm. The form and

the project files can be found in this chapter’s folder on the CD.
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Your first task is to decide the font and size of the text you’ﬂ use for most controls on the form.
Although we aren’t going to display anything on the form directly, all the controls we place on it will
have, by default, the same font as the form. The form is the container of the controls, and they
inherit some of the form’s properties, such as the Font. You can change the font later during the
design, but it’s a good idea to start with the right font. At any rate, don't try to align the controls if
you're planning to change their fonts. This will, most likely, throw off your alignment efforts.

TiP  Try not to mix fonts on a form. A form, or a printed page for that matter, that includes type in several fonts looks
like it has been created haphazardly and is difficult to read. However, you can use different sizes for some of the controls on
the form.

The loan application you'll find on the CD uses the 10-point Verdana font. To change it, select
the form with the mouse, double-click the name of the Font property in the Properties window to
open the Font dialog box, and select the desired font and attributes. When the form s selected, its
name appears in the ComboBox at the top of the window, as shown in Figure 2.2.

FIGURE 2.2
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To design the form shown previously in Figure 2.1, follow these steps:

1. Place four labels on the form and assign the following captions to them:

Label Caption

Labell Loan Amount
Label2 Duration (months)
Label3 Interest Rate
Label4 Monthly Payment

The labels should be large enough to fit their captions. You don’t need to change the default
names of the four Label controls on the form because their captions are all we need. You
aren’t going to program them.
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2. Place a TextBox control next to each label. Set their Name and Text properties to the follow-
ing values. These initial values correspond to a loan of $25,000 with an interest rate of

14.5% and a payoft period of 48 months.

TextBox Name Text
TextBox1 txtAmount 25,000
TextBox2 txtDuration 48
TextBox3 txtRate 14.5
TextBox4 txtPayment

3. The fourth TextBox control is where the monthly payment will appear. The user isn’t sup-
posed to enter any data in this box, so you must set its ReadOnly property to True. You'll be
able to change its value from within your code, but users won't be able to type anything in it.
(We could have used a Label control instead, but the uniform look of TextBoxes on a form is

usually preferred.)

4. Next, place a CheckBox control on the form. By default, the control’s caption is Check1, and
it appears to the right of the check box. Because we want the titles to be to the left of the cor-
responding controls, we'll change this default appearance.

5. Select the check box with the mouse (if it's not already selected), and in the Properties win-
dow, locate the CheckAlign property. Its value is MiddTeLeft. If you expand the drop-down
list by clicking the arrow button, you'll see that this property has many different settings
and each setting is shown as a square. Select the square in the middle row, the right column.
The string MiddTeRight will appear in the property’s box when you click the appropriate
button. The first component of the CheckAlign property’s value indicates the vertical align-
ment of the check box, and the second component of the value indicates the horizontal
alignment. MiddleRight means that the check box should be centered vertically and right-
aligned horizontally.

=

|chkPayEarIy System.\Windows.Forms. CheckBox j
=

BackColar [ ActiveBorder s

Backgroundimage [ inone)
Causesvalidation True

. MiddleLeft -
Checked

CheckState Q
ContextMenu

Cursor
Dock |

L L L]

Enabled TR

Flaenie Stardsed =l
Properties D Dyniamic Help

6. With the check box selected, locate the Name property in the Properties window, and set it
to chkPayEarly.
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7. Change the CheckBox’s caption by entering the string Early Payment in its Text property
field.

8. Place a Button control in the bottom-left corner of the form. Name it bttnShowPayment, and
set its caption to Show Payment.

9. Finally, place another Button control on the form, name it bttnExit, and set its Text property
to Exit.

ALIGNING THE CONTROLS

Your next step is to align the controls on the form. First, be sure that the captions on the labels are
visible. Our labels contain lengthy captions, and if you don’t make the labels long enough, the cap-
tions may wrap to a second line and become invisible.

TIP  Be sure to make your labels long enough to hold their captions, especially if you’re using a nonstandard font.
A user’s computer may substitute another font for your nonstandard font, and the corresponding captions may increase

in lengtb,

The IDE provides commands to align the controls on the form, all of which can be accessed
through the Format menu. To align the controls that are already on the LoanForm, follow these steps:

1. Select the four labels on the form with the mouse and left-align them by choosing Format >
Align > Lefts. The handles of all selected controls will be white, except for one control whose
handles will be black. All controls will be left-aligned with this control. To specify the con-
trol that will be used as reference point for aligning the other controls, click it after making
the selection. (You can select multiple controls either by drawing a rectangle that encloses
them with the mouse, or by clicking each control while holding down the Ctrl button.)

2. With the four text boxes selected, choose Format > Align > Lefts. Don’t include the check
box in this selection.

TiP When you select multiple controls to altgn togetber, use the control with black handles as a guide Sfor altgm'ng the
other controls.

3. With all four text boxes still selected, use the mouse to align them above and below the box
of the CheckBox control.

Your form should now look like the one in Figure 2.1. Take a good look at it and check to see if
any of your controls are misaligned. In the interface design process, you tend to overlook small prob-
lems such as a slightly misaligned control. The user of the application, however, instantly spots such
mistakes. It doesn’t make any difference how nicely the rest of the controls are arranged on the form;
if one of them is misaligned, it will attract the user’s attention.

Programming the Loan Application

Now run the application and see how it behaves. Enter a few values in the text boxes, change the
state of the check box, and test the functionality already built into the application. Clicking the
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Show Payment button won't have any effect because we have not yet added any code. If you're
happy with the user interface, stop the application, open the form, and double-click the Show Pay-
ment Button control. Visual Basic opens the code window and displays the definition of the Show-
Payment_Click event:

Private Sub bttnShowPayment_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnShowPayment.Click

End Sub

NOTE  I've broken the first line with an underline character, because it wouldn’ fit on the page. The underscore charac-
ter is the line-continuation character, which allows you to break a long code line into multiple texct lines.

This is the declaration of the Button’s Click event handler. This subroutine will be invoked when
the user clicks the Show Payrnent button. Above the definition of the event handler, you will see the
foﬂowing two statements:

PubTic Class LoanForm
Inherits System.Windows.Forms.Form

The first statement creates a new class for the project’s form; the second inherits the functionality
of the Form object. These statements are placed there by the IDE, and you shouldn’t change them.
When you learn more about classes and inheritance in the second part of the book, you'll be able to
better understand the role of these statements.

Place the pointer between the lines Private Sub and End Sub, and enter the rest of the lines of
Listing 2.1 (you don't have to reenter the first and last lines that declare the event handler).

LISTING 2.1: THE SHOW PAYMENT BUTTON

Private Sub bttnShowPayment_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnShowPayment.Click
Dim Payment As Single
Dim payEarly As DueDate
If chkPayEarly.Checked Then
payEarly = DueDate.BegOfPeriod
Else
payEarly = DueDate.EndOfPeriod
End If
Payment = Pmt(0.01 * txtRate.Text / 12, txtDuration.Text, _
-txtAmount.Text, 0, payEarly)
txtPayment.Text = Payment.ToString("#.00")
End Sub

The code window should now look like the one shown in Figure 2.3. Notice the underscore
character at the end of the first part of the long line. The underscore lets you break long lines so that
they will fit nicely in the code window. I'm using this convention in this book a lot to fit long lines
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on the printed page. The same statement you see as multiple lines in the book may appear in a single,
long line in the project.

FIGURE 2.3 Object Browser | Start Page | LoanForm.vb [Design]* LnanForm.vb"‘l 40 X
N |#¢ LoanForm (LoanCalculator ~| | (peclarations; 4
The Show Payment i ¢ ! =l g ! =
y . Public Class LoanForm =
button S Chck event Inherits System.Vindows.Forms.Form
subroutine

Private Sub bttnShowPayment Click(BEyVal sender is System.Object, _
EvyVal e Ls Systew.Eventdrgs) Handles bttnShowPayment.Click
Dim Payment is Single
Dim payEarly As DueDate
If chkPayEarly.Checked Then
payEarly = DueDate.BegOfPeriod
Else
pavEarly = Duelate.EndOfPeriod
End If
Payment = Pmt(0.01 * txtRate.Text / 12, txtDuration.Text, _
—txtAmount. Text, 0, payEarly)
txtPayment.Text = Payment.ToString("#.00")

End Sub j

You don’t have to break long lines manually as you enter code in the editor’s window. Open the
Edit menu and select Advanced > Word Wrap. The editor will wrap long lines automatically at a
word boundary. While the word wrap feature is on, a check mark appears in front of the Edit >
Advanced > Word Wrap command. To turn off word wrapping, select the same command again.

In Listing 2.1, the first line of code within the subroutine declares a variable. It lets the applica-
tion know that Payment is a placeholder for storing a floating-point number (a number with a decimal
part —the Single data type. The second line declares a variable of the DueDate type. This is the
type of the argument that determines whether the payment takes place at the beginning or the end of
the month. The last argument of the Pmt() function must be a variable of this type, so we declare a
variable of the DueDate type. As mentioned earlier in this chapter, DueDate is an enumeration with
two members: BegOfPeriod and EndOfPeriod. In short, the last argument of the Pmt() function can
be one of the following values:

DueDate.BegOfPeriod
DueDate.EndOfPeriod

The first really executable line in the subroutine is the If statement that examines the value of
the chkPayEarly CheckBox control. If the control is checked, the code sets the payEarly variable to
DueDate.BegOfPeriod. If not, the code sets the same variable to DueDate.End0OfPeriod. The Combo-
Box control’s Checked property returns True if the control is checked at the time, False otherwise.
After setting the value of the payEarly variable, the code calls the Pmt() function, passing the values of
the controls as arguments:

¢ The first argument is the interest rate. The value entered by the user in the txtRate TextBox is
multiplied by 0.01 so that the value 14.5 (which corresponds to 14.5%) is passed to the
Pmt() function as 0.145. Although we humans prefer to specify interest rates as integers
(8%) or floating-point numbers larger than 1 (8.24%), the Pmt() function expects to read a
number less than 1. The value 1 corresponds to 100%. Therefore, the value 0.1 corresponds
to 10%. This value is also divided by 12 to yield the monthly interest rate.
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¢ The second argument is the duration of the loan in months (the value entered in the txtDura-
tion TextBox).

The third argument is the loan’s amount (the value entered in the txtAmount TextBox).
The fourth argument (the loan’s future value) is O by definition.

¢  The last argument is the payEarly variable, which is set according to the status of the chk-
PayEarly control.

The following two statements convert the numeric value returned by the Pmt() function to a
string and display this string in the fourth TextBox control. The result is formatted appropriately
with the following expression:

Payment.ToString("#.00")

The Payment variable is numeric, and all numeric variables provide the method ToString, which
formats the numeric value and converts it to a string. The character # stands for the integer part of the
variable. The period separates the integer from the fractional part, which is rounded to two decimal
digits. Because the Pmt() function returns a precise number, such as 372.2235687646345, you must
round and format it nicely before displaying it. Since the bank can’t charge you anything less than a
penny, you don’t need extreme accuracy. Two fractional digits are sufficient. For more information on
formatting numeric (and other) values, see the section “Formatting Numbers” in Chapter 3.

To display the result returned by the Pmt() function directly on the txtPayment TextBox control,
use the following statement:

txtPayment.Text = Pmt(0.01 * txtRate.Text / 12, txtDuration.Text, _
-txtAmount.Text, 0, payEarly)

This statement assigns the value returned by the Pmt() function directly to the Text property of
the control. The monthly payment will be displayed with four decimal digits, but this isn’t a proper
dollar amount.

TIP  You almost always use the ToString method (or the Format() function) when you want to display the results of
numeric calculations, because most of the time you don’t need Visual Basic’s extreme accuracy. A few fmctz’onal dzgz'ts are
all you need. In addition to numbers, the ToString method can format dates and time. The ToString method’s formatting
capabilities are discussed in Chapter 12, and the Format() function is described in the reference “VB.NET Functions and
Statements” on the CD.

The code of the LoanCalculator project on the CD is different and considerably longer than
what I have presented here. The statements discussed in the preceding text are the bare minimum for
calculating a lIoan payment. The user may enter any values on the form and cause the program to
crash. In the next section, we'll see how you can validate the data entered by the user, catch errors,
and handle them gracefuﬂy (that is, give the user a chance to correct the data and proceed), as
opposed to terminating the application with a runtime error.

Validating the Data

If you enter a nonnumeric value in one of the fields, the program will crash and display an error mes-
sage. For example, if you enter twenty in the Duration text box, the program will display the error
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message shown in Figure 2.4. A simple typing error can crash the program. This isn’t the way Win-
dows applications should work. Your applications must be able to handle most user errors, provide
helpful messages, and in general, guide the user in running the application efficiently. If a user error
goes unnoticed, your application will either end abruptly or will produce incorrect results without an

indication.

FIGURE 2.4 Chject Brawser | Start Page | Formi.»h [Desion] | Farmiwb | 4bx
. s - " i -

The Cast Excepnon ¢ LoanForm {Loan) =] |s¥bttnshowpayment_Click J:|

message means that
you supplied a string .

where a numeric
txtPayment.Text = Paywent.ToString("#.00™)

value was expected.

An unhandled exception of type ‘System. InvalidCastException’ accurred in J
microsoft . visualbasic,dii0 O Additional information: Cast: from String
'twenty') to Double is nok valid.

Break Continus | ep |

=
4 | »

Click the Break button, and Visual Basic will take you back to the application’s code window,
where the statements that caused the error will be highlighted in green. Obviously, we must do some-
thing about user errors. One way to take care of typing errors is to examine each control’s contents;
if they don’t contain valid numeric values, display your own descriptive message and give the user
another chance. Listing 2.2 is the revised Click event handler that examines the value of each text
box before attempting to use it in any calculations.

LISTING 2.2: THE REVISED SHOW PAYMENT BUTTON

Private Sub bttnShowPayment_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnShowPayment.Click
Dim Payment As Single
Dim LoanIRate As Single
Dim LoanDuration As Integer
Dim LoanAmount As Integer
' Validate amount
If IsNumeric(txtAmount.Text) Then
LoanAmount = txtAmount.Text
Else
MsgBox("Please enter a valid amount")
Exit Sub
End If
' Validate interest rate
If IsNumeric(txtRate.Text) Then
LoanIRate = 0.01 * txtRate.Text / 12
Else
MsgBox("Invalid interest rate, please re-enter")
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Exit Sub
End If
' Validate loan's duration
If IsNumeric(txtDuration.Text) Then
LoanDuration = txtDuration.Text
Else
MsgBox("Please specify the loan's duration as a number of months")
Exit Sub
End If
' If all data were validated, proceed with calculations
Dim payEarly As DueDate
If chkPayEarly.Checked Then
payEarly = DueDate.BegOfPeriod
Else
payEarly = DueDate.EndOfPeriod
End If
Payment = Pmt(LoanIRate, LoanDuration, -LoanAmount, 0, payEarly)
txtPayment.Text = Payment.ToString("#.00")
End Sub

First, we declare three variables in which the loan’s parameters will be stored: LoanAmount, Loanl-
Rate, and LoanDuration. These values will be passed to the Pmt() function as arguments. Each text
box’s value is examined with an If structure. If the corresponding text box holds a valid number, its
value is assigned to the numeric variable. If not, the program displays a warning and exits the subrou-
tine without attempting to calculate the monthly payment. The user can then fix the incorrect value
and click the ShowPayment button again. IsNumeric() is another built-in function that accepts a
variable and returns True if the variable is a number, False otherwise.

If the Amount text box holds a numeric value, such as 21,000 or 21.50, the function IsNumeric
(txtAmount.Text) returns True, and the statement following it is executed. That following statement
assigns the value entered in the Amount TextBox to the LoanAmount variable. If not, the Else clause of
the statement is executed, which displays a warning in a message box and then exits the subroutine.
The Exit Sub statement tells Visual Basic to stop executing the subroutine immediately, as if the End
Sub line were encountered.

You can run the revised application and test it by entering invalid values in the fields. Notice that
you can’t specify an invalid value for the last argument; the CheckBox control won't let you enter a
value. You can only check or clear it and both options are valid. The LoanCalculator application
you'll find on the CD contains this last version with the error-trapping code.

The actual calculation of the monthly payment takes a single line of Visual Basic code. Display-
ing it requires another line of code. Adding the code to validate the data entered by the user, how-
ever, is an entire program. And that’s the way things are.

NOTE  The applications in this book don’t contain much data-validation code because it would obscure the “useful” code
that applies to the topic at hand. Instead, they demonstrate specific techniques. You can use parts of the examples in your
applimtz‘ons, but you should provide your own data~validation code (and error-bandling code, as you’ll see in the following
section).
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WRITING WELL-BEHAVED APPLICATIONS

A well-behaved application must contain data-validation code. If an application such as LoanCalculator
crashes because of a typing mistake, nothing really bad will happen. The user will try again or else give up
on your application and look for a more professional one. However, if the user has been entering data for
hours, the situation is far more serious. It’s your responsibility as a programmer to make sure that only valid
data are used by the application and that the application keeps working, no matter how the user misuses
or abuses it.

Now run the application one last time and enter an enormous loan amount. Try to find out what
it would take to pay off the national debt with a reasonable interest rate in, say, 72 months. The
program will crash again (as if you didn’t know). This time the program will go down with a differ-
ent error message. Visual Basic will complain about an “overflow.” The exact message 1S shown in
Figure 2.5 and the program will stop at the line that assigns the contents of the txtAmount TextBox
to the LoanAmount variable. Press the Break button and the offending statement in the code will be

highlighted.

FIGURE 2.5 hbject Browser | Start Page | Forml b [Design]  FormLwb | b x
Very large values can ¢ LoanForm {Loan) =] [s®Button1_click -
cause the application Microsoft Development Environment j

to crash Wlth thiS 't An unhandled exception of bype ‘System. OverflowException’ occurred in J

microsoft, visualbasic,dl

error message.

Private Sub B _J
Dim Payme:
Dim LoanIl Break contrs | mep |

Dim LoanD
Dim Loandmount As Integer
Console.Uriceline (System. Int32 . HaxValue)
If IsNuweric(txtimount.Text) Then

Else

J Hemoe D1ases enter < we1in g " f

TIP  An overflow is a numeric value too large for the program to handle. This error is usually produced when you divide
a number by a very small value. When you attempt to assign a very large value to an Integer variable, you'll also get an
overflow exception.

Actually, in the LoanCalculator application, any amount greater than 2,147,483,647 will cause
an overflow condition. This is largest value you can assign to an Integer variable; it’s plenty for our
banking needs, but not nearly adequate for handling government budgets. As you’ﬂ see in the next
chapter, Visual Basic provides other types of variables, which can store enormous values (making the
national debt look really small). In the meantime, if you want to use the loan calculator, change the
declaration of the LoanAmount variable to:

Dim LoanAmount As Single
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The Single data type can hold much larger values. Besides, the Single data type can also hold non-
integer values. I'm assuming you won'’t ask for a loan of $25,000 and some cents, but if you want to
calculate the precise monthly payment for a debt you have accumulated, then you should be able to
specify a non-integer amount. In short, we should have declared the LoanAmount variable with the
Single data type in the first place (but then I wouldn’t have been able to demonstrate the overflow
exception).

An overflow error can't be caught with data-validation code. There’s always a chance your calcu-
lations will produce overflows or other types of math errors. Data validation isn’t going to help here;
you just don't know the result before you carry out the calculations. We need something called error
handling, or error trapping. This is additional code than can handle errors after they occur. In effect, you're
telling VB that it shouldn’t stop with an error message. This would be embarrassing for you and
wouldn’t help the user one bit. Instead, VB should detect the error and execute the proper statements
that will handle the error. Obviously, you must supply these statements, and you'll see examples of
handling errors at runtime in the following section.

Building a Math Calculator

Our next application is more advanced, but not as advanced as it looks. It’s a math calculator with a
typical visual interface that demonstrates how Visual Basic can simplify the programming of fairly
advanced operations. If you haven’t tried it, you may think that writing an application such as this
one is way too complicated, but it isn’t. The MathCalculator application is shown in Figure 2.6, and
you'll find it in this chapter’s folder on the CD. The application emulates the operation of a hand-
held calculator and implements the basic arithmetic operations. It has the structure of a math calcu-
lator, and you can easily expand it by adding more features. In fact, adding features like cosines and
logarithms is actually simpler than performing the basic arithmetic operations.

FIGURE 2.6 [Hsimptc calcutotor——R[=IE
The Calculator 4238.00199

application window j ﬂ ﬂ j J
HiBDeRin
[FlE][E] =]
[lelle] =

Designing the User Interface
The application’s interface is straightforward, but it takes quite a bit of effort. You must align but-
tons on the form and make the calculator look as much like a hand-held calculator as possible. Start
a new project, the MathCalculator project, and name its main form CalculatorForm.

Designing the interface of the application isn’t trivial, because it's made up of many buttons, all

perfecdy aligned on the form. To simplify the design, follow these steps:

1. Select a font that you like for the form. All the Command buttons you’ﬂ place on the form will
inherit this font. The MathCalculator application on the CD uses 10-point Verdana font.
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. Add the Label control, which will become the calculator’s display. Set its BorderStyle prop-

erty to Fixed 3D so that it will have a 3-D look, as shown in Figure 2.6. Change its Fore-
Color and BackColor properties too, if you want it to look different than the rest of the
form. The project you will find on the CD uses colors that emulate the—now extinct—
green CR'T monitors.

. Draw a Button control on the form, change its caption (Text property) to 1, and name it

bttn1. Size the button carefully so that its caption is centered on the control. The other but-
tons on the form will be copies of this one, so make sure you’ve designed the first button as
best as you can, before you start making copies of it.

. Place the button in its final position on the form. At this point you're ready to create the

other buttons for the calculator’s digits. Right-click the button and select Copy. The Button
control is copied to the Clipboard, and now you can paste it on the form (which is much
faster than designing an identical button).

. Right-click somewhere on the form and select Paste to create a copy of the button you copied

earlier. The button you copied to the Clipboard will be pasted on the form, on top of the
original button. The copy will have the same caption as the button it was copied from, and its
name will be Button1.

. Now set the button’s Name to bttn2 and its Text property to 2. This button is the digit 2.

Place the new button to the right of the previous button. You don’t have to align the two
buttons perfectly now; later we'll use the Format menu to align the buttons on the form.

. Repeat Steps S and 6 eight more times, once for each numeric digit. Each time a new Button

control is pasted on the form, Visual Basic names it Button1 and sets its caption to 1; you
must change the Name and Text properties. You can name the buttons anything you like;
their Click event will be handled by the same subroutine, which will read the button’s Text
property to find out which digit was clicked.

. When the buttons of the numeric digits are all on the form, place two more buttons, one for

the C (Clear) operation and one for the Period button. Name them bttnClear and bttnPeriod,
and set their captions accordingly. Use a larger font size for the Period button to make its
caption easier to read.

. When all the digit buttons of the first group are on the form and in their approximate posi-

tions, align them with the commands of the Format menu.

A. First, align the buttons of the top row. Start by aligning the 1 button with the left side of
the Ileisplay Label. Then select all the buttons of the top row and make their horizontal
spacing equal (select Format > Horizontal Spacing > Make Equal). Then do the same
with the buttons in the first column, and this time, make sure their vertical distances are

equal (Format > Vertical Spacing > Make Equal).

B. Now you can align the buttons in each row and each column separately. Use one of the
buttons you aligned in the last step as the guide for the rest of them. The buttons can be
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aligned in many ways, so don’t worry if somewhere in the process you ruin the ahgnment.
You can always use the Undo command in the Edit menu. Select the three buttons on the
second row and align their Tops using the first button as reference. Do the same for the
third and fourth rows of buttons. Then do the same for the four columns of buttons.

Now, place the buttons for the arithmetic operations on the form—addition (+), subtraction (-),
multiplication (*), and division ( / ). Use the commands on the Format menu to align these buttons
as shown earlier in Figure 2.6. The control with the black handles can be used as a reference for
aligning the other controls into rows and columns. The form shown in Figure 2.6 has a few more
buttons, which you can align using the same techniques you used to align the numeric buttons.

The Equals button at the bottom is called bttnEquals, and you must make it wide enough to
cover the space of the three buttons above it.

Programming the MathCalculator App

Now you're ready to add some code to the application. Double-click one of the digit buttons on the
form, and you'll see the following in the code window:

Private Sub bttnl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnl.Click

End Sub

This is the Click event’s handler for a single digit button. Your first attempt is to program the
Click event handler of each digit button, but repeating the same code 10 times isn’t very productive.
We're going to use the same event handler for all buttons that represent digits. All you have to do is
append the names of the events to be handled by the same subroutine after the Handles keyword.
You should also change the name of the event handler to something that indicates its role. Since this
subroutine handles the Click event for all the digit buttons, let’s call it Digit_Click(). Here’s the
revised declaration of a subroutine that can handle all the digit buttons:

Private Sub Digit_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnl.Click, bttn2.Click, _
bttn3.Click, bttn4.Click, bttn5.Click, bttn6.Click, _
bttn7.Click, bttn8.Click, bttn9.Click, bttn0.Click

End Sub

When you press a digit button on a hand-held calculator, the corresponding digit is appended to
the display. To emulate this behavior, insert the following line in the Click event handler:

Tb1Display.Text = Tb1Display.Text + sender.Text

This line appends the digit clicked to the calculator’s display. The sender argument of the Click
event represents the control that was clicked (the control that fired the event). The Text property of
this control is the digit of the button that was clicked. For example, if you have already entered the
value 345, clicking the digit O displays the value 3450 on the Label control that acts as the calcula-
tor’s display.
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The expression sender.Text is not the best method of accessing the Text property of the button
that was clicked, but it will work as long as the Strict option is off. We'll return to this topic later in
the book, but for now let me brieﬂy explain that you should convert the sender object to a TextBox
object and then access its Text property with the following statement:

CType(sender, TextBox).Text

The CType() function is discussed in the following chapter. For now, keep in mind that it con-
verts an object to an object of a different type. You will also notice that after typing the period fol-
lowing the closing parenthesis, all the members of the TextBox control will appear in a list, as if you
had entered the name of a TextBox control followed by a period.

The code behind the digit buttons needs a few more lines. After certain actions, the display
should be cleared. After pressing one of the buttons that correspond to math operations, the
display should be cleared in anticipation of the second operand. Actually, the display must be
cleared as soon as the first digit of the second operand is pressed. Revise the Digit_Click event
handler as shown in Listing 2.3.

LISTING 2.3: THE DIGIT_CLICK EVENT

Private Sub Digit_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnl.Click, bttn2.Click, _
bttn3.Click, bttn4.Click, bttn5.Click, bttn6.Click, _
bttn7.Click, bttn8.Click, bttn9.Click, bttn0.Click
If clearDisplay Then
Tb1Display.Text = ""
clearDisplay = False
End If
Tb1Display.Text = Tb1Display.Text + sender.text
End Sub

The clearDisplay variable is declared as Boolean, which means it can take a True or False value.
Suppose the user has performed an operation and the result is on the calculator’s display. The user
now starts typing another number. Without the If clause, the program would continue to append
digits to the number already on the display. This is not how calculators work. When a new number
is entered, the display must clear. And our program uses the clearDisplay variable to know when to
clear the display.

The Equals button sets the clearDisplay variable to True to indicate that the display contains
the result of an operation. The Digit_Click() subroutine examines the value of this variable each
time a new digit button is pressed. If the value is True, Digit_Click() clears the display and then
prints the new digit on it. The subroutine also sets clearDisplay to False so that when the next digit is
pressed, the program won't clear the display again.

What if the user makes a mistake and wants to undo an entry? The typical hand-held calculator
has no backspace key. The Clear key erases the current number on the display. Let’s implement this
teature. Double-click the C button and enter the code of Listing 2.4 in its Click event.
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LISTING 2.4: THE CLEAR BUTTON

Private Sub bttnClear_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnClear.Click
Tb1Display.Text = ""
End Sub

Now we can look at the Period button. A calculator, no matter how simple, should be able to
handle fractional numbers. The Period button works just like the digit buttons, with one exception.
A digit can appear any number of times in a numeric value, but the period can appear only once. A
number like 99.991 is valid, but you must make sure that the user can’t enter numbers such as
23.456.55. Once a period is entered, this button mustn’t insert another one. The code in Listing 2.5
accounts for this.

LISTING 2.5: THE PERIOD BUTTON

Private Sub bttnPeriod_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnPeriod.Click
If 1b1Display.Text.IndexOf(".") > 0 Then
Exit Sub
Else
Tb1Display.Text = 1b1Display.Text & "."
End If
End Sub

IndexOf is a method that can be applied to any string. The expression 1b1Display.Text is a
string (the text on the Label control), so we can call its IndexOf method. The code Index0f(".")
returns the location of the first instance of the period in the caption of the Label control. If this
number is positive, the number entered contains a period already, and another can’t be entered. In
this case, the program exits the subroutine. If the method returns 0, the period is appended to the
number entered so far, just like a regular digit.

Check out the operation of the application. We have already created a functional user interface
that emulates a hand-held calculator with data-entry capabilities. It doesn’t perform any operations
yet, but we have already created a functional user interface with only a small number of statements.

MATH OPERATIONS
Now we can move to the interesting part of the application: considering how a calculator works.
Let’s start by defining three variables:

Operand1 The first number in the operation
Operator The desired operation
Operand?2 The second number in the operation
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‘When the user clicks one of the math symbols, the value on the display is stored in the variable
Operand]. If the user then clicks the Plus button, the program must make a note to itself that the cur-
rent operation is an addition and then clear the display so that the user can enter another value. The
symbol of the operation is stored in the Operator variable. The user enters another value and then
clicks the Equals button to see the result. At this point, our program must do the following:

1. Read the OpemndZ value on the display.
2. Add that value to Operandl.
3. Display the result.

The Equals button must perform the following operation:

Operandl Operator Operand?2

Suppose the number on the display when the user clicks the Plus button is 3342. The user then
enters the value 23 and clicks the Equals button. The program must carry out the addition:

3342 + 23
If the user clicked the Division button, the operation is:
3342 / 23

In both cases, when Equals is clicked, the result is displayed (and it may become the first operand for
the next operation).

Variables are local in the subroutines where they are declared. Other subroutines have no access to
them and can’t read or set their values. Sometimes, however, variables must be accessed from many
places in a program. If the Opmmdl , Opemnd2, and Operator variables in this application must be
accessed from within more than one subroutine, they must be declared outside any subroutine. The
same is true for the clearDisplay variable. Their declarations, therefore, must appear outside any proce-
dure, and they usually appear at the beginning of the code with the foﬂowing statements:

Dim clearDisplay As Boolean
Dim Operandl As Double
Dim Operand2 As Double
Dim Operator As String

Let’s see how the program uses the Operator variable. When the user clicks the Plus button, the
program must store the value “+” in the Operator variable. This takes place from within the Plus but-
ton’s Click event. But later, the Equals button must have access to the value of the Operator variable in
order to carry out the operation (in other words, it must know what type of operation the user speci-
fied). Because these variables must be manipulated from within more than a single subroutine, they
were declared outside any subroutine.

The keyword Double is new to you. It tells VB to create a numeric variable with the greatest pos-
sible precision for storing the values of the operators. (Numeric variables and their types are dis-
cussed in detail in the next chapter.) The Boolean type takes two values, True and False. You have
already seen how the dearDisplay variable is used.

The variables Operand1, Operand2, and Operator are called Form-wide, or simply Form, variables,
because they are visible from within any subroutine on the form. If our application had another
form, these variables wouldn't be visible from within the other form(s). In other words, any
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subroutine on a form on which the variables are declared can read or set the values of the variables,
but no subroutine outside that form can do so.

With the variable declarations out of the way, we can now implement the Operator buttons.
Double-click the Plus button and, in the Click event’s handler, enter the lines shown in Listing 2.6.

LISTING 2.6: THE PLUS BUTTON

Private Sub bttnPTus_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnPlus.Click

Operandl = Val(lb1Display.Text)
Operator = "+"
clearDisplay = True

End Sub

The variable Operand1 is assigned the value currently on the display. The Val() function returns
the numeric value of its argument. The Text property of the Label control is a string. For example,
you can assign the value “My Label” to a label’s Text property. The actual value stored in the Text
property is not a number. It’s a string such as “428”, which is different from the numeric value 428.
That's why we use the Val() function to convert the value of the Label’s caption to a numeric value.
The remaining buttons do the same, and I won't show their listings here.

So far, we have implemented the following functionality in our application: When an operator
button is clicked, the program stores the value on the display in the Operand] variable and the opera-
tor in the Operator variable. It then clears the display so that the user can enter the second operand.
After the second operand is entered, the user can click the Equals button to calculate the result.

When this happens, the code of Listing 2.7 is executed.

LISTING 2.7: THE EQUALS BUTTON

Private Sub bttnEquals_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnEquals.Click
Dim result As Double
Operand2 = Val(lb1Display.Text)
Select Case Operator
Case "+"
result = Operandl + Operand2
Case "-"
result
Case "*"
result = Operandl * Operand2
Case "/"
If Operand2 <> "0" Then result = Operandl / Operand?2
End Select
Tb1Display.Text = result
clearDisplay = True
End Sub

Operandl - Operand?2
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The result variable is declared as Double so that the result of the operation will be stored with
maximum precision. The code extracts the value displayed in the Label control and stores it in the
variable Operand2. It then performs the operation with a Select Case statement. This statement
compares the value of the Operator variable to the values listed after each Case statement. If the value
of the Operator variable matches one of the Case values, the foHowing statement is executed.

& If the operator is “+”, the result variable is set to the sum of the two operands.

& If the operator is “-”, the result variable is set to the difference of the first operand minus the
second.

& If the operator is “*”, the result variable is set to the product of the two operands.

If the operator is “/”, the result variable is set to the quotient of the first opemnd divided by
the second operand, provided that the divisor is not zero.

NOTE  Division takes into consideration the value of the second operand because if it’s zero, the division can’t be carried
out. The last If statement carries out the division only if the divisor is not zero. If Operand2 happens to be zero, nothing
happens.

Now run the application and check it out. It works just like a hand-held calculator, and you can’t
crash it by specifying invalid data. We didn’t have to use any data-validation code in this example
because the user doesn’t get a chance to type invalid data. The data-entry mechanism is foolproof.
The user can enter only numeric values because there are only numeric digits on the calculator. The
only possible error is to divide by zero, and that’s handled in the Equals button.

DEBUGGING TOOLS

Our application works nicely and is quite easy to test—and to fix, if you discover something wrong
with it. But that’s only because it’s a very simple application. As you write code, you'll soon discover
that something doesn’t work as expected, and you should be able to find out why and repair it. The
process of eliminating errors is called debugging, and Visual Studio provides the tools to simplify
the process of debugging. These tools are discussed in Chapter 17. There are a few simple operations
you should know, though, even as you work with simple projects like this one.

Open the MathCalculator project in the code editor and place the cursor in the line that calcu-
lates the difference between the two operands. Let’s pretend there’s a problem with this line and we
want to follow the execution of the program closely, to find out what's going wrong with the appli-
cation. Press F9 and the line will be highlighted in brown. This line has become a breakpoint: as soon
as it is reached, the program will stop.

Press FS to run the application and perform a subtraction. Enter a number, then click the minus
button, then another number, and finally the Equals button. The application will stop, and the code
editor will open. The breakpoint will be highlighted in yellow. Hover the pointer over the Operand1
and Operand2 variables in the code editor’s window. The value of the corresponding variable will
appear in a small box or tooltip. Move the pointer over any variable in the current event handler
to see its value. These are the values of the variables just prior to the execution of the highlighted
statement.
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The result variable will most likely be zero, because the statement hasn’t been executed yet. If the
variables involved in this statement have their proper values (if not, you know that the problem is
prior to this statement, and perhaps in another event handler), then you can execute this statement
by pressing F10. By pressing F10, you're executing the highlighted statement only. The program will
stop at the next line. The next statement to be executed is the End Select statement.

Find an instance of the result variable in the current event handler, rest the mouse over it, and you
will see the value of the variable after it has been assigned a value. Now you can press F10 to execute
another statement or FS to return to normal execution mode.

You can also evaluate expressions involving any of the variables in the current event handler by
entering the appropriate statement in the Command window. The Command window appears at the
bottom of the IDE. If it’s not visible, then from the main menu, select View > Other Windows >
Command Window. The current line in the Output window is prefixed with the greater than sym-
bol (reminiscent of the DOS days). Place the cursor next to it and enter the following statement:

? Operandl / Operand?2

The quotient of the two values will appear in the following line. The question mark is just a
shorthand notation for the Print command. If you want to know the current value on the calculator’s
display, enter the following statement:

? 1b1Display.Text

This statement requests the value of a property of a control on the form. The current value of the
Label control’s Text property will appear in the following line. You can also evaluate math expres-
sions with statements like the following:

? Math.Log(3/4)

Log() is the logarithm function, and it's a method of the Math class. To create a random value
between O and 1, enter the statement:

? Rnd()

With time, you’ﬂ discover that the Command window is a very handy tool in debugging applica—
tions. If you have a statement with a complicated expression, you can request the values of the indi-
vidual components of the expression and thereby make sure they can be evaluated.

Now move the pointer oft the breakpoint and press F9 again. This will toggle the breakpoint sta-
tus, and the execution of the program won't halt the next time this statement is executed.

If the execution of the program doesn’t stop at a breakpoint, it means that the statement was
never reached. In this case, you must search for the bug in statements that are executed before the
breakpoint. If you didn’t assign the proper value to the Operator variable, the Case "-" statement will
never be reached. You should place the breakpoint at the first executable statement of the Equals but-
ton’s Click event handler to examine the values of all variables the moment this subroutine starts its
execution. If all variables had the expected values, you will continue testing the code forward. If not,
you'd have to test the statements that lead to this statement—the statements in the event handlers of
the various buttons.

Another sirnple technique for debugging applications is the Output window. Although this isn’t a
debugging tool, it's very common among VB programmers (and very practical, may | add). Many
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programmers print the values of selected variables after the execution of some complicated state-
ments. To do so, use the statement:

Console.WriteLine
followed by the name of the variable you want to print, or an expression:
Console.WriteLine(Operandl)

This statement sends its output to the Output window, which is displayed next to the Command
window—click the Output tab at the bottom of the IDE to view this window. Alternatively, you
can select the command View > Other Windows > Output. This is a very simple technique, but it
works. You can also use it to test a function or method call. If you're not sure about the syntax of a
function, pass an expression that contains the specific function to the Console.WriteLine statement
as argument. If the expected value appears in the Output window, you can go ahead and use it in
your code.

Let’s consider the DateDiff() function, which contains the difference between two dates. The
simplest syntax of this function is

DateDiff(interval, datel, date2)

I never know whether it subtracts datel from date2 or the other way around—if you don’t get it
right the first time, then every time you want to use this function, there’s always a doubt in your
mind. Before using the function in my code, I insert a statement like

Console.WriteLine(DateDiff(DateInterval.Day, #1/1/2000#, #1/2/2000#))

The value printed on the Output window is 1, by the way, indicating that the first date is sub-
tracted from the second.

You will find more information on debugging in Chapter 17. I've just shown you a few simple
techniques that will help you take advantage of the simpler debugging tools of Visual Studio as you

write your first applications.

Adding More Features

Now that we have implemented the basic functionality of a hand-held calculator, we can add more
features to our application. Let’s add two more useful buttons:

¢ The+/- or Negate, button, which inverts the sign of the number on the display
& The 1/x, or Inverse, button, which inverts the display number itself

Open the code window for each of the Command buttons and enter the code from Listing 2.8 in
the corresponding Click event handlers. For the + /- button, enter the event handler named
bttnNegate_Click, and for the 1 /x button, enter the one named bttnlnverse_Click.

LISTING 2.8: THE NEGATE AND INVERSE BUTTONS

Private Sub bttnNegate_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnNegate.Click
Tb1Display.Text = -Val(1b1Display.Text)
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clearDisplay = True
End Sub
Private Sub bttnInverse_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnInverse.Click
If val(1b1Display.Text) <> 0 Then 1b1Display.Text = 1 / Val(lb1Display.Text)
clearDisplay = True
End Sub

As with the Division button, we don’t attempt to invert a zero value. The operation (1 / 0)is
undefined and causes a runtime error. Notice also that I use the value displayed on the Label control
directly in the code. I could have stored the Tb1Display.Text value to a variable and used the variable
instead:

TempValue = Val(lb1Display.Text)
If TempValue <> 0 Then 1b1Display.Text = 1 / TempValue

This is also better coding, but in short code segments, we all tend to minimize the number of statements.
You can easily expand the Math application by adding Function buttons to it. For example, you
can add buttons to calculate common functions, such as Cos, Sin, and Log. The Cos button calculates

the cosine of the number on the display. The code behind this button’s Click event is a one-liner:

Tb1Display.Text = Math.Cos(Val(1b1Display.Text))

It doesn’t require a second operand, and it doesn’t keep track of the operation. You can implement
all math functions with a single line of code.

Of course, you should add some error trapping, and in some cases, you can use data-validation
techniques. For exarnple, the Sqrto function, which calculates the square root of a number, expects a
positive argument. If the number on the display is negative, you can issue a warning:

If 1b1Display.Text < 0 Then

MsgBox("Can't calculate the square root of a negative number")
Else

Tb1Display.Text = Math.Sqrt(Val(1b1Display.Text))
End If

All math functions are part of the Math class; that’s why they’re preﬁxed by the name of the class.
You can also tmport the Math class to the project with the following statement and thus avoid pre-
fixing the math functions:

Imports System.Math

The Log() function can calculate the logarithms of positive numbers only. If you add a button to
calculate logarithms and attempt to calculate the logarithrn of a negative number, the result will be
the string “NalN.” This value is similar to inﬁnity, and it says that the result is not a valid number
(NaN stands for not a number and is discussed in detail in the following chapter). Of course, display—
ing a value like NalN on the calculator’s display isn't the most user-friendly method of handling
math errors. I would validate the data and POp up a message box with the appropriate description, as
shown in Listing 2.9.
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LISTING 2.9: CALCULATING THE LOGARITHM OF A NUMBER

Private Sub bttnLog_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnLog.Click
If Val(lb1Display.Text) < 0 Then
MsgBox("Can't calculate the logarithm of a negative number")

Else
Tb1Display.Text = Math.Log(1b1Display.Text)
End If
clearDisplay = True
End Sub

One more feature you could add to the calculator is a limit to the number of digits on the display.
Most calculators can only display a limited number of digits. To add this feature to the Math appli-
cation (if you consider this a “feature™), use the Len() function to find out the number of digits on
the display and ignore any digits entered after the number has reached the maximum number of

allowed digits.

Exception Handling

Crashing this application won't be as easy as crashing the Loan application. If you start multiplying
very large numbers, you won’t get an overflow exception. Enter a very large number by typing repeat-
edly the digit 9, then rnultiply this value with another, equally large value. When the result appears,
click the multiplication symbol and enter another very large value. Keep multiplying the result with
very large numbers, until you exhaust the value range of the Double data type (that is, until the result
1S SO large that it can’t be stored to a variable of the Double type). When this happens, the string
“infinity” will appear in the display.

Our code doesn’t include statements to capture overflows, so where did the string “inﬁnity” come
from? As you will learn in the following chapter, 1t 1s possible for numeric calculations to return the
string “infinity.” It’s Visual Basic’s way of telling you that it can’t handle very large numbers. This
isn't a limitation of VB; it’s the way computers store numeric values: they provide a limited number
of bytes for this. You will find out more about oddities such as infinity in the following chapter.

You can't create an overflow exception by dividing a number with zero either, because the code
will not even attempt to carry out this calculation. In short, the Calculator application is pretty
robust. However, we can't be sure that users won't cause the application to generate an exception, so
we must provide some code to handle all types of errors.

Errors are now called exceptions. Y ou can think of them as exceptions to the normal (or intended)
flow of execution. If an exception occurs, the program must execute special statements to handle the
exception—statements that wouldn’t be executed normally. I think they’re called exceptions because
“error” is a word none of us likes, and most people can’t admit they wrote code that contains errors.
The term exception can be vague. What would you rather tell your customers: that the application you
wrote has errors, or that your code has raised an exception? You may not have noticed it, but the
term bug is not used as frequently any more; bugs are now called “known issues.” The term debugging,
however, hasn’t changed yet.
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VB6 programmers used the term error to describe something wrong in their code, and they
used to write error-trapping code. With VB.NET, your code is error-free—it just raises exceptions
every now and then. Both the error-trapping code of VB6 and the exception-handling features of
VB.NET are supported. The error-trapping code of VBO6 could get messy, so Microsoft added what
they call structured exception handling. It’s a more organized method to handle runtime errors—or excep-
tions. The basic premise is that when an exception occurs, the program doesn’t crash with an error
message. Instead, it executes a segment of code that you, the developer, provide.

TIP By the way, if you have a bard time admitting it’s a bug in your code, use the expression “mea culpa.” It’s Latin,
and it sounds so sophisticated, most people won’t even ask what it means.

How do you prevent an exception raised by a calculation? Data validation isn’t going to help.
You just can’t predict the result of an operation without actually performing the operation. And if
the operation causes an overflow, you can’t prevent it. The answer is to add a structured exception
handler. Most of the application’s code is straightforward, and you can’t generate an exception. The
only place that an exception may occur is the handler of the Equals button, where the calculations
take place. This is where we must add an exception handler. The outline of the error structure is the

foﬂowing:

Try
{ statements block }
Catch Exception
{ handler block }
Finally
{ clean-up statements block }
End Try

The program will attempt to perform the calculations, which are coded in the statements block.
If it succeeds, it continues with the clean-up statements. These statements are mostly clean-up
code, and the Finally section of the statement is optional. If missing, the program execution contin-
ues with the statement following the End Try statement. If an error occurs in the first block of state-
ments, then the Catch Exception section is activated and the statements in the handler block are
executed.

The Catch block is where you handle the error. There’s not much you can do about errors that
result from calculations. All you can do is display a warning and give the user a chance to change the
values. There are other types of errors, however, which can be handled much more gracefully. If your
program can't read a file from a CD drive, you can give the user a chance to insert the CD and retry.
In other situations, you can prompt the user for a missing value and continue. In general, there’s no
unique method to handle all exceptions. You must consider all types of exceptions your application
may cause and handle them on an individual basis.

The error handler for the Math application must inform the user that an error occurred and abort
the calculations—not even attempt to display a result. If you open the Equals button’s Click event
handler, you will find the statements detailed in Listing 2.10.
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LISTING 2.10: THE REVISED EQUALS BUTTON

Private Sub bttnEquals_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnEquals.Click
Dim result As Double
Operand2 = Val(lb1Display.Text)

Try
Select Case Operator

Case "+"

result = Operandl + Operand2
Case "-"

result = Operandl - Operand2
Case "*"

result = Operandl * Operand2
Case "/"

If Operand2 <> "0" Then result = Operandl / Operand?2
End Select

Tb1Display.Text = result
Catch exc As Exception
MsgBox(exc.Message)
1b1Display.Text= "ERROR"
Finally
clearDisplay = True
End Try
End Sub

Most of the time, the error handler remains inactive and doesn’t interfere with the operation of
the program. If an error occurs, which most Iikely will be an overflow error, the error—handling
section of the Try..Catch..End Try statement will be executed. This code displays a message box
with the description of the error, and it also displays the string “ERROR” on the display, The
Finaﬂy section is executed regardless of whether an exception occurred or not. In this example,
the Finaﬂy section sets the flmrDisplay variable to True so that when another digit button is clicked,
a new number will appear on the display.

NOTE  The exc variable represents an exception; it exposes a few properties in addition to the Message property, which is
the destription of the exception. For more information on the members of the Exception class and how to handle exceptions,

see Chapter 17.

Taking the LoanCalculator to the Web

In this section, we're going to build a new project that is a loan calculator just like the one we built
earlier. This time, though, the application will run on the browser, and any user who can connect to
your server will be able to use it without having to install it on their computer. As you can understand,
you're about to convert the LoanCalculator from a Windows application to a Web application. It’s a
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little early in the book to discuss Web applications, but I wanted to show you that building a Web
application is quite similar to building a Windows app.

Web applications are discussed in detail in the last part of the book, but since they're among the
hot new features of the NET platform, let me demonstrate why they are so hot. In a sentence,
Visual Studio.NET is the first attempt to make the development of Web applications as easy as VB
applications. You will see shortly that you can create the interface of a Web form (an HTML page
with controls that interact with the user) just as you create a Windows form. As for the application’s
code, it’s just like writing VB code to handle the events of a Windows form.

To write and test Web applications, you must have Internet Information Server (IIS) installed
and running on your computer. IIS is distributed with Windows 2000, and you must make sure it's
running. Open the Start menu and select Settings > Control Panel. Double-click the Administrative
Tools, then double-click the icon of the Internet Services Manager tool. When the Internet Services
Manager window appears, expand the node of your computer, right-click the Default Web Site item,
and from the context menu, select Start. This will start the Web server.

Start a new project and, on the New Project dialog box, click the ASP.NET Web Application
icon. Then enter the name of the application in the Name box—call it WebLoanCalculator. When
you close the New Project dialog box, you will see a window with a grid as usual, which represents
the Web page, or Web form. This document is called WebForm1.aspx (the default name of the Web
form). The Web form is equivalent to the Windows form, but it’s displayed as HTML on a

browser such as Internet Explorer, as you see in Figure 2.7.

FIGURE 2.7 ; http://localhost /ebLoanCalculator/WeblLoanForm.aspx - Microsoft I =] B3
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A new Windows project is stored in its own folder under the folder specified in the Location
field on the New Project dialog box. Web applications are also stored in their own folder, but this
folder is created under the Web server’s root folder (usually the C:\Inetpub\wwwroot folder).

Opening a Web project is not as simple as double-clicking the icon of a Solution file. I suggest
you follow the steps described in this chapter to create the project. If you want to open the
WebLoanCalculator project on the CD, copy the entire WebLoanCalculator folder into the Web
Server’s root folder. Then start Visual Studio.NET and open the WebLoanCalculator solution file.
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The text describes how to create the project from scratch. The application’s main form is called
WebLoanForm.aspx (it’s equivalent to a Windows form). You can open the application by starting
Internet Explorer and enter the foﬂowing URL in its Address box:

http://localhost/WebLoanCalculator/WebLoanForm.aspx

Let me describe the process of building the Web application from scratch. Change the name of
WebForm1 to WebLoanForm. Open the Toolbox, and you see that the Web Forms tab is acti-
vated, instead of the Windows Forms tab. The Web Forms tab contains the icons of the controls
you can place on a Web form, which are similar to the Windows controls but not as elaborate or as
rich in functionality. As you already know, Web pages use a much simpler user-interaction model.
The viewer can enter text on certain controls, check or clear a few options, and click a button to sub-
mit the form to the server. The server reads the values on the controls, processes them, and returns a
new page with the results. In the future, you can expect that applications running over the Internet
will become more and more elaborate, but for now no one questions the HTML model used so far.
As long as the browser can only handle HTML files, the Web application’s front end is confined to
HTML pages.

There’s another tab on the Toolbox, the HTML tab. These are the standard HTML controls
you can use on any Web page. The Web Forms tab contains the so-called Web controls, and there
are quite a few Web controls, as opposed to the rather limited number of HTML controls. Some
of the Web controls are also quite advanced compared to the really limited capabilities of the
HTML controls. Does this mean that a page that contains Web controls can’t be displayed on a
browser other than Internet Explorer? Not at all. Web controls are translated automatically into
standard HTML code that can be rendered on any browser. For example, on the Web Forms tab
you'll find some very elaborate controls, such as the TreeView control. HTML doesn’t provide
any controls that come even near the functionality of TreeView. Yet a Web TreeView control can
be rendered on any browser. The Web Forms Designer will insert the appropriate HTML tags to
create something that looks and behaves like the TreeView control—but it’s not a TreeView
control. There’s a lot to be said about Web controls, but you'll have to wait until the last part of
the book. For now, we'll build a simple application that uses Web controls to prompt the user
for the parameters of a loan and that will display the monthly payment on the same page, just like
a Windows application.

Start by placing four Label controls on the Web form. (Double-click the Label control’s icon on
the Toolbox four times, and four labels be placed on the Web form for you.) Change their place-
ment on the form by arranging them with the mouse, just as you would do with the controls on a
Windows form. You don’t have to align them perfectly now; you'll use the commands of the Format
menu to align the controls on the form. Just place them roughly at positions shown in Figure 2.7.
Then select each Label with the mouse and, in the Properties window, locate the Text property of
the control.

As you can see, most of the basic properties of the Web controls have the same name as the Win-
dows controls. Change the captions of the four labels to “Loan Amount,” “Duration (months),”
“Interest,” and ‘Monthly Payment.” Notice that the Label Web control is resized automatically to
accommodate the string you assign to its Text property.

Now place four TextBox controls on the Web form, each next to one of the Labels. By defaul,
all TextBox controls are empty (they have no initial content). Change their size with the mouse and
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align them roughly to the Label controls they correspond to. Then select them one at a time and

change their ID property to txtAmount, txtDuration, txtRate, and txtPayment, respectively. The ID
property of a Web control is the unique identifier of the control, similar to the Name property of a
Windows control. You'll use the ID property to access the control’'s members from within your code.

Then place a CheckBox control, set its Text property to Early Payment, and name it chkPay-
Early. Set its TextAlign property to Left, so that its check box will be placed to the right of the text.
The check box will be drawn immediately after the text, so you have to append a few spaces to the
control’s caption to clearly separate it from the check box.

The last control to place on the form is the Button control, whose Text property will be “Monthly
Payment” and Name property will be bttnShowPayment. This button will submit the loan parame-
ters entered on the form to the server, where the appropriate code will calculate the monthly pay-
ment and return it to the client. This is a good point to align the controls on the Web form. Select
the Label controls and align them left with the Format > Align > Lefts command. While the labels
are selected, use Format > Vertical Spacing > Make Equal to space them equally from one another.
Once the labels are in place, you can align each text box to the corresponding label, with the Format >
Align > Middles command. Select a pair of a Label and a TextBox control at a time and align them.
Just make sure that the Label control is used as the reference control for the alignment.

At this point, you're done designing the interface of the application. The interface is quite similar to
the interface of the equivalent Windows application, only this one was designed on a Web form with
Web controls. Other than that, the process was the same; even the tools for aligning the controls on
the Web form are the same as those for the Windows form. Our next task is to program the application.

Double-click the button on the Web form, and the editor window will open. The Web Form
Designer has selected the Click event of the button and inserted its definition. All you have to do is
insert the same code we used in the LoanCalculator application. You can switch to the Windows
application and copy the code (which was shown back in Listing 2.2). Just paste the code behind the
Show Payment button of the LoanCalculator Windows application in the Click event handler of
the Monthly payment button of the Web application, and there won't be a single error. You can
reuse the code as is!

Press FS to run the application. It will be several seconds before the Internet Explorer window
will pop up, displaying the page you've designed. Enter the parameters of a loan and then click the
Monthly Payment button. A few seconds later, the monthly payment will appear on the form. As
you will notice, a totally new page will arrive in the browser; this page contains the parameters of
the loan (the values you've entered on the form) and the result of the calculations.

If you look at the source code of the document shown on Internet Explorer, you will see straight
HTML code. The interface of the WebLoanCalculator application looks fine, but not quite like
a Web page. There’s none of the color or graphics we're so accustomed to seeing on Web pages.
Our Web form contains only controls, but it’s an HTML page and you can add any element that
could appear on a Web page. In other words, the Web form can be edited as an HTML document.
Not only that, but the IDE allows you to edit your page either VisuaHy or in HTML mode. Let’s
add a colored caption and change the page’s background color.

Select the Web form by clicking somewhere on the form. In the Properties window, locate the
property pageLayout. Its setting is GridLayout, which explains why you were able to place the con-
trols anywhere on the page and align them in all possible ways. Those of you familiar with HTML
know that aligning controls on a Web form is anything but trivial. Change the pageLayout property
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from GridLayout to FlowLayout. Now you're in normal HTML editing mode. Place the cursor at the
top of the page and start typing. Enter the string Easy Loan Calculator and then select it with

the mouse. You will notice that the text-formatting buttons on the toolbar have been enabled. Set the
text’s size to 6 and set its foreground and background colors. To set these properties, use the two
buttons next to the Bold/Italic/Underline group of buttons. The string is flush left on the form, so

enter a few spaces in front of the string to center it above the controls.

NOTE A quick comment for readers familiar with HIML: Browsers ignore multiple spaces, but the editor silently con-
verts the spaces you enter into &nbsp; codes, which are the HTML equivalent of “hard”—that is, nonbreaking—spaces.

You can also change the color of the page. Locate the page’s bgColor property in the Properties
window and set it to a light color. When the Color Picker dialog box appears on the form, you will
see the tab with the Web colors. These are the colors than can be displayed by all browsers, the so-

called safe colors. The form now looks like Figure 2.8 when viewed in a browser.

FIGURE 2.8 -} http:/ /localhost /WebLoanCalculator,/WebLoanForm.as| _ ol x|
Fle Edit VWew Favortss Tools Help

The WebLoan- ‘ O |

Caleul <= Back - D [ 4At| (CrersonalBar  Chsearch [GlFavorites o4 | SN S = 5] ®

culator as a Agdress [@] httpi flocalhost /WebLoanCalculatorfwebloanForm.aspx | oo | Links >

Web page ]

Easy Loan Calculator
Loan Amount 26000
Duration (months) |48

Interest Rate 14.5

Early Payment [

Monthly Payment 685.45

IEl

#] Done Local intranet

To see how the Web Form Designer handles the HTML elements of the page, click the HTML
button at the bottom of the Designer. The Web form can be viewed and designed either in Design
view (which is the default view) or in HTML view. The Web Form Designer inserted the following
statement in the HTML document to generate the header of the page:

<FONT style="BACKGROUND-COLOR: #ffff66" color="#996666" size="6">
<STRONG>Easy Loan Calculator</STRONG></FONT>

This is straight HTML code that could appear in any Web page, and it doesn't use any Web
controls. Select the <FONT> tag and delete it. Then switch to the Design view to see that the
header has disappeared. Switch back to the HTML view and insert the following statement right
after the <body> tag and before the <form> tag, as shown in Figure 2.9:

<h1>Easy Loan Calculator</h1>
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FIGURE 2.9 Object Browser | Start Page WebLnanForm.aspu*‘
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Click FS to run the application. When Internet Explorer appears, enter some values in the text
boxes and check out the application. The Web application is functionally equivalent to the Win-
dows loan application you developed at the beginning of this chapter. Yet its user interface runs in
the browser, but the calculations take place on the server (the machine to which the clients connect
to request the WebLoanForm.aspx Web page). Every time you click the Monthly Payment button on
the page, the page is posted to the server. The browser transmits the values on the various controls
back to the server. The server processes these values (actually, it executes the event handler you wrote)
and creates a new page, which is sent to the client. This page includes the value of the monthly pay-
ment. Web applications are discussed in detail later in this book; with this example I wanted to
demonstrate the similarities between Windows forms and Web forms and how the same code works

with both types of applications.

Working with Multiple Forms

Let’s return to Windows applications. Few applications are built on a single form. Most applications
use two, three, or more forms, which correspond to separate sections of the application. In this sec-
tion, we are going to build an application that uses three forms and lets the user switch among them
at will. You'll see how to write an application that opens multiple windows on the Desktop. In
Chapter 4, we'll explore in depth the topic of building Windows applications with multiple forms.
In this chapter, we'll build a simple example of a multiform application by combining the math and
financial calculators we built earlier in the chapter.

The way to combine the two applications is to create a new form, which will become the switch-
ing point for the two calculators. The user will be able to invoke either of the two calculators by
clicking a button on the new form. Let’s design an application that combines the forms of the two
projects.

Start a new project and call it Calculators. The project’s form will become the switching point
between the other two forms, and it’s shown in Figure 2.10. Start by renaming the new form from
Form1 to CalculatorsForm. To design it, add two Button controls and name them bttnMath and
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bttnLoan. Then set their Text properties to Simple Math and Simple Loan, respectively. As you can
guess, all you have to do now is add the code to invoke each of the existing forms from within each
button’s Click event handler. Add a third button on the form, call it bttnGame, and later you can
add an action game to the Calculators project.

FIGURE 2.10 =]
The main form of ‘ Simple Math |
the Calculators
c o Simple Loan |
application
Flay a Gamel |

At this point, we must add the forms of the MathCalculator and LoanCalculator projects into the
new project. Right-click the name of the project, and from the context menu, select Add Existing
Item. In the dialog box that appears, select the item MathForm.vb in the MathCalculator project’s
folder. Do the same for the LoanForm of the LoanCalculator project. The Calculators project now
contains three forms.

If you run the project now, you will see the Calculators form, but clicking its button won'’t bring
up the appropriate form. Obviously, you must add a few lines of code in the Click event handler of
each button to invoke the corresponding form. To display one form from within another form’s
code, you must create an object that represents the second form and then call its Show method.

The code behind the Simple Math button is shown in Listing 2.11.

LISTING 2.11: INVOKING THE MATH CALCULATOR

Private Sub bttnMath_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnMath.Click
Dim calcForm As New CalculatorForm
calcForm.Show()
End Sub

The calcForm variable is an object variable that represents the CalculatorForm form of the Calcula-
tors application. The name of the form is actually used as a data type, and this requires some expla-
nation. The form is implemented as a Class and therefore you create objects of this type.

The Dim statement creates a new instance of the form, and the Show method loads and displays
the form. If you run the project now, you'll see the main form, and if you click the first button, the
math calculator’s form will appear. If you click the same button again, another instance of the form
will appear. What can we do to prevent this? We would like to display the CalculatorForm initially
and then simply show it, but not load another instance of the form. The answer is to move the dec-
laration of the calcForm variable outside the event handler, into the Form’s declaration section. The
variable is declared once, and all the procedures in the form can access its members. Variables
declared in an event handler take effect only in the event handler in which they were declared, and
that’s why at this point, every time you click a button, a new instance of the corresponding form is
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created and displayed. If the variable calcForm points to a single instance of the CalculatorForm, then
the form will be displayed every time we click the Simple Math button, but no new instance of it
will be created. You'll find out more about the scope of variables in the following chapter.

When one of the two calculators is displayed, it doesn’t automatically become the active form.
The active form is the one that has the focus, and this is the main form of the application. To work
with a calculator, you must click the appropriate form to make it active. To activate the most recently
displayed form from within another form’s code, we'll use the Activate method of the Form object.
Rewrite the Click event handlers of the two buttons on the form as shown in Listing 2.12 (the list-
ing shows the entire code of the form, so that you can see the declarations of the two variables that
represent the forms of the application).

LISTING 2.12: THE CALCULATORS PROJECT

PubTlic Class CalculatorsForm
Inherits System.Windows.Forms.Form
Dim calcForm As New CalculatorForm()
Dim ToanForm As New loanForm()
Private Sub bttnMath_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnMath.Click
calcForm.Show()
calcForm.Activate()
End Sub
Private Sub bttnLoan_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnLoan.Click
ToanForm. Show()
loanForm.Activate()
End Sub
End Class

Notice the statement that declares the loanForm variable: the variable has the same name as the
data type, but this is no problem. It goes without saying that the name of the variable can be any-
thing. Our next task is to specify which form will be displayed when we start the application. Right-
click the Calculators project name and, in the context menu, select Properties. On the Calculators
Property Pages dialog box (Figure 2.11) is a ComboBox named StartUp Object. Expand it and you
will see the names of all the forms in the project. Select the name of form you want to appear when
the program starts, which is the CalculatorsForm.

The code behind the Play A Game button should also call the Show method of another form,
but it doesn’t. I regret not developing a game for your enjoyment, but I did implement a fun feature.
‘When you click this button, it jumps to another place on the form. The button’s Click event handler
is shown next:

Private Sub bttnGame_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles bttnGame.Click
bttnGame.Left = Rnd() * Me.Width * 0.8
bttnGame.Top = Rnd() * Me.Height * 0.8
End Sub
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FIGURE 2.11
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This subroutine manipulates the Left and Top properties of the control to move the button to a
different position. The Rnclo function returns a random value between O and 1. To calculate the
horizontal position, the code multiplies the random value by the width of the form (actually, 80 per-
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cent of the Width). The vertical position is calculated in a similar manner.

Each Visual Basic project is made up of files that are all listed in the Solution Explorer window.
Each project contains quite a few files in addition to the Form files, and they’re all stored in a single
folder, which is named after the project. If you open the Calculators folder (Figure 2.12), you will
see that it contains the CalculatorForm and LoanForm forms. These are copies of the original forms
of their corresponding applications. ‘When you add an existing item to a project, VB makes a copy of

this item in the project’s folder.

FIGURE 2.12
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the project, just copy the project’s folder to a different location.
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Working with Multiple Projects
As you have noticed, every new project you create with VB is a so-called solution. Each solution con-
tains a project, which in turn contains one or more files, references to .NET or custom components,
and other types of items, which will be discussed in the following chapters. Both solutions and proj-
ects are containers—they contain other items. A solution may contain multiple projects. Each proj-
ect in a solution is independent of the other projects, and you can distribute the projects in a
solution separately. So, why create a solution? Let’s say you're working on several related projects,
which are likely to use common components. Instead of creating a different solution for each proj-
ect, you can create a single solution to contain all the related projects.

Let’s build a solution with two related projects. The two related projects are the two calculators
we built earlier in this chapter. The two projects don’t share any common components, but
they’re good enough for a demonstration, and you will see how VB handles the components of
a solution.

VB.NET AT WORK: THE CALCULATORS SOLUTION

Create an Empty Project and name it Calculators by selecting File > New > Blank Solution. In the
Solution Explorer window, you will see the name of the project and nothing else, not even the list of
references that are present in any other project type. To add a project to the solution, choose File >
Add Project > Existing Project. (You can also right-click the solution’s name in the Solution
Explorer, select Add Existing Item > Project, and, in the dialog box that pops up, select the Calcula-
tor project.) Do the same for the LoanCalculator project. When the Add Existing Project dialog box
appears, navigate to the folders with the corresponding projects and select the project’s file.

You now have a solution, called Calculators, that contains two projects. If you attempt to run the
project, the IDE doesn’t know which of the two projects to execute and will generate an error message.
We must decide how to start the new project (that is, which form to display when the user runs the
Calculators application). When a solution contains more than a single project, you must specify
the startup project. Right-click the name of one of the projects and, from the context menu, select
Set As StartUp Project. To test a different project, set a different StartUp project. Normally, you
will work for a while with the same project, so switching from one project to another isn’t really a
problem. It is also possible that different developers will work on different projects belonging to the
same solution.

Let’s say you're going to design a documentation file for both projects. A good choice for a short
documentation file is an HTML file. To add an HTML file to the solution, right-click the solu-
tion’s name and select Add New Item. In the dialog box, select the HTML Page template, and then
enter a name for the new item. An HTML page will be added to the project, and an empty page
will appear in the Designer. This is the newly added HTML page, and you must add some content
to 1t.

Place the cursor on the design surface and start typing. Figure 2.13 shows a very simple HTML
page with an introduction to the application. To format the text, use the buttons on the toolbar.
These buttons embed the appropriate tags in the text, while you see the page as it would appear in
the browser. This is the Design view of the document. You can switch to the HTML view and edit
the document manually, if you're familiar with HTML. The HTML page can be used by either
project—at the very least, you can distribute it with the application.
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FIGURE 2.13 Ohiect Browser | Start Page  HTMLPagel.htm | CalculatorForm.vb [Design] | LoanForm.vb [Design] 4bx
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If you open the folder created for the project, you'll find that it contains an unusually small num-
ber of files. The projects reside in their respective folders. Make a change to one of the project’s files.
You can change the background color of the three TextBox controls on the LoanForm to a light
shade, like Bisque. Then open the LoanCalculator project, and you will see that the changes have
taken effect. VB doesn’t create new copies of the forms (or any other component) added to the Cal-
culators solution. It uses the existing files and modifies them, if needed, in their original locations.
Of course, you can create a solution from scratch and place all the items in the same folder. Each
project is a separate entity, and you can create executables for each project and distribute them.

To create the executables, open the Build menu and select Build Solution or Rebuild Solution.
The Build Solution command compiles the files that have been changed since the last build; Rebuild
Solution compiles all the files in the project. The executables will be created in the Bin folder
under each project’s folder. The file Loan.exe will be created under the \Loan\Bin folder and the
Calculator.exe file under the \Calculator\Bin folder.

The solution is a convenience for the programmer. When you work on a large project that
involves several related applications, you can put them all in a solution and work with one project at
a time. Other developers may be working with other projects belonging to the same solution. A
designer may create graphics for the applications, you can include them in the solution, and they’ll be
available to all the projects belonging to the solution.

The Calculators project we built earlier contains copies of the forms we added to the project. The
Calculators solution contains references to external projects.

Executable Files

So far, you have been executing applications within Visual Basic’s environment. However, you can't
expect the users of your application to have Visual Studio installed on their systems. If you develop
an interesting application, you won't feel like giving away the code of the application (the source code,
as it's caﬂed), Applications are distributed as executable files, along with their support files. The
users of the apphcation can’t see your source code, and your application can’t be modified or made
to look like someone else’s application (that doesn’t mean it can’t be copied, of course).

NOTE  An executable file is a binary file that contains instructions only the machine can understand and execute.
The commands stored in the executable file are known as machine language.
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Applications designed for the Windows environment can’t fit in a single file. It just wouldn't
make sense. Along with the executable files, your application requires support files, and these files may
already exist on many of the machines on which your application will be installed. That's why it
doesn’t make sense to distribute huge files. Each user should install the main application and only
the support files that aren’t already installed on their computer.

The executable will run on the system on which it was developed, because the support files are there.
Under the project’s file, you will find two folders named Bin and 0bj. Open the Obj folder, and you
will see that it contains a subfolder named Debug. This is where you will find the executable, which is
named after the project and has the extension .exe. Make sure that no instance of VS is running on
your computer and then double-click the icon of the MathCalculator.exe or LoanCalculator.exe file.
The corresponding application will start outside the Visual Studio IDE, and you can use it like any
other application on your PC. You can create desktop shortcuts to the two applications.

The folder Debug contains the Debug version of the executable. Normally, after you're done
debugging the application, you should change the default configuration of the project from Debug
to Release. To change the project’s configuration, select Build > Configuration Manager. The Con-
tiguration Manager dialog box will pop up, as shown in Figure 2.14.

FIGURE 2.14 Configuration Manager B x|
. it St el
The Configuration
Manager WIHdOW Project Contexts (check the project configurations ta build or deploy):
Project Configuration | Platform | Build
Calculator Release JMNET Ld
LoanCalculator Release j MET j v

The default configuration for all projects is Debug. This configuration generates code optimized
for debugging. The other possible setting for the configuration is Release. Change the configuration
to Release and close the dialog box. If you build the project or the solution again, a Release folder
will be created under the Obj folder and will contain the new executable. The difference between the
two versions of the executable files is that Debug files contain symbolic debug information. The
Release configuration executes faster because it doesn't contain any debugging information.

Distributing an Application

Distributing just an EXE file isn’t going to be any good, because the executable requires support
tiles. If these files aren’t installed on the target system (the computer on which your application will
be installed), then the EXE file isn't going to work. The file will be executed only on a system that
has Visual Studio.NET on it. Distributing a large number of files and installing them on the target
computer is quite a task. You must create an installation program that (almost) automatically installs
your application and the required support files on the target computer. If some of those files are

already installed, they will not be installed again.
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NOTE Eventually, all the support files will become part of the operating system, and then you’ll be able to distribute a
single EXE file (or a small number of files). This hasn’t happened with Windows 2000 or Windows XP and won’t for

some time. Until it does, you must provide your own installer.

A Setup project creates a Windows installer file (a file with extension .ms1i), which contains the
executable(s) of the application and auxiliary files that are necessary for the application, Registry
entries (if the application interacts with the Registry), installation instructions, and so on. The
resulting MSI file is usually quite long, and this is the file you distribute to end users. They must
double-click the icon of the MSI file to install the application on their computer. If they run the
same file again, the application will be removed. Moreover, if something goes wrong during the
installation, the installation will be rolled back and any components that were installed in the
process will be removed.

The topic of creating and customizing Windows installers is huge, and there are already a couple
of books on this topic alone—for example, VB/VBA Developer’s Guide to the Windows Installer by Mike
Gunderloy (Sybex, 2000). As you can understand, in this chapter we'll only scratch the surface. I
will show you how to create a simple Setup project for installing the Calculators project on another
machine. Your main priority right now is to learn to write NET applications and master the language.
You should be able to distribute even small applications, so the topic of creating Setup projects
shouldn’t be missing from this book. Yet you aren’t going to use the more advanced features for a
while—not before you can write elaborate applications that require a customized installation
procedure. In this section, I'll show you how to create a Setup project for the Calculators project.
It's a simple project that demonstrates the basic steps of creating a Windows installer using the
default options, and you'll be able to use this application to install the Calculators application to a
target computer.

VB.NET at Work: Creating a Windows Installer

To create a Windows installer, you must add a Setup project to your solution. The Setup project
will create an installation program for the projects in the current solution. Open the Calculators
solution and add a new project (File > Add Project > New Project). In the dialog box that appears
(Figure 2.15), click the Setup and Deployment Projects item. In the Templates pane, you will see
tive difterent types of Setup and Deployment projects. The simplest type of Setup project is the
Setup Wizard. This wizard takes you through the steps of creating a Setup project, which is another
wizard that takes the user through the steps of installing the application on the target computer.
Select this template and then enter the project’s name in the Name box: name the project Simple-
Calculators. Click OK, and the first screen of the wizard will appear. This is a welcome screen, and
you can click the Next button to skip it.

On the next screen, you'll be prompted to choose a project type. You can create a project that
installs an application or one that adds components to an existing installation. We want to create a
project that installs an application for the first time, and we have two options: to create a setup for a
Windows application or for a Web application. Select the first option, as shown in Figure 2.16,
and click Next to move to the next screen of the wizard.
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FIGURE 2.15 5
Adding a Setup and Praject Types: Templates:
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FIGURE 2.16 Setup Wizard (2 of 4)
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On the next screen, you'll be prompted to select any files you want to add to the installation pro-
gram. Here you must click the items checked in Figure 2.17. The Primary Output is the executable
file, and the Content Files include things like the HTML file we added to the project. In the release
version of the program, you don’t usually want to include debug symbols or source files (well, per-
haps the debug symbols for large projects that are also tested at the client’s side). If your application
includes localized resource files, you should check the second option. Localized resources allow you
to write apphcations that adjust their text to the end user’s culture. It’s a special topic that’s not cov-
ered in this book.

The Setup project we're creating here is part of a solution with the project you want to install
on the target machine. I've included the Setup project in the same solution for convenience only.
You can also create a Setup project and specify any executable file you want to install. The Setup
project takes a while to compﬂe, SO you should add it to the solution only after you have debugged
the application‘ Or remove the Setup project from the solution after you have created the setup file.
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FIGURE 2.17 Setup Wizard (3 of 5)
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Click Next again to see another screen, where you can specify additional files that are not part of

the project. You can add text files with installation instructions, compatibility data, registration

information, and so on. Click Next again, and the last screen of the wizard displays a summary of

the project you specified. Click Finish to close the wizard and create the Setup project.

The wizard adds the Setup project to your solution. Select the new project with the mouse and

open the Properties window to see the properties of the new project. The Solution Explorer and the

new project’s Properties window should look like the ones shown in Figure 2.18. The good news is

that you don’t have to write any code for this project. All you have to do is set a few properties and

you're done.

The AddRemoveProgramslcon property lets you specify the icon of the installation and removal

programs—rves, VB will also create a program to uninstall the application. You can specify whether

the Setup project will detect newer versions of the application and won't overwrite them with an
older version. The DetectNewerInstalledVersion property is True by default. You can also specify

your company’s name and URL, support line, the title of the installation windows, and so on.

FIGURE 2.18
The Setup project’s

Properties

PR
[ Solution 'Calculators' (2 projects)
= 58 Calculators
+- x2] References

& Assemblylnfa.vb

= calculatorForm.«b
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ors:
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5 dotnetfxredist_x86_snu.msm
O mscorlib.dil
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Conkent Files from Calculators (Active)

E Solution E..., E Class Vi, @ Corkents | & Search
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The Manufacturer property will become the name of the folder in which the installation will take
place. By default, this folder will be created in the user’s Program Files folder. Assign a name that
reflects either your company or the project type—a string like “The Math Experts” for the Calcula-
tors example. The Author property is where your name should appear. The ProductName property
is by default the name of the Setup project; change it to “The EasyCalc Project”. The Title property is
the title of the installer (what users see on the installation wizard’s title bar while the application is being
installed).

THE SOLUTION EXPLORER BUTTONS

You will notice that the usual buttons on the Solution Explorer have been replaced by six new but-
tons, which are described in the following sections.

File System Editor Button

Click this button and you will see the four sections of the target machine’s file system your setup
program can affect. Decide whether your application’s action should appear on the user’s Desktop or
in the Programs menu. Right—click either item and you will see a context menu that contains the
commands Add and Create Shortcut. The Add command leads to a submenu with four objects you
can automatically create from within your Setup program: Folder, Project Output, File, Assembly.
For typical applications you can add a folder (in which you can later place the project’s output), or
the project output. The less intruding option is to place a shortcut in the user’s Programs menu.

To make the project a little more interesting, we'll install not only the Calculators application,
but the two individual applications: the Calculator and LoanCalculator projects. We're going to add
three new commands to the user’s Programs menu, so let’s add a folder to this menu and then the
names of the applications in this folder. Right-click the item User’s Programs Menu and select Add
Folder. A new folder will be added under the User’s Programs Menu item. Change its name to Demo
Calculators, as shown in Figure 2.19. Select the new folder and look up its properties. The
AlwaysCreate property should be True—if not, the wizard will not add the folder to the user’s Pro-
grams ment.

Then right-click the newly added folder and select Add > File. A dialog box will pop up where
you can select the executables that must appear in the Demo Calculators folder on the Programs
menu. Browse your disk and locate the Calculators, Calculator, and LoanCalculator executables in the
\Obj\Release folder under the corresponding project’s folder (all three files have the extension EXE).

After adding the items you want to appear in the Demo Calculators folder of the Programs
menu, the File System Editor should like the one in Figure 2.19.

FIGURE 2.19 rm vk File System (SimpleCalculatars) | Fle Types (Sipleckeulstors) | User Interfz 4 b %
. =) File System on Target Machine Tame [ Type
=
Specifying how the o1 Applcaton Folder FaTer—— prsse—
instaﬂation program ‘s Global Assembly Cache Folder “OCakyltors.exe.. Assembly
; , I User's Desktop “Jlgan.exe Assembly
will affect the user’s =/ o) User's Programs Henu

1 Dema Caleulstors

File System
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Registry Editor Button

Click this button to add new keys to the user’s Registry. You don’t have to add anything to the user’s
Registry, especially for this project. But you can place special strings in the Registry, like an encoded
date to find out when a demo version of your application may expire. You must first familiarize
yourself with the Registry and how to program it with Visual Basic, before you attempt to use it
with your applications.

File Types Editor Button

If your application uses its own file type, you can associate that type with your application, so that
when the user double-clicks a file of this type your application starts automatically. This is a sure way
to ruin the user’s file associations. If your application can handle GIF images or HTML files, don’t
even think of taking over these files. Use this option only with files that are unique to your application.
To add a new file type on the user’s machine, click the File Types Editor button on the Proper-
ties window. On the Designer's surface, you will see a single item: File Types On Target Machine.
Right-click the item and select Add File Type. This command will add a new file type and the verb
&Open under it. Click the new file type and you will see its properties in the Properties window.
You can assign a description to the new file type, its extension, and the command that will be used

to open the files of this type (the name of your application’s EXE file).

User Interface Editor Button

Click this button and you will see the steps of the installation on the Designer’s surface, as shown in
Figure 2.20. Each phase of the installation process has one or more steps, and a different dialog box
is displayed at each step. Some of the dialog boxes contain messages, like a short description of the
application or a copyright message. These strings are exposed as properties of the corresponding dia-
log box, and you can change them. Just click a dialog box in the User Interface Editor and then look
up its properties in the Properties window.

FIGURE 2.20 npleCalculators) | File Types (SimpleCalculatars)  User Interface ..pleCalculators) | 40X
. =
The outline of the o me—
= Welcome
[= Installation Folder
= Confirm Installation

= g] Progress
= Progress

installation process

= Administrative Install
= = start
= welcome
= Installation Foldsr
= Confirm Installation
= =1 Progress
= Progress
== end

=) Finished

The wizard inserts all the necessary dialog boxes, but you can add custom dialog boxes. If you do,
you must also provide some code to process the user’s selections on the custom dialog box. For our
simple example, we don’t need any customized dialog boxes. I will repeat here that the topic of creat-
ing a customized Windows installer is one of the major aspects of Visual Studio.NET, and when
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you're ready to build an installer for a large application, you will have to consult the documentation
eXtensively.

Custom Actions and System Requirements Buttons

The last two buttons on the Properties window allow you to specify custom actions and require-
ments for the target machine. For example, you may specify that the application be installed only on
systems on which a specific component has already been installed. You can ignore these buttons for
a simple installation project.

Finishing the Windows Installer

OK, we’re almost there. Select Build > Build Solution, and VB will create the installation program.
First, it will create a new project folder, the SimpleCalculators folder. This is where the Setup
project’s files will be stored and where the executable file of the installation program will be created.
The process of building the executables and creating the Setup program will take several minutes. The
output of the build process is the SimpleCalculators.msi file. This is an executable file (known as
Windows Installer Package), and it will be created in the \SimpleCalculators\Release folder. Its
size will be approximately 15 MB. If you’re wondering what’s in this file, take a look at the Output
window of the IDE and you will see a large list of components added to the package.

Running the Windows Installer

Now you're ready to install the Calculators project to your computer. If you have access to another
computer that doesn’t have Visual Studio installed, you should copy the SimpleCalculators.msi file
there and install the application there. The components required for your application to run prop-
erly are already installed on the development machine, and you can test the Setup project better on
another machine.

Go to the folder \SimpleCalculators\Release and double-click the icon of the Windows Installer
Package (or the folder to which you have copied this file on another machine). The MSI file is
represented by the typical installation icon (a computer and a CD). The following figures show the
installation steps. Please notice where the captions you specified in the Setup project’s properties
appear in the screens of the installation wizard. Consult these figures as you build a Setup applica-
tion to make sure the proper messages are displayed during the installation on the target computer.

1. This dialog appears while the Windows installer starts.

| Windows Installer =

1 Ié- Preparing to install

2. The welcome screen of the wizard that will guide the user through the installation procedure. The
messages on this screen are the properties Copyright Warning and WelcomeText of the Welcome
dialog box in the User Interface Editor.
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3. This screen lets the user change the default path of the application to be installed. Notice
how the default path is formed. You can control the default installation path by setting the
appropriate properties of the Setup project. The installer will create a folder, under the Pro-
gram Files folder, named after the Manufacturer and ProductNName properties of the Setup

project.

]ﬂ The EasyCalc Project

Select Installation Folder

The installer will install The EasyCale Project to the following folder.

To install in this folder, click "Next". Toinstall to a different folder, enter it below or click "Browse".

Folder

C:\Program FilestDefault Company MameXT he E asyCalc Project's

Browse. ..
Disk Cost

Install The EaspCale Project for yourself, or for anpone who uses this computer:
s Everyone
" Justme

Cancel < Back

| T e >

|ﬂ The EasyCalc Project

Welcome to the The EasyCalc Project Setup
Wizard

The installer will guide you through the: steps required to install The EasyCale Project on your
GOMmputer,

WARMING: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any partion of it, mag result in severe civil
or criminal penalties, and wil be prosecuted to the maximum extent possible under the law.

Canicel

l ety

4. This screen asks the user to confirm the installation—which can be cancelled later as well.

5. The application 1s being installed, and this screen displays a progress indicator. The user can
terminate the installation by clicking the Cancel button.

]ﬂ DemoSetup

Confirm Installation

The installer is ready to install DemoSetup on your computer.

Click "Mext" to start the installation,

Cancel < Back

Installing The EasyCalc Project

The EasyCalc Froject is being installed.

Please wait...

6. The last screen of the installer confirms the successful installation of the application. Click
Close to end the program. If there was a problem installing the application, a description of
the problem will be displayed on this last screen. In this case, all the components installed
in the process will be automatically removed as well.
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]ﬂ The EasyCalc Project

Installation Complete

The EasyCalc Project has been sucessfully installed

Click "Close" to exit

Verifying the Installation

You already know the kind of changes made to your system by an installation program. If you open
the Programs menu (Start > Programs), you will see that a new item was added, the Demo Calcula-
tors item. If you select it with the mouse, a submenu will open, as shown in Figure 2.21. You can
select any of the three commands (Calculators, Calculator, or LoanCalculator) to start the corre-
sponding application.

Tt All three items in the Demo Caleulators submenu bave the default application icon. You should change the default
icons of your applimtions for a more prgfessional look.

FIGURE 2.21 % windows Update
The new items B8 | new office Document
A
added to the Pro- Open Offics Document
grams menu by the vz
Windows installer )
= Accessories 4
_j Skartup 4

4 Microsaft Word

£ = ooaumens
i =] Microsoft Wisual Studio NET 7.0 ¥
ﬂ} Settings r o
L=} Paint Shop Pro & >

@ Search » [ Creative 3
5 4 O calculator

Log Off evangelos petroutsas..,,

& P&

Shut Down...

The Windows installer has created and installed a program for uninstalling the application from
the target computer. Open Control Panel and double-click the Add/Remove Programs icon. The
dialog box that appears contains an item for each program you can remove from your computer. The
newly installed application is the item The EasyCalc Project, as shown in Figure 2.22. Click its

Remove button to uninstall the application or the Change button to repair an existing installation.
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FIGURE 2.22 gy Add/Remove Programs _[oj x|
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As for the location of the executables and their support files, they're in the EasyCalc Project
folder under \Program Files\CompanyName folder. If the same customer installs another of your
applications—say, the ProCalc Project—it will also be installed in its own folder under \Program
Files\CompanyName. Just make sure all the Setup projects have the same value for the Manufacturer
property, and the support files won’t be installed in multiple folders.

Summary

This chapter introduced you to the concept of solutions and projects. Y ou learned how to build a simple
solution with a single project, as well as a solution with multiple projects. Use solutions to combine
multiple related projects into a single unit, so that your projects can share components. Each project
in a solution maintains its individuality, and you can either edit one from within the solution or
open it as a project and edit independently of the other projects in the solution.

You also learned how to develop Web applications. With VB.NET, developing Web applica-
tions is as easy as developing Windows applications. In a few short years, you should be able to
design a single interface that can be used by both types of projects (even if this means that there will
be nothing but Web applications). The user interface of Web and Windows applications may be
different, but the code behind both types of projects is straight Visual Basic.

After you have developed an application, you will have to distribute it. Distributing Windows
application isn’t a trivial process, but building a Setup program for your application with VB.NET is.
All you have to do is add a Setup project to a solution that contains the project or projects that you
want to distribute. The simplest type of Setup program doesn't require any code, and you can create a
Windows installer by just setting a few properties. The output of the Setup program is a file with the
extension .msi, which you can copy to another computer. Once executed on the target computer, the
MSI file will install the application, create a shortcut to the application in the user’s Programs menu,
and even create an entry in Add/Remove Programs for repairing or uninstalling the application.

By now, you have a good idea about the environment and how Windows applications are built. In
the following two chapters, you'll read about the language itself.
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Visual Basic: The Language

THIS CHAPTER AND THE next discuss the fundamentals of any programming language: vari-
ables, flow-control statements, and procedures. A variable stores data, and a procedure is code that
manipulates variables. To do any serious programming with Visual Basic, you must be familiar
with these concepts. To write efficient applications, you need a basic understanding of some fun-
damental topics, such as the data types (the kind of data you can store in a variable), the scope
and lifetime of variables, and how to write procedures and pass arguments to them.

As you have seen in the first two chapters, most of the code in a Visual Basic application deals
with manipulating control properties and variables. This chapter explores in greater depth how
variables store data and how programs process variables. If you're familiar with Visual Basic, you
might want to simply scan the following pages and make sure you're acquainted with the topics
and the sample code discussed in this chapter. I would, however, advise you to read this chapter
even if you're an experienced VB programmer.

VB6 "» VB.NET

Experienced Visual Basic programmers should pay attention to these special sidebars with the “VB6 to
VB.NET” icon, which calls your attention to changes in the language. These sections usually describe
new features in VB.NET or enhancements of VB6 features, but also VB6 features that are no longer sup-
ported by VB.NET.

If you're new to Visual Basic, you may find that some material in this chapter less than excit-
ing. It covers basic concepts and definitions—in general, tedious, but necessary, material. Think
of this chapter as a prerequisite for the following ones. If you need information on core fea-
tures of the language as you go through the examples in the rest of the book, you'll probably find

it here.
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Variables

In Visual Basic, as in any other programming language, variables store values during a program'’s exe-
cution. Let’s say you're writing a program that converts amounts between different currencies. Instead
of prompting the user for the exchange rates all the time—or even worse, editing your code to change
the currency rates every day—you can store the exchange rates into variables and use these variables to
perform the conversions. If the current exchange rate between the U.S. dollar and the euro is 0.9682,
you can store this value to a variable called USD2Euro. If you change the value of this variable once in
your code, all the conversions will be calculated based on the new rate. Or you can prompt the users
for the exchange rate when they start the program, store the rate to the USD2Euro variable, and then
use it in your code.

A variable has a name and a value. The variable UserName, for example, can have the value “Joe,”
and the variable Discount can have the value 0.35. UserName and Discount are variable names, and
“Joe” and 0.3S are their values. “Joe” is a string (that is, text or an alphanumeric value), and 0.35 is a
numeric value. When a variable’s value is a string, it must be enclosed in double quotes. In your code,
you can refer to the value of a variable by the variable’s name. For example, the following statements

calculate and display the discounted price for the amount of $24,500:

Dim Amount As Single

Dim Discount As Single

Dim DiscAmount As Single

Amount = 24500

Discount = 0.35

DiscAmount = Amount * (1 - Discount)
MsgBox("Your price is $" & DiscAmount)

Single is a numeric data type; it can store both integer and non-integer values. There are other
types of numeric variables, which are discussed in the following sections. I've used the Single data
type because it’s the most commonly used data type for simple calculations that don’t require
extreme accuracy.

The message that this expression displays depends on the values of the Discount and Amount vari-
ables. If you decide to offer a better discount, all you have to do is change the value of the Discount
variable. If you didn’t use the Discount variable, you’d have to make many changes in your code. In
other words, if you coded the line that calculated the discounted amount as follows:

DiscAmount = 24500 * (1 - 0.35)

you'd have to look for every line in your code that calculates discounts and change the discount from
0.35 to another value. By changing the value of the Discount variable in a single place in your code,
the entire program is updated.

VB6 "» VB.NET

InVB6, amounts of money were usually stored in Currency variables. The Currency data type turned out to
be insufficient for monetary calculations and was dropped from the language. Use the Decimal data type,
discussed later in this chapter, to represent money amounts.
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Variables in VB.NET are more than just names, or placeholders, for values. They’re intelligent
entities that can not only store but also process a value. I don’t mean to scare you, but I think you
should be told: VB.NET variables are objects. And here’s why:

A variable that holds dates must be declared as such with the following statement:

Dim expiration As Date
Then you can assign a date to the expiration variable, with a statement like this:
expiration = #1/1/2003#

So far, nothing out of the ordinary. This is how you use variables with any other language. In
addition to holding a date, however, the expiration variable can process it. The expression

expiration.AddYears(3)

will return a new date that’s three years ahead of the date stored in the expiration variable. The new
date can be assigned to another Date variable:

Dim newExpiration As Date
newExpiration = expiration.AddYears(3)

The keywords foﬂowing the period after the variable’s name are called methods and properties, just like
the properties and methods of the controls you place on a form to create your application’s visual inter-
face. The methods and properties (or the members) of a variable expose the functionality that’s built into
the class that represents the variable itself. Without this built-in functionality, you’d have to write some
serious code to extract the month from a Date variable, to figure out whether a character is a letter, a
digit, or a punctuation symbol, and so on. Much of the functionality you'ﬂ need in an application that
manipulates dates, numbers, or text has already been built into the variables themselves, and you will see
examples of other properties and methods exposed by the various data types later in this chapter.

Don’t let the terminology scare you. Think of variables as placeholders for values and access their
functionality with expressions like the ones shown earlier. Start using variables to store values and,
if you need to process them, enter a variable’s name followed by a period to see a list of the members
it exposes. In most cases, you'll be able to figure out what these members do by just reading their
names. I'll come back to the concept of variables as objects, but I wanted to hit it right off the bat. A
more detailed discussion of the notion of variables as object can be found later in this chapter.

Since this book isn’t for computer scientists, I can simplify the text in the foﬂowing sections by
treating variables as locations in memory where you store values. Later in this chapter, and after dis-
cussing the data types of the Common Language Runtime (CLR), I will treat them as objects.

Declaring Variables

In most programming languages, variables must be declared in advance. Historically, the reason for
doing this has been to help the compiler. Every time a compiled application runs into a new variable,
it has to create it. Doing so doesn't take a lot of statements, but it does produce a delay that could be
avoided. If the compiler knows all the variables and their types that are going to be used in the appli-
cation ahead of time, it can produce the most compact and efficient, or optimized, code. For example,
when you tell the compiler that the variable Discount will hold a number, the compiler sets aside a cer-
tain number of bytes for the Discount variable to use.
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One of the most popular, yet intensely criticized, features of BASIC was that it didn’t force the
programmer to declare all variables. As you will see, there are more compelling reasons than speed
and efficiency for declaring variables. For example, if the compiler knows the types of the variables,
it will catch many errors at design or compile time—errors that otherwise would surface at runtime.
When you declare a variable as Date, the compiler won’t let you assign an integer value to it. It also
won't let you request the Month property of an Integer variable (Month is a property that applies
only to Date variables). Because the type of the variable is known at compile time, similar errors will
be caught as you enter code and therefore won’t cause runtime errors. Later in the chapter, in the sec-
tion “Why Declare Variables?”, you'll see how variable declarations can simplify coding too.

When programming in VB.NET, you should declare your variables, because this is the default
mode and Microsoft recommends this practice strongly. They’ve been recommending it with previ-
ous versions of VB, but up to VB6 the language was accepting undeclared variables by default. If
you attempt to use an undeclared variable in your code, VB.NET will throw an exception. It will
actually catch the error as soon as you complete the line that uses the undeclared variable, underlin-
ing it with a wiggly red line. It is possible to change the default behavior and use undeclared variables
the way most people did with earlier versions of VB (you’ﬂ see how this is done in the section “The
Strict and Explicit Options,” later in this chapter), but nearly all the examples of the book declare
their variables. In any case, you're strongly encouraged to declare your variables.

VB6 "» VB.NET

Although not an absolute requirement, VB.NET encourages the declaration of variables. By default, every
variable must be declared. Moreover, when you declare a variable, you must also specify its type. One of the
new terms in the VB.NET documentation is strictly typed, which simply means that a variable has a specific
type and you can’t store a value of a different type to the variable. See the discussion of Option Explicit
and Option Strict statements later in this chapter for more information on using variables without
declaring them, or declaring them without a specific type.

VB.NET recognizes the type identifier characters. A variable name like note$ implies a String variable, and
you need not supply a data type when you declare the variable. The Defxxx statements (Deflnt, DefDbl, and
so on), however, are not supported by VB.NET. The Defxxx statements were already obsolete, and they were
rarely used even with older versions of Visual Basic.

In VB.NET you can declare multiple variables of the same type without having to repeat each variable’s
type. The following statement, for instance, will create three Integer variables:

Dim width, depth, height As Integer
The following statement will create three Integer and two Double variables:
Dim width, depth, height As Integer, area, volume As Double

Another convenient shortcut introduced with VB.NET is that now you can initialize variables along with
their declaration. Not only can you declare a variable with the Dim statement, you can also initialize it by
assigning a value of the proper type to it:

Dim width As Integer = 9
Dim distance As Integer = 100, time As Single = 9.09
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When you declare variables in your code, you're actually telling the compiler the type of data you
intend to store in each variable. This way, the compiler can generate code that handles the variables
most efficiently. A variable that holds characters is different from a variable that holds numbers. If
the compiler knows in advance the type of data you're going to store in each variable, it can not only
optimize the executable it will produce, it can also catch many mistakes as you type (an attempt to
store a word to a numeric variable, for instance).

To declare a variable, use the Dim statement followed by the variable’s name, the As keyword,
and its type, as follows:

Dim meters As Integer
Dim greetings As String

We'll look at the various data types in detail in the next section. In the meantime, you should
know that a variable declared As Integer can store only integer numbers, and a variable declared As
String can only store text (strings of characters, or simply strings).

The first variable, meters, will store integers, such as 3 or 1,002, and the second variable, greetings,
will store text, such as “Thank you for using Fabulous Software”. You can declare multiple variables
of the same or different type in the same line, as follows:

Dim Qty As Integer, Amount As Decimal, CardNum As String

When Visual Basic finds a Dim statement, it creates one or more new variables, as speciﬁed in the
statement. T hat is, it creates a structure in the memory where it can store a value of the speciﬁed
type and assigns a name to it. Each time this name is used in subsequent commands, Visual Basic
accesses this structure to read or set its value. For instance, when you use the statement

meters = 23

Visual Basic places the value 23 in the structure reserved for the meters variable. When the program
asks for the value of this variable, Visual Basic reads it from the same structure.

To use the meters variable in a calculation, reference it by name in a statement in your code. The
statement

inches = meters * 39.37

multiplies the value stored in the meters variable and assigns the result to the inches variable. The equal
sign is the assignment operator: it assigns the value of the expression that appears to its right, to the
variable listed to its left. Only the variable to the left of the equal sign changes value.

The following statement displays the value of the same variable on a message box:

MsgBox(meters)

It causes Visual Basic to retrieve the value 23 from the area of memory named meters.
It's also possible for a single statement to both read and set the value of a variable. The following
statement increases the value of the meters variable:

meters = meters + 1

Visual Basic reads the value (here, 23), adds 1 to it, and then stores the new value (24) in the origi-
nal location.

One good reason for declaring variables is so that Visual Basic knows the type of information the
variable must store and can validate the variable’s value. Attempting to assign a value of the wrong type
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to a declared variable generates an error. For example, if you attempt to assign the value “Welcome” to
the meters variable, Visual Basic won't compile the statement because this assignment violates the vari-
able’s declaration. The meters variable was declared as Integer, and you're attempting to store a string in
it. It will actually underline the statement in the editor with a red wiggly line, which indicates an error.
If you hover the pointer over the statement in error, a box with an explanation of the error will appear.

You can use other keywords in declaring variables, such as Private, Public, and Static. These key-
words are called access modifiers, because they determine what sections of your code can access the spe-
cific variables and what sections can’t. We'll look at these keywords in later sections of this chapter.
In the meantime, bear in mind that all variables declared with the Dim statement exist in the module
in which they were declared. If the variable Count is declared in a subroutine (an event handler, for
example), it exists only in that subroutine. You can’t access it from outside the subroutine. Actually,
you can have a Count variable in multiple procedures. Each variable is stored locally, and they don’t
interfere with one another.

VARIABLE-NAMING CONVENTIONS
When declaring variables, you should be aware of a few naming conventions. A variable’s name:

¢ Must begin with a letter.

¢ Can’t contain embedded periods. Except for certain characters used as data type identifiers
(which are described later in this chapter), the only special character that can appear in a vari-
able’s name is the underscore character.

¢ Mustn’t exceed 255 characters.

Must be unique within its scope. This means that you can’t have two identically named variables
in the same subroutine, but you can have a variable named counter in many different subroutines.

Variable names in VB.INET are case-insensitive: The variable names myAge, myage, and MYAGE all
refer to the same variable in your code. Conversely, you can’t use the names myage
and MYAGE to declare two different variables.

TiP  In fact, as you enter variable names, the editor converts their casing so that tkey match their declaration.

VARIABLE INITIALIZATION
You can also initialize variables in the same line that declares them. The following line declares an
Integer variable and initializes it to 3,045:

Dim distance As Integer = 3045
This statement is equivalent to the foﬂowing statements:

Dim distance As Integer
distance = 3045

It is also possible to declare and initialize multiple variables, of the same or different type, on the
same line:

Dim quantity As Integer = 1, discount As Single = 0.25
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If you want to declare multiple variables of the same type, you need not repeat the type. Just sepa-
rate all the variables of the same type with commas and set the type of the last variable:

Dim length, width, height As Integer, volume, area As Double

This statement declares three Integer variables and two Double variables. Double variables hold
fractional values (or floating-point values, as they’re usually called) similar to the Single data type, only
they can represent non-integer values with greater accuracy. Declaring and initializing variables in a
single step was a common feature among programming languages, but missing from previous ver-
sions of Visual Basic.

You can even initialize variables that represent objects on the same line that declares them. In
Chapter 14, you will learn about pens and brushes, which are the two “instruments” for drawing.
Before you can draw a shape on your form, you must create a Pen or a Brush object and then use it
to draw something with. The simplest method of creating a new Pen is to specify its color. The fol-
lowing statement declares a Pen object that will draw in a blue-green color:

Dim myPen As Pen = New Pen(Color.AquaMarine)

This New keyword is used with object variables and tells VB to create a new instance of the Pen
object (in effect, to create a new Pen). Color is another object that lets you manipulate the color of
pens, backgrounds, and so on. Among other properties, the Color object exposes the names of colors
it recognizes, and Color.AquaMarine is one of them.

You can also create variables of type Color. The following statement creates two variables that rep-
resent a different color each (one will be used as the background and the other as the drawing color):

Dim bgColor As Color = Color.LightYellow, fgColor As Color = Color.Blue

VB6 " VB.NET

Another interesting new feature introduced with VB.NET is the shorthand notation of common operations,
such as the addition of a value to a variable. The statement

counter = counter + 1
can now be written as
counter += 1

The symbols += form a new VB operator (there’s no space between the plus and the equal sign), which
adds the value on its left to the value on its right and assigns the result to the initial variable. Only a vari-
able may appear to the left of this operator, while on the right you can type either a variable or a value. The
statement

totalCount = totalCount + count
is equivalent to
totalCount += count

The same notation applies to other operators, like subtraction (-=), multiplication (*=), division (/=), inte-
ger division (\=), and concatenation (&=). All these operators are new to VB.NET. ] will not overuse this nota-
tion in the book for the sake of current VB programmers; most of them consider this notation one of the
trademarks of the C language.
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Types of Variables

Visual Basic recognizes the following five categories of variables:
¢ Numeric

String

Boolean

Date

Object

* & o o

The two major variable categories are numeric and string. Numeric variables store numbers, and string
variables store text. Object variables can store any type of data. Why bother to specify the type if one
type suits all? On the surface, using object variables may seem like a good idea, but they have their
disadvantages. Integer variables are optimized for storing integers, and date variables are optimized
for storing dates. Before VB can use an object variable, it must determine its type and perform the
necessary conversions, if any. If an object variable holds an integer value, VB must convert it to a
string before concatenating it with another string. This introduces some overhead, which can be
avoided by using typed variables.

We begin our discussion of variable types with numeric variables. Text is stored in string vari-
ables, but numbers can be stored in many formats, depending on the size of the number and its pre-
cision. That's why there are many types of numeric variables.

NUMERIC VARIABLES

You'd expect that programming languages would use a single data type for numbers. After all, a
number is a number. But this couldn’t be farther from the truth. All programming languages provide
a variety of numeric data types, including the following:

*

Integers (there are several integer data types)

¢ Decimals

& Single, or floating-point numbers with limited precision
L 2

Double, or floating-point numbers with extreme precision

NOTE  Decimal, Single, and Double are the three basic data types for storing floating-point numbers. The Double type
can represent these numbers more afmmtely than the Single type, and it’s used almost exclusz‘vely in scientific caleulations.
The integer data types store whole numbers.

The data type of your variable can make a difference in the results of the calculations. The proper
variable types are determined by the nature of the values they represent, and the choice of data type
is frequently a trade-off between precision and speed of execution (less-precise data types are manip-
ulated faster). Visual Basic supports the numeric data types shown in Table 3.1.
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TABLE 3.1: VISUAL BASIC NUMERIC DATA TYPES

DATA TYPE MEMORY STORES
REPRESENTATION
Short (Int16) 2 bytes Integer values in the range —32,768 to 32,767.
Integer (Int32) 4 bytes Integer values in the range —2,147,483,648 t0 2,147,483,647.
Long (Int64) 8 bytes Very large integer values.
Single 4 bytes Single-precision floating-point numbers. It can represent negative

numbers in the range —3.402823E38 to —1.401298E—45 and positive
numbers in the range 1.401298E—45 to 3.402823E38. The value 0 can’t
be represented precisely (it’s a very, very small number, but not
exactly 0).

Double 8 bytes Double-precision floating-point numbers. It can represent negative
numbers in the range —1.79769313486232E308 to
—4.94065645841247E-324 and positive numbers in the range
4.94065645841247E-324 t01.79769313486232E308.

Decimal 16 bytes Integer and floating-point numbers scaled by a factor in the range
from 0 to 28. See the description of the Decimal data type for the
range of values you can store in it.

VB6 " VB.NET

The Short data type is the same as the Integer data type of VB6. The new Integer data type is the same as
the Long data type of VB6; the VB.NET Long data type is new and can represent extremely large integer
values. The Decimal data type is new to VB.NET, and you use it when you want to control the accuracy of
your calculations in terms of number of decimal digits.

Integer Variables

There are three different types of variables for storing integers, and the only difference is the range
of numbers you can represent with each type. As you understand, the more bytes a type takes, the
larger values it can hold. The type of integer variable you'll use depends on the task at hand. You
should choose the type that can represent the largest values you anticipate will come up in your cal-
culations. You can go for the Long type, to be safe, but Long variables are four times as large as
Short variables, and it takes the computer longer to process them.

The statements in Listing 3.1 will help you understand when to use the various integer data types.
Each numeric data type exposes the MinValue and MaxValue properties, which return the mini-
mum and maximum values that can be represented by the corresponding data type. I have included
comments after each statement to explain the errors produced by some of the statements.
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LISTING 3.1: EXPERIMENTING WITH THE RANGES OF NUMERIC VARIABLES

Dim shortInt As Intl6

Dim Int As Int32

Dim longInt As Int64

Console.WriteLine(shortInt.MinValue)
Console.WriteLine(shortInt.MaxValue)
Console.WriteLine(Int.MinValue)
Console.WriteLine(Int.MaxValue)
Console.WriteLine(longInt.MinValue)
Console.WriteLine(longInt.MaxValue)

shortInt = shortInt.MaxValue + 1

' ERROR, exceeds the maximum value of the Short data type
Int = shortInt.MaxValue + 1

' 0K, is within the range of the Integer data type

Int = Int.MaxValue + 1

' ERROR, exceeds the maximum value of the Integer data type
Int = Int.MinvValue — 1

' ERROR, exceeds the minimum value of the Integer data type
TongInt = Int.MaxValue + 1

' 0K, is within the range of the Long data type

TongInt = longInt.MaxValue + 1

' ERROR, exceeds the range of all integer data types

The six WriteLine statements will print the minimum and maximum values you can represent
with the integer data types. The following statement attempts to assign to a Short integer variable a
value that exceeds the largest possible value you can represent with the Short data type, and it will
generate an error. If you attempt to store the same value to an Integer variable, there will be no prob-
lem, because this value is well within the range of the Integer data type.

The next two statements attempt to store to an Integer variable two values that are also outside
the range that an Integer can represent. The first value exceeds the range of positive values, and the
second exceeds the range of the negative values.

If you attempt to store these values to a Long variable, there will be no problem. If you exceed
the range of values that can be represented by the Long data type, you're out of luck. This value can’t
be represented as an integer, and you must store it in one of the variable types discussed in the next
sections.

Single- and Double-Precision Numbers
The names Single and Double come from single-precision and double-precision numbers. Double-
precision numbers are stored internally with greater accuracy than single-precision numbers. In scien-
tific calculations, you need all the precision you can get; in those cases, you should use the Double
data type.

The result of the operation 1 / 31is0.333333... (an infinite number of digits “3™). You could
fill 64 MB of RAM with “3” digits, and the result would still be truncated. Here’s a simple, but illu-

minating, example:
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In a button’s Click event handler, declare two variables as follows:
Dim a As Single, b As Double

Then enter the following statements:

a=1/3
Console.WriteLine(a)

Run the application and you should get the following result in the Output window:
.3333333

There are seven digits to the right of the decimal point. Break the application by pressing
Ctrl+Break and append the following lines to the end of the previous code segment:

a = a * 100000
Console.WritelLine(a)

This time the following value will be printed in the Output window:
33333.34

The result is not as accurate as you might have expected initially—it isn’t even rounded properly.

If you divide a by 100,000, the result will be:
0.3333334

which is different from the number we started with (0.3333333). This is an important point in
numeric calculations, and it’s called error propagation. In long sequences of numeric calculations, errors
propagate. Even if you can tolerate the error introduced by the Single data type in a single operation,
the cumulative errors may be significant.

Let’s perform the same operations with double-precision numbers, this time using the variable b.
Add these lines to the button’s Click event handler:

b=1/3
Console.WriteLine(b)
b =b * 100000
Console.WriteLine(b)

This time, the following numbers are displayed in the Output window:

0.333333333333333
33333.3333333333

The results produced by the double-precision variables are more accurate.

NOTE Smal[er—prefision numbers are stored in fewer bytes) and larger—prefision numbers are stored in more bytes. The
actual format of the ﬂoating-point numeric types is fomplieated and won'’t be discussed in this book. ]ust keep in mind that
fmetional values can’t be always represented prefisely in the computer’s memory; tbey prodme more accurate results, but
Using more precision requires 1more memory.

Why are such errors introduced in our calculations? The reason is that computers store numbers
internally with two digits: zero and one. This is very convenient for computers, because electronics
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understand two states: on and off. As a matter of fact, all the statements are translated into bits
(zeros and ones) before the computer can understand and execute them. The binary numbering sys-
tem used by computers is not much different than the decimal system we, humans, use; computers
just use fewer digits. We humans use 10 different digits to represent any number, whole or frac-
tional, because we have 10 fingers. Just as with the decimal numbering system some numbers can’t be
represented precisely, there are numbers that can’t be represented precisely in the binary system. Let
me give you a more iﬂuminating example‘

Create a single-precision variable, 4, and a double-precision variable, b, and assign the same value
to them:

Dim a As Single, b As Double
a = 0.03007
b = 0.03007

Then print their difference:
Console.WriteLine(a-b)

If you execute these lines, the result won't be zero! It will be -6.03199004634014E-10. This is a very
small number that can also be written as 0.000000000603199004634014. Because different numeric
types are stored differendy in memory, they don’t quite match. What this means to you is that all vari-
ables in a calculation should be of the same type. In addition, don’t make comparisons like:

If a = b Then { do something }

Use a threshold instead. If the difference is smaller than a threshold, then the two values can be
considered equal (depending on the nature of your calculations, of course):

If (a - b) < 0.000001 Then { do something }

If your applications involve heavy math, always follow the values of the intermediate results to see
where truncation errors were introduced.

Eventually, computers will understand mathematical notation and will not convert all numeric
expressions into values, as they do today. If you multiply the expression 1/3 by 3, the result should
be 1. Computers, however, must convert the expression 1/3 into a value before they can multiply it
with 3. Since 1/3 can’t be represented precisely, the result of the (1 /3) x 3 will not always be 1. If

the variables a and b are declared as Single or Double, the following statements will print 1:

a=3
b=1/a
Console.WriteLine(b * a)

If the two variables are declared as Decimal, however, the result will be a number very close to 1,
but not exactly 1 (it will be 0.9999999999999999999999999999—there are 28 digits after the
decimal period).

The Decimal Data Type

Variables of the last numeric data type, Decimal, are stored internally as integers in 16 bytes and
are scaled by a power of 10. The scaling power determines the number of decimal digits to the right
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of the floating point, and it’s an integer value from O to 28. When the scaling power is O, the value is
multiplied by 10 or 1, and it’s represented without decimal digits. When the scaling power is 28,
the value is divided by 1028 (which is 1 followed by 28 zeros—an enormous V&lue), and it’s repre-
sented with 28 decimal digits.

The largest possible value you can represent with a Decimal value is an integer:
79,228,162,514,264,337,593,543,950,335. The smallest number you can represent with a Decimal

variable is the negative of the same value. These values use a scaling factor of 0.

VB6 "» VB.NET

The Decimal data type is new to VB.NET and has replaced the Currency data type of previous versions of
VB. The Currency type was introduced to handle monetary calculations and had a precision of four decimal
digits. It was dropped from the language because it didn’t provide enough accuracy for the types of calcu-
lations it was designed for. Most programmers wanted to be able to control the accuracy of their calcula-
tions, so a new, more flexible type was introduced, the Decimal type.

When the scaling factor is 28, the largest value you can represent with a Decimal variable is quite
small, actuaﬂy. It's 7.9228162514264337593543950335 (and the largest negative value is the
same with the minus sign). The number zero can’t be represented precisely with a Decimal variable
scaled by a factor of 28. The smallest positive value you can represent with the same scaling factor is
0.00...01 (there are 27 zeros between the decimal period and the digit 1)—an extremely small

value, but still not quite zero.

NOTE  The more accuracy you want to achieve with a Decimal variable, the smaller the range of available values you have
at your disposal—just as with the other numeric types, or just like about everything else in life.

When using Decimal numbers, VB keeps track of the decimal digits (the digits following the dec-
imal point) and treats all values as integers. The value 235.85 is represented as the integer 23588,
but VB knows that it must scale the value by 100 when it’s done using it. Scaling by 100 (that 1s,
10?) corresponds to shifting the decimal point by two places. First, VB multiplies this value by 100
to make it an integer. Then, it divides it by 100 to restore the original value. Let’s say you want to
multiply the following values:

328.558 * 12.4051

First, you must turn them into integers. You must remember that the first number has three deci-
mal digits and the second number has four decimal digits. The result of the multiplication will have
seven decimal digits. So you can multiply the following integer values:

328558 * 124051

and then treat the last seven digits of the result as decimals. Use the Windows Calculator (in the
Scientific view) to calculate the previous product. The result is 40,757,948,458. The actual value
after taking into consideration the decimal digits is 4,075.7948458. This is how VB works with the
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Decimal data type. If you perform the same calculations with Decimals in VB, you will get the exact
same result. Insert the following lines in a button’s Click event handler and execute the program:

Dim a As Decimal = 328.558
Dim b As Decimal 12.4051
Dim ¢ As Decimal

c=a*hb
Console.WriteLine(c)

If you perform the same calculations with Single variables, the result will be truncated (and
rounded) to 3 decimal digits: 4,075.795. Notice that the Decimal data type didn’t introduce any
rounding errors. It’s capable of representing the result with the exact number of decimal digits. This
is the real advantage of decimals, which makes them ideal for financial applications. For scientific
calculations, you must still use Doubles. Decimal numbers are the best choice for calculations that
require a specific precision (like four or eight decimal digits).

Numeric-calculation errors due to truncation are not unique to VB, or even to Pentium processors.
This how computers and programming Ianguages are designed, and you can’t avoid them. People who
write scientific applications have come up with techniques to minimize the effect of the truncations.
For other types of applications, the truncation errors are practically negligible. If you write financial
apphcations, use the Decimal data type and round the amounts to two decimal digits at the end.

INFINITY AND OTHER ODDITIES

VB.NET can represent two very special values, which may not be numeric values themselves but are
produced by numeric calculations: NaN (not a number) and Infinity. If your calculations produce
NaN or Infinity, you should confirm the data and repeat the calculations, or give up. For all practi-
cal purposes, neither NaN nor Infinity can be used in everyday business calculations.

VB6 "» VB.NET

VB.NET introduces the concepts of an undefined number (NaN) and infinity to Visual Basic. In the past, any
calculations that produced an abnormal result (i.e., a number that couldn’t be represented with the exist-
ing data types) generated runtime errors. VB.NET can handle abnormal situations much more gracefully.
NaN and Infinity aren’t the type of result you’d expect from meaningful numeric calculations, but at least
they don’t produce run-errors.

Some calculations produce undefined results, like infinity. Mathematically, the result of dividing
any number by zero is infinity. Unfortunately, computers can’t represent infinity, so they produce an
error when you request a division by zero. VB.NET will report a special value, which isn’t a number:
the Infinity value. If you call the ToString method of this value, however, it will return the string
“Infinity”. Let's generate an Infinity value. Start by declaring a Double variable, dblVar:

Dim db1Var As Double = 999
Then divide this value by zero:

Dim infVar as Double
infVar = dblvar / 0
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and display the variable’s value:
MsgBox(infVar)

The string “Infinity” will appear on a message box. This string is just a description; it tells you
that the result is not a valid number (it’s a very large number that exceeds the range of numeric
values that can be represented in the computer’s memory).

Another calculation that will yield a non-number is when you divide a very large number by a
very small number. If the result exceeds the largest value that can be represented with the Double
data type, the result is Infinity. Declare three variables as follows:

Dim largeVar As Double = 1E299
Dim smallVar As Double = 1E-299
Dim result As Double

NOTE  The notation 1E299 means 10 raised to the power of 299, which is an extremely large number. Likewise, 1E-
299 means 10 raised to the power of —299, which is equivalent to dividing 10 by a number as large as 1E299.

Then divide the Iarge variable by the small variable and display the result:

result = largeVar / smallVar
MsgBox(result)

The result will be Infmity. If you reverse the operands (that is, you divide the very small by the
very large variable), the result will be zero. It’s not exactly zero, but the Double data type can’t accu-
rately represent numeric values that are very, very close to zero.

NOT A NUMBER (NAN)

NaN is not new. Packages like Mathematica and Excel have been using it for years. The value NaN indicates
that the result of an operation can’t be defined: it’s not a regular number, not zero, and not Infinity. NaN is
more of a mathematical concept, rather than a value you can use in your calculations. The Log() function,
for example, calculates the logarithm of positive values. By default, you can’t calculate the logarithm of a
negative value. If the argument you pass to the Log() function is a negative value, the function will return
the value NaN to indicate that the calculations produced an invalid result.

The result of the division 0 / 0, for example, is not a numeric value. If you attempt to enter the
statement “0 / 0” in your code, however, VB will catch it even as you type and you'll get the error
message “Division by zero occurs in evaluating this expression”.

To divide zero by zero, set up two variables as follows:

Dim varl, var2 As Double
Dim result As Double
varl = 0

var2 = 0

result = varl / var2
MsgBox(result)
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If you execute these statements, the result will be a NaN. Any calculations that involve the result

variable (a NaN value) will yield NaN as a result. The statements:

result = result + result
result = 10 / result
result = result + 1E299
MsgBox(result)

will all yield NaN.

If you make var2 a very small number, like 1E-299, the result will be zero. If you make var! a very

small number, then the result will be Inﬁnity.

For most practical purposes, Inﬁnity is handled just like NaN. They’re both numbers that
shouldn’t occur in business applications, and when they do, it means you must double-check your
code or your data. They are much more Iikely to surface in scientific calculations, and they must be
handled with the statements described in the next section.

Testing for Infinity and NaN

To find out whether the result of an operation is a NalN or Infinity, use the IsNaN and IsInfinity
methods of the Single and Double data type. The Integer data type doesn’t support these methods,
even though it’s possible to generate Infinity and NaN results with Integers. If the IsInfinity method
returns True, you can further examine the sign of the Infinity value with the IsNegativelnfinity and
IsPositivelnfinity methods.

In most situations, you'll display a warning and terminate the calculations. The statements of
Listing 3.2 do just that. Place these statements in a Button’s Click event handler and run the
application.

LISTING 3.2: HANDLING NAN AND INFINITY VALUES

Dim varl, var2 As Double
Dim result As Double
varl = 0
var2 = 0
result = varl / var2
If result.IsInfinity(result) Then
If result.IsPositiveInfinity(result) Then
MsgBox("Encountered a very large number. Can't continue")
Else
MsgBox("Encountered a very small number. Can't continue")
End If
Else
If result.IsNaN(result) Then
MsgBox("Unexpected error in calculations")
Else
MsgBox("The result is " & result.ToString)
End If
End If
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This listing will generate a NaN value. Change the value of the var variable to 1 to generate a
positive inﬁnity value, or to —1 to generate a negative inﬁnity value. As you can see, the Islnﬁnity,
IsPositivelnfinity, IsNegativelnfinity, and IsNaN methods require that the variable be passed as
argument, even though these methods apply to the same variable. An alternate, and easier to read,
notation is the following:

System.Double.IsInfinity(result)

This statement is easier to understand, because it makes it clear that the IsInfinity method is a
member of the System.Double class. (As if variables that expose methods and properties weren't
enough, a class has now surfaced! The class is the factory” that produces the object. The code that
implements the various methods and properties of the variable is stored in the class. You will learn
the relationship between objects and classes as you move along.)

This odd notation is something you will have to get used to. Some methods don’t apply to the
object they refer to, and they're called shared methods. They act on the value passed as argument and
not the object to which you apply them. You'll read more on shared methods (and their counter-
patts, the reference methods) in Chapter 8.

If you change the values of the var and var2 variables to the following and execute the applica-
tion, you'll get the message “Encountered a very large number”:

1E+299
1E-299

varl
var2

If you reverse the values, you'll get the message “Encountered a very small number.” In any case,
the program will terminate gracefully and let you know the type of problem that prevents further
calculations.

The Byte Data Type
None of the previous numeric types is stored in a single byte. In some situations, however, data is
stored as bytes, and you must be able to access individual bytes. The Byte type holds an integer in
the range O to 255. Bytes are frequently used to access binary files, image and sound files, and so on.
Note that you no longer use bytes to access individual characters. Unicode characters are stored in
two bytes.

To declare a variable as a Byte, use the following statement:

Dim n As Byte

The variable n can be used in numeric calculations too, but you must be careful not to assign the
result to another Byte variable if its value may exceed the range of the Byte type. If the variables 4
and B are initialized as follows:

Dim A As Byte, B As Byte
A = 233
B =50

the following statement will produce an overflow exception:

Console.WriteLine(A + B)
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The same will happen if you attempt to assign this value to a Byte variable with the following
statement:

B=A+8B

The result (283) can’t be stored in a single byte. Visual Basic generates the correct answer, but it
can’t store it into a Byte variable. If you do calculations with Byte variables and the result may exceed
the range of the Byte data type, you must convert them to integers, with a statement like the following:

Console.WriteLine((CInt(A) + CInt(B)))

The Clnt() function converts its argument to an Integer value. You will find more information
on converting variable types later in this chapter, in the section “Converting Variable Types.” Of
course, you can start with integer variables and avoid all the conversions between types. In rare occa-
sions, however, you may have to work with bytes and insert the appropriate code to avoid overflows.

TIP  The operators that won'’t cause overflows are the Boolean operators AND, OR, NOT, and XOR, which are fre-
quently used with Byte variables. These aren’t logical operators that return True or False. They combine the matching bits
in the two operands and return another byte. If you combine the numbers 199 and 200 with the AND operator, the
result is 192. The two values in binary format are 11000111 and 11001000. If you perform a bitwise AND
operation on these two values, the result is 11000000, which is the decimal value 192.

In addition to the Byte data type, VB.INET provides a Signed Byte data type, which can represent
signed values in the range from —128 to 127.

BOOLEAN VARIABLES

The Boolean data type stores True/False values. Boolean variables are, in essence, integers that take
the value —1 (for Tme) and O (for False). Actually, any non-zero value is considered True. Boolean
variables are declared as:

Dim failure As Boolean

and they are initialized to False.
Boolean variables are used in testing conditions, such as the following:
If failure Then MsgBox("Couldn't complete the operation")

They are also combined with the logical operators AND, OR, NOT, and XOR. The NOT
operator toggles the value of a Boolean variable. The following statement is a toggle:

running = Not running

If the variable running is True, it's reset to False, and vice versa. This statement is a shorter way of

coding the following:

Dim running As Boolean
If running = True Then
running = False

Else
running = True
End If
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Boolean operators operate on Boolean variables and return another Boolean as their result. The
following statements will display a message if one (or both) of the variables ReadOnly and Hidden are
True (presumably these variables represent the corresponding attributes of a file):

If ReadOnly Or Hidden Then
MsgBox("Couldn't open the file")
Else
{ statements to open and process file }
End If

You can reverse the logic and process the file if none of these variables are set to True:

If Not (ReadOnly Or Hidden) Then

{ statements to process the file }
Else

MsgBox("Couldn't open the file")
End If

The condition of the If statement combines the two Boolean values with the Or operator. If both,
or one, of them are True, the parenthesized expression is True. This value is negated with the Not
operator, and the If clause is executed only if the result of the negation is True. If ReadOnly s True
and Hidden is False, the expression is evaluated as:

If Not (True Or False)
(True Or False) is True, which reduces the expression to
If Not True

which, in turn, is False.

STRING VARIABLES
The String data type stores only text, and string variables are declared with the String type:

Dim someText As String

You can assign any text to the variable someText. You can store nearly 2 GB of textin a string vari-
able (that’s 2 billion characters and is much more text than you care to read on a computer screen).
The foﬂowing assignments are all valid:

Dim aString As String

aString = "Now is the time for all good men to come to the aid of their country"
aString = ""
aString = "There are approximately 29,000 words in this chapter"

aString = "25,000"

The second assignment creates an empty string, and the last one creates a string that just happens
to contain numeric digits, which are also characters. The difference between these two variables

Dim aNumber As Integer = 25000
Dim aString As String = "25,000"
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is that they hold different values. The aString variable holds the characters “2”, “5”, “,”, “0”, “0”, and
“0”, and aNumber holds a single numeric value. However, you can use the variable aString in numeric
calculations and the variable aNumber in string operations. VB will perform the necessary conversions,
as long as the Strict option is off (its default value).

VB6 "» VB.NET

Another feature not supported by VB.NET is the fixed-length string. With earlier versions of VB, you could
declare variables of fixed length with a statement like the following, to speed up string operations:

Dm shortText As String * 100
This is no longer needed, as the Framework supports two powerful classes for manipulating strings: the
String class and the StringBuilder class. They’re both described in Chapter 11.

CHARACTER VARIABLES

Character variables store a single Unicode character in two bytes. In effect, characters are unsigned
short integers (Ulnt16); you can use the CChar() function to convert integers to characters, and the
Clnt() function to convert characters to their equivalent integer values.

VB6 " VB.NET

Character variables are new to VB.NET, and they correspond to the String * 1type so often used with pre-
vious versions of VB.

To declare a character variable, use the Char keyword:
Dim charl, char2 As Char

You can initialize a character variable by assigning either a character or a string to it. In the latter
case, only the first character of the string is assigned to the variable. The following statements will
print the characters “a” and “A” to the Output window:

Dim charl As Char = "a", char2 As Char = "ABC"
Console.WriteLine(charl)
Console.WriteLine(char2)

The integer values corresponding to the English characters are the ANSI codes of the equivalent
characters. The statement:

Console.WriteLine(CInt("a"))

will print the value 68.

If you convert the Greek character alpha (0() to an integet, its value is 945. The Unicode value of
the famous character © is 960.

Character variables are used in conjunction with strings. You'll rarely save real data as characters.
However, you may have to process the individual characters in a string, one at a time. Because the
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Char data type exposes interesting methods (like IsLetter, IsDigit, IsPunctuation, and so on), you
can use these methods in your code. Let’s say the string variable password holds a user’s new password,
and you require that passwords contain at least one special symbol. The code segment of Listing 3.3
scans the password and rejects if it contains letter and digits only.

LISTING 3.3: PROCESSING INDIVIDUAL CHARACTERS

Dim password As String, ch As Char
Dim i As Integer
Dim valid As Boolean = False
While Not valid
password = InputBox("Please enter your password")
For i = 0 To password.Length - 1
ch = password.Chars(i)
If Not System.Char.IsLetterOrDigit(ch) Then
valid = True
Exit For
End If
Next
If valid Then
MsgBox("You new password will be activated immediately!")
Else
MsgBox("Your password must contain at least one special symbol!")
End If
End While

NOTE  If you are not familiar with the If..Then, For..Next, or While..End While structures, you can read their
description in the “Flow~Control Statements” section of this chapter and then return to check out this excample.

The code prompts the user with an input box to enter a password. (Later in the book, you'll find
out how to create a form that accepts the characters typed but displays asterisks in their place, so
that the password isn’t echoed on the screen.) The valid variable is Boolean, and it’s initialized to
False (you don’t have to initialize a Boolean variable to False, because this is its default initial value,
but it makes the code easier to read). It's set to True from within the body of the loop, only if the
password contains a character that is not a letter or a digit. We set it to False initially, so that the
While..End While loop will be executed at least once. This loop will keep prompting the user until a
valid password is entered.

The loop scans the string variable password, one letter at a time. At each iteration, the next letter is
copied into the ch variable. The Chars property of the String data type is an array that holds the indi-
vidual characters in the string (another example of the functionality built into the data types).

Then the program examines the current character. The IsLetterOrDigit method of the Char data
type returns True if a character is either a letter or a digit. If the current character is a symbol, the
program sets the valid variable to True, so that the outer loop won’t be executed again, and it exits
the For..Next loop. Finally, it prints the appropriate message and either prompts for another pass-
word or quits.
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You could write more compact code by using the IsLetterOrDigit method directly on the indi-
vidual characters of the password, instead of storing them first in a Char variable. Listing 3.4 is
another way to code the same program. (I've omitted the variable declarations at the beginning of the
code; they're the same as before.)

LISTING 3.4: REQUESTING A PASSWORD WITH ONE SPECIAL CHARACTER

While True
password = InputBox("Please enter your password")
For i = 0 To password.Length - 1
If Not System.Char.Chars(i).IsLetterOrDigit(password.Chars(i)) Then
MsgBox("Your new password will be activated immediately!")
Exit Sub
End If
Next
MsgBox("Your password must contain at least one special symbol!")
End While

It’s shorter and certainly much more real code. There’s nothing wrong with the first implementa-
tion, but the second one is “programmer’s code” as opposed to “beginner's code.” Don't worry if
you don’t quite understand how it works; you can come back and explore it after you finish this
chapter.

TIP  Notice that neither implementation would be possible without the methods exposed by the Char function. Although
the second implementation doesn’t use a variable of Char type, it relies on the functionality exposed by the Char data type.
The expression password.Chars (i) is actually a character, and that’s why we can apply to it the members of the Char
data type.

DATE VARIABLES

Date and time values are stored internally in a special format, but you don’t need to know the exact
format. They are double-precision numbers: the integer part represents the date and the fractional
part represents the time. A variable declared as Date can store both date and time values with a state-
ment like the following:

Dim expiration As Date
The following are all valid assignments:

expiration = #01/01/2004#
expiration = #8/27/2001 6:29:11 PM#
expiration = "July 2, 2002"
expiration = Now()

(The Now() function returns the current date and time). The pound sign tells Visual Basic to
store a date value to the expiration variable, just as the quotes tell Visual Basic that the value is a string.
You can store a date as string to a Date variable, but it will be converted to the appropriate format.
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If the Strict option is on, you can’t specify dates using the long date format (as in the third statement
of this example)

TiP  The date format is determined by the Regional Settings (found in Control Panel). In the United States, it’s
mm/dd /yy (in other countries, the format is dd/mm/yy), If you assign an invalid date to a date variable, like
23/04/2 002, Visual Basic will automatimlly swap the month and day values to produ[e a valid date as you type. If
the date is invalid even after the swapping of the month and day values, then an error message will appear in the Task List
window. The description of the error is “Lxpected expression.”

The Date data type is extremely flexible; Visual Basic knows how to handle date and time values,
so that you won't have to write complicated code to perform the necessary conversions. To manipu-
late dates and times, use the members of the Date type, which are discussed in detail in Chapter 12,
or the Date and Time functions, which are described in the reference “VB.NET Functions and
Statements” on the book’s companion CD. The difference between two dates is calculated by the
function DateDiff(). This function accepts as argument a constant that determines the units in
which the difference will be expressed (days, hours, and so on) as well as two dates, and it returns the
difference between them in the speciﬁed increments. The following statement returns the number of
days in the current millennium:

Dim days As Long
days = DateDiff(DateInterval.Day, #12/31/2000#, Now())

You can also call the Subtract method of the Date class, which accepts a date as argument and
subtracts it from a Date variable. The difference between the two dates is returned as a TimeSpan
object, which includes number of days, hours, minutes, and so on. For more information on the
members of the Date class, see Chapter 12.

VB6 " VB.NET

Previous versions of VB allowed direct numeric calculations with date variables. For example, you used to
be able to calculate the difference between two dates in days with by subtracting two date variables
directly:

days = datel - date2 ' DOESN'T WORK IN VB.NET

VB.NET doesn’t allow the use of date variables with the arithmetic operators, even if the Strict option has
been turned off.

DATA TYPE IDENTIFIERS

Finally, you can omit the As clause of the Dim statement, yet create typed variables, with the vari-
able declaration characters, or data type identifiers. These characters are special symbols, which you
append to the variable name to denote the variable’s type. To create a string variable, you can use
the statement:

Dim myText$
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The dollar sign signifies a string variable. Notice that the name of the variable includes the dollar
sign—it’s myText$, not myText. To create a variable of a particular type, use one of the data declara-
tion characters in Table 3.2 (not all data types have their own identifier).

TABLE 3.2: DATA TYPE DEFINITION CHARACTERS

SYMBOL DATA TYPE EXAMPLE

$ String A$, messageText$

% Integer (Int32) counter%, var%

& Long (Int64) population&, colorValue&
! Single distance!

# Double ExactDistance#

@ Decimal Balance@

Using type identifiers doesn’t help in producing the cleanest and easiest to read code. If you
haven’t used them in the past, there’s no really good reason to start using them now.

THE STRICT AND EXPLICIT OPTIONS

Previous versions of Visual Basic didn’t require that variables be declared before they were used.
VB.INET doesn’t require that you declare your variables either, but the default behavior is to throw an
exception if you attempt to use a variable that hasn’t been previously declared. If an undeclared vari-
able’s name appears in your code, the editor will underline the variable’s name with a wiggly red line,
indicating that it caught an error. Rest the pointer over the segment of the statement in question to
see the description of the error.

To change the default behavior, you must insert the following statement at the beginning of the
tile, above the Imports statements:

Option Explicit Off

The Option Explicit statement must appear at the very beginning of the file. This setting affects
the code in the current module, not in all files of your project or solution.

The sample code in this section assumes that the Option Explicit has been set to Off. For all
other examples in the book, I will assume that this option is set to On. Not only that, but in the first
few chapters I include the declarations of the variables I use in short code samples that demonstrate
an object property or the syntax of a function.

You can also specify the settings of the Strict and Explicit options from the Property Pages dia-
log box of the current project, as shown in Figure 3.1. To open this dialog box, right-click the name
of the project in the Solution Explorer and, from the context menu, select Properties. The settings
you specify here take effect for all the components of the current project.
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The default value of the Option Explicit statement is On. This is also the recommended value,
and you should not make a habit of changing this setting. Most programmers familiar with previous
versions of VB will not like having to declare their variables, but using variants for all types of vari-
ables has never been a good idea. In the later section “Why Declare Variables?”, you will see an
example of the pitfalls you'll avoid by declaring your variables. (The truth is that all VB programmers
will miss variants, but this is a very small price to pay for the new features added to the language.)

By setting the Explicit option to Off, you're telling VB that you intend to use variables without
declaring them. As a consequence, VB can’t make any assumption as to the variable’s type, so it uses
a generic type of variable that can hold any type of information. These variables are called Object
variables, and they're equivalent to the old variants.

As you work with the Option Explicit set to Off, you can use variables as needed, without
declaring them first. When Visual Basic meets an undeclared variable name, it creates a new variable
on the spot and uses it. The new variable’s type is Object, the generic data type that can accommo-
date all other data types. Using a new variable in your code is equivalent to declaring it without type.
Visual Basic adjusts its type according to the value you assign to it. Create two variables, var and
var2, by referencing them in your code with statements like the following ones:

varl = "Thank you for using Fabulous Software"
var2 = 49.99

The varl variable is a string variable, and var2 is a numeric one. You can Verify this with the Get-
Type method, which returns a variable’s type. The following statements print the types shown below
each statement, in bold:

Console.WriteLine("Variable varl is " & varl.GetType().ToString)
Variable varl is System.String
Console.WriteLine("Variable var2 is " & var2.GetType().ToString)
Variable var2 is System.Double

Later in the same program you can reverse the assignments:

varl = 49.99
var2 "Thank you for using Fabulous Software"
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If you execute the previous Print statements again, you’ll see that the types of the variables have
changed. The var1 variable is now a double, and var2 is a string.

Another related option is the Strict option, which is Off by default. The Strict option tells the
compiler whether the variables should be strictly typed. A strictly typed variable can accept values of the
same type as the type it was declared with. With the Strict option set to Off, you can use a string
variable that holds a number in a numeric calculation:

Dim a As String = "25000"
Console.WriteLine(a / 2)

The last statement will print the value 12500 on the Output window. Likewise, you can use
numeric variables in string calculations:

Dim a As Double = 31.03
a=a+ "1"

If you turn the Strict option on by nserting the foﬂowing statement at the beginning of the file,
you won’t be able to mix and match variable types:

Option Strict On

If you attempt to execute any of the last two code segments while the Strict option is On, the
compiler will underline a segment of the statement to indicate an error. If you rest the pointer over
the underlined segment of the code, the foﬂowing error message will appear in a tip box:

Option strict disallows implicit conversions from String to Double

(or whatever type of conversion is implied by the statement).

‘When the Strict option is set to On, the compiler doesn’t disallow all implicit conversions
between data types. For example, it will allow you to assign the value of an Integer to a Long, but
not the opposite. The Long value may exceed the range of values that can be represented by an Inte-
ger variable. You will find more information on implicit conversions in the section “Widening and
Narrowing Conversions,” later in this chapter.

Moreover, with Option Strict On, you can’t late-bind an expression. Late binding means to call a
method or a property of an object, but not be able to resolve this call at design time.

When you declare an object, like a Pen or a Color object, and then you call one of its properties,
the compiler can verify that the member you call exists. Take a look at the following lines:

Dim myPen As Pen
myPen = New Pen(Color.Red)
myPen.Width = 2

These three statements declare a Pen object and initialize it to red color and a width of two pixels.
All the shapes you’ll draw with this pen will be rendered in red, and their outlines will be two pixels wide.
This is early binding, because as soon as the variable is declared, the compiler can verify that the Pen
object has a Width and a Red property.

Now let’s use an Object variable to store our Pen object:

Dim objPen As Object
objPen = New Pen(Color.Red)
objPen.Width = 2
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This is called late binding, and it will work only if the Strict option is turned off. The objPen vari-
able is an Object variable and can store anything. The compiler has no way of knowing what type of
object you've stored to the variable, and therefore it can’t verify that the objPen variable exposes a
Width property. In this short segment, it’s pretty obvious that the objPen variable holds a Pen object,
but in a larger application the objPen variable may be set by any statement.

Early binding seems pretty restricting, but you should always use it. You should keep the default
value only when absolutely necessary (which is rare). Notice that you don’t have to turn on the Strict
option to use early binding—just declare your variables with a specific type. Early-bound variables
display their members in a drop-down list when you enter their name, followed by a period. If you
enter myPen and the foﬂowing period in the editor’s window, you will see a list of all the methods
supported by the Pen object. However, if you enter objPen and the foﬂowing period, you will see a list
with just four members—the members of any Object variable.

OBJECT VARIABLES

Variants—variables without a fixed data type—were the bread and butter of VB programmers up to
version 6.0. VB.INET supports variants only for compatibility reasons, and you shouldn’t be sur-
prised if they're dropped altogether from the language in a future version. Variants are the opposite
of strictly typed variables: they can store all types of values, from a single character to an object. If
you're starting with VB.NET, you should use strictly typed variables. However, variants are a major
part of the history of VB, and most applications out there (the ones you may be called to maintain)
make use of them. So I will discuss variants briefly in this chapter and show you what was so good

(and bad) about them.

VB6 " VB.NET

By default, you can’t use variants with VB.NET. In order for variables to handle any value you assign to
them, you can either declare them as Object type or turn off the Strict option. The keyword Variant has dis-
appeared from the language.

Variants were the most flexible data type because they could accommodate all other types. A vari-
able declared as Object (or a variable that hasn’t been declared at all)) is handled by Visual Basic
according to the variable’s current contents. If you assign an integer value to an Object variable,
Visual Basic treats it as an integer. If you assign a string to an Object variable, Visual Basic treats it
as a string. Variants can also hold different data types in the course of the same program. Visual
Basic performs the necessary conversions for you.

To declare a variant, you can turn off the Strict option and use the Dim statement without speci-

fying a type, as follows:
Dim myVar

If you don’t want to turn off the Strict option (which isn’t recommended anyway), you can

declare the variable with the Object data type:

Dim myVar As Object
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Every time your code references a new variable, Visual Basic will create an Object variable. For
example, if the variable validKey hasn't been declared, when Visual Basic runs into the following line:

validKey = "002-6abbgd"

it will create a new Object variable and assign the value “002-6abbgd” to it.
You can use Object variables in both numeric and string calculations. Suppose the variable modem-
Speed has been declared as Object with one of the following statements:

Dim modemSpeed ' Option Strict = Off
Dim modemSpeed As Object ' Option Strict = On

and later in your code you assign the foHowing value to it:
modemSpeed = "28.8"
The modemSpeed variable is a string variable that you can use in statements such as the foHowing:
MsgBox "We suggest a " & modemSpeed & " modem."
This statement displays the following message:
We suggest a 28.8 modem.
You can also treat the modemSpeed variable as a numeric value with the following statement:

Console.WriteLine "A " & modemSpeed & " modem can transfer " & modemSpeed * _
1000 / 8 & " bytes per second."

This statement displays the following message:
A 28.8 modem can transfer 3600 bytes per second.

The first instance of the modemSpeed variable in the above statement is treated as a string, because
this is the variant’s type according to the assignment statement (We assigned a string to it). The sec-
ond instance, however, is treated as a number (a single—precision number). Visual Basic converts it to
a numeric value because it’s used in a numeric calculation.

Another example of this behavior of variants can be seen in the following statements:

Dim I As Integer, S As String
I=10

S = "11"

Console.WriteLine(I + S)
Console.WriteLine(I & S)

The first WriteLine statement will display the numeric value 21, while the second statement will
print the string “1011”. The plus operator (+) tells VB to add two values. In doing so, VB must
convert the two strings into numeric values, then add them. The concatenation operator (&) tells VB
to concatenate the two strings.

Visual Basic knows how to handle variables in a way that makes sense. The result may not be
what you had in mind, but it certainly is dictated by common sense. If you really want to concate-
nate the strings “10” and “11”, you should use the & operator, which would tell Visual Basic exactly
what to do. Quite impressive, but for many programmers this is a strange behavior that can lead to

Copyright ©2002 SYBEX, Inc., Alameda, CA www.sybex.com


http://www.sybex.com

VARIABLES | 107

subtle errors, and they avoid it. It’s up to you to decide whether to use variants and how far you will
go with them. Sure, you can perform tricks with variants, but you shouldn’t overuse them to the
point that others can’t read your code.

You can also store dates and times in an Object variable. To assign a date or time value to a vari-
ant, surround the value with pound signs, as follows:

datel = #03/06/1999#

All operations that you can perform on date variables (discussed in the section “Date Variables™)
you can also perform with variants, which hold date and time values.

Converting Variable Types

In some situations, you will need to convert variables from one type into another. Table 3.3 shows
the Visual Basic functions that perform data—type conversions. Actuaﬂy, you will have to convert
between data types quite often now that VB doesn’t do it for you.

TABLE 3.3: DATA-TYPE CONVERSION FUNCTIONS

FUNCTION CONVERTS ITS ARGUMENT TO
CBool Boolean

CByte Byte

CChar Unicode character

CDate Date

CDbl Double

CDec Decimal

Cint Integer (4-byte integer, Int32)
CLng Long (8-byte integer, Int64)
CObj Object

CShort Short (2-byte integer, Int16)
CSng Single

CStr String

To convert the variable initialized as
Dim A As Integer
to a Double, use the function:

Dim B As Double
B = CDb1(A)
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Suppose you have declared two integers, as follows:

Dim A As Integer, B As Integer
A =23
B =7

The result of the operation 4 / B will be a double value. The following statement:
Console.Write(A / B)

displays the value 3.28571428571429. The result is a double, which provides the greatest possible
accuracy. If you attempt to assign the result to a variable that hasn’t been declared as Double, and the
Strict option is On, then VB.NET will generate an error message. No other data type can accept this
value without loss of accuracy.

As a reminder, the Short data type is equivalent to the old Integer type, and the CShortO func-
tion converts its argument to an Int16 value. The Integer data type is represented by 4 bytes (32
bits), and to convert a value to Int32 type, use the Clnt() function. Finaﬂy, the CLngO function
converts its argument to an Int64 value.

You can also use the CType() function to convert a variable or expression from one type to
another. Let’s say the variable 4 has been declared as String and holds the value “34.56”. The fol-

lowing statement converts the value of the A variable to a Decimal value and uses it in a calculation:

Dim A As String = "34.56"
Dim B As Double
B = CType(A, Double) / 1.14

The conversion is necessary only if the Strict option is On, but it’s a good practice to perform
your conversions explicitly. The following section explains what may happen if your code relies to
implicit conversions.

WIDENING AND NARROWING CONVERSIONS
In some situations, VB.NET will convert data types automaticaﬂy, but not always‘ Let’s say you
have declared and initialized two variables, an integer and a double, with the foHowing statements:

Dim count As Integer = 99
Dim pi As Double = 3.1415926535897931

If the Strict option is On and you attempt to assign the value of the pi variable to the count vari-
able, the compiler will generate an error message to the effect that you can’t convert a double to an
integer. The exact message is:

Option Strict disallows implicit conversions from Double to Integer

VB6 "» VB.NET

You will probably see this message many times, especially if you’re a VB6 programmer. In the past, VB
would store the value 3 to the count variable and proceed. If you weren’t careful, you’d lose significant dec-
imal digits and might not even know it. This implicit conversion results in loss of accuracy, and VB.NET
doesn’t perform it by default. This is a typical example of the pitfalls of turning off the Strict option.

Copyright ©2002 SYBEX, Inc., Alameda, CA www.sybex.com


http://www.sybex.com

VARIABLES | 109

‘When the Strict option is On, VB.NET will perform conversions that do not result in loss of
accuracy (precision) or magnitude. These conversions are called widening conversions, as opposed to
the narrowing conversions. When you assign an Integer value to a Double variable, no accuracy or
magnitude is lost. On the other hand, when you assign a double value to an integer variable, then
some accuracy is lost (the decimal digits must be truncated). Since you, the programmer, are in con-
trol, you may wish to give up the accuracy—presumably, it’s no longer needed. When the Strict
option is on, VB.INET doesn’t assume that you're willing to sacrifice the accuracy, even if this is
your intention. Instead, it forces you to convert the data type explicitly with one of the data type
conversion functions. Normally, you must convert the Double value to an Integer value and then
assign it to an Integer variable:

count = CInt(pi)

This is a narrowing conversion (from a value with greater accuracy or magnitude to a value with
smaller accuracy or magnitude), and it’s not performed automatically by VB.NET. Table 3.4 sum-
marizes the widening conversions VB.INET will perform for you automatically.

TABLE 3.4: VB.NET WIDENING CONVERSIONS

ORIGINAL DATA TYPE WIDER DATA TYPE

Any type Object

Byte Short, Integer, Long, Decimal, Single, Double
Short Integer, Long, Decimal, Single, Double
Integer Long, Decimal, Single, Double

Long Decimal, Single, Double

Decimal Single, Double

Single Double

Double none

Char String

In the first beta version of Visual Studio NET, the Strict option was on by default. It seems that
pressure from VB6 programmers forced the designers of Visual Studio to change the default setting
of this option. I expect that the default settings of the Strict option will be turned on again in the
future, and eventually you won’t be able to turn it off.

If the Strict option is off (the default value), the compiler will allow you to assign a Long variable
to an Integer variable. Should the Long variable contain a value that exceeds the range of values of
the Integer data type, then you’ﬂ end up with a runtime error. Of course, you can avoid the runtime
error with the appropriate error—handling code. If the Strict option is on, the compiler will point out
all the statements that may cause similar runtime errors, and you can re-evaluate your choice of vari-
able types. You can also turn on the Strict option temporarily to see the compiler’s warnings, then
turn it off again.
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User-Defined Data Types
In the previous sections, we assumed that applications create variables to store individual values. As a
matter of fact, most programs store sets of data of different types. For example, a program for bal-
ancing your checkbook must store several pieces of information for each check: the check’s number,
amount, date, and so on. All these pieces of information are necessary to process the checks, and ide-
ally, they should be stored together.

A structure for storing multiple values (of the same or different type) is called a record. For
example, each check in a checkbook-balancing application is stored in a separate record, as shown in
Figure 3.2. When you recall a given check, you need all the information stored in the record.

FIGURE 3.2 Record Structure
Pictorial representa-

[ Check Number | Check Date | Check Amount | Check Paid To |

tion of a record

Array Of Records

275 04/12/01 104.25 Gas Co.
276 04/12/01 48.76 Books
277 04/14/01 200.00 VISA
278 04/21/01 430,00 Rent

To define a record in VB.NET, use the Structure statement, which has the following syntax:

Structure structureName
Dim variablel As varType
Dim variable2 As varType

Dim variablen As varType
End Structure

varType can be any of the data types supported by the framework. The Dim statement can be
replaced by the Private or Public access modifiers. For structures, Dim is equivalent to Public.

After this declaration, you have in essence created a new data type that you can use in your appli-
cation. structureName can be used anywhere you'd use any of the base types (integers, doubles, and so
on). You can declare variables of this type and manipulate them as you manipulate all other variables
(with a little extra typing). The declaration for the record structure shown in Figure 3.2 is

Structure CheckRecord
Dim CheckNumber As Integer
Dim CheckDate As Date
Dim CheckAmount As Single
Dim CheckPaidTo As String
End Structure

This declaration must appear outside any procedure; you can’t declare a Structure in a subroutine
or function. The CheckRecord structure is a new data type for your application. Depending on
where the structure was declared, it may not be visible from the entire code, but it's up to you to give
your structure the proper scope (see the section “A Variable’s Scope,” later in this chapter for more
information on variable scoping).
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To declare variables of this new type, use a statement such as this one:

Dim checkl As CheckRecord, check2 As CheckRecord

To assign a value to one of these variables, you must separately assign a value to each one of its
components (they are called fields), which can be accessed by combining the name of the variable and
the name of a field separated by a period, as follows:

checkl.CheckNumber = 275

Actually, as soon as you type the period following the variable’s name, a list of all members to the
CheckRecord structure will appear, as shown in Figure 3.3. Notice that the structure supports a few
members on its own. You didn’t write any code for the Equals, GetType, and ToString members,
but they’re standard members of any Structure object and you can use them in your code. Both the
GetType and ToString methods will return a string like “ProjectName.FormName+CheckRecord”.

FIGURE 3.3 Object Browser | Predefined Mumer...Format Function) | Forml.vb [Design]*  Forml.vb® | 4k x
Variables of PgForm1 (tests3) | [s#Buttons_ciick =
custom types j

Private Zub Buttonl Click({EyVal sender iz Zystem.Chject, EByVal e
Dim check is CheckRecord
bers as properties. sheck.|
End Ul g chedkamount
End Class ¢ checkDate
# CheckNumber
# CheckPaidTo
% Equals
% GetHashCode
$ GetType
& Referencebquals

expose their mem-

& Tastring

< of

You can think of the record as an object and its fields as properties. Here are the assignment
statements for a check:

check2.CheckNumber = 275
check2.CheckDate = #09/12/2001#
check2.CheckAmount = 104.25
check2.CheckPaidTo = "Gas Co."

You can also create arrays of records with a statement such as the following (arrays are discussed
later in this chapter):

Dim Checks(100) As CheckRecord

Each element in this array is a CheckRecord record and holds all the fields of a given check. To

access the fields of the third element of the array, use the following notation:

Checks(2).CheckNumber = 275
Checks(2).CheckDate = #09/12/2001#
Checks(2).CheckAmount = 104.25
Checks(2).CheckPaidTo = "Gas Co."

All data types expose the Equals method, which compares an instance of a data type (a integer
variable, for example) to another instance of the same type. This is a trivial operation for simple data
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types, as you can compare the two variables directly. The Equals method can also compare two
Structure variables and return True if all of their fields match. It a single field differs, the two objects
represented by the variables are not identical. Use this method to compare variables declared as cus-
tom structures to avoid comparing all their members. Let’s say you have created two variables of the

CheckRecord type:

Dim c1, c2 As CheckRecord
{ assign values to the cl and c2 variables }
If cl.Equals(c2) Then
MsgBox "Same"
Else
MsgBox "Different"
End If

You can also use arrays as Structure members. The following structure uses an array to store mul-
tiple e-mail addresses for the same person:

Structure Person
Dim First As String
Dim Last As String
Dim Address As String
Dim Phone As String
Dim EMai1(10) As String
End Structure

Using this structure, you can store up to 10 e-mail addresses per person. To use the Person struc-
ture in your code, declare a variable of this type:

Dim aPerson As Person

To access the first element of the EMail member, use the foHowing notation:
aPerson.EMail1(0) = "JDoe@tex.com"

You can also declare an array of Person structures, with the following statement:
Dim al1Peop1e(1000) As Person

This array can hold contact information for 1,000 persons, and each person is identified by an
index. That is, you must know the index corresponding to each person, or you must search the array
to locate the person you're interested in. In Chapter 11, you'll learn how to index and search arrays
with meaningful keys, like names, rather than indices.

To access an element of the EMail array, use two indices, one for the array of structures and
another one for the array member: al1People(3).EMai1(0), al1People(3).EMail(1), and so on.

THE NOTHING VALUE

The Nothing value is used with Object variables and indicates a variable that has not been initial-
ized. If you want to disassociate an Object variable from the object it represents, set it to Nothing.
The following statements create an Object variable that references a Brush, use it, and then release it:

Dim brush As System.Drawing.Brush
brush = New System.Drawing.Brush(bmap)
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{ use brush object to draw with }

brush = Nothing

The first statement declares a Brush variable. At this point, the brush variable is Nothing. The sec-
ond statement initializes the brush variable with the appropriate constructor. After the execution of
the second statement, the brush variable actually represents an object you can draw with. After using
it to draw something, you can release it by setting it to Nothing,

VB6 "» VB.NET

The Set statement is obsolete in VB.NET. You can initialize Object variables just like any other type of vari-
able, with the assignment operator.

If you want to find out whether an object variable has been initialized, use the Is keyword, as
shown in the foﬂowing example:

Dim myPen As Pen
{ more statements here }
If myPen Is Nothing Then
myPen = New Pen(Color.Red)
End If

The variable myPen is initialized with the New constructor only if it hasn’t been initialized
already. If you want to release the myPen variable later in your code, you can set it to Nothing with
the assignment operator.

Examining Variable Types

Besides setting the types of variables and the functions for converting between types, Visual Basic
provides two methods that let you examine the type of a variable. They are the GetType() and Get-
TypeCode() methods. The GetType() method returns a string with the variable’s type (“Int32”,
“Decimal”, and so on). The GetTypeCode() method returns a value that identifies the variable’s
type. The code for the Double data type is 14. The values returned by the GetType() and GetType-
Code() methods for all data types are shown in Table 3.5.

TABLE 3.5: VARIABLE TYPES AND TYPE CODES

GETTYPE() GETTYPECODE() DESCRIPTION
Boolean 3 Boolean value

Byte 6 Byte value (0 to 255)
Char 4 Character
DateTime 16 Date/time value
Decimal 15 Decimal

Continued on next page
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TABLE 3.5: VARIABLE TYPES AND TYPE CODES (continued)

GETTYPE() GETTYPECODE()
Double 14
Int16 7
Int32 9
Int64 11
Object

SByte 5
Single 13
String 8
Ulnt16 8
Ulnt32 10
Ulnt64 12

DESCRIPTION

Double-precision floating-point number
2-byte integer (Short)

4-byte integer (Integer)

8-byte integer (Long)

Object (a non-value variable)

Signed byte (-127 to 128)
Single-precision floating-point number
String

2-byte unsigned integer

4-byte unsigned integer

8-byte unsigned integer

Any variable exposes these methods autornaticaﬂy, and you can call them like this:

Dim var As Double

Console.WriteLine("The variable's type is " & var.GetType)

These functions are used mostly in If structures, like the following one:

If var.GetType() Is GetType(System.Double) Then

{ code to handle a Double value }

End If

Notice that the code doesn’t reference data type names directly. Instead, it uses the value returned
by the GetType() function to retrieve the type of the class System.DoubTe and then compares this

value to the variable’s type with the Is keyword.

IS IT A NUMBER OR A STRING?

Another set of Visual Basic functions returns variables’ data types, but not the exact type. They
return a broader type, such as “numeric” for all numeric data types. This is the type you usually need
in your code. The following functions are used to validate user input, as well as data stored in files,

before you PI‘OCGSS them.

IsNumeric() Returns True if its argument is a number (Short, Integer, Long, Single, Double,
Decimal). Use this function to determine whether a variable holds a numeric value before passing
it to a procedure that expects a numeric value or process it as a number. You can also use this
function to test a value entered by a user when a numeric value is expected. The foﬂowing state-
ments keep prompting the user with an InputBox for a numeric value. The user must enter a
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numeric value, or click the Cancel button to exit. As long as the user enters nonnumeric values,
the InputBox pops up and prompts for a numeric value:

Dim strAge as String = "$"
Dim Age As Integer
While Not IsNumeric(strAge)
strAge = InputBox("Please enter your age")
End While

The variable strAge 1s initialized to a nonnumeric value so that the While..End While loop will be
executed at least once. You can use any value in the place of the dollar sign, as long as it’s not a
valid numeric value.

IsDate() Returns True if its argument is a valid date <or time). The foﬂowing expressions
return True, because they all represent valid dates:

IsDate(#10/12/2010#)
IsDate("10/12/2010")
IsDate("October 12, 2010")

If the date expression includes the day name, as in the following expression, the IsDate() function
will return False:

IsDate("Sat. October 12, 2010") ' FALSE
IsArray() Returns True if its argument is an array.

IsDBNull() Detects whether an object variable has been initialized or is a DBNull value. This
function is equivalent to the IsNull() function of VB6.

IsReference() Returns True if its argument is an object. This function is equivalent to the

IsObject() function of VB6.

Tip Al these functions are described in the bonus reference “VB.NET Functions and Statements,” on the CD.

Why Declare Variables?

All previous versions of Visual Basic didn’t enforce variable declaration, which was a good thing for
the beginner programmer. When you want to slap together a “quick and dirty” program, the last
thing you need is someone telling you to decide which variables you're going to use and to declare
them before using them.

But most programmers accustomed to the free format of Visual Basic also carry their habits of
quick-and-dirty coding to large projects. When writing large applications, you will probably find
that variable declaration is a good thing. It will help you write clean code and simplify debugging.
Variable declaration eliminates the source of the most common and pesky bugs.

Let’s examine the side effects of using undeclared variables in your application. To be able to get
by without dedaring your variables, you must set the Explicit option to Off. Let’s assume you’re
using the following statements to convert German marks to U.S. dollars:

DM2USD = 1.562
USDoTllars = amount * DM2USD
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The first time your code refers to the DM2USD variable name, Visual Basic creates a new variable
and then uses it as if it was declared.

Suppose the variable DM2USD appears in many places in your application. If in one of these places
you type DM2UDS instead of DM2USD and the program doesn’t enforce variable declaration, the
compiler will create a new variable, assign it the value zero, and then use it. Any amount converted
with the DM2UDS variable will be zero! If the application enforces variable declaration, the compiler
will complain (the DM2UDS variable hasn’t been declared), and you will catch the error.

Many programmers, though, feel restricted by having to declare variables. Others live by it.
Depending on your experiences with Visual Basic, you can decide for yourself. For a small applica-
tion, you don’t have to declare variables; just insert the statement Option Explicit Off at the top of
your files. Be warned, though, that the river won’t go backward; VB.NET encourages the explicit
declaration of variables, but a future version of VB is quite likely to enforce variable declaration—in

the spirit of the other two languages of Visual Studio.

A Variable’s Scope

In addition to its type, a variable also has a scope. The scope (or visibility) of a variable is the section of
the application that can see and manipulate the variable. If a variable is declared within a procedure,
only the code in the specific procedure has access to that variable. This variable doesn’t exist for the
rest of the application. When the variable’s scope is limited to a procedure, it’s called local.

Suppose you're coding the Click event of a Button to calculate the sum of all even numbers in the
range O to 100. One possible implementation is shown in Listing 3.5.

LISTING 3.5: SUMMING EVEN NUMBERS

Private Sub Buttonl Click(ByVal sender As Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim i As Integer
Dim Sum As Integer
For i = 0 to 100 Step 2
Sum = Sum + i
Next
MsgBox "The sum is " & Sum
End Sub

The variables i/ and Sum are local to the Button1_Click() procedure. If you attempt to set the value
of the Sum variable from within another procedure, Visual Basic will complain that the variable hasn’t
been declared. (Or, if you have turned off the Explicit option, it will create another Sum variable, ini-
tialize it to zero, and then use it. But this won't affect the variable Sum in the Button1_Click() subrou-
tine.) The Sum variable is said to have procedure-level scope. It’s visible within the procedure and invisible
outside the procedure.

Sometimes, however, you'll need to use a variable with a broader scope, such as one whose value is
available to all procedures within the same file. In principle, you could declare all variables outside
the procedures that use them, but this would lead to problems. Every procedure in the file would
have access to the variable, and you would need to be extremely careful not to change the value of a
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variable without good reason. Variables that are needed by a single procedure (such as loop coun-
ters) should be declared in that procedure.

A new type of scope was introduced with VB.NET?: the block-level scope. Variables introduced in a
block of code, such as an If statement or a loop, are local to the block but invisible outside the block.
Let’s revise the previous code segment, so that it calculates the sum of squares. To carry out the cal-
culation, we first compute the square of each value and then sum the squares. The square of each
value is stored to a variable that won't be used outside the loop, so we can define the squalue variable
in the loop’s block and make it local to this specific loop, as shown in Listing 3.6.

LISTING 3.6: A VARIABLE SCOPED IN ITS OWN BLOCK

Private Sub Buttonl Click(ByVal sender As Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim i, Sum As Integer
For i = 0 to 100 Step 2
Dim sqrValue As Integer
sqrvalue = i * i
Sum = Sum + sqrValue
Next
MsgBox "The sum of the squares is " & Sum
End Sub

The squalm variable is not visible outside the block of the For..Next Ioop. If you attempt to
use it before the For statement, or after the Next statement, VB will throw an exception. Insert the
statement

Console.WriteLine(sqrvalue)

after the call to the MsgBox function to see what will happen: the sgrValue variable maintains its value
between iterations. If you insert the WriteLine statement after the line that declares the variable, you
will see that it’s not initialized at each iteration, even though there’s a Dim statement in the loop.
The values printed by this statement will keep getting larger, and they're not reset to zero. Of course,
if you re-enter the block in which a variable is declared, you must initialize the variable to avoid side
effects. Even though the variable’s scope 1s the block in which it was declared, it exists while the sub-
routine is executing.

Another type of scope is the module-level scope. Variables declared outside any procedure in a
module are visible from within all procedures in the same module, but they’re invisible outside the
module. Variables with a module-level scope can be set from within any procedure, so you should
try to minimize the number of such variables. Setting many variables from within many procedures
can seriously complicate the debugging of the application. Beginners have a tendency to overuse
module-level scope, because they simplify the exchange of data among procedures. You can write
procedures that don’t accept any arguments—they simply act on module-level variables. Even
though they may simplify small projects, too many variables with module-level scope reduce the
maintainability and readability of large projects.

Let’s say you're writing a text-editing application that provides the usual Save and Save As com-
mands. The Save As command prompts the user for the filename in which the text will be stored.
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The Save command, however, must remember the name of the file used with the most recent Save
As command, so that it can save the text to the same file. It must also remember the name of the file
that was read most recently, so that it can save the text back to the same file. The path of the file is
needed from within three separate procedures, so it must be saved in a variable with module-level
scope: the Open procedure should be able to set this variable, the Save As procedure should be able
to either read or set it, and the Save procedure should be able to read it. This is a typical example of
a variable with module-level scope.

Finally, in some situations the entire application must access a certain variable. In this case, the
variable must be declared as Public. Public variables have a global scope: they are visible from any part
of the application. To declare a public variable, use the Public statement in place of the Dim state-
ment. Moreover, you can’t declare public variables in a procedure. If you have multiple forms in your
application and you want the code in one form to see a certain variable in another form, you can use
the Public modifier. You can also make a control on a form visible outside its own form, by setting
its Modifier property to Public. Setting this property causes VB to insert the Public keyword in the

declaration of the control.
NOTE  You will learn how to access variables declared in one form from within another form’s code, in Chapter 5.

The Public keyword makes the variable available not only to the entire project, but also to all
projects that reference the current project. If you want your variables to be public within a project
(in other words, available to all procedures in any module in the project) but invisible to referencing
projects, use the Friend keyword in the declaration of the module. Variables that you want to use
throughout your project, but not have available to other projects that reference the current one,
should be declared as Friend. There is no way to make some of the public variables available to the
referencing projects.

So, Why do we need so many different types of scope? You'll develop a better understanding of
scope and which type of scope to use for each variable as you get involved in larger projects. In gen-
eral, you should try to limit the scope of your variables as much as possible. If all variables were
declared within procedures, then you could use the same name for storing a temporary value in each
procedure and be sure that one procedure’s variables don’t interfere with those of another procedure,
even if you use the same name. Not that you can run out of variable names, but names like tempString,
amount, total, and so on are quite common. All loop counters should also be local to the procedure
that uses them. The variable counter in the foﬂowing Ioop should never be declared outside the
procedure:

For counter = 1 To 100
{ statements }
Next

This statement repeats the block of statements 100 times. There’s absolutely no reason to declare
the counter variable outside the procedure. Most programmers tend to use the same counter names in
all of their loops, SO they have to use local variables.

Procedure-level variables are necessary, but you should try to minimize their use. If a variable looks
like a good candidate for procedure—level scope, see if you can implement the code with two or more
local-level scope variables. Many procedure-level variables can be reduced to local-level variables if
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they’re used by a couple of functions only. You can pass their values from one function to the other
and avoid the creation of a new procedure-level variable.

The Lifetime of a Variable

In addition to type and scope, variables have a lifetime, which is the period for which they retain their
value. Variables declared as Public exist for the lifetime of the application. Local variables, declared
within procedures with the Dim or Private statement, live as long as the procedure. When the proce-
dure finishes, the local variables cease to exist and the allocated memory is returned to the system. Of
course, the same procedure can be called again. In this case, the local variables are recreated and ini-
tialized again. If a procedure calls another, its local variables retain their values while the called pro-
cedure is running.

You also can force a local variable to preserve its value between procedure calls with the Static
keyword. Suppose the user of your application can enter numeric values at any time. One of the tasks
performed by the application is to track the average of the numeric values. Instead of adding all the
values each time the user adds a new value and dividing by the count, you can keep a running total

with the function RunningAvg(), which is shown in Listing 3.7.

LISTING 3.7: CALCULATIONS WITH GLOBAL VARIABLES

Function RunningAvg(ByVal newValue As Double) As Double
CurrentTotal = CurrentTotal + newValue
TotalItems = TotalItems + 1
RunningAvg = CurrentTotal / TotalItems

End Function

You must declare the variables CurrentTotal and Totalltems outside the function so that their values
are preserved between calls. Alternatively, you can declare them in the function with the Static key-
word, as in Listing 3.8.

LISTING 3.8: CALCULATIONS WITH LOCAL STATIC VARIABLES

Function RunningAvg(ByVal newValue As Double) As Double
Static CurrentTotal As Double
Static TotalItems As Integer
CurrentTotal = CurrentTotal + newValue
TotalItems = Totalltems + 1
RunningAvg = CurrentTotal / TotalItems
End Function

The advantage of using static variables is that they help you minimize the number of total vari-
ables in the application. All you need is the running average, which the RunningAng function pro-
vides without making its variables visible to the rest of the apphcation, Therefore, you don’t risk
changing the variables’ values from within other procedures.
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VB6 " VB.NET

InVB6 you could declare all the variables in a procedure as static by prefixing the procedure definition with
the keyword Static. This option is no longer available with VB.NET: the Static modifier is not a valid modi-
fier for procedures.

Variables declared in a module outside any procedure take effect when the form is loaded and
cease to exist when the form is unloaded. If the form is loaded again, its variables are initialized, as if
it's being loaded for the first time.

Variables are initialized when they’re declared, according to their type. Numeric variables are ini-
tialized to zero, string variables are initialized to a blank string, and Object variables are initialized to
Nothing. Of course, if the variable is declared with an initializer (as in Dim Tast As Integer = 99),
it is initialized to the specified value.

Constants

Some variables don’t change value during the execution of a program. These are constants that appear
many times in your code. For instance, if your program does math calculations, the value of pi
(3.14159...) may appear many times. Instead of typing the value 3.14159 over and over again, you

can define a constant, name it pi, and use the name of the constant in your code. The statement
circumference = 2 * pi * radius

is much easier to understand than the equivalent
circumference = 2 * 3.14159 * radius
You could declare pi as a variable, but constants are preferred for two reasons:

Constants don’t change value. This is a safety feature. Once a constant has been declared, you
can’t change its value in subsequent statements, so you can be sure that the value specified in the
constant’s declaration will take effect in the entire program.

Constants are processed faster than variables. When the program is running, the values of con-
stants don’t have to be looked up. The compiler substitutes constant names with their values, and
the program executes faster.

The manner in which you declare constants is similar to the manner in which you declare vari-
ables, except that in addition to supplying the constant’s name, you must also supply a value, as
follows:

Const constantname As type = value

Constants also have a scope and can be Public or Private. The constant iy for instance, is usuaﬂy
declared in a module as Public so that every procedure can access it:

PubTic Const pi As Double = 3.14159265358979
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The name of the constant follows the same rules as variable names. The constant’s value is a lit-
eral value or a simple expression composed of numeric or string constants and operators. You can’t
use functions in declaring constants. The best way to define the value of the pi variable is to use the

pi member of the Math class:
pi = Math.pi
However, you can’t use this assignment in the constant declaration. Y ou must supply the actual value.

Constants can be strings, too, like these:
Const ExpDate = #31/12/1997#
Const ValidKey = "A567dfe"

Visual Basic uses constants extensively to define method arguments and control properties. The
value of a CheckBox control, for instance, can be CheckState.Checked or CheckState.UnChecked. If
the CheckBox control’s ThreeState property is True, it can have yet another value, which is Check-
State.Intederminate. These constants correspond to integer values, but you don’t need to know
what these values are. You see only the names of the constants in the Properties window. If you type
the expression

CheckBox1.CheckState =

a list of all possible values of the CheckState property will appear as soon as you type the equal sign,
and you can select one from the list.

VB.NET recognizes numerous constants, which are grouped according to the property they
apply to. Each property’s possible values form an enumeration, and the editor knows which enumera-
tion applies to each property as you type. As a result, you don’t have to memorize any of the con-
stant names or look up their names. They're right there as you type, and their names make them
self—explanatory. Notice that the name of the constant is preﬁxed by the name of the enumeration it
belongs to.

NOTE  Enumerations are often named after the property they apply to, bur not always. The set of possible values of the
BorderStyle property for all controls is named BorderStyle enumeration. The value set for the alignment of the text on a
control, however, is the HorizontalAlignment enumeration. But you always see the proper enumeration in the Properties
window, and the editor knows which one to dz’splay and when.

Constant declarations may include other constants. In math calculations, the value 2 x piis
almost as common as the value pi. You can declare these two values as constants:

PubTic Const pi As Double = 3.14159265358979

PubTic Const pi2 As Double = 2 * pi

TP When defining constants in terms of other constants, especially if they reside in different modules, be sure to avoid
circular a’efinitions. Try to pla[e all your constant declarations in the same module. If you have modules you use with sev-
eral applimtions, try to include the module’s name in the constant names to avoid ronﬂz’fts and duplz’rate definitions.
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Arrays

A standard structure for storing data in any programming language is the array. Whereas individual
variables can hold single entities, such as one number, one date, or one string, arrays can hold sets of
data of the same type (a set of numbers, a series of dates, and so on). An array has a name, as does a
variable, and the values stored in it can be accessed by an index.

For example, you could use the variable Salary to store a person’s salary:

Salary = 34000

But what if you wanted to store the salaries of 16 employees? You could either declare 16 vari-
ables—Salary1, Salary2, up to Salaryl 6—or you could declare an array with 16 elements. An array is
similar to a variable: it has a name and multiple values. Each value is identified by an index (an inte-
ger value) that follows the array’s name in parentheses. Each different value is an element of the array.
If the array Salaries holds the salaries of 16 employees, the element Salaries(0) holds the salary of
the first employee, the element Salaries(1) holds the salary of the second employee, and so on up
the element Salaries(15).

VB6 "» VB.NET

The indexing of arrays in VB.NET starts at zero, and you can’t change this behavior, because the Option
Base statement, which allowed you to specify whether the indexing of the array would start at 0 or 1, is no
longer supported by VB.NET. Whether you like it or not, your arrays must start at index zero. If you don’t
feel comfortable with the notion of zero being the first element, you can increase the dimensions of your
arrays by one and ignore the zeroth element.

In VB6 you could specify not only the dimensions of an array but also the index of the very first element,
with a declaration like

Dim myArray(101 To 999) As Integer

This notation is not valid in VB.NET.

Declaring Arrays

Unlike simple variables, arrays must be declared with the Dim (or Public, or Private) statement fol-
lowed by the name of the array and the index of the last element in the array in parentheses—for
example,

Dim Salaries(15) As Integer
NOTE Aftually, there are occasions when you need not specify the exact dimensions of an array, as you’ll see sbortly.

As I said before, Salaries is the name of an array that holds 16 values (the salaries of the 16
employees), with indices ranging from O to 15. Salaries(0) is the first person’s salary, Salaries(1)
the second person’s salary, and so on. All you have to do is remember who cotresponds to each
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salary, but even this data can be handled by another array. To do this, you'd declare another array of
16 elements as follows:

Dim Names(15) As String

and then assign values to the elements of both arrays:

Names(0) = "Joe Doe"
Salaries(0) = 34000
Names(1) = "Beth York"
Salaries(1) = 62000

Names(15) = "Peter Smack"
Salaries(15) = 10300

This structure is more compact and more convenient than having to hard-code the names of
employees and their salaries in variables.
All elements in an array have the same data type. Of course, when the data type is Object, the
individual elements can contain different kinds of data (objects, strings, numbers, and so on).
Arrays, like variables, are not limited to the basic data types. You can declare arrays that hold any
type of data, including objects. The following array holds colors, which can be used later in the code
as arguments to the various functions that draw shapes:

Dim colors(2) As Color
colors(0) = Color.BurlyWood
colors(1l) = Color.AliceBlue
colors(2) = Color.Sienna

The Color object represents colors, and among the properties it exposes are the names of the col-
ors it recognizes. The Color object recognizes 128 color names (as opposed to the 16 color names
of VB6).

As a better technique to store names and salaries together in an array, create a Structure and then
declare an array of this type. The following structure holds names and salaries:

Structure Employee
Dim Name As String
Dim Salary As Single
End Structure

Insert this declaration in a form’s code file, outside any procedure. Then create an array of the

Employee type:
Dim Emps(15) As Employee

Each elements in the Emps array exposes two fields, and you can assign values to them with state-
ments like the foﬂowing ones:

Emps(2).Name = "Beth York"
Emps(2).Salary = 62000
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The advantage of storing related pieces of information to a structure is that you can access all the
items with a single index. The code is more compact, and you need not maintain multiple arrays. In
Chapter 11, you'll see how to store structures and other objects to collections like ArrayLists and

HashTables.

Initializing Arrays
Just as you can initialize variables in the same line where you declare them, you can initialize arrays,
too, with the following constructor:

Dim arrayname() As type = {entry0, entryl, .. entryN}
Here’s an exarnple that initializes an array of strings:
Dim names() As String = {"Joe Doe", "Peter Smack"}

This statement is equivalent to the foﬂowing statements, which declare an array with two ele-
ments and then set their values:

Dim names(1) As String
names(0) = "Joe Doe"
names(1l) = "Peter Smack"

The number of elements in the curly brackets following the array’s declaration determines the
dimensions of the array, and you can’t add new elements to the array without resizing it. If you need
to resize the array in your code dynamically, you must use the ReDim statement, as described in the
section “Dynamic Arrays,” later in this chapter. However, you can change the value of the existing
elements at will, as you would with any other array. The following declaration initializes an array of
Color objects in a single statement:

Dim Colors() As Color = {Color.BurlyWood, Color.AliceBlue, Color.Sienna, _
Color.Azure, Color.Fuchsia, Color.White}

Array Limits
The first element of an array has index 0. The number that appears in parentheses in the Dim state-
ment is one less than the array’s total capacity and is the array’s upper limit (or upper bound).

The index of the last element of an array (its upper bound) is given by the function UBoundO,

which accepts as argument the array’s name. For the array
Dim myArray(19) As Integer

its upper bound is 19, and its capacity is 20 elements. The function UBound() is also exposed as a
method of the Array object, and it’s the GetUpperBound method. It returns the same value as the
UBound() function. The GetLowerBound method returns the index of the array’s first element,
which is always zero anyway. As you will see, arrays can have multiple dimensions, so these two
methods require that you specify the dimensions whose limits you want to read as arguments. For
one-dimensional arrays, like the ones discussed in this section, this argument is zero. Multidimen-
sional arrays are discussed later in this chapter.

Let’s say you need an array to store 20 names. Declare it with the following statement:

Dim names(19) As String
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The first element is names(0), and the last is names(19). If you execute the following statements,
the values in bold will appear in the Output window:

Console.WriteLine(names.GetLowerBound(0))
0
Console.WriteLine(names.GetUpperBound(0))
19

TO assign a Value to the ﬁrst and last element Of the names array, use the following statements:

names(0) = "First entry"
names(19) = "Last entry'
If you want to iterate through the array’s elements, use a loop like the following one:
Dim i As Integer, myArray(19) As Integer
For i = 0 To myArray.GetUpperBound(0)
myArray(i) = i * 1000
Next

The actual number of elements in an array is given by the expression myArray.GetUpperBound(0)
+ 1. You can also use the array’s Length property to retrieve the count of elements. The following
statement will print the number of elements in the array myArray on the Output window:

Console.WriteLine(myArray.Length)

Still confused with the zero indexing scheme, the count of elements, and the index of the last ele-
ment in the array? It’s safe to make the array a little larger than it need be and ignore the first ele-
ment. Just make sure you never use the zeroth elements in your code—don’t store a value in the
element Array(0), and you can then ignore this element. To get 20 elements, declare an array with
21 elements as Dim myArray(20) As type and then ignore the first element.

Arrays are one of the most improved areas of VB.INET. For years, programmers invested endless
hours to write routines for sorting and searching arrays. It took Microsoft years to get arrays right,
but with VBINET you can manipulate arrays with several methods and properties available through
the Array class, which is described in detail in Chapter 11. In this chapter, you'll learn the basics of
declaring, populating, and accessing array elements, which is all you need to start using arrays in your
code. The Array class will help you manipulate arrays in more elaborate ways.

Multidimensional Arrays

One-dimensional arrays, such as those presented so far, are good for storing long sequences of one-
dimensional data (such as names or temperatures). But how would you store a list of cities and their
average temperatures in an array? Or names and scores, years and profits, or data with more than two
dimensions, such as products, prices, and units in stock? In some situations you will want to store
sequences of multidimensional data. You can store the same data more conveniently in an array of as
many dimensions as needed. Figure 3.4 shows two one-dimensional arrays—one of them with city
names, the other with temperatures. The name of the third city would be City(2), and its tempera-
ture would be Temperature(2).
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A two-dimensional array has two indices. The first identifies the row (the order of the city in the
array), and the second identifies the column (city or temperature). To access the name and tempera-
ture of the third city in the two-dimensional array, use the foﬂowing indices:

Temperatures(2, 0) ' the third city's name
Temperatures(2, 1) ' the third city's average temperature

The benefit of using multidimensional arrays is that they’re conceptually easier to manage. Sup-
pose you're writing a game and want to track the positions of certain pieces on a board. Each square
on the board is identified by two numbers, its horizontal and vertical coordinates. The obvious
structure for tracking the board’s squares is a two-dimensional array, in which the first index corre-
sponds to the row number and the second corresponds to the column number. The array could be
declared as follows:

Dim Board(9, 9) As Integer

When a piece is moved from the square on the first row and first column to the square on the
third row and fifth column, you assign the value O to the element that corresponds to the initial
position:

Board(0, 0) = 0

and you assign 1 to the square to which it was moved, to indicate the new state of the board:

Board(2, 4) =1

To tind out if a piece is on the top-left square, you'd use the following statement:

If Board(0, 0) = 1 Then
{ piece found }

Else
{ empty square }

End If

This notation can be extended to more than two dimensions. The following statement creates an

array with 1,000 elements (10 by 10 by 10):

Dim Matrix(9, 9, 9)
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You can think of a three-dimensional array as a cube made up of overlaid two-dimensional arrays,
such as the one shown in Figure 3.5.
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It is possible to initialize a multidimensional array with a single statement, just as you do with a
one-dimensional array. You must insert enough commas in the parentheses following the array name
to indicate the array’s rank (the number of commas is one less than the actual dimensions). The fol-
lowing statements initialize a two-dimensional array and then print a couple of its elements:

Dim a(,) As Integer = {{10, 20, 30}, {11, 21, 31}, {12, 22, 32}}
Console.WriteLine(Ca(0, 1)) "will print 20
Console.WriteLine(a(2, 2)) "will print 32

You should break the line that initializes the dimensions of the array into multiple lines to make
your code easier to read. Just insert the line-continuation character at the end of each continued line:

Dim a(,) As Integer = {{10, 20, 30}, _
{11, 21, 31}, _
{12, 22, 32}}

If the array has more than one dimension, you can find out the number of dimensions with the
Array.Rank property. Let’s say you have declared an array for storing names as salaries with the fol-
lowing statements:

Dim Salaries(1,99) As Object
To tind out the number of dimensions, use the statement:
Salaries.Rank

‘When using the Length property to find out the number of elements in a multidimensional array,
you will get back the total number of elements in the array—2 X 100, for our example. To find out
the number of elements in a speciﬁc dimension use the GetLength method, passing as argument a
speciﬁc dimension. The foﬂowing expression will return the number of elements in the first dimen-
sion of the array:

Console.WriteLine(Salaries.GetLength(0))
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Since the index of the first array element is zero, the index of the last element is the length of the
array minus 1. Let’s say you have declared an array with the following statement to store player sta-

tistics for 15 players, and there are §

values per player:

Dim Statistics(14, 4) As Integer

The following statements will return the values shown beneath them, in bold:

Console.WriteLine(Statistics.
2 1

Console.WriteLine(Statistics.
75 !
Console.WriteLine(Statistics
15 '
Console.WriteLine(Statistics.
5 '
Console.WriteLine(Statistics
14 !
Console.WriteLine(Statistics.
4 1

Dynamic Arrays

Rank)

dimensions in array
Length)

total elements in array

.GetLength(0))

elements in first dimension
GetLength(1))
elements in second dimension

.GetUpperBound(0))

Tlast index in the first dimension
GetUpperBound(1))
Tast index in the second dimension

Sometimes you may not know how large to make an array. Instead of making it large enough to hold the
(anticipated) maximum number of data (which means that, on the average, most of the array may be

empty), you can declare a dynamic array.

The size of a dynamic array can vary during the course of the

program. Or you might need an array until the user has entered a bunch of data and the application has
processed it and displayed the results. Why keep all the data in memory when it is no longer needed?
With a dynamic array, you can discard the data and return the resources it occupied to the system.

To create a dynarnic array, declare it as usual with the Dim statement (or Public or Private) but

don't specify its dimensions:

Dim DynArray() As Integer

Later in the program, when you know how many elements you want to store in the array, use the

ReDim statement to redimension the array, this time to its actual size. In the following example,

UserCount is a user-entered value:

ReDim DynArray(UserCount)

The ReDim statement can appear only in a procedure. Unlike the Dim statement, ReDim is

executable—it forces the application to carry out an action at runtime. Dim statements aren’t exe-
cutable, and they can appear outside procedures.

A dynamic array also can be redimensioned to multiple dimensions. Declare it with the Dim
statement outside any procedure as follows:

Dim Matrix() As Double
and then use the ReDim statement in a procedure to declare a three-dimensional array:

ReDim Matrix(9, 9, 9)
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Note that the ReDim statement can’t change the type of the array—that’s why the As clause
is missing from the ReDim statement. Moreover, subsequent ReDim statements can change the
bounds of the array Matrix but not the number of its dimensions. For example, you can’t use the
statement ReDim Matrix(99, 99) later in your code. Once an array has been redimensioned once, its
number of dimensions can’t change. In the preceding example, the Matrix array will remain three-
dimensional through the course of the application.

NOTE  The ReDim statement can be issued only from within a procedure. In addition, the array to be redimensioned must
be visible from within the procedure that calls the ReDim statement.

THE PRESERVE KEYWORD

Each time you execute the ReDim statement, all the values currently stored in the array are lost.
Visual Basic resets the values of the elements as if they were just declared. (It resets numeric elements
to zero and String elements to empty strings.)

In most situations, when you resize an array, you no longer care about the data in it. You can,
however, change the size of the array without losing its data. The ReDim statement recognizes the
Preserve keyword, which forces it to resize the array without discarding the existing data. For
example, you can enlarge an array by one element without losing the values of the existing elements

by using the UBound() function as follows:
ReDim Preserve DynamicArray(UBound(DynArray) + 1)

If the array DynamicArray held 12 elements, this statement would add one element to the array, the
element DynamicArray(12). The values of the elements with indices O through 11 wouldn’t change.
The UBound() function returns the largest available index (the number of elements) in a one-dimen-
sional array. Similarly, the LBoundO function returns the smallest index. If an array was declared
with the statement

Dim Grades(49) As Integer

then the functions LBound(Grades) and UBound(Grades) would return the values O and 49. For more
information on the functions LBoundO and UBoundO, see the reference “VB.NET Functions and
Statements” on the CD. Obviously, the LBoundO function is of no practical value in VB.NET, since

the indexing of all arrays must start at 0.

Arrays of Arrays

Arrays are a major part of the language. In the section “User-Defined Data Types,” earlier in this
chapter, you saw how to create arrays of structures. It is possible to create even more complicated
structures for storing data, such as arrays of arrays. If an array is declared as Object, you can assign
other types to its elements, including arrays.

NOTE  The technique described in this section will work only when the Strict option is Off. If it is On, VB will gener-
ate an error to the effect that the Strict option does not allow late binding.

Copyright ©2002 SYBEX, Inc., Alameda, CA www.sybex.com

129


http://www.sybex.com

130 |CHAPTER3 VISUAL BASIC: THE LANGUAGE

Suppose you have declared and populated two arrays, one with integers and another with strings.
You can then declare an Object array with two elements and populate it with the two arrays, as
shown in Listing 3.9.

LISTING 3.9: POPULATING AN ARRAY OF ARRAYS

Dim IntArray(9) As Integer
Dim StrArray(99) As String
Dim BigArray(1l) As Object
Dim i As Integer
' populate array IntArray
For i = 0 To 9
IntArray(i) = i
Next
' populate array StrArray
For i = 0 To 99
StrArray(i) = "ITEM " & 1i.ToString("0000")
Next
BigArray(0) = IntArray
BigArray(1l) = StrArray
Console.WriteLine(BigArray(0)(7))
Console.WriteLine(BigArray(1)(16))

The last two statements will print the foﬂowing values on the Output window:

7
ITEM 0016

BigArray was declared as a one-dimensional array, but because each of its elements is an array, you
must use two indices to access it. To access the third element of IntArray in BigArray, use the indices O
and 2. Likewise, the tenth element of the SirArray in BigArray is BigArray(1)(9). The notation is quite
unusual, but the indices of the BigArray must be entered in separate parentheses. In most cases, you'll be
able to use Structures and avoid arrays of arrays, so you won't have to bother with this notation.

Variables as Objects

As you have understood by now, variables are objects. This shouldn’t come as a surprise, but it's an
odd concept for programmers with no experience in object-oriented programming. We haven't cov-
ered objects and classes formally yet, but you have a good idea of what an object is. It’s an entity that
exposes some functionality by means of properties and methods. The TextBox control is an object,
and it exposes the Text property, which allows you to read, or set, the text on the control. Any name
followed by a period and another name signifies an object. The “other name” is a property or
method of the object.

At this point, I'll ask you to take a leap forward. Things will become quite clear when you learn
more about objects later in the book, but I couldn’t postpone this discussion; you need a good
understanding of variables to move on. If you want, you can come back and re-read this section. In
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the meantime, I'll attempt to explain through examples how VB.NET handles variables. It’s a sim-
phﬁed view of objects and, at points, I won’t even use proper terminology.

So, What’s an Object?

An object is a collection of data and code. You don’t see the code, and you'll never have to change
it—unless you've written it, of course. An integer variable, intVar, is an object because it has a value
and some properties and methods. Properties and methods are implemented as functions. The
method intVar.ToString for instance, returns the numeric value held in the variable as a string, so
that you can use it in string operations. In other words, an Integer variable is an object that knows
about itself. It knows that it holds a whole number; it knows how to convert itself to a string; it
knows the minimum and maximum values it can store (properties MinValue and MaxValue); and so
on. In the past, a variable was just a named location in the memory. Now, it’s a far more complex
structure with its own “intelligence.” This intelligence consists of code that implements some of the
most common actions you're expected to perform on its value. The same is true for strings, even
characters. Actually, the Char data type exposes a lot of very useful properties. In the past, program-
mers wrote their own functions to determine whether a character is a numeric digit or a letter,
whether it’s in upper- or lowercase, and so forth. With the Char data type, all this functionality
comes for free. The IsDigit and IsLetter methods return True if the character is a digit or a letter,
respectively, False otherwise. The Date data type even has a property called IsLeapYear.

As I mentioned, in the past programmers had to write their own functions to perform all these oper-
ations that are now built into the variables themselves. Since VB1, Microsoft has included many func-
tions to manipulate strings. Without these functions, VB programmers wouldn’t be able to do much
with String variables. These functions were enhanced with subsequent versions of VB. They did the
same with date-manipulation functions, and VBNET has inherited a large number of functions from
VB6. Instead of bloating the language, the designers of VBINET decided to move all this functionality
into the classes that implement the various data types. The old functions are still there, because there
are innumerable applications out there that use them. Applications written in VB.NET from scratch
should use the newer methods and properties, but old VB programmers are so accustomed to using the
equivalent VB functions that it will take them some time to switch to the new way of coding.

The main advantage of exposing so much functionality through the data types, instead of individ-
ual functions, is that you don’t have to learn the names of all these functions. Now, you can type the
period following a variable’s name and see the list of members it exposes. The alternative would be
to look up the documentation and try to locate a function that provides the desired functionality.

Another good reason for attaching so much functionality to the data types is that the specific
functions are meaningless with other data types. Since the IsLeapYear method is so specific to dates,
we better contain it in the world of the Date data type.

The real reason Microsoft is trying to eliminate the old functions is that all this functionality will
eventually become part of the operating system. As a result, the number of support runtime libraries
that are distributed with an EXE today will be greatly reduced.

The old VB functions that have been replaced by methods and properties are explained in the refer-
ence “VB.NET Functions and Statements” on the CD. These functions are still part of the language,
and you can't ignore them, because of the applications that already use them. I suspect programmers
will mix both functions and methods with VB.INET, and it will be a while before the old functions

are abandoned. So, whether you're a VB6 programmer (in which case you're very familiar with the
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string- and date-manipulation functions of VB) or you're new to VB.NET (in which case you
should be able to read and understand existing code), you can’t ignore these functions, neither can
you ignore the members that expose the same functionality.

How about the code that implements all the functionality built into the variable? The code
resides in a class. A class is the code that implements the properties and methods of a variable. The
class that implements the Date type is the System.Date class, and it exposes the same functionality as
a Date variable. A Date variable is nothing more than an instance of the System.Date class. Here’s an
example. The Date class exposes the IsLeapYear method, which returns True if a specific year is
leap. The expression:

System.Date.IsLeapYear(2001)

will return False, because 2001 is not a leap year.
If you declare a variable of the Date type, it carries with it all the functionality of the System.Date
class. The IsLeapYear method can be applied to a Date variable as well:

Dim d1 As Date = #3/4/2001#
MsgBox(dl.IsLeapYear(2001))

If you execute these statements, a message box will pop up displaying the string “False.” But
shouldn’t the IsLeapYear method be applied to the dI variable? The answer is no, because
IsLeapYearisa shared method: it requires an argument. You can use the System.Date class to

call the IsLeapYear method:
Console.WriteLine(System.Date.IsLeapYear(2001)

It 1s even possible to use expressions like the foHowing:
Console.WriteLine(#3/4/2001#.IsLeapYear(2001))

This expression will return False. Change the year to 2004, and it will return True. The date, even
though it's a value, it’s represented by an instance of the System.Date class. The compiler figures out that
the expression between the pound signs is a date and loads an instance of the System.Date class automat-
icaﬂy to represent the value. As an expression, I think it’s rather ridiculous, but it’s a valid expression nev-
ertheless. (An even more perplexing expression is #1/1/1900#. IsLeapYear(2020), but it's also valid).

NOTE  I've shown you how to create custom data types with the Structure keyword. A Structure doesn’t expose any prop-
erties or methods, just values. So, can we build custom data types with added fun[tionality, like the fun[tionality found in
the base data types? The answer is yes, but you must provide your own class. You'll learn how to build custom data types
that provide properties and method, but you must first learn how to build your own classes, in Cbapter 8.

Formatting Numbers

The ToString method, exposed by all data types except the String data type, converts a value to the
equivalent string and formats it at the same time. You can call the ToString method without any
arguments, as we have done so far, to convert any value to a string. The ToString method, however,
accepts an argument, which determines how the value will be formatted as a string. For example, you
can format a number as currency by prefixing it with the appropriate sign (e.g., the dollar symbol)
and displaying it to two decimal digits.
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Notice that ToString is a method, not a property. It returns a value, which you can assign to
another variable or pass as arguments to a function like MsgBox(), but the original value is not
aftected. The ToString method can also format a value if called with the format argument:

ToString(formatString)

The formarString argument is a format specifier (a string that specifies the exact format to be applied
to the variable) This argument can be a specific character that corresponds to a predetermined format
(standard numeric format string, as it’s called) or a string of characters that have special meaning in format-
ting numeric values (a picture numeric format string). Use standard format strings for the most common
operations and picture strings to specify unusual formatting requirements. To format the value
9959.95 as a dollar amount, you can use the following standard currency format string:

Dim int As Single = 9959.95
Dim strInt As String
strInt = int.ToString("C")

or the foHowing picture numeric format string:

strInt = int.ToString("$###,###.00")

Both statements will format the value as “$9,959.95”. The “C” argument in the first exarnple
means currency and formats the numeric value as currency. If you're using a non-U.S. version of Win-
dows, the currency symbol will change accordingly. Depending on your culture, the currency symbol
may also appear after the amount. The picture format string is made up of literals and characters that
have special meaning in formatting. The dollar sign has no special meaning and will appear as is. The
# symbol is a digit placeholder. All # symbols will be replaced by numeric digits, starting from the
right. If the number has fewer digits than speciﬁed in the string, the extra symbols to the left will be
ignored. The comma tells the Format function to insert a comma between thousands. The period is
the decimal point, which is followed by two more digit placeholders. Unlike the # sign, the O is a spe-
cial placeholder: if there are not enough digits in the number for all the zeros you've specitied, a O will
appear in the place of the missing digits. If the original value had been 9959.9, for example, the last
statement would have formatted it as $9,959.90. If you used the # placeholder instead, then the
string returned by the Format method would have a single decimal digit.

STANDARD NUMERIC FORMAT STRINGS
VB.NET recognizes the standard numeric format strings shown in Table 3.6.

TABLE 3.6: STANDARD NUMERIC FORMAT STRINGS

FORMAT CHARACTER DESCRIPTION EXAMPLE

Corc Currency 12345.67.ToString("C") returns $12,345.67

Eore Scientific format 12345.67.ToString("E") returns 1.234567E+004
Forf Fixed-point format 12345.67.ToString("F") returns 12345.67

Gorg General format Return a value either in fixed-point or scientific format
Norn Number format 12345.67.ToString("N") returns 12,345.67

Xorx Hexadecimal format 250.ToString("X") returns FA
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The format character can be followed by an integer. If present, the integer value specities the
number of decimal places that are displayed. The default accuracy is two decimal digits.

The “C” format string causes the ToString method to return a string representing the number as
a currency value. An integer following the “C” determines the number of decimal places that are dis-
played. If no number is provided, two digits are shown after the decimal separator. The expression
5596.ToString("c") will return the string “$5,596.00”, and the expression 5596.4499.ToString("c3")
will return the string “$5,596.450”.

The fixed-point format returns a number with one or more decimal digits. The expression
(134.5).ToString("f3") will return the value 134.500. I've used the optional parentheses around
the value here to make clear that the number has a decimal point. VB doesn’t require that you supply
these parentheses.

NOTE  Notice that not all format strings apply to all data types. For example, only integer values can be converted to
hexcadecimal format.

PICTURE NUMERIC FORMAT STRINGS

If the format characters listed in Table 3.6 are not adequate for the control you need over the
appearance of numeric values, you can provide your own picture format strings. Picture format
strings contain special characters that allow you to format your values exactly as you like. Table 3.7
lists the picture formatting characters.

TABLE 3.7: PICTURE NUMERIC FORMAT STRINGS

FORMAT CHARACTER DESCRIPTION EFFECT

0 Display zero placeholder Results in a non-significant zero if a number has fewer
digits than there are zeros in the format.

# Display digit placeholder Replaces the “#” symbol with only significant digits.
Decimal point Displays a “.” character.

, Group separator Separates number groups; for example, “1,000”.

% Percent notation Displays a “%?” character.

E+o, E-0, e+0, e-0 Exponent notation Formats the output of exponent notation.

\ Literal character Used with traditional formatting sequences like “\n”
(newline).

“» Literal string Displays any string within quotes or apostrophes
literally.

; Section separator Specifies different output if the numeric value to be for-

matted is positive, negative, or zero.
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Formatting Dates
To format dates, use the format characters shown in Table 3.8.

TABLE 3.8: DATE FORMATTING STRINGS

FORMAT CHARACTER DESCRIPTION

d Short date format

D Long date format

f Long date followed by short time
F Long date followed by long time

(General) Short date followed by short time

G (General) Short date followed by long time
morM Month/day format

rorR RFC1123 pattern

s Sortable date/time format

t Short time format

T Long time format

u Universal date/time

U Universal sortable date/time format
Yory Year month format

FLOW-CONTROL STATEMENTS | 135

FORMAT
MM/dd/yyyy

dddd, MMMM dd, yyyy

dddd, MMMM dd, yyyy HH:mm
dddd, MMMM dd, yyyy HH:mm:ss
MM/dd/yyyy HH:mm
MM/dd/yyyy HH:mm:ss

MMMM dd

ddd, dd MMM yyyy HH:mm:ssGMT
yyyy-MM-dd HH:mm:ss

HH:mm

HH:mm:ss

yyyy-MM-dd HH:mm:ss

dddd, MMMM dd, yyyy HH:mm:ss

MMMM, yyyy

If the variable birthDate contains the value #1/1/2000#, the following expressions return the val-

ues shown below them, in bold:

Console.WriteLine(birthDate.ToString("'d"))
1/1/2000
Console.WriteLine(birthDate.ToString('D"))
Saturday, January 01, 2000
Console.WriteLine(birthDate.ToString("f"))
Saturday, January 01, 2000 12:00 AM
Console.WriteLine(birthDate.ToString("s"))
2000-01-01T00:00:00
Console.WriteLine(birthDate.ToString("'U"))
Saturday, January 01, 2000 12:00:00 AM

Flow-Control Statements

‘What makes programming languages ﬂexible—capable of handling every situation and programming

chaﬂenge with a relatively small set of commands—is the capability to examine external conditions
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and act accordingly. Programs aren’t monolithic sets of commands that carry out the same calculations
every time they are executed. Instead, they adjust their behavior depending on the data supplied; on
external conditions, such as a mouse click or the existence of a peripheral; or even on abnormal con-
ditions generated by the program itself. For example, a program that calculates averages may work
time and again until the user forgets to supply any data. In this case, the program attempts to divide
by zero, and it must detect this condition and act accordingly. In effect, the statements discussed in
the section are what programs are all about. Without the capability to control the flow of the pro-
gram, computers would just be bulky calculators. To write programs that react to external events and
produce the desired results under all circumstances, you'll have to use the following statements.

Test Structures
An application needs a built-in capability to test conditions and take a different course of action
depending on the outcome of the test. Visual Basic provides three such decision structures:

¢ If.Then
¢ If.Then.Else

& Select Case

IF...THEN

The If.Then statement tests the condition speciﬁed; if it’s True, the program executes the state-
ment(s) that follow. The If structure can have a single-line or a multiple-line syntax. To execute one
statement conditionaﬂy, use the single—line syntax as follows:

If condition Then statement

Visual Basic evaluates the condition, and if it’s True, executes the statement that follows. If the condi-
tion is False, the application continues with the statement foHowing the If statement.
You can also execute multiple statements by separating them with colons:

If condition Then statement: statement: statement

Here’s an example of a single-line If statement:

If Month(expDate) > 12 Then expYear = expYear + 1l: expMonth = 1
You can break this statement into multiple lines by using End If, as shown here:
If expDate.Month > 12 Then
expYear = expYear + 1
expMonth = 1
End If

The Month property of the Date type returns the month of the date to which it's applied as a
numeric value. Some programmers prefer the multiple-line syntax of the If.Then statement, even if it
contains a single statement, because the code is easier to read. The block of statements between the
Then and End If keywords form the body of the conditional statement, and you can have as many
statements in the body as needed.
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IF...THEN...ELSE

A variation of the If.Then statement is the If.Then..Else statement, which executes one block of
statements if the condition is True and another block of statements if the condition is False. The
syntax of the If.Then.Else statement is as follows:

If condition Then
statementblockl
Else
statementbTlock?2
End If

Visual Basic evaluates the condition; if it's True, VB executes the first block of statements and then
jumps to the statement following the End If statement. If the condition is False, Visual Basic ignores
the first block of statements and executes the block following the Else keyword.

Another variation of the If.Then..E1se statement uses several conditions, with the Elself

keyword:

If conditionl Then
statementblockl
ElseIf condition2 Then
statementbTlock?2
ElseIf condition3 Then
statementblock3

Else
statementblock4
End If

You can have any number of Elself clauses. The conditions are evaluated from the top, and if one
of them is True, the corresponding block of statements is executed. The Else clause will be executed
if none of the previous expressions are True. Listing 3.10is an example of an If statement with

Elself clauses.

LISTING 3.10: MULTIPLE ELSEIF STATEMENTS

score = InputBox("Enter score")
If score < 50 Then
Result = "Failed"
ElseIf score < 75 Then
Result = "Pass"
ElseIf score < 90 Then
Result = "Very Good"
Else
Result = "Excellent"
End If
MsgBox Result
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MULTIPLE IF...THEN STRUCTURES VS. ELSEIF

Notice that once a True condition is found, Visual Basic executes the associated statements and skips the
remaining clauses. It continues executing the program with the statement immediately after End If.Allfol-
lowing Elself clauses are skipped, and the code runs a bit faster. That’s why you should prefer the compli-
cated structure with Elself statements used in Listing 3.10 to this equivalent series of simple If statements:

If score < 50 Then
Result = "Failed"

End If

If score < 75 And score >= 50 Then
Result = "Pass"

End If

If score < 90 And score > =75 Then
Result = "Very Good"

End If

If score >= 90 Then
Result = "Excellent"

End If

Visual Basic will evaluate the conditions of all the If statements, even if the score is less than 50.

You may have noticed that the order of the comparisons is vital in an If.Then structure that uses
Elself statements. Had you written the previous code segment with the first two conditions

switched, like this:

If score < 75 Then
Result = "Pass"
ElseIf score < 50 Then
Result = "Failed"
ElseIlf score < 90 Then
Result = "Very Good"
Else
Result = "Excellent"
End If

the results would be quite unexpected. Let’s assume that score is 49. The code would compare the score
variable to the value 75. Since 49 is less than 75, it would assign the value “Pass” to the variable Result,
and then it would skip the remaining clauses. Thus, a student who made 49 would have passed the test!
So be extremely careful and test your code thoroughly if it uses multiple Elself clauses.

SELECT CASE

An alternative to the efficient, but difficult-to-read, code of the multiple—ElseIf structure is the
Select Case structure, which compares one expression to different values. The advantage of
the Select Case statement over multiple If..Then..E1se/E1seIf statements is that it makes the
code easier to read and maintain.
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The Select Case structure tests a single expression, which is evaluated once at the top of the
structure. The result of the test is then compared with several values, and if it matches one of
them, the corresponding block of statements is executed. Here’s the syntax of the Select Case
statement:

Select Case expression
Case valuel
statementblockl
Case value2
statementblock?2

Case Else
statementblockN
End Select

A practical example based on the Select Case statement is Listing 3.11.

LISTING 3.11: USING THE SELECT CASE STATEMENT

Dim message As String
Select Case Now.DayOfWeek
Case DayOfWeek.Monday

message = "Have a nice week"
Case DayOfWeek.Friday
message = "Have a nice weekend'
Case Else
message = "Welcome back!"
End Select
MsgBox(message)

In the Iisting, the expression variable, which is evaluated at the beginning of the statement, is the
Weekday, as reported by the DayOfW eek property of the Date type. It's a numeric value, but its pos-
sible settings are the members of the DayOfWeek enumeration, and you can use the names of these
members in your code to make it easier to read. The value of this expression is cornpared with the
values that follow each Case keyword. If they match, the block of statements up to the next Case
keyword is executed, and then the program skips to the statement following the End Select state-
ment. The block of the Case Else statement is optional and is executed if none of the previous Case
values match the expression. The first two Case statements take care of Fridays and Mondays, and
the Case Else statement takes care of the Weekdays.

Some Case statements can be followed by multiple values, which are separated by commas. List-
ing 3.12 is a revised version of the previous example.
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LISTING 3.12: A SELECT CASE STATEMENT WITH MULTIPLE CASES PER CLAUSE

Select Case Now.DayOfWeek
Case DayOfWeek.Monday
message = "Have a nice week"
Case DayOfWeek.Tuesday, DayOfWeek.Wednesday, _
DayOfWeek.Thursday, DayOfWeek.Friday
message = "Welcome back!"
Case DayOfWeek.Friday, DayOfWeek.Saturday, DayOfWeek.Sunday
message = "Have a nice weekend!"
End Select
MsgBox(message)

Monday, Friday (and weekends), and the remaining weekdays are handled separately by three
Case statements. The second Case statement handles multiple values (all weekdays, except for Mon-
day and Friday). Monday is handled by a separate Case statement. This structure doesn’t contain a
Case Else statement because all possible values are examined in the Case statements. The Day-
OfWeek method can’t return another value.

TIP  If more than one Case value matches the expression, only the statement block associated with the first matching
Case executes.

For comparison, Listing 3.13 contains the equivalent If..Then..E1lse statements that would imple-
ment the example of Listing 3.12.

LISTING 3.13: LISTING 3.12 IMPLEMENTED WITH NESTED IF STATEMENTS

If Now.DayOfWeek = DayOfWeek.Monday Then
message = "Have a nice week"
Else
If Now.DayOfWeek >= DayOfWeek.Tuesday And _
Now.DayOfWeek <= DayOfWeek.Friday Then

message = "Welcome back!"
Else
message = "Have a nice weekend!"
End If
End If
MsgBox(message)

To say the least, this coding is verbose. If you attempt to implement a more elaborate Select
Case statement with If..Then..Else statements, the code becomes even more difficult to read.

Of course, the Select Case statement can’t always substitute for an If..Then structure. The
Select Case structure only evaluates the expression at the beginning. By contrast, the If..Then.Else
structure can evaluate a different expression for each Elself statement, not to mention that you can
use more complicated expressions with the If clause.
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Loop Structures

Loop structures allow you to execute one or more lines of code repetitively. Many tasks consist of
trivial operations that must be repeated over and over again, and looping structures are an important
part of any programming language. Visual Basic supports the following loop structures:

¢ For.Next
¢ Do..Loop

¢ While..End WhiTe

FOR...NEXT

The For..Next loop is one of the oldest loop structures in programming languages. Unlike the other
two loops, the For..Next loop requires that you know how many times the statements in the loop
will be executed. The For..Next loop uses a variable (it’s called the loop’s counter) that increases or
decreases in value during each repetition of the loop. The For..Next loop has the following syntax:

For counter = start To end [Step increment]
statements
Next [counter]

The keywords in the square brackets are optional. The arguments counter, start, end, and increment are all
numeric. The loop is executed as many times as required for the counter to reach (or exceed) the end
value.

In executing a For..Next loop, Visual Basic completes the following steps:

1. Sets counter equal to start

2. Tests to see if counter is greater than end. If so, it exits the Ioop. If increment is negative, Visual
Basic tests to see if counter is less than end. If it is, it exits the Ioop.

3. Executes the statements in the block

4. Increments counter by the amount speciﬁed with the increment argument. If the increment argu-
ment isn't speciﬁed, counter 1s incremented by 1.

5. Repeats the statements

The For..Next loop in Listing 3.14 scans all the elements of the numeric array data and calculates
their average.

LISTING 3.14: ITERATING AN ARRAY WITH A FOR...NEXT LOOP

Dim i As Integer, total As Double

For i = 0 To data.GetUpperBound(0)
total = total + data(i)

Next i

Console.WriteLine (total / data.Length)
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The single most important thing to keep in mind when working with For..Next loops is that the
loop’s counter is set at the beginning of the loop. Changing the value of the end variable in the Ioop’s
body won't have any effect. For example, the following Ioop will be executed 10 times, not 100
times:

endvalue = 10
For i = 0 To endValue
endvalue = 100
{ more statements }
Next i

You can, however, adjust the value of the counter from within the Ioop. The foﬂowing 1s an
example of an endless (or infinite) loop:

For i = 0 To 10
Console.WritelLine(i)
i=1-1

Next i

This loop never ends because the Ioop’s counter, in effect, is never increased. (If you try this, press
Ctrl+Break to interrupt the endless loop.)

WARNING Mam’pulﬂting the counter of a For..Next Zoop is strongly dz'stoumged. This practice will most Zi/eely lead
to bugs such as infinite loops, oveg‘lows, and so on. If the number of repetitions of a loop isn’t known in advance, use a
Do..Loop or a While..End WhiTle structure (dismssed in tkefollowz’ng section),

The increment argument can be either positive or negative. If start is greater than end, the value of
increment must be negative, If not, the loop’s body won't be executed, not even once.

Finaﬂy, the counter variable need not be listed after the Next statement, but it makes the code eas-
fer to read, especially when For..Next Ioops are nested within each other (nested loops are discussed
in the section “Nested Control Structures” later in the chapter).

Do...LooP

The Do..Loop executes a block of statements for as long as a condition is True. Visual Basic evaluates
an expression, and if it’s True, the statements are executed. When the end of block is reached, the
expression is evaluated again and, if it's True, the statements are repeated. If the expression is False,
the program continues and the statement following the loop is executed.

There are two variations of the Do..Loop statement; both use the same basic model. A loop can be
executed either while the condition is True or until the condition becomes True. These two varia-
tions use the keywords While and Until to specify how Iong the statements are executed. To execute
a block of statements while a condition is True, use the foﬂowing syntax:

Do While condition
statement-block
Loop
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To execute a block of statements until the condition becomes True, use the foﬂowing syntax:

Do Until condition
statement-block
Loop

When Visual Basic executes these loops, it first evaluates condition. If condition is False, a Do.While
loop is skipped (the statements aren’t even executed once) but a Do..Unti1 loop is executed. When
the Loop statement is reached, Visual Basic evaluates the expression again and repeats the statement
block of the Do.While loop if the expression is True, or repeats the statements of the Do..Unti1 loop
if the expression is False.

In short, the Do While Ioop is executed when the condition is True, and the Do Until loop is exe-
cuted when the condition is False.

The Do..Loop can execute any number of times as long as condition is True or False, as appropriate
(zero or nonzero if the condition evaluates to a number). Moreover, the number of iterations need
not be known before the loops starts. In fact, the statements may never execute if condition is initially
False for While or True for Until.

Here’s a typical example of using a Do..Loop. Suppose the string MyText holds a piece of text (per-
haps the Text property of a TextBox control), and you want to count the words in the text. (We’ﬂ
assume that there are no multiple spaces in the text and that the space character separates successive
Words.) To locate an instance of a character in a string, use the InStrO function, which accepts three
arguments:

¢ The starting location of the search
¢ The text to be searched
¢ The character being searched

The following loop repeats for as long as there are spaces in the text. Each time the InStr() func-
tion finds another space in the text, it returns the location (a positive number) of the space. When
there are no more spaces in the text, the InStrO function returns zero, which signals the end of the
loop, as shown:

Dim MyText As String = "The quick brown fox jumped over the Tazy dog"
Dim position, words As Integer

position = 1

Do While position > 0

position = InStr(position + 1, MyText, " ")
words = words + 1
Loop

Console.WriteLine "There are " & words & " words in the text"

The Do..Loop is executed while the InStr() function returns a positive number, which happens for
as long as there are more words in the text. The variable position holds the location of each successive
space character in the text. The search for the next space starts at the location of the current space plus
1 (so that the program won't keep finding the same space). For each space found, the program incre-
ments the value of the words variable, which holds the total number of words when the loop ends.
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NOTE  There are simpler methods of brmking a string info ifs constituent words, like the Splz’t method of the String class.
This is Just an example of the Do While loop.

You may notice a problem with the previous code segment. It assumes that the text contains at
least one word and starts by setting the position variable to 1. If the MyText variable contains an empty
string, the program reports that it contains one word. To fix this problem, you must specify the con-
dition, as shown:

Do While InStr(position + 1, MyText, " ")
position = InStr(position + 1, MyText, " ")
words = words + 1

Loop

Console.WriteLine("There are " & words & " words in the text")

This code segment counts the number of words correctly, even if the MyText variable contains an
empty string. If the MyText String variable doesn’t contain any spaces, the function InStr(position
+ 1, MyText, " ") returns O, which corresponds to False, and the Do loop isn’t executed.

You can code the same routine with the Until keyword. In this case, you must continue to search
for spaces until position becomes zero. Here’s the same code with a different loop (the InStr() func-
tion returns O if the string it searches for doesn't exist in the longer string):

position = 1
Do Until position = 0

position = InStr(position + 1, MyText, " ")
words = words + 1
Loop

Console.WriteLine("There are " & words & " words in the text")

Another variation of the Do loop executes the statements first and evaluates the condition after each
execution. This Do loop has the following syntax:

Do
statements
Loop WhiTle condition

or

Do
statements
Loop Until condition

The statements in this type of loop execute at least once, since the condition is examined at the end
of the loop.

Could we have implemented the previous example with one of the last two types of loops? The
fact that we had to do something special about zero-length strings suggests that this problem
shouldn’t be coded with a loop that tests the condition at the end. Since the loop’s body will be exe-
cuted once, the words variable is never going to be zero.

As you can see, you can code loops in several ways with the Do..Loop statement, and the way you
use it depends on the problem at hand and your programming style.
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WHILE...END WHILE
The While..End WhiTe loop executes a block of statements as long as a condition is True. The While
loop has the following syntax:

While condition
statement-block
End While

VB6 " VB.NET

The End While statement replaces the Wend statement of VB6.

If condition is True, all statements are executed and, when the End While statement is reached, con-
trol is returned to the While statement, which evaluates condition again. If condition is still True, the
process is repeated. If condition is False, the program resumes with the statement following End While.

The loop in Listing 3.15 prompts the user for numeric data. The user can type a negative value to
indicate that all values are entered.

LISTING 3.15: READING AN UNKNOWN NUMBER OF VALUES

Dim number, total As Double
number = 0
While number => 0
total = total + number
number = InputBox("Please enter another value")
End While

You assign the value O to the number variable before the loop starts because this value can't affect
the total. Another technique is to precede the While statement with an InputBox function to get the
first number from the user.

Sometimes, the condition that determines when the loop will terminate is so complicated that it
can’t be expressed with a single statement. In these cases, we declare a Boolean value and set it to
True or False from within the loop’s body. Here’s the outline of such a loop:

Dim repeatLoop As Boolean
repeatLoop = True
While repeatLoop
{ statements }
If condition Then
repeatLoop = True
Else
repeattLoop = False
End If
End While
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You may also see an odd loop statement like the foﬂowing one:

While True
{ statements }
End While

This seemingly endless loop must be terminated from within its own body with an Exit state-
ment, which is called when a condition becomes True or False. The foHowing loop terminates when
a condition is met in the loop’s body:

While True
{ statements }
If condition Then Exit While
{ more statements }

End While

Nested Control Structures

You can place, or nest, control structures inside other control structures (such as an If..Then block
within a For..Next loop). Control structures in Visual Basic can be nested in as many levels as you
want. It's common practice to indent the bodies of nested decision and Ioop structures to make the
program easier to read.

When you nest control structures, you must make sure that they open and close within the same
structure. In other words, you can’t start a For.Next loop in an If statement and close the loop after
the corresponding End If. The following pseudocode demonstrates how to nest several flow-control
statements:

For a = 1 To 100
{ statements }
If a = 99 Then
{ statements }
End If
While b < a
{ statements }
If total <= 0 Then
{ statements }
End If
End While
For c =1 to a
{ statements }
Next
Next

I'm not showing the names of the count variables after the Next statement, because it's not neces-
sary. To find the matching closing statement (Next, End If, or End While), move down from the
opening statement until you hit a line that starts at the same column. This is the matching closing
statement. Notice that you don't have to align the nested structures yourself. The editor reformats
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the code automatically as you edit. It also inserts the matching closing statement—the End If state-
ment is inserted automaticaﬂy as soon as you enter an If statement, for example.

Listing 3.16 shows the structure of a nested For..Next loop that scans all the elements of a two-
dimensional array.

LISTING 3.16: ITERATING THROUGH A TWO-DIMENSIONAL ARRAY

Dim Array2D(6, 4) As Integer
Dim iRow, iCol As Integer
For iRow = 0 To Array2D.GetUpperBound(0)
For iCol = 0 To Array2D.GetUpperBound(1)
Array2D(iRow, iCol) = iRow * 100 + 1iCol
Console.Write(iRow & ", " & iCol & " = " & Array2D(iRow, iCol) & " ")
Next iCol
Console.WritelLine()
Next iRow

The outer loop (with the iRow counter) scans each row of the array, and the inner loop scans each
column in the current row. At each iteration, the inner Ioop scans all the elements in the row speciﬁed
by the counter of the outer loop (iRow). After the inner loop completes, the counter of the outer loop
is increased by one and the inner loop is executed again, this time to scan the elements of the next row.
The loop’s body consists of two statements that assign a value to the current array element and then
print it in the Output window. The current element at each iteration is Array2D(iRow, iCol).

Part of the output produced by this code segment is shown here. The pair of values separated by

a comma are the indices of an element, and its value follows the equal sign:

0, 0=0 0, 1=1 0, 2 =2 0, 3=3 0, 4 =14

1, 0 = 100 1, 1 =101 1, 2 =102 1, 3 =103 1, 4 = 104
2, 0 =200 2, 1 =201 2, 2 =202 2, 3 =203 2, 4 =204
3, 0 = 300 3, 1 =301 3, 2 =302 3, 3 =303 3, 4 = 304
4, 0 = 400 4, 1 =401 4, 2 = 402 4, 3 =403 4, 4 = 404
5, 0 = 500 5, 1 =501 5, 2 =502 5, 3 =503 5, 4 = 504
6, 0 = 600 6, 1 =601 6, 2 = 602 6, 3 =603 6, 4 = 604

TiP  The presence of the counter names iCol and iRow aren’t really required after the Next statement. Actually, if
you supply them in the wrong order, Visual Basic will catch the error. In practice, few programmers specify counter values
after a Next statement because Visual Basic matches each Next statement to the corresponding For statement. If the loop’s
body is lengthy, you can improve the program’s readability by specifying the corresponding counter name after each Next
statement.

You can also nest multiple If statements. The structure shown in Listing 3.17 tests a user-sup-
phed value to determine whether it’s positive and, if so, determines whether the value exceeds a cer-
tain limit.
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LISTING 3.17: SIMPLE NESTED IF STATEMENTS

Income = InputBox("Enter your income")
If Income > 0 Then
If Income > 10000 Then
MsgBox "You will pay taxes this year"

Else
MsgBox "You won't pay any taxes this year"
End If
Else
MsgBox "Bummer"
End If

The Income variable is first compared with zero. If it's negative, the Else clause of the If..Then
statement is executed. If it’s positive, it's compared with the value 10,000, and depending on the
outcome, a different message is displayed.

The Exit Statement

The Exit statement allows you to exit prematurely from a block of statements in a control structure,
from a loop, or even from a procedure. Suppose you have a For.Next loop that calculates the square
root of a series of numbers. Because the square root of negative numbers can’t be calculated (the
Sqrto function will generate a runtime error), you might want to halt the operation if the array con-
tains an invalid value. To exit the loop prematurely, use the Exit For statement as follows:

For i = 0 To UBound(nArray)
If nArray(i) < 0 Then Exit For
nArray(i) = Math.Sqrt(nArray(i))
Next

Ifa negative element is found in this loop, the program exits the loop and continues with the
statement following the Next statement.

There are similar Exit statements for the Do loop (Exit Do) and the While loop (Exit While), as
well as for functions and subroutines (Exit Function and Exit Sub). If the previous loop was part
of a function, you might want to display an error and exit not only the loop, but the function itself:

For i = 0 To nArray.GetUpperBound()
If nArray(i) < 0 Then
MsgBox "Negative value found, terminating calculations"
Exit Function
End If
nArray(i) = Sqgr(nArray(i))
Next

If this code is part of a subroutine procedure, you use the Exit Sub statement. The Exit state-
ments for loops are Exit For, Exit While, and Exit Do. There is no way (or compelling reason) to
exit prematurely from an If or Case statement.
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Summary

It's been a long chapter, but we wouldn’t be able to go far without the information presented here.
You have learned the base data types supported by Visual Basic, how to declare variables, and when
to use them. Actually, the base data types aren’t supplied by Visual Basic; they're part of the Com-
mon Language Runtime (CLR) and are the same for all languages. At this point, it doesn’t really
make much difference what part of NET supplies each feature (the CLR, the Framework, or Visual
Basic itself).

You've also learned how to store sets of values to an array, which is a great convenience. Arrays
have always been a prime tool for programmers, and they've gotten so much better in NET. You
will read more about arrays in Chapter 11.

The base types supported by CLR are just too basic for the needs of a real application. To store
more complicated information (like customers, accounts and so on), you can create your own cus-
tom structures. After defining the structure of the information, you can declare variables with the
same structure. These variables behave like objects (even though they’re not technically objects),
because they expose the fields of the structure as properties.

The most interesting information presented in this chapter is the notion of variables as objects.
That will all make much more sense in Chapter 8, where we'll discuss classes formally and you'll
learn how to build your own classes and declared variables that represent them. Until then, think of
variables as entities that expose some functionality through properties and methods. Properties and
methods are just names following the name of a variable.
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Chapter 4

Writing and Using Procedures

THE ONE THING YOU should have learned about programming in Visual Basic so far is that an
application is made up of small, self-contained segments. The code you write isn’t a monolithic list-
ing; it's made up of small segments called procedures, and you work on one procedure at a time.

For example, when you write code for a control’s Click event, you concentrate on the event at
hand—namely, how the program should react to the Click event. What happens when the con-
trol is double-clicked, or when another control is clicked, is something you will worry about later,
in another control’s event handler. This “divide and conquer” approach isn't unique to program-
ming events. It permeates the Visual Basic language, and even the longest applications are written
by breaking them into small, well-defined tasks. Each task is performed by a separate procedure
that is written and tested separately from the others.

Procedures are also used for implementing repeated tasks, such as frequently used calculations.
Suppose you're writing an application that, at some point, must convert temperatures between
different scales or calculate the smaller of two numbers. You can always do the calculations inline
and repeat them in your code wherever they are needed, or you can write a procedure that per-
forms the calculations and call this procedure. The benefit of the second approach is that code is
cleaner and easier to understand and maintain. If you discover a more efficient way to implement
the same calculations, you need change the code in only one place. If the same code is repeated in
several places throughout the application, you will have to change every instance.

The two types of procedures supported by Visual Basic are the topics we'll explore in this
chapter: subroutines and functions—the building blocks of your applications. We'll discuss them in
detail, how to call them with arguments and how to retrieve the results returned by the functions.
You may find that some of the topics discussed in this chapter are rather advanced, but I wanted
to exhaust the topic in a single chapter, rather than having to interrupt the discussion of other
topics to explain an advanced, procedure-related technique. You can skip the sections you find
difficult at first reading and come back to these sections later, or look up the technique as needed.
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Modular Coding

The idea of breaking a large apphcamon into smaller, more manageable sections is not new to com-
puting. Few tasks, programming or otherwise, can be managed as a whole. The event handlers are
just one example of breaking a large application into smaller tasks. Some event handlers may require
alot of code. A button that calculates the average purchase or sale price of a specific product must
scan all the purchase orders or invoices, find the ones that include the specific product, take into
consideration all units purchased or sold and the corresponding prices, and then calculate the average
price. You could calculate the net profit with the following statements, which will most likely appear
behind a button’s event handler:

RetrievePOLines(productID)

Suml = SumQtyPrice()

Qtyl = SumQuantities()
Retrievelnvoicelines(productID)
Sum2 = SumQtyPrice()

Net = (Sum2 - Suml) / Qtyl

The task is broken into smaller units, and each unit is implemented by a function or subroutine.
(T'll detine the difference between the two shortly.) The name of the procedure indicates the opera-
tion it performs. First, the RetrievePOLines() subroutine retrieves quantities and purchase prices of
a specific product—the productID argument—ifrom a database. The SumQtyPrice() function multi-
plies the quantities by prices at which they were sold and sums the results to get the total value paid
for the purchase of a specific product. This result is stored in the Sum1 variable. The SumQuantities()
function sums the unit quantities into the Qty1 variable.

The RetrievelnvoiceLines() subroutine gets similar data from the invoices in the database, so that
the SumQtyPrice() function can calculate the total income generated by the same product. The value
returned by the SqutyPriceO function is stored in the Sum2 variable.

The Qty! variable holds the total number of items purchased. We don'’t take into consideration
any units in stock, but we'll assume a very small, or zero, stock. In the last statement, the expression
(Sum2 - Suml) is the total profit, and, dividing by the quantity of units sold, we calculate the average
profit made by the specific product.

Even if you have no idea how to retrieve invoices from a database, you can understand what this
code segment does. You don’t know yet how it does it, but the functions themselves are also broken
into small, easy-to-understand parts. Besides, not all programmers in a team need to understand all
aspects of the application. Programmers who are responsible for producing charts don’t have to
understand how the data are actually retrieved from the database. As long as they have the proper
data, they can produce the required graphs.

Functions and subroutines are segments of code that perform well-defined tasks and can be called
from various parts of an application to perform the same operation, usually on different data. The
difference is that functions return a value, while subroutines don’t. This explains why function
names are assigned to a variable—we save the value returned by a function and reuse it later.
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As you can see, the divide-and-conquer approach in software is nothing less than a requirement
in large applications. It's so common in programming, that there’s a name for it: modular programming.
Ideally, every program should be broken down into really simple tasks, and the code should read
almost like English. You can write your application at a high level, and then start coding the low-
level procedures.

The best thing about modular programming is that it allows programmers with different skills to
focus on different parts of the application. A database programmer could write the RetrievePOLines()
and RetrievelnvoiceLines() procedures, while another programmer could use these procedures as black
boxes to build applications, just like the functions that come with the language. Imagine if you had to
write code to calculate the number of days between two dates without the advantage of the DateDiff()
function!

If you need a procedure to perform certain actions, such as changing the background color of a
control or displaying the fields of a record on the form, you can implement it either as a function or
subroutine. The choice of the procedure type isn’t going to aftect the code. The same statements can
be used with either type of procedure. However, if your procedure doesn’t return a value, then it
should be implemented as a subroutine. If it returns a value, then it must be implemented as a func-
tion. The only difference between subroutines and functions is that functions return a value, while
subroutines don’t.

Both subroutines and functions can accept arguments, which are values you pass to the procedure
when you call it. Arguments and the related keywords are discussed in detail in the section “Argu-
ments,” later in this chapter.

Subroutines

A subroutine is a block of statements that carries out a well-defined task. The block of statements is
placed within a set of Sub..End Sub statements and can be invoked by name. The following subrou-
tine displays the current date in a message box and can be called by its name, ShowDate():

Sub ShowDate()
MsgBox(Now())
End Sub

Normally, the task a subroutine performs is more complicated than this; nevertheless, even this is
a block of code isolated from the rest of the application. All the event handlers in Visual Basic, for
example, are coded as subroutines. The actions that must be performed each time a button is clicked
are coded in the button’s Click procedure.

The statements in a subroutine are executed, and when the End Sub statement is reached,
control returns to the calling program. It's possible to exit a subroutine prematurely, with the Exit
Sub statement. For example, some condition may stop the subroutine from successfully completing
its task.

All variables declared within a subroutine are local to that subroutine. When the subroutine exits,
all variables declared in it cease to exist.
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Most procedures also accept and act upon arguments. The ShowDate() subroutine displays the cur-
rent date on a message box. If you want to display any other date, you'd have to pass an argument to
the subroutine telling it to act on a different value, like this:

Sub ShowDate(ByVal birthDate As Date)
MsgBox(b1irthDate)
End Sub

birthDate is a variable that holds the date to be displayed; its type is Date. (The ByVal keyword means
that the subroutine sees a copy of the variable, not the variable itself. What this means practically is that
the subroutine can’t change the value of the birthDate variable.)

To display the current date on a message box, you must call the ShowDate subroutine as follows
from within your program:

ShowDate()
To display another date with the second implementation of the subroutine, use a statement like

the following:

Dim myBirthDate = #2/9/1960#
ShowDate(myBirthDate)

Or, you can pass the value to be displayed directly without the use of an intermediate variable:

ShowDate(#2/9/1960#)

SUBROUTINES AND EVENT HANDLERS

In the first couple of chapters, you learned to develop applications by placing code in event handlers.
An event handler is a segment of code that is executed each time an external (or internal to your appli—
cation) condition triggers the event. When the user clicks a control, the control’s Click event handler
executes. This handler is nothing more than a subroutine that performs all the actions you want to
perform when the control is clicked. It is separate from the rest of the code and doesn’t have to
know what would happen if another control was clicked, or if the same control was double-clicked.
It's a self-contained piece of code that’s executed when needed.

Every application is made up of event handlers, which contain code to react to user actions. Event
handlers need not return any results, and they’re implemented as subroutines. For example, to react
to the click of the mouse on the Buttonl control, your application must provide a subroutine that
handles the Button1.Click event. The code in this subroutine is executed indepenclently of any other
event handler, and it doesn’t return a result because there is no main program to accept it. The code
of a Visual Basic application consists of event handlers, which may call other subroutines and func-
tions but aren’t called by a main program. They are automatically activated by VB in response to
external events.

Functions

A function is similar to a subroutine, but a function returns a result. Subroutines perform a task and
don’t report anything to the calling program; functions commonly carry out calculations and report
the result. Because they return values, functions—Iike variables—have types. The value you pass
back to the calling program from a function is called the return value, and its type must match the type
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of the function. Functions accept arguments, just like subroutines. The statements that make up a
tunction are placed in a set of Function..End Function statements, as shown here:

Function NextDay() As Date
Dim theNextDay As Date
theNextDay = DateAdd(DateInterval.Day, 1, Now())
Return(theNextDay)

End Function

DateAdd() is a built-in function that adds a number of intervals to a date. The interval is speci-
tied by the first argument (here, it’s days), the number of intervals is the second argument (one day),
and the third argument is the date to which the number of intervals is added (today). So the Next-
Dayo function returns tomorrow’s date by adding one day to the current date. (The DateAdd()
function is described in the reference “VB.NET Functions and Statements” on the CD.) NextDayO
is a custom function, which calls the built-in DateAdd() function to complete its calculations.
Another custom function might call NeXtDayO for its own purposes.

The result of a function is returned to the calling program with the Return statement. In our
example, the Return statement happens to be the last statement in the function, but it could appear
anywhere; it could even appear several times in the function’s code. The first time a Return state-
ment is executed, the function terminates and control is returned to the calling program.

You can also return a value to the caﬂing routine by assigning the result to the name of the func-
tion. The foﬂowing is an alternate method of coding the NeXtDayO function:

Function NextDay() As Date
NextDay = DateAdd(DateInterval.Day, 1, Now())
End Function

Notice that this time I've assigned the result of the calculation to the function’s name directly and
didn’t use a variable.

Similar to variables, a custom function has a name, which must be unique in its scope. If you
declare a function in a form, the function name must be unique in the form. If you declare a function
as Public or Friend, its name must be unique in the project. Functions have the same scope rules as
variables and can be prefixed by many of the same keywords. In effect, you can modity the default
scope of a function with the keywords Public, Private, Protected, Friend, and Protected Friend.

BUILT-IN FUNCTIONS

Let’s look at a couple of functions, starting with one of the built-in functions, the AbsQ function.
This function returns the absolute value of its argument. If the argument is positive, the function
returns it as is; if it’s negative, the function inverts its sign. The AbsQ function could be imple—
mented as follows:

Function Abs(X As Double) As Double
If X >= 0 Then
Return(X)
Else
Return(-X)
End If
End Function
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This is a trivial procedure, yet it's built into Visual Basic because it's used frequently in math and
science calculations. Developers can call a single function rather than supplying their own Abs()
tunctions. Visual Basic and all other programming languages provide many built-in functions to
implement the tasks needed most frequently by developers. But each developer has special needs, and
you can't expect to find all the procedures you may ever need in a programming language. Sooner or
later, you will have to supply your own.

The NET Framework provides a large number of functions that implement common or compli-
cated tasks. There are functions for the common math operations, functions to perform calculations
with dates (these are complicated operations), financial functions, and many more. When you use
the built-in functions, you don’t have to know how they work internaﬂy.

The Pmt() function, for example, calculates the monthly payments on a loan. All you have to
know is the arguments you must pass to the function and retrieve the result. The syntax of the Pmt()
function is

MPay = Pmt(Rate, NPer, PV, FV, Due)

where MPay is the monthly payment, Rate is the monthly interest rate, NPer is the number of pay-
ments (the duration of the loan in months), and PV is the present value of the loan (the amount you
took from the bank). Due is an optional argument that specifies when the payments are due (the
beginning or the end of the month), and FV/is another optional argument that specifies the future
value of an amount; this isn’t needed in the case of a loan, but it can help you calculate how much
money you should deposit each month to accumulate a target amount over a given time. (The
amount returned by the Pmt() function is negative, because it’s a negative cash flow—it’s money
you owe—so pay attention to the sign of your values.)

To calculate the monthly payment for a $20,000 loan paid off over a period of 6 years at a fixed
interest rate of 7.25%, you call the Pmt() function as follows:

Dim mPay As Double

Dim Duration As Integer = 6 * 12

Dim Rate As Single = (7.25 / 100) / 12

Dim Amount As Single = 20000

mPay = Pmt(Rate, Duration, Amount)

MsgBox("Your monthly payment will be $" & -mPay & vbCrLf & _
"You will pay back a total of $" & -mPay * duration)

Notice that the interest (7.25%) is divided by 12, because the function requires the monthly inter-
est. The value returned by the function is the monthly payment for the loan specified with the Dura-
tion, Amount, and Rate variables. If you place the preceding lines in the Click event handler of a Button,
run the project, and then click the button, the following message will appear on a message box:

Your monthly payment will be $343.3861
You will pay back a total of $24723.8

To calculate the monthly deposit amount, you must call the Pmt() function passing O as the pres-
ent value and the target amount as the future value. Replace the statements in the Click event handler
with the following and run the project:

Dim mPay As Double
Dim Duration As Integer = 15 * 12
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Dim Rate As Single = (4 / 100) / 12

Dim Amount As Single = -40000

mPay = Pmt(Rate, Duration, 0, Amount)

MsgBox("A monthly deposit of $" & mPay & vbCrLf & _
"every month will yield $40,000 in 15 years")

It turns out that if you want to accumulate $40,000 over the next 15 years to send your kid to
college, assuming a constant interest rate of 4%, you must deposit $162.55 every month.

Pmto is one of the simpler financial functions provided by the Framework, but most of us would
tind it really difficult to write the code for this function. Since financial calculations are quite com-
mon in business programming, many of the functions you may need already exist, and all you need
to know is how to call them. The financial functions, along with all other built-in functions you can
use in your apphcations, are described in the reference “VB.NET Functions and Statements” (found
on the companion CD).

CUSTOM FUNCTIONS

The built-in functions, however, aren’t nearly enough for all types of applications. Most of the code
we write is in the form of custom functions, which are called from several places in the application.
Let’s ook at an example of a more advanced function that does something really useful.

Every book has a unique International Standard Book Number (ISBN). Every application that
manages books—and there are many bookstores on the Internet—needs a function to verify the
ISBN, which is made up of nine digits followed by a check digit. To calculate the check digit, you
multiply each of the nine digits by a constant; the first digit is multiplied by 10, the second digit is
multiplied by 9, and so on. The sum of these multiplications is then divided by 11, and we take the
remainder. The check digit is the remainder subtracted from 11. Because the remainder is a digit
from O to 10, when it turns out to be 10, the check digit is set to “X.” This is the only valid charac-
ter that may appear in an ISBN, and it can only be the check digit. To calculate the check digit for
the ISBN 078212283, compute the sum of the following products:

0% 10+ 7 %9+ 8% 8+2 %7 +1%6+2%5+2%4+8%3+3%2

The sum is 195, and when you divide that by 11, the remainder is 8. The check digit is 11 — 8§,
or 3, and the book’s complete ISBN is 0782122833. The ISBNCheckDigit() function, shown in
Listing 4.1, accepts the nine digits of the ISBN as argument and returns the appropriate check digit.

LISTING 4.1: THE ISBNCHECKDIGIT() CUSTOM FUNCTION

Function ISBNCheckDigit(ByVal ISBN As String) As String
Dim i As Integer, chksum, chkDigit As Integer
For i = 0 To 8
chkSum = chkSum + (10 - i) * ISBN.Substring(i, 1)
Next
chkDigit = 11 - (chkSum Mod 11)
If chkDigit = 10 Then
Return ("X")
Else
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Return (chkDigit.ToString)
End If
End Function

The ISBNCheckDigitO function returns a string value, because the check digit can be either a
digit or “X.” It also accepts a string, because the complete ISBN (nine digits plus the check digit) 1s
a string, not a number (leading zeros are important in an ISBN but totally meaningless 1N a numeric
value). The Substring method of a String object extracts a number of characters from the string it's
applied to. The first argument is the starting location in the string, and the second is the number of
characters to be extracted.

The expression ISBN.Substring(i, 1) extracts one character at a time from the ISBN string vari-
able. During the first iteration of the loop, it extracts the first character; during the second iteration,
it extracts the second character, and so on.

The character extracted is a numeric digit, which is multiplied by the value (10 - i) and the result
is added to the chkSum variable. This variable is the checksum of the ISBN. After it has been calcu-
lated, we divide it by 11 and take its remainder, which we subtract from 11. This is the ISBN’s

check digit and the function’s return value.

VB6 " VB.NET

There’s something odd about the way the .NET Framework handles strings. The index of the first character
inastringis 0, not 1. That’s why the loop that scans the first nine digits of the ISBN goes from o to 8. Because
the variable i is one less than the position of the digit in the ISBN, we subtract it from 10 and not from 11.
Up to the last version of Visual Basic, the indexing of strings started at 1, but .NET changed all that, and this
is something you must get used to.

You can use this function in an application that maintains a book database, to make sure that all
books are entered with a valid ISBN. You can also use it with a Web application that allows viewers
to request books by their ISBN. The same code will work with two different applications, even
when passed to other developers. Developers using your function don’t have to know how the check
digit is calculated, just how to call the function and retrieve its result.

To test the ISBNCheckDigitO function, start a new project, place a button on the form, and

enter the following statements in its Click event handler (or open the ISBN project in this chapter’s
folder on the CD):

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
Console.WriteLine("The check Digit is " & ISBNCheckDigit("078212283"))
End Sub

After inserting the code of the ISBNCheckDigit() function and the code that calls the function,
your code editor should look like Figure 4.1. You can place a TextBox control on the Form and pass
the Text property of the control to the ISBNCheckDigit() function to calculate the check digit.
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. Object Browser | Start Page | Formlovb [Desion]*  Forml.wb™ 4%
FIGURE 4.1

. ®igForm1 (ch4tests) r| [5®Buttont_ciick -
Calling the Publie Ciass Formi =
ISBNCheCleg[t() Inherits System.Windows.Forms.Form
function

Private Zuh Buttonl Click(EyVal sender s System.Chject, ByVal e As System.Eventirgs] Handles Buttoni.Click
Console.VriteLine("The check Digit is " & ISBNCheckDigit("432598435"))
End Sub

Function TSBNCheckDigit (ByVal ISEN As String] As String
Dim i As Integer, chkswn, chkDigit ks Integer
For i = 1 To 9
chicswm = chksws + (11 - 1) * Mid(ISBN, i, 1)
Hext
chkDigit = 11 - [chksws Hod 11}
If chksum = 11 Then
Return (%"
Else
Return ichkDigit.ToString)
End If
End Function
End Class

Calling Functions and Subroutines

When you call a procedure, you must supply values for all the arguments specitied in the procedure’s
definition and in the same order. To call a procedure, you simply enter its name, followed by 1ts
arguments in parentheses:

Dim chDigit As String
chDigit = ISBNCheckDigit("078212283")

The values of the arguments must match their declared type. If a procedure expects an integer
value, you shouldn’t supply a date value or a string. If the procedure is a function, you must assign its
return value to a variable so you can use it from within your code. The following statement creates

the complete ISBN by calling the ISBNCheckDigit() function:

Dim ISBN As String = "078212283"
MsgBox("The complete ISBN is " & ISBN & ISBNCheckDigit(ISBN))

The argument of the MsgBox() function needs a some explanation. It calls the ISBNCheck-
Digit() function, passing the ISBN as argument. Then it appends the check digit (which is the value
returned by the function) to the ISBN value and prints it. It is equivalent to the following state-
ments, which are simpler to read, but not nearly as common:

Dim wholeISBN As String
whoTeISBN = ISBN & ISBNCheckDigit(ISBN)
MsgBox("The complete ISBN is " & wholeISBN)

Functions are called by name, and a list of arguments follows the name in parentheses as shown:
Degrees = Fahrenheit(Temperature)

In this example, the Fahrenheit() function converts the Temperature argument (which presumably is
the temperature in degrees Celsius) to degrees Fahrenheit, and the result is assigned to the Degrees
variable.
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Functions can be called from within expressions, as the foﬂowing statement shows:

MsgBox("40 degrees Celsius are " & Fahrenheit(40).ToString & _
" degrees Fahrenheit")

Notice that the ToString method applies to the numeric value returned by the function, and you
need not implement it as part of your function. All numeric types provide the ToString method,
which converts the numeric value to a string.

Suppose the function CountWords() counts the number of words and the function
CountChars() counts the number of characters in a string. The average length of a word could be
calculated as follows:

Dim longString As String, avglLen As Double
TongString = TextBox1l.Text
avgLen = CountChars(longString) / CountWords(longString)

The first executable statement gets the text of a TextBox control and assigns it to a variable, which is
then used as an argument to the two functions. When the second statement executes, Visual Basic
tirst calls the functions CountChars()) and CountWords() with the specified arguments and then
divides the results they return.

You can call functions in the same way that you call subroutines, but the result won’t be stored
anywhere. For example, the function Convert() may convert the text in a textbox to uppercase and
return the number of characters it converts. Normally, you'd call this function as follows:

nChars = Convert()

If you don’t care about the return Value—you only want to update the text on a TextBox control—
you would call the Converto function with the following statement.

Convert()

VB6 '» VB.NET

The Call statement of VB6 has disappeared. Also, the parentheses around the argument list are manda-
tory, even if the subroutine or function doesn’t accept any arguments. You can no longer call a subroutine
with a statement like

ConvertText myText
You must enclose the arguments in a pair of parentheses:

ConvertText(myText)

Arguments

Subroutines and functions aren’t entirely isolated from the rest of the application. Most procedures
accept arguments from the calling program. Recall that an argument is a value you pass to the proce-
dure and on which the procedure usually acts. This is how subroutines and functions communicate
with the rest of the application.
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Functions also accept arguments—in many cases, more than one. The function Min(), for
instance, accepts two numbers and returns the smaller one:

Function Min(ByVal a As Single, ByVal b As Single) As Single
Min = IIf(a < b, a, b)
End Function

Hfo is a built-in function that evaluates the first argument, which is a Iogical expression. If the
expression is True, the HfO function returns the second argument. If the expression is False, the
function returns the third argument.

To call this function use a few statements like the following:
Dim vall As Single = 33.001

Dim val2 As Single = 33.0011

Dim smallerVal as Single

smallervVal = Min(vall, val2)

Console.Write("The smaller value is " & smallerVal)

If you execute these statements (place them in a button’s Click event handler), you will see the
following on the Output window:

The smaller value is 33.001
If you attempt to call the same function with two double values, as in a statement like the foﬂowing:
Console.WriteLine(Min(3.33000000111, 3.33000000222))

you will see the value 3.33 in the Output window. The compiler converted the two values from
Double to Single data type and returned one of them. Which one is it? It doesn’t make a difference,
because when converted to Single, both values are the same.

Interesting things will happen if you attempt to use the Min() function with the Strict option
turned on. Insert the statement Option Strict On at the very beginning of the file. First, the editor
will underline the statement that implements the Min() function—the IIf() function. The IIf()
function accepts two Object variables as arguments, and you can'’t call it with Single or Double val-
ues. The Strict option prevents the compiler from converting numeric values to objects. To use the
Hfo function with the Strict option, you must change 1ts implementation as follows:

Function Min(ByVal a As Object, ByVal b As Object) As Object
Min = IIf(Val(a) < Val(b), a, b)
End Function

Argument-Passing Mechanisms

One of the most important issues in writing procedures is the mechanism used to pass arguments.
The examples so far have used the default mechanism: passing arguments by value. The other mecha-
nism 1s passing them by reference. Although most programmers use the default mechanism, it’s
important to know the difference between the two mechanisms and when to use each.

PASSING ARGUMENTS BY VALUE

When you pass an argument by value, the procedure sees only a copy of the argument. Even if the
procedure changes it, the changes aren’t permanent. The benefit of passing arguments by value is that
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the argument values are isolated from the procedure, and only the code segment in which they are
declared can change their values. This is the default argument-passing mechanism in VB.NET.

To specify the arguments that will be passed by value, use the ByVal keyword in front of the
argument’s name. If you omit the ByVal keyword, the editor will insert it automatically, since it’s the
default option. To declare that the Degrees() function’s arguments are passed by value, use the
ByVal keyword in the argument’s declaration as follows:

Function Degrees(ByVal Celsius as Single) As Single
Degrees = (9 / 5) * Celsius + 32
End Function

To see what the By\/al keyword does, add a line that changes the value of the argument in the
function:

Function Degrees(ByVal Celsius as Single) As Single
Degrees = (9 / 5) * Celsius + 32
Celsius = 0

End Function

Now call the function as follows:

CTemp = InputBox("Enter temperature in degrees Celsius")
MsgBox(CTemp.ToString & " degrees Celsius are " & Degrees((CTemp)) & _
" degrees Fahrenheit")

If the value entered in the InputBox is 32, the following message 1s displayed:
32 degrees Celsius are 89.6 degrees Fahrenheit

Replace the ByVal keyword with the ByRef keyword in the function’s definition and call the

function as follows:

Celsius = 32.0

FTemp = Degrees(Celsius)

MsgBox(Celsius.ToString & " degrees Celsius are " & FTemp & _
" degrees Fahrenheit")

This time the program displays the following message:
0 degrees Celsius are 89.6 degrees Fahrenheit

‘When the Celsius argument was passed to the DegreesO function, its value was 32. But the func-
tion changed its value, and upon return it was 0. Because the argument was passed by reference, any
changes made by the procedure affected the variable permanently. When the calling program
attempted to use it, the variable had a different value than expected.

NOTE  When you pass arguments to a proredme by reference, you’re aftmzlly passing the variable itseb‘, Any ckanges made
to the argument by the procedwe will be permanent. When you pass arguments by value, the proazdwe gets a copy of the
variable, which is discarded when the proafdme ends. Any f}mnges made to the argument by the procedme won’t affect the
variable of the mllz’ng program.
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NOTE  When ‘you pass an array as argument 1o a proa’dme, the array is always passed by reference—even if you specify
the By Val /eeyword The reason for this is that it would take the machine some time to create a copy qf the array. Since the copy
of the array must also live in memory, passing too many arrays back and fortk by value would dqplete your system’s memory.

PASSING ARGUMENTS BY REFERENCE

Passing arguments by reference gives the procedure access to the actual variable. The calling proce-
dure passes the address of the variable in memory so that the procedure can change its value perma-
nently. With VB6, this was the default argument-passing mechanism, but this is no longer the case.

Start a new Visual Basic project and enter the following function definition in the form’s code
window:

Function Add(ByRef numl As Integer, ByRef num2 As Integer) As Integer
Add = numl + num2
numl = 0
num2 = 0

End Function

This simple function adds two numbers and then sets them to zero.
Next, place a Command button on the form and enter the foﬂowing code in the button’s Click
event:

Dim A As Integer, B As Integer
A =10

B =2

Dim Sum As Integer

Sum = Add(A, B)
Console.WriteLine(A)
Console.WriteLine(B)
Console.WritelLine(Sum)

This code displays the following results in the Output window:

0
0
12

The changes made to the function’s arguments take effect even after the function has ended. The
values of the variables 4 and B have changed value perrnanently.
Now change the definition of the function by nserting the keyword ByVal before the names of

the arguments, as follows:
Function Add(ByVal numl As Integer, ByVal num2 As Integer) As Integer

With this change, Visual Basic passes copies of the arguments to the function. The rest of the pro-
gram remains the same. Run the application, click the button, and the foﬂowing values display in the
Output window:

10
2
12
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The function has changed the values of the arguments, but these changes remain in effect only in
the function. The variables A and B in the Button1_Click event handler haven't been affected.

As you type the names of the arguments in the declaration of a subroutine or function, the editor
inserts automatically the ByVal keyword if you omit it (unless, of course, you specify the ByRef key-
word). In general, you pass arguments by reference only if the procedure has reason to change its
value. If the values of the arguments are required later in the program, you run the risk of changing
their values in the procedure.

Returning Multiple Values
If you want to write a function that returns more than a single result, you will most likely pass addi-
tional arguments by reference and set their values from within the function’s code. The following
function calculates the basic statistics of a data set. The values of the data set are stored in an array,
which is passed to the function by reference.

The Stats() function must return two values, the average and standard deviation of the data set. In
a real-world application, a function like Stats() should calculate more statistics than this, but this is
just an example to demonstrate how to return multiple values through the function’s arguments.
Here’s the declaration of the Stats() function:

Function Stats(ByRef Data() As Double, ByRef Avg As Double, _
ByRef StDev As Double) As Integer

The function returns an integer, which is the number of values in the data set. The two important
values calculated by the function are returned in the Avg and StDev arguments.

Function Stats(ByRef Data() As Double, ByRef Avg As Double, _
ByRef StDev As Double) As Integer
Dim i As Integer, sum As Double, sumSqr As Double, points As Integer
points = Data.lLength
For i = 0 To points - 1
sum = sum + Data(i)
sumSqr = sumSqr + Data(i) ™ 2
Next
Avg = sum / points
StDev = System.Math.Sqrt(sumSqr / points - Avg ~ 2)
Return(points)
End Function

To call the Stats() function from within your code, set up an array of doubles and declare two
variables that will hold the average and standard deviation of the data set:

Dim Values(100) As Double

' Statements to populate the data set

Dim average, deviation As Double

Dim points As Integer

points = Stats(Values, average, deviation)
Console.WriteLine points & " values processed."
Console.WriteLine "The average is " & average & " and"
Console.WriteLine "the standard deviation is " & deviation
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Using ByRef arguments is the simplest method for a function to return multiple values. However,
the definition of your functions may become cluttered, especially if you want to return more than a
tew values. Another problem with this technique is that it’s not clear whether an argument must be
set before caﬂing the function or not. As you will see shordy, 1t 1s possible for a function to return an
array, or a custom structure with fields for any number of values.

Passing Objects as Arguments

When you pass objects as arguments, they're passed by reference, even if you have specified the
ByVal keyword. The procedure can access and modify the members of the object passed as argu-
ment, and the new value will be visible in the procedure that made the call.

The following code segment demonstrates this. The object is an ArrayList, which is an enhanced
form of an array. The ArrayList is discussed in detail later in the book, but to follow this example all you
need to know is that the Add method adds new items to the ArrayList, and you can access individual
items with an index value, similar to an array’s elements. The Click event handler of a Button control cre-
ates a new instance of the ArrayList object and calls the PopulateList() subroutine to populate the list.
Even though the ArrayList object is passed to the subroutine by value, the subroutine has access to its
items:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click

Dim aList As New ArrayList()
PopulatelList(alList)
Console.WriteLine(aList(0).ToString)
Console.WriteLine(aList(1).ToString)
Console.WriteLine(aList(2).ToString)

End Sub

Sub PopulatelList(ByVal Tist As ArraylList)
Tist.Add("1")
Tist.Add("2")
Tist.Add("3")

End Sub

The same is true for arrays and all other collections. Even if you specify the By\/al keyword,
they’re passed by reference. A more elegant method of modifying the members of a structure from
within a procedure 1s to implement the procedure as a function returning a structure, as eXplained n
the section “Functions Returning Structures,” later in this chapter.

Event-Handler Arguments

In this section, we're going to look at the implementation of event handlers as subroutines. Event han-
dlers never return a result, so they're implemented as subroutines. In specific, we're going to examine
the two arguments that are common to all event handlers, which pass information about the object
and the action that invoked the event.

You may have noticed that the subroutines that handle events accept two arguments: sender and e.
Here’s the declaration of the Click event handler for a button:

Private Sub Buttonl Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
End Sub
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The sender argument conveys information about the object that initiated the event; we use this
argument in our code to find out the type of the object that raised the event. The following two
statements in a button’s Click event handler will print the values shown in bold on the Output
window:

Console.WriteLine(sender.ToString)
System.Windows.Forms.Button, Text: Buttonl

Console.WriteLine(sender.GetType)
System.Windows.Forms.Button

The second argument contains all the information you really need to process the event. The ¢
argument is an object that exposes some properties, which vary depending on the type of the event
and the control that raised the event. A TextBox control, for example, raises several events when a
key 1s pressed, in addition to the events of the mouse. The information you need to process the dif-
ferent types of events is passed to your application through the second argument of the event han-
dler.

Let’s examine the members of this argument for two totally different event types. The ¢ argument
passed to the Click event handler has no special properties. All the information you reaﬂy need is
that a button was clicked and nothing more. The location of the pointer, for example, doesn’t make
any difference in your code, neither do you care about the status of the various control keys. Regard—
less of whether the Alt or the Shift key was down or not when the left mouse button was clicked,
your application will be notified about the Click event. If you want to capture the state of the con-
trol keys and react differently depending on their status, you must program the handler of the
MouseDown or MouseUp events. These events are raised when the mouse is pressed or released and
are independent of the Click event.

THE MOUSE EVENTS

Every time you click the mouse, a series of events is triggered. When you perform a single click, your
application receives a MouseDown event, then a Click event, and then a MouseUp event. You get
mouse events even as you scroll the mouse over a control: the MouseEnter when the mouse enters
the control, a series of MouseMove events as you move the mouse over the control, a MouseHover
event if you hover the mouse over the control, and a MouseLeave event as soon as the pointer gets
outside the bounds of the control. Different mouse events report different information to the appli-
cation through the arguments of the appropriate event handler, and this information is passed to
your application in the form of properties of the ¢ argument. The ¢ argument of most mouse events
provides the following properties.

Button

This property returns the button that was pressed, and its value is one of the members of the
MouseButtons enumeration: Left, Middle, None, Right, XButtonl, and XButton2. The last two mem-
bers of the enumeration are for five-button mice and correspond to the two side buttons. The But-
ton property is present in events that involve the button of the mouse. The ¢ argument of the Click
and DoubleClick events, however, doesn’t provide a Button property; these two events can only be
triggered with the left button.
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Clicks

This property returns the number of times the mouse button was pressed and released. Its value is 1
for a single click and 2 for a double-click. You can’t click a control three times—as soon as you
click it for the second time, a double-click event will be raised.

Delta

This property is used with wheel mice; it reads the number of detents (that is, notches or stops) that
the mouse wheel was rotated. You can use this property to figure out how much a TextBox control
was scrolled (or any other control that can be scrolled with a scrollbar).

XY

These two properties return the coordinates of the pointer at the moment the mouse button was
pressed (in the MouseDown event) or released (in the MouseUp event). The coordinates are
expressed in pixels in the client’s area. If you click a Button control at the very first pixel (its top-left
corner), the X and Y properties will be O.

The same properties are exposed by both the MouseDown and MouseUp events. Notice that
these two events are fired regardless of which button was pressed—unlike the Click and Dou-
bleClick events, which can’t be triggered with a button other than the left one.

The X and Y properties may be different for the MouseDown and MouseUp events. For
example, you can press a button and hold it down while you move the pointer around. When you
release the button, its coordinates will be different than the coordinates reported by the Mouse-
Down event. If you move the mouse outside the control in which you pressed the button, the coor-
dinates may exceed the dimensions of the control, or even be negative. They are the distances of the
pointer, at the moment you released the button, from the top-left corner of the control.

Insert the following code in a Button's MouseDown and MouseUp event handlers:

Private Sub Buttonl_MouseDown(ByVal sender As Object, _
ByVal e As System.Windows.Forms.MouseEventArgs) _
Handles Buttonl.MouseDown
Console.WriteLine("Button pressed at " & e. X & ", " & e.Y)
End Sub
Private Sub Buttonl_MouseUp(ByVal sender As Object, _
ByVal e As System.Windows.Forms.MouseEventArgs) _
Handles Buttonl.MouseUp
Console.WriteLine("Button released at " & e. X & ", " & e.Y)
End Sub

If you press and release the mouse at a single point, both handlers will report the same point. If
you move the pointer before releasing the button, you will see four values like the following:

Button pressed at 63, 16
Button released at -107, -68

As you can guess, the mouse button was pressed while the pointer was over the Button control,
and it was released after the pointer was moved to the left and above the Button control.
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THE KEY EVENTS

The TextBox control recognizes the usual mouse events, but the most important events in program-
ming the TextBox (or other controls that accept text) are the key events, which are raised when a key
is pressed, while the control has the focus. The KeyPress event is fired every time a key is pressed.
This event reports the key that was pressed. You can have finer control over the user’s interaction
with the keyboard with the KeyDown and KeyUp events, which are fired when a key is pressed and
released respectively. The KeyDown event handler’s definition is:

Private Sub TextBox1l_KeyDown(ByVal sender As Object, _
ByVal e As System.Windows.Forms.KeyEventArgs) _
HandTes TextBox1.KeyDown

The second argument of the KeyDown and KeyUp event handlers provides information about
the status of the keyboard and the key that was pressed through the following properties.

Alt, Control, Shift

These three properties return a True/False value indicating whether one or more of the control keys
were down when the key was pressed.

KeyCode

The KeyCode property returns the code of the key that was pressed, and its value can be one of the
members of the Keys enumeration. This enumeration contains a member for all keys, including the
mouse keys, and its members are displayed ina drop—down list when you need them. Notice that
each key has its own code, which usually corresponds to two different characters. The “a” and “A”
characters, for example, have the same code, the KeysA member. The code of the key “0” on the
numeric keypad is the member Key0, and the function key F1 has the code KeyF1.

KeyData

This property returns a value that identifies the key pressed, similar to the KeyCode property, but it
also distinguishes the character or symbol on the key. The KeyCode for the 4 key 1s 52, regardless of
whether it was pressed with the Shift key or not. The same KeyCode value appiies to the § symboL
because they’re both on the same key. The KeyData values for the same two characters are two long
values that include the status of the control keys. The value of the KeyData property is a member of
the Keys enumeration.

KeyValue

This property returns the keyboard value for the key that was pressed. It's usually the same as the Key-
Data value, but certain keys don’t report a value (the control keys, for example, don’t report a KeyValue).

Passing an Unknown Number of Arguments

Generally, all the arguments that a procedure expects are listed in the procedure’s definition, and the
program that calls the procedure must supply values for all arguments. On occasions, however, you
may not know how many arguments will be passed to the procedure. Procedures that calculate aver-
ages or, in general, process multiple values can accept a few to several arguments whose count is not
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known at design time. In the past, programmers had to pass arrays with the data to similar proce-
dures. Visual Basic supports the ParamArray keyword, which allows you to pass a variable number
of arguments to a procedure.

Let’s look at an example. Suppose you want to populate a ListBox control with elements. To add
an item to the ListBox control, you call the Add method of its Items collection as follows:

ListBox1l.Items.Add("new item")

This statement adds the string “new item” to the ListBox1 control.

If you frequently add multiple items to a ListBox control from within your code, you can write a
subroutine that performs this task. The following subroutine adds a variable number of arguments
to the ListBox1 control:

Sub AddNamesTolList(ParamArray ByVal NamesArray() As Object)
Dim x As Object
For Each x In NamesArray
ListBox1l.Items.Add(x)
Next x
End Sub

This subroutine’s argument is an array prefixed with the keyword ParamArray. This array holds
all the parameters passed to the subroutine. To add items to the list, call the AddNamesToList()

subroutine as follows:
AddNamesTolList("Robert", "Manny", "Renee", "Charles", "Madonna')

If you want to know the number of arguments actually passed to the procedure, use the Length
property of the parameter array. The number of arguments passed to the AddNamesToList() sub-

routine is given by the expression:
NamesArray.Length

The following loop goes through all the elements of the NamesArray and adds them to the list:

Dim i As Integer

For i = 0 to NamesArray.GetUpperBound(0)
ListBox1l.Items.Add(NamesArray(i))

Next i

If you want to use the array’s Length property, write a loop like the following:

Dim i As Integer

For i = 0 to NamesArray.Length - 1
ListBox1l.Items.Add(NamesArray(i))

Next i

A procedure that accepts multiple arguments relies on the order of the arguments. To omit some
of the arguments, you must use the corresponding comma. Let’s say you want to call such a proce-
dure and specify the first, third, and fourth arguments. The procedure must be called as:

ProcName(argl, , arg3, arg4)
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The arguments to similar procedures are usually of equal stature, and their order doesn’t make
any difference. A function that calculates the mean or other basic statistics of a set of numbers, or a
subroutine that populates a ListBox or ComboBox control, are prime candidates for implementing
using this technique. If the procedure accepts a variable number of arguments that aren’t equal in
stature, then you should consider the technique described in the following section.

Named Arguments

You've learned how to write procedures with optional arguments and how to pass a variable number
of arguments to the procedure. The main limitation of the argument-passing mechanism, though, is
the order of the arguments. If the first argument is a string and the second is a date, you can’t change
their order. By default, Visual Basic matches the values passed to a procedure to the declared argu-
ments by their order. That's why the arguments you've seen so far are called positional arguments.

This limitation s lifted by Visual Basic’s capability to specify named arguments. With named argu-
ments, you can supply arguments in any order, because they are recognized by name and not by their
order in the list of the procedure’s arguments. Suppose you've written a function that expects three
arguments: a name, an address, and an e-mail address:

Function Contact(Name As String, Address As String, EMail As String)

‘When calling this function, you must supply three strings that correspond to the arguments Narne,
Address, and EMail, in that order. However, there’s a safer way to call this function: supply the argu-
ments in any order by their names. Instead of caﬂing the Contact function as follows:

Contact("Peter Evans", "2020 Palm Ave., Santa Barbara, CA 90000", _
"PeterEvans@example.com")

you can call it this way:

Contact(Address:="2020 Palm Ave., Santa Barbara, CA 90000", _
EMail:="PeterEvans@example.com", Name:="Peter Evans")

The := operator assigns values to the named arguments. Because the arguments are passed by name,
you can supply them in any order.
To test this technique, enter the following function declaration in a form’s code:

Function Contact(ByVal Name As String, ByVal Address As String, _
ByVal EMail As String) As String
Console.WriteLine(Name)
Console.WriteLine(Address)
Console.WriteLine(EMail)
Return ("OK")
End Function

Then, call the Contact() function from within a button’s Click event with the following
statement:

Console.WriteLine(Contact(Address:="2020 Palm Ave., Santa Barbara, CA 90000", _
Name:="Peter Evans", EMail:="PeterEvans@example.com"))
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You'll see the foﬂowing in the Immediate window:

Peter Evans

2020 Palm Ave., Santa Barbara, CA 90000
PeterEvans@example.com

OK

The function knows which value corresponds to which argument and can process them the same
way that it processes positional arguments. Notice that the function’s definition is the same whether
you call it with positional or named arguments. The difference is in how you call the function and
how you declare it.

Named arguments make code safer and easier to read, but because they require a lot of typing,
most programmers don’t use them. Besides, programmers are so used to positional arguments that
the notion of naming arguments is like having to declare variables when variants will do. Named
arguments are good for situations in which you have optional arguments that require many consecu-
tive commas, which may cornplicate the code. The methods of the various objects exposed by the
Office applications (discussed n Chapter 10) require a large number of arguments, and they’re fre-
quently called with named arguments.

More Types of Function Return Values

Functions are not limited to returning simple data types like integers or strings. They may return cus-
tom data types and even arrays. The ability of functions to return all types of data makes them very
flexible and can simplify coding, so we'll explore it in detail in the following sections. Using complex
data types, such as structures and arrays, allows you to write functions that return multiple values.

FUNCTIONS RETURNING STRUCTURES

Suppose you need a function that returns a customer’s savings and checking balances. So far, you've
learned that you can return two or more values from a function by supplying arguments with the ByRef
keyword. A more elegant method s to create a custom data type (a structure) and write a function that
returns a variable of this type. The structure for storing balances could be declared as follows:

Structure CustBalance
Dim BalSavings As Decimal
Dim BalChecking As Decimal
End Structure

Then, you can define a function that returns a CustBalance data type as:

Function GetCustBalance(ByVal custID As Integer) As CustBalance
{ statements }
End Function

The GetCustBalance() function must be defined in the same module as the declaration of the cus-
tom data type it returns. If not, you'll get an error message.

‘When you call this function, you must assign its result to a variable of the same type. First declare
a variable of the CustBalance type and then use it as shown here:

Private Balance As CustBalance
Dim custID As Integer
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custID = 13011

Balance = GetCustBalance(custID)
Console.WriteLine(Balance.BalSavings)
Console.WriteLine(Balance.BalChecking)

Here, custID is a customer’s ID (a number or string, depending on the application). Of course, the
function’s body must assign the proper values to the CustBalance variable’s fields.

Here's the simplest example of a function that returns a custom data type. This example outlines

the SthS YOLI must repeat every time you want to create functions that return custom data types:

1.

Create a new project and insert the declarations of a custom data type in the declarations sec-
tion of the form:

Structure CustBalance
Dim BalSavings As Decimal
Dim BalChecking As Decimal
End Structure

Then implement the function that returns a value of the custom type. You must declare a
variable of the type returned by the function and assign the proper values to its fields. The
following function assigns random values to the fields BalChecking and BalSavings. Then, assign
the variable to the function’s name, as shown next:

Function GetCustBalance(ID As Long) As CustBalance
Dim tBalance As CustBalance
tBalance.BalChecking = CDec(1000 + 4000 * rnd())
tBalance.BalSavings = CDec(1000 + 15000 * rnd())
GetCustBalance = tBalance

End Function

Then place a button on the form from which you want to call the function. Declare a variable
of the same type and assign to it the function’s return value. The example that follows prints
the savings and checking balances on the Output window:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim balance As CustBalance
balance = GetCustBalance(1l)
Console.WriteLine(balance.BalChecking)
Console.WriteLine(balance.BalSavings)
End Sub

For this example, I created a project with a single form. The form contains a single Command

button whose Click event handler is shown here. Create this project from scratch, perhaps using your

own custom data type, to explore its structure and experiment with functions that return custom
data types.

In the following section, I'll describe a more complicated (and practical) example of a custom
data type function.
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VB.NET AT WORK: THE TYPES PROJECT

The Types project, which you'll find in this chapter’s folder on the CD, demonstrates a function
that returns a custom data type. The Types project consists of a form that displays record fields and
is shown in Figure 4.2. Every time you click the View Next button, the fields of the next record are
displayed. When all records are exhausted, the program wraps back to the first record.

FIGURE 4.2 [® 1ypes Demo B[]
The Types project Company The Cradher Box |
demonstrates Customer Since 17171999 |
functions that Address 55 Gty R T |
v o |
return custom
N = a—
data types. s [T
‘ View Next |

The project consists ofa single form. The following custom data type appears in the form’s code,
outside any procedure:

Structure Customer
Dim Company As String
Dim Manager As String
Dim Address As String
Dim City As String
Dim Country As String
Dim CustomerSince As Date
Dim Balance As Decimal
End Structure
Private Customers(8) As Customer
Private cust As Customer
Private currentIndex as Integer

The array Customers holds the data for nine customers, and the cust variable is used as a temporary
variable for storing the current customer’s data. The currentIndex variable is the index of the current
element of the array.

The Click event handler of the View Next button calls the GetCustomer() function with an index
value (Which is the order of the current customer), and displays its fields in the Label controls on the
form. Then it increases the value of the currentIndex variable, so that it points to the next customer.

The GetCustomer() function returns a variable of Customer type (the variable aCustomer). The
code behind the View Next button follows:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
If currentIndex = CountCustomers() Then currentIndex = 0
Dim aCustomer As Customer
aCustomer = GetCustomer(currentIndex)
ShowCustomer(currentIndex)
currentIndex = currentIndex + 1
End Sub
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The CountCustomers() function returns the number of records stored in the Customers array. The
event handler starts by comparing the value of the current index to the number of elements in the
Customers array. If they’re equal, the currentIndex variable is reset to zero. The definitions of the
CountCustomers() and GetCustomer() functions are shown next:

Function CountCustomers() As Integer
Return(Customers.Length)

End Function

Function GetCustomer(ByVal idx As Integer) As Customer
Return(Customers(idx))

End Function

Finally, the ShowCustomer() subroutine displays the fields of the current record on the Label

controls on the form:

Sub ShowCustomer(ByVal idx As Integer)
Dim aCustomer As Customer
aCustomer = GetCustomer(idx)
Tb1Company.Text = aCustomer.Company
1b1Since.Text = aCustomer.CustomerSince
TbTAddress.Text = aCustomer.Address
Tb1City.Text = aCustomer.City
Tb1Country.Text = aCustomer.Country
Tb1Balance.Text = aCustomer.Balance

End Sub

The array Custormers 1s populated when the program starts with a call to the InitDataO subroutine
(also in the project’s module). The program assigns data to Customers, one element at a time, with
statements like the foﬂowing:

Dim cust As Customer

cust.Company = "Bottom-Dollar Markets"
cust.Manager = "Elizabeth Lincoln"
cust.Address = "23 Tsawassen Blvd."
cust.City = "Tsawassen"

cust.Country = "Canada"

cust.CustomerSince = #10/20/1996#
cust.Balance = 33500
Customers(1l) = cust

The code assigns values to the fields of the cust variable and then assigns the entire variable to an
element of the Customers array. The data could originate in a file or even a database. This wouldn’t
affect the operation of the application, which expects the GetCustomer() function to return a record
of Customer type. If you decide to store the records in a file or a collection like the ones discussed in
Chapter 11, the form’s code need not change; only the implementation of the GetCustomer() func-
tion will change. You should also change the CountCustomers() function, so that it detects when it
has reached the last record.
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The Types project uses a single button that allows users to view the next record. You can place
another button that displays the previous record. This button’s code will be identical to the code of
the eXisting button, with the exception that it will decrease the currentIndex variable.

FUNCTIONS RETURNING ARRAYS

In addition to returning custom data types, VB.NET functions can also return arrays. This is an
interesting possibility that allows you to write functions that return not only multiple values, but
also an unknown number of values. Earlier in the chapter you saw how to return multiple values
from a function as arguments, passed to the function by reference. You can also consider a custom
structure as a collection of values. In this section, we’ll revise the Stats() function that was described
earlier in this chapter, so that it returns the statistics in an array. The new Stats() function will return
not only the average and the standard deviation, but the minimum and maximum values in the data
set as well. One way to declare a function that calculates all the statistics is the following:

Function Stats(ByRef DataArray() As Double) As Double()

This function accepts an array with the data values and returns an array of doubles. This notation is
more compact and helps you write easier-to-read code.
To implement a function that returns an array, you must do the following:

1. Specify a type for the function’s return value, and add a pair of parentheses after the type’s
name. Don’t specify the dimensions of the array to be returned here; the array will be declared
formaﬂy in the function.

2. In the function’s code, declare an array of the same type and specify its dimensions. If the
function should return four values, use a declaration like this one:

Dim Results(3) As Double

The Results array will be used to store the results and must be of the same type as the func-
tion—its name can be anything.

3. To return the Results array, simply use it as argument to the Return statement:
Return(Results)

4. In the calling procedure, you must declare an array of the same type without dimensions:
Dim Stats() As Double

5. Finally, you must call the function and assign its return value to this array:
Stats() = Stats(DataSet())

Here, DataSet is an array with the values whose basic statistics will be calculated by the Stats()
function. Your code can then retrieve each element of the array with an index value as usual.

VB.NET AT WORK: THE STATISTICS PROJECT
The next project demonstrates how to design and call functions that return arrays. It’s the Statistics

project, which you can find in this chapter’s folder on the CD. When you run it, the Statistics appli—

cation creates a data set Of random Values and then calis the ArrayStatsQ function to calculate the
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data set’s basic statistics. The results are returned in an array, and the main program displays them in
Label controls, as shown in Figure 4.3. Every time the Calculate Statistics button is clicked, a new
data set is generated and its statistics are displayed.

FIGURE 4.3 =IOl x|
S atiats _ 504.113306665846 | |Average 479.120781674645
The Statistics pro 170.300684319376 j Std, Deviation 285 516046502262
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: ‘o B67.113677257259
basic statistics of a 211 11o0enresan
607.827496066609
data set and returns 15 075015349158
hem i 369.062981740135
them 1n an array. 927.127046942304
£48.145541850545
660.076041164378
347.2023913118598 =/

Let's start with the ArrayStatsO function’s code, which is shown in Listing 4.2.

LISTING 4.2: THE ARRAYSTATS() FUNCTION

Function ArrayStats(ByVal DataArray() As Double) As Double()
Dim Result(3) As DoubTle
Dim Sum, SumSquares, DataMin, DataMax As Double
Dim DCount, i As Integer

Sum = 0
SumSquares = 0
DCount = 0

DataMin = System.Double.MaxValue

DataMax = System.Double.MinValue

For i = 0 To DataArray.GetUpperBound(0)
Sum = Sum + DataArray(i)
SumSquares = SumSquares + DataArray(i) ~ 2
If DataArray(i) > DataMax Then DataMax DataArray(i)
If DataArray(i) < DataMin Then DataMin = DataArray(i)
DCount = DCount + 1

Next

Dim Avg, StdDev As Double

Avg = Sum / DCount

StdDev = Math.Sqrt(SumSquares / DCount - Avg " 2)

Resu1t(0) = Avg

Result(1l) = StdDev

Result(2) = DataMin

Result(3) = DataMax

ArrayStats = Result

End Function
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The function’s return type is Double(), meaning the function will return an array of doubles; that’s
what the empty parentheses signify. This array is declared in the function’s body with the statement:

Dim Result(3) As Double

The function performs its calculations and then assigns the values of the basic statistics to the ele-
ments of the array Result. The first element holds the average, the second element holds the standard
deviation, and the other two elements hold the minimum and maximum data values. The Resulr array
is finally returned to the calling procedure by the statement that assigns the array to the function
name, just as you'd assign a variable to the name of the function that returns a single result.

The code behind the Calculate Statistics button, which calls the ArrayStats() function, is shown
in Listing 4.3.

LISTING 4.3: CALCULATING STATISTICS WITH THE ARRAYSTATS() FUNCTION

Protected Sub Button2_Click(ByVal sender As Object, _
ByVal e As System.EventArgs)
Dim SData(99) As Double
Dim Stats() As Double
Dim i As Integer
Dim rnd As New System.Random()
ListBox1l.Items.Clear()
For i = 0 To 99
SData(i) = rnd.NextDouble() * 1000
ListBox1l.Items.Add(SData(i))
Next
Stats = ArrayStats(SData)
TextBox1l.Text = "Average"' & vbTab & vbTab & Stats(0)
TextBox1l.Text = TextBox1l.Text & cvCrLf & "Std. Deviation" & vbTab & Stats(1l)
TextBox1l.Text = TextBox1l.Text & vbCrLf & "Min. Value" & vbTab & Stats(2)
TextBox1l.Text = TextBoxl.Text & vbCrLf & "Max. Value" & vbTab & Stats(3)
End Sub

The code generates 100 random values and displays them on a ListBox control. Then, it calls the
ArrayStats() function, passing the data values to it through the SData array. The function’s return
values are stored in the Swss array, which is declared as double but without dimensions. Then, the
code displays the basic statistics on a TextBox control, one item per line.

Overloading Functions

There are situations where the same function must operate on different data types, or a different
number of arguments. In the past, you had to write different functions, with different names and dif-
ferent arguments, to accommodate similar requirements. VB.INET introduces the concept of function
overloading, which means that you can have multiple implementations of the same function, each with
a different set of arguments and, possibly, a different return value. Yet, all overloaded functions
share the same name. Let me introduce this concept by examining one of the many overloaded func-
tions that come with the NET Framework.
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To generate a random number in the range from O to 1 (exclusive), use the NextDouble method
of the System.Random class. To use the methods of the Random class, you must first create an
instance of the class and then call the methods:

Dim rnd As New System.Random

Console.WriteLine("Three random numbers")

Console.Write(rnd.NextDouble() & " — " & rnd.NextDouble() & " — '
rnd.NextDoubTle())

&

The random numbers that will be printed on the Output window will be double precision values
in the range O to 1:

0.656691639058614 — 0.967485965680092 — 0.993525570721145

More often than not, we need integer random values. The Next method of the System.Random
class returns an integer value from —2,147,483,648 to 2,147,483,647 (this is the range of values
that can be represented by the Integer data type). We also want to generate random numbers in a
limited range of integer values. To emulate the throw of a dice, we want a random value in the range
from 1 to 6, while for a roulette game we want an integer random value in the range from O to 36.
You can specify an upper limit for the random number with an optional integer argument. The fol-
lowing statement will return a random integer in the range from O to 99:

randomInt = rnd.Next(100)

Finally, you can specify both the lower and upper limits of the random number’s range. The fol-
lowing statement will return a random integer in the range from 1,000 to 1,999:

randomInt = rnd.Next(1000, 2000)

The same method behaves differently based on the arguments we supply. The behavior of the
method depends either on the type of the arguments, the number of the arguments, or both of them.
As you will see, there’s no single function that alters its behavior based on its arguments. There are as
many different implementations of the same function as there are argument combinations. All the
functions share the same name, so that they appear to the user as a single, multifaceted function.
These functions are overloaded, and you'll see in the following section how they’re implemented.

If you haven’t turned off the IntelliSense feature of the editor, then as soon as you type the open-
ing parenthesis after a function or method name, you see a yellow box with the syntax of the func-
tion or method. You'll know that a function is overloaded when this box contains a number and two
arrows. Each number corresponds to a different overloaded form, and you can move to the next or
previous overloaded form by clicking the two little arrows or by pressing the arrow keys.

Let’s return to the Min() function we implemented earlier in this chapter. The initial implemen-
tation of the Min() function is shown next:

Function Min(ByVal a As Double, ByVal b As Double) As Double
Min = IIf(a < b, a, b)
End Function

By accepting double values as arguments, this function can handle all numeric types. VBINET
performs automatically widening conversions (it can convert integers and decimals to doubles), SO
this trick makes our function work with all numeric data types. However, what about strings? If you
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attempt to call the Min() function with two strings as arguments, you'll get an exception. The Min()
tunction just can’t handle strings.

To write a Min() function that can handle both numeric and string values, you must, in essence,
write two Min() functions. All Min() functions must be prefixed with the Overloads keyword. The

foHowing statements show two different implementations of the same function:

Overloads Function Min(ByVal a As Double, ByVal b As Double) As Double
Min = IIf(a < b, a, b)

End Function

Overloads Function Min(ByVal a As String, ByVal b As String) As String
Min = IIf(a < b, a, b)

End Function

As you may have guessed, we need a third overloaded form of the same function to compare
dates. It you call the Min() function with two dates are arguments, as in the following statement, the
Min() function will compare them as strings.

Console.WriteLine(Min(#1/1/2001#, #3/4/2000#))

This statement will print the date 1 /1/2001, which is not the smaller (earlier) date. If you swap

the years and call the function as
Console.WriteLine(Min(#1/1/2000#, #3/4/2001#))

you'll get the earlier date, but just because it happens that their alphanumeric order is now the same
as their chronological order.
The overloaded form of the function that accepts dates as arguments is shown next:

Overloads Function Min(ByVal a As Date, ByVal b As Date) As Date
Min = IIf(a < b, a, b)
End Function

If you now call the Mino function with the dates #1/1/2001# and #3/4/20004#, the function will
return the second date, which is chronologically smaller than the first.

OK, the exarnple of the Mino function is rather trivial. You can also write a Mino function that
compares two objects and handle all other data types. Let’s look into a more complicated overloaded
function, which makes use of some topics discussed later in this book. The CountFilesO function
counts the number of files that meet certain criteria. The criteria could be the size of the files, their
type, or the date they were created. You can come up with any combination of these criteria, but
here are the most useful combinations. (These are the functions I would use, but you can create even
more combinations, or introduce new criteria of your own.> The names of the arguments are self-
descriptive, so I need not explain what each form of the CountFﬂesO function does.

CountFiles(ByVal minSize As Integer, ByVal maxSize As Integer) As Integer
CountFiles(Byval fromDate As Date, ByVal toDate As Date) As Integer
CountFiles(Byval type As String) As Integer
CountFiles(ByVal minSize As Integer, ByVal maxSize As Integer, _

Byval type As String) As Integer
CountFiles(Byval fromDate As Date, ByVal toDate As Date, _

ByVal type As String) As Integer
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Listing 4.4 shows the implementation of these overloaded forms of the CountFiles() function.
Since we haven’t discussed files yet, most of the code in the function’s body will be new to you—but
it's not hard to follow. For the benefit of readers who are totally unfamiliar with file operations, I've
included a statement that prints on the Output window the type of files counted by each function.
The Console.WritelLine statement prints the values of the arguments passed to the function, along
with a description of the type of search it’s going to perform. The overloaded form that accepts two
integer values as arguments prints something like:

You've requested the files between 1000 and 100000 bytes

while the overloaded form that accepts a string as argument prints the following:

You've requested the .EXE files

LISTING 4.4: THE OVERLOADED IMPLEMENTATIONS OF THE COUNTFILES() FUNCTION

Overloads Function CountFiles(ByVal minSize As Integer, _
ByVal maxSize As Integer) As Integer
Console.WriteLine("You've requested the files between " & minSize & _
"and " & maxSize & " bytes")
Dim files() As String
files = System.IO.Directory.GetFiles("c:\windows")
Dim i, fileCount As Integer
For i = 0 To files.GetUpperBound(0)
Dim FI As New System.IO.FileInfo(files(i))
If FI.Length >= minSize And FI.Length <= maxSize Then
fileCount = fileCount + 1
End If
Next
Return(fileCount)
End Function
Overloads Function CountFiles(ByVal fromDate As Date, _
ByvVal toDate As Date) As Integer
Console.WriteLine("You've requested the count of files created from " & _
fromDate & " to " & toDate)
Dim files() As String
files = System.IO.Directory.GetFiles("c:\windows")
Dim i, fileCount As Integer
For i = 0 To files.GetUpperBound(0)
Dim FI As New System.IO.FileInfo(files(i))
If FI.CreationTime.Date >= fromDate And _
FI.CreationTime.Date <= toDate Then
fileCount = fileCount + 1
End If
Next
Return(fileCount)
End Function
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Overloads Function CountFiles(ByVal type As String) As Integer
Console.WriteLine("You've requested the " & type & " files")
Dim files() As String
files = System.IO.Directory.GetFiles("c:\windows")
Dim i, fileCount As Integer
For i = 0 To files.GetUpperBound(0)
Dim FI As New System.IO.FileInfo(files(i))
If FI.Extension = type Then
fileCount = fileCount + 1
End If
Next
Return(fileCount)
End Function
Overloads Function CountFiles(ByVal minSize As Integer, _
ByVal maxSize As Integer, ByVal type As String) As Integer
Console.WriteLine("You've requested the " & type & " files between " & _
minSize & " and " & maxSize & " bytes")
Dim files() As String
files = System.IO.Directory.GetFiles("c:\windows")
Dim i, fileCount As Integer
For i = 0 To files.GetUpperBound(0)
Dim FI As New System.IO.FileInfo(files(i))
If FI.Length >= minSize And _
FI.Length <= maxSize And _
FI.Extension = type Then
fileCount = fileCount + 1
End If
Next
Return(fileCount)
End Function
Overloads Function CountFiles(ByVal fromDate As Date, ByVal toDate As Date, _
Byval type As String) As Integer
Console.WriteLine("You've requested the " & type & _
" files created from " & fromDate & " to " & toDate)
Dim files() As String
files = System.IO.Directory.GetFiles("c:\windows")
Dim i, fileCount As Integer
For i = 0 To files.GetUpperBound(0)
Dim FI As New System.IO.FileInfo(files(i))
If FI.CreationTime.Date >= fromDate And _
FI.CreationTime.Date <= toDate And FI.Extension = type Then
fileCount = fileCount + 1
End If
Next
Return(fileCount)
End Function
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P ¢ If you're unfamiliar with the Directory and File objects, focus on the statement that prints to the

% Output window and ignore the statements that actually count the files that meet the specified crite-
ria. After reading Chapter 13, you can revisit this example and understand the counting statements.
The Console.WritelLine statements report all the values passed as arguments, and they differentiate
between the various overloaded forms of the function.

Start a new project and enter the definitions of the overloaded forms of the function on the
form’s level. Listing 4.4 is lengthy, but all the overloaded functions have the same structure and dif-
ter only in how they select the files to count. Then place a TextBox and a button on the form, as
shown in Figure 4.4, and enter the statements from Listing 4.5 in the button’s Click event handler.
The project shown in Figure 4.4 is called OverloadedFunctions, and you'll find it in this chapter’s

folder on the CD.
FIGURE 4.4 runcton averloading Den R[-I5
The Overloaded- 91 files with size between 1KB and 100KE
B . 76 files created in 2001
Functions project 3 BP files

4 EXE files between 1 and 100 KB
3 EXE files created in 2000 and 2001

Count Files

LISTING 4.5: TESTING THE OVERLOADED FORMS OF THE COUNTFILES() FUNCTION

Private Sub Buttonl Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
TextBox1l.AppendText(CountFiles(1000, 100000) & _

" files with size between 1KB and 100KB" & vbCrLf)
TextBox1.AppendText(CountFiles(#1/1/2001#, #12/31/2001#) & _

" files created in 2001" & vbCrLf)
TextBox1.AppendText(CountFiles(".BMP") & " BMP files" & vbCrLf)
TextBox1.AppendText(CountFiles(1000, 100000, ".EXE") & _

" EXE files between 1 and 100 KB" & vbCrLf)
TextBox1.AppendText(CountFiles(#1/1/2000#, #12/31/2001#, ".EXE") & _

" EXE files created in 2000 and 2001")

End Sub

The button calls the various overloaded forms of the CountFiles() function one after the other
and prints the results on the TextBox control.

Function overloading is new to VB.INET, but it’s used heavily throughout the language. There
are relatively few functions (or methods, for that matter) that aren’t overloaded. Every time you
enter the name of a function followed by an opening parenthesis, a list of its arguments appears in
the drop-down list with the arguments of the function. If the function is overloaded, you'll see a

Copyright ©2002 SYBEX, Inc., Alameda, CA www.sybex.com


http://www.sybex.com

SUMMARY | 183

number in front of the list of arguments, as shown in Figure 4.5. This number is the order of the
overloaded form of the function, and it’s followed by the arguments of the specific form of the func-
tion. The ﬁgure shows all the forms of the CountFﬂesO function.

FIGURE 4.5 [<1ofS~ CountFies (minSize As Integer, maxsis As Integer) As Integer]

The overloa de d [220f 5+ CountFiles (fromDate As Date, toDate As Date) As Integer]

forms of the Count-
Files() function

[240f 5 CountFiles (minSize As Integer, maxSize As Integer, type As String) &s Integer]

(
[
[230f 5= CountFiles (type As String) &s Integer]
(
(

[250f5¥ CountFiles (fromDate &s Date, toDate As Date, type &s String) As Integer|

You will have to overload many of the functions you'll be writing once you start developing real
applications, because you’ﬂ want your functions to work on a Variety of data types. This is not the
only reason to overload functions. You may also need to write functions that behave differendy
based on the number and types of their arguments.

NOTE  Notice that you can’t overload a function by fkanging its return type. That’s wky the MinO function returns a
double value, which is the most accurate value. If you don’t need more than a couple of decimal dzgz'ts (or 1o fmctional part
at all)) “you can round the return value in your code accom’z‘ngly‘ However, you can’t have two Mz'nO functions that accept
the exact same arguments and return dyj‘m’nt data types. Owerloaded forms of a function are dﬁerzntiated by the num-
ber and /or the type of their arguments, but not by the return value.

Summary

This chapter concludes the presentation of the core of the language. In the last two chapters, you've
learned how to declare and use variables, and how to break your applications into smaller, manage-
able units of code. These units of code are the subroutines and functions. Subroutines perform
actions and don’t return any values. Functions, on the other hand, perform calculations and return
values. Most of the language’s built-in functionality is in the form of functions. The methods of the
various controls look and feel like functions, because they're implemented as functions. Functions
are indeed a major aspect of the language.

Subroutines aren’t as common. Many programmers actually prefer to write only functions and use
the return value to indicate the success or failure of the procedure, even if the procedure need not
return any value. Event handlers are implemented as subroutines, because they don’t return any val-
ues. Event handlers aren’t called from within your code; they are simply activated by the Common
Language Runtime.

Subroutines and functions communicate with the rest of the application through arguments.
There are many ways to pass arguments to a procedure, and you've seen them all. You have also seen
how to write overloaded functions, which are new to VB.INET; and as you will see in the rest of this
book, they’re quite common.

In the following chapters, we'll explore the Windows controls in depth, and you will write your
tirst “real” Windows applications.

Copyright ©2002 SYBEX, Inc., Alameda, CA www.sybex.com


http://www.sybex.com

Copyright ©2002 SYBEX, Inc., Alameda, CA www.sybex.com


http://www.sybex.com

Chapter S

Working with Forms

In VisuaL Basic, THE form is the container for all the controls that make up the user interface.
When a Visual Basic application is executing, each window it displays on the desktop is a form.
In previous chapters, we concentrated on placing the elements of the user interface on forms, set-
ting their properties, and adding code behind selected events. Now, we'll look at forms them-
selves and at a few related topics, such as menus (forms are the only objects that can have menus
attached), how to design forms that can be automatically resized, and how to access the controls
of one form from within another form’s code. The form is the top-level object in a Visual Basic
application, and every application starts with the form.

NOTE  The terms form and window describe the same entity. A window is what the user sees on the desktop when
the applimtion is running. A form is the same entity at deszgn time. The proper term is a Windows form, as opposed fo

a Web form, but I will refer to them as forms.

Forms have built-in functionality that is always available without any programming effort on
your part. You can move a form around, resize it, and even cover it with other forms. You do so
with the mouse, or with the keyboard through the Control menu. As you will see, forms are not
passive containers; they're “intelligent” objects that are aware of the controls placed on them and
can actually manipulate the controls at runtime. For example, you can instruct the form to resize
certain controls when the form itself is resized. Forms have many trivial properties that won't be
discussed here. Instead, let’s jump directly to the properties that are unique to forms and then
look at how to manipulate forms from within an application’s code.

The forms that constitute the visible interface of your application are called Windows forms; this
term includes both the regular forms and dialog boxes, which are simple forms you use for very spe-
cific actions, such as to prompt the user for a specific piece of data or to display critical information.
A dialog box is a form with a small number of controls, no menus, and usually an OK and a Cancel
button to close it. For more information on dialog boxes, see the section “Forms vs. Dialog Boxes”
later in this chapter. Everything you'll read about forms in the following sections applies to dialog
boxes as well, even if some form features (such as menus) are never used with dialog boxes.
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VB6 " VB.NET

The Form Designer is one of the most improved areas of VB.NET. For the first time, you can design forms
that can be easily resized—anyone who has programmed in earlier versions of VB knows what a hassle the
resizing of forms could be. The Anchor and Dock properties allow you to anchor controls on the edges of
the form and dock them on the form. When the form is resized, the controls on it can be either resized or
moved to new locations, so that they remain visible.

If the controls can’t fit the form, scroll bars can appear automatically, so that users can scroll the form in
its window and bring another section into view, if the form’s AutoScroll property is True. Scrolling forms
are also new to VB.NET.

Anew special control was added, whose sole purpose is to act as a pane separator on forms: the Splitter con-
trol. This control is a thin horizontal or vertical stripe that allows you to resize two adjacent controls. If
two TextBox controls on the same form are separated by a Splitter control, users can shrink one TextBox to
make more room for the other. Again, no code required.

Of course, many things have changed too. You can no longer show a form by calling its Show method. You
must first create an instance of the form (a variable of the Form type) that you want to show and then call
the Show method of this variable. You no longer have arrays of controls. This isn’t much of a problem,
though, because with VB.NET you can create instances of new controls from within your code and position
them on the form.

The Appearance of Forms

Applications are made up of one or more forms (usually more than one), and the forms are what
users see. You should craft your forms carefully, make them functional, and keep them simple and
intuitive. You already know how to place controls on the form, but there’s more to designing forms
than populating them with controls. The main characteristic of a form s the title bar on which the

form’s caption is displayed (see Figure 5.1).

FIGURE 5.1 . Minimize Maximize Close
The elements of Title bar button button  button
the form \_ulu
= Restare.
Move
Control e
menu O Maximize
X Close Alt+F4
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Clicking the icon on the left end of the title bar opens the Control menu, which contains the
commands shown in Table 5.1. On the right end of the title bar are three buttons: Minimize, Maxi-
mize, and Close. Clicking these buttons performs the associated function. When a form is maxi-
mized, the Maximize button is replaced by the Restore button. When clicked, this button resets the
form to the size and position before it was maximized. The Restore button is then replaced by the
Maximize button.

TABLE 5.1: COMMANDS OF THE CONTROL MENU

COMMAND EFFECT

Restore Restores a maximized form to the size it was before it was maximized; available only
if the form has been maximized

Move Lets the user move the form around with the mouse
Size Lets the user resize the form with the mouse
Minimize Minimizes the form

Maximize Maximizes the form

Close Closes the current form

Properties of the Form Control

You're familiar with the appearance of the forms, even if you haven’t programmed in the Windows
environment in the past; you have seen nearly all types of windows in the applications you're using
every day. The floating toolbars used by many graphics applications, for example, are actually forms
with a narrow title bar. The dialog boxes that display critical information or prompt you to select
the file to be opened are also forms. You can duplicate the look of any window or dialog box
through the following properties of the Form object.

ACCEPTBUTTON, CANCELBUTTON

These two properties let you specify the default Accept and Cancel buttons. The Accept button is
the one that’s automatically activated when you press Enter, no matter which control has the focus
at the time, and is usuaﬂy the button with the OK caption. Likewise, the Cancel button is the one
that’s automatically activated when you hit the Esc key and is usually the button with the Cancel
caption. To specify the Accept and Cancel buttons on a form, locate the AcceptButton and Cancel-
Button properties of the form and select the corresponding controls from a drop-down list, which
contains the names of all the buttons on the form. You can also set them to the name of the corre-
sponding button from within your code.
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AUTOSCALE

This property is a True /False value that determines whether the controls you place on the form are
automatically scaled to the height of the current font. When you place a TextBox control on the
form, for example, and the AutoScale property is True, the control will be tall enough to display a
single line of text in the current font. The default value is True, which is why you can’t make the
controls smaller than a given size. This is a property of the form, but it affects the controls on the
form. If you change the Font property of the form after you have placed a few controls on it, the
existing controls won't be affected. The controls are adjusted to the current font of the form the
moment they're placed on it.

AUTOSCROLL

This is one of the most needed of the Form object’s new properties. The AutoScroll property is a
True/False value that indicates whether scroll bars will be automaticaﬂy attached to the form (as
seen in Figure 5.2) if it’s resized to a point that not all its controls are visible. This property is new
to VB.NET and will help you design large forms without having to worry about the resolution of
the monitor on which they’ﬂ be displayed,

FIGURE 5.2 [Mcontactspero [=lE
If the controls company [ )
don’t fit in the Contact |
form’s visible area, address1 |
scroll bars can be Address2 |
attached automati- gy [ sae | o [
CaHY’ Telephone ’7
EMail
URL | =
il | ;I_‘

The AutoScroll property is used in conjunction with three other properties, described next: Auto-
ScrollMargin, AutoScrollMinSize, and AutoScrollPosition.

AUTOSCROLLMARGIN

This is a margin, expressed in pixels, that’s added around all the controls on the form. If the form is
smaller than the rectangle that encloses all the controls adjusted by the margin, the appropriate scroll
bar(s) will be displayed automatically.

If you expand the AutoScrollMargin property in the Properties window, you will see that it’s an
object (a Size object, to be specific). It exposes two members, the Width and Height properties, and
you must set both values. The default value is (0,0). To set this property from within your code, use
statements like these:

Me.AutoScrolIMargin.Width = 40
Me.AutoScrolIMargin.Height = 40
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AUTOSCROLLMINSIZE

This property lets you specify the minimum size of the form, before the scroll bars are attached. If
your form contains graphics you want to be visible at all times, set the Width and Height members
of the AutoScrollMinSize property accordingly. Notice that this isn't the form’s minimum size;
users can make the form even smaller. To specify a minimum size for the form, use the Minimum-
Size property, described later in this section.

Let’s say the AutoScrollMargin properties of the form are 180 by 150. If the form is resized to
less than 180 pixels horizontally or 150 pixels vertically, the appropriate scroll bars will appear auto-
matically, as long as the AutoScroll property is True. If you want to enable the AutoScroll feature
when the form’s width is reduced to anything less than 250 pixels, set the AutoScrollMinSize prop-
erty to (250, 0). Obviously, if the AutoScrollMinSize value is smaller than the dimensions of the
form that will automatically invoke the AutoScroll feature, AutoScrollMinSize has no effect. In this
example, setting AutoScrolIMinSize.Width to anything less than 180 or AutoScrolIMinSize.Height
to anything less than 150 will have no effect on the appearance of the form and its scroll bars.

AUTOSCROLLPOSITION

This property lets you read (or set) the location of the auto-scroll position. The AutoScrollPosition
is the number of pixels by which the two scroll bars were displaced from their initial locations. You
can read this property to find out by how much the scroll bars were moved, or to move the scroll
bars from within your code.

Use this property in very specialized applications, because the form’s scroll bars are adjusted auto-
rnatically to bring the control that has the focus into view. As long as the users of the application
press the Tab key to move the focus to the next control, the focused control will be visible.

BORDERSTYLE

The BorderStyle property determines the style of the form’s border and the appearance of the form;

it takes one of the values shown in Table 5.2. You can make the form’s title bar disappear altogether
by setting the form's BorderStyle property to Fixed ToolWindow, the ControlBox property to False,
and the Text property to an empty string. However, a form like this can't be moved around with the
mouse and will probably frustrate users.

TABLE 5.2: THE FORMBORDERSTYLE ENUMERATION

VALUE EFFECT

None Borderless window that can’t be resized; this setting should be avoided.

Sizable (default) Resizable window that’s used for displaying regular forms.

Fixed3D Window with a visible border, “raised” relative to the main area. Can’t be resized.
FixedDialog A fixed window, used to create dialog boxes.

Continued on next page
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TABLE 5.2: THE FORMBORDERSTYLE ENUMERATION (continued)

VALUE EFFECT
FixedSingle A fixed window with a single line border.
FixedToolWindow A fixed window with a Close button only. It looks like the toolbar displayed by the
drawing and imaging applications.
SizableTooTWindow Same as the FixedToolWindow but resizable. In addition, its caption font is smaller
than the usual.
CONTROLBOX

This property is also True by default. Set it to False to hide the icon and disable the Control menu.
Although the Control menu is rarely used, Windows applications don’t disable it. When the Con-
trolBox property is False, the three buttons on the title bar are also disabled. If you set the Text
property to an empty string, the title bar disappears altogether.

KEYPREVIEW

This property enables the form to capture all keystrokes before they’re passed to the control that
has the focus. Normally, when you press a key, the KeyPress event of the control with the focus is
triggered (as well as the other keystroke—related events), and you can handle the keystroke from
within the control’s appropriate handler. In most cases, we let the control handle the keystroke and
don’t write any form code for that.

If you want to use “universal” keystrokes in your application, you must set the KeyPreview prop-
erty to True. Doing so enables the form to intercept all keystrokes, so that you can process them
from within the form’s keystroke events. The same keystrokes are then passed to the control with
the focus, unless you “kill” the keystroke by setting its Handled property to True when you process
it on the form’s level. For more information on processing keystrokes at the Form level and using
special keystrokes throughout your application, see the Contacts project later in this chapter.

MINIMIZEBOX, MAXIMIZEBOX

These two properties are True by default. Set them to False to hide the corresponding buttons on
the title bar.

MINIMUMSIZE, MAXIMUMSIZE

These two properties read or set the minimum and maximum size of a form. When users resize the
form at runtime, the form won’t become any smaller than the dimensions specified with the Mini-
mumbSize property and no larger than the dimensions specified by MaximumSize. The Minimum-
Size property is a Size object, and you can set it with a statement like the following:

Me.MinimumSize = New Size(400, 300)
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Or, you can set the width and height separately:

Me.MinimumSize.Width = 400
Me.MinimumSize.Height = 300

The MinimumSize.Height property includes the height of the Form’s title bar; you should take
that into consideration. If the minimum usable size of the Form is 400 by 300, use the following
statement to set the MinimumSize property:

me.MinimumSize = New Size(400, 300 + SystemInformation.CaptionHeight)

Tip  The ketgbt of the caption is not a property of the Form object) even t})ougb you will ﬁnd it useful in determining the
useful area g’ the form (tke total betgkt minus the caption bm). Keep in mind that the betgbt g" the caption bar is given by
the CaptionHeight property of the SystemInformation object.

SIZEGRIPSTYLE

This property gets or sets the style of sizing handle to display in the bottom-right corner of the
form; it can have one of the values shown in Table 5.3. By default, forms are resizable, even if no
special mark appears at the bottom-right corner of the form. This little mark indicating that a form
can be resized is new to VB.INET and adds a nice touch to the look of the form.

TABLE 5.3: THE SIZEGRIPSTYLE ENUMERATION

VALUE EFFECT
Auto (default) The SizeGrip is displayed as needed.
Show The SizeGrip is displayed at all times.
Hide The SizeGrip is not displayed, but the form can still be resized with the mouse
(Windows 95/98 style).
STARTPOSITION

This property determines the initial position of the form when it’s first displayed; it can have one of
the values shown in Table 5.4.

TABLE 5.4: THE FORMSTARTPOSITION ENUMERATION

VALUE EFFECT

CenterParent The form is centered in the area of its parent form.

CenterScreen The form is centered on the monitor.

Manual The location and size of the form will determine its starting position. See the

discussion of the Top, Left, Width, and Height properties of the form, later in
this section.

Continued on next page
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TABLE 5.4: THE FORMSTARTPOSITION ENUMERATION (continued)

VALUE EFFECT
WindowsDefaultBounds The form is positioned at the default location and size determined by Windows.
WindowsDefaultLocation The form is positioned at the Windows default location and has the dimensions

you’ve set at design time.

ToOP, LEFT

These two properties set or return the coordinates of the form'’s top—left corner in pixels. You'll
rarely use these properties in your code, since the location of the window on the desktop is deter-
mined by the user at runtime.

ToPMoOST

This property is a True/False value that lets you specify whether the form will remain on top of all
other forms in your application. Its default property is False, and you should change it only in rare
occasions. Some dialog boxes, like the Find and Replace dialog box of any text processing applica-
tion, are always visible, even when they don't have the focus. To make a form remain visible while
it's open, set its TopMost property to True.

WIDTH, HEIGHT

These two properties set or return the form’s width and height n pixels. They are usuaHy set from
within the form’s Resize event handler, to keep the size of the form at a minimum size. The form’s
width and height are usually controlled by the user at runtime.

Placing Controls on Forms

As you already know, the second step in designing your application’s interface is the design of the
forms (the first step being the analysis and careful planning of the basic operations you want to pro-
vide through your interface). Designing a form means placing Windows controls on it, setting their
properties, and then writing code to handle the events of interest. Visual Studio.NET is a rapid
application development (RAD) environment. This doesn't mean that you’re expected to develop
applications rapidly. It has come to mean that you can rapidly prototype an application and show
something to the customer. And this is made possible through the visual tools that come with
VS.NET, especially the new Form Designer.

To place controls on your form, you select them in the Toolbox and then draw, on the form, the
rectangle in which the control will be enclosed. Or, you can double-click the control’s icon to place
an instance of the control on the form. All controls have a default size, and you can resize the con-
trol on the form with the mouse. Next, you set the control’s properties in the Properties window.

Each control's dimensions can also be set in the Properties window, through the Width and Height
properties. These two properties are expressed in pixels. You can also call the Width and Height prop-
erties from within your code to read the dimensions of a control. Likewise, the Top and Left
properties return (or set) the coordinates of the top-left corner of the control. In the section
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“Building Dynamic Forms at Runtime,” later in this chapter, you'll see how to create new controls at
runtime and place them on a form from within your code. You'll use these properties to specify the
location of the new controls on the form in your code.

Setting the TabOrder

Another important issue in form design is the tab order of the controls on the form. As you know,
pressing the Tab key at runtime takes you to the next control on the form. The order of the controls
isn't determined by the form; you specify the order when you design the application, with the help
of the TabOrder property. Each control has its own TabOrder setting, which is an integer value.
When the Tab key is pressed, the focus is moved to the control whose tab order immediately fol-
lows the tab order of the current control. The TabOrder of the various controls on the form need
not be consecutive.

To specify the tab order of the various controls, you can set their TabOrder property in the
Properties window, or you can select the Tab Order command from the View menu. The tab order
of each control will be displayed on the corresponding control, as shown in Figure 5.3 (the form
shown in the figure is the Contacts application, which is discussed shortly). Notice that some of the
buttons at the bottom of the form are not aligned as they should be. The OK and Cancel buttons
should be on top of the Add and Delete buttons, hiding them. I had to displace them to set the tab

order of all controls on the form and then align some of the buttons again.

FIGURE 5.3 [Hcontactsemo 8 [ |
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To set the tab order of the controls, click each control in the order in which you want them to
receive the focus. Notice that you can’t change the tab order of a few controls only. You must click
all of them in the desired order, starting with the first control in the tab order. The tab order need
not be the same as the physical order of the controls on the form, but controls that are next to each
other in the tab order should be placed next to each other on the form as well.

NOTE  The default tab order is the same as the order in which you place the controls on the form. Unless you keep the tab
order in mind while you design the form, you'll end up with a_form that moves the focus from one control to the next in a
totally unpredictable manner. Once all the controls are on the form, you should always check their tab order to make sure it
won’t confuse users.
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As you place controls on the form, don't forget to lock them, so that you won't move them
around by mistake as you work with other controls. You can lock the controls in their places either
by setting their Locked property to True, or by locking all the controls on the form with the
Format > Lock Controls command.

VB6 "» VB.NET

Many of the controls in earlier versions of Visual Basic exposed a Locked property too, but this property had
a totally different function. The old Locked property prevented users from editing the controls at runtime
(entering text on a TextBox control, for example). The new Locked property is effective at design time
only; it simply locks the control on the form, so that it can’t be moved by mistake.

Designing functional forms is a crucial step in the process of developing Windows applications.
Most data-entry operators don’t work with the mouse, and you must make sure all the actions can
be performed with the keyboard. This doesn’t apply to graphics applications, of course, but most
applications developed with VB are business applications. If you're developing a data—entry form, for
example, you must take into consideration the needs of the users in designing these forms. Make a
prototype and ask the people who will use the application to test-drive it. Listen to their objections
carefuﬂy, collect all the information, and then use it to refine your application’s user interface. Don't
defend your design—just learn from the users. They will uncover all the flaws of the application,
and they’ll help you design the most functional interface.

The process of designing forms is considered to be the sirnplest step by most beginners, but a bad
user interface might force you to redesign the entire application later on—not to mention that an
inefficient interface will discourage people from using your application. Take your time to think
about the interface, the controls on your forms, and how users will navigate, I'm not going to discuss
the topic of designing user interfaces in this book. Besides, this is one of the skills you’ﬂ acquire
with time.

VB.NET at Work: The Contacts Project

P~ I would like to conclude this section with an example of a simple data-entry form that demon-

@ strates many of the topics discussed here, as well as a few techniques for designing easy-to-use forms.
Figure 5.4 shows a data-entry form for contact information, and I'm sure you will add your own
tields to make this application more useful. You can navigate through the contacts using the buttons
with the arrows, as well as add new contacts or delete existing ones by clicking the appropriate but-
tons. When you're entering a new contact, the buttons shown in Figure 5.4 are replaced by the usual
OK and Cancel buttons. The action of adding a new contact must end by clicking one of these two
buttons. After committing a new contact, or canceling the action, the usual navigation buttons will
appear again.

Once the controls are on the form, the first step is to set their tab order. You must specify a

TabOrder even for controls that never receive focus, such as the labels. In addition to the tab order
of the controls, we'll also use shorteut keys to give the user quick access to the most common fields.
The shortcut keys are displayed as underlined characters on the corresponding labels, as you can see

in Figure 5.4.
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FIGURE 5.4 = =ik
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To set the TabOrder of the controls, use the View > Tab Order command. Click all the con-
trols in the order you want them to receive the focus, starting with the first label. The proper order
of the controls is shown back in Figure 5.3. You can change the order of the buttons, if you want,
but the labels and text boxes must have consecutive settings. Don't forget to include the buttons in
the tab order. Then open the View menu again and select the Tab Order command to return to the
regular view of the Form Designer.

If you run the application now, you'll see that the focus moves from one TextBox to the next and
the labels are skipped. Since the labels don’t accept any data, they receive the focus momentarﬂy and
then the focus is passed to the next control in the tab order. After the last TextBox control, the focus
is moved to the buttons, and then back to the first TextBox control. To add a shortcut key for the
most common fields, determine which of the fields will have their own shortcut key and which keys
will be used for that purpose. Being the Internet buffs that we all are, let’s assign shortcut keys to the
Company, EMail, and URL fields. Locate each label’s Text property in the Properties window and
insert the & symbol in front of the character you want to act as a shortcut for each Label. The Text
properties of the three controls should be &Company, &EMail, and &URL.

Shortcut keys are activated at runtime by pressing the shortcut character while holding down the
Alt key. The shortcut key will move the focus to the corresponding Label control, but because labels
can’t receive the focus, it's passed immediately to the next control in the tab order, which is the adja—
cent TextBox control. For this technique to work, you must make sure that all controls are properly
arranged in the tab order.

TIP By the way, if you want to display the & symbol on a Label control, prefix it with another & symbol. To display
the string “Tom & Jerry” on a Label control, assign the string “Tom & & Jerry” to its Text property.

If you run the application now, you'll be able to quickly move the focus to the Company,
EMail, and URL boxes by pressing the shortcut key while holding down the Alt key‘ To access the
other fields (the TextBoxes without shortcuts), the user can press Tab to move forward in the tab
order or Shift+Tab to move backward. Try to move the focus with the mouse and enter data with
the keyboard, and you'll soon understand what kind of interface a data-entry operator would rather
work with.
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The contacts are stored in an ArrayList object, which is similar to an array but a little more con-
venient. We'll discuss ArrayList in Chapter 11; for now, you can ignore the parts of the application
that manipulate the contacts and focus on the design issues.

Now enter a new contact by clicking the Add button, or edit an existing contact by clicking the
Edit button. Both actions must end with the OK or Cancel button. In other words, we won't allow
users to switch to another contact while adding or editing a contact. The code behind the various
buttons is straightforward. The Add button hides all the navigational buttons at the bottom of the
form and clears the TextBoxes. The OK button saves the new contact to an ArrayList structure and
redisplays the navigational buttons. The Cancel button ignores the data entered by the user and like-
wise displays the navigational buttons. In either case, when the user switches back to the view mode,
the TextBoxes are also locked, by setting their ReadOnly properties to True.

Don’t worry about the statements that manipulate the ArrayList with the contacts or the state-
ments that save the contacts to a disk file and load them back to the application from a disk file.
We'll come back to this project in Chapter 11, where we'll discuss ArrayLists. Just focus on the
statements that control the appearance of the form.

For now, you can use the commands of the File menu to load or save a set of contacts. These
commands are quite simple: they load the same file, CONTACTS.BIN in the application’s folder. After
reading about the Open File and Save File dialog controls, you can modify the code so that it
prompts the user about the file to read from or write to. The CONTACTS.BIN file you will find on the
CD contains a few contacts I created from the Northwind sample database.

The application keeps track of the current contact through the currentContact variable. As you
move with the navigation keys, the value of this variable is increased or decreased accordingly. When
you edit a contact, the new values are stored in the Contact object that corresponds to the location
indicated by the currentContact variable. When you add a new contact, a new Contact object is added
to the current collection, and its order becomes the new value of the currentContact variable. Most of
the project’s code performs trivial tasks—hiding and showing the buttons at the bottom of the form,
displaying the fields of the current contact on the TextBox control, clearing the same controls to
prepare them to accept a new contact, and so on. We'll come back to this project in Chapter 11,
where I'll show you how to manipulate ArrayLists. There you'll find more information about storing
data in an ArrayList, as well as how to save an ArrayList to a disk file and how to load the data from
the file back to the ArrayList.

HANDLING KEYSTROKES

The last topic demonstrated in this example is how to capture certain keystrokes, regardless of the
control that has the focus. We'll use the F10 keystroke to display the total number of contacts
entered so far. Set the form’s KeyPreview property to True and then enter the following code in the
form’s KeyDown event:

If e.Keycode = keys.F10 Then
MsgBox("There are " & Contacts.Count.ToString & " contacts in the database")
e.Handled = True

End If

The form captures all the keystrokes and processes them. After it's done with them, it may
allow the keystrokes to be passed to the control that has the focus. The processing is quite trivial. It
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compares the key pressed to the F10 key and, if F10 was pressed, it displays the number of contacts
entered so far in a message box. Then, it stops the keystroke from propagating back to control with
the focus by setting its Handled property to True. Listing 5.1 is the complete event handler; if you
omit that statement in the Iisting, the F10 keystroke will be passed to the control with the focus—
the control that would receive the notification about the keystroke by default, if the form’s Key-
Preview property was left to its default value. Of course, the key F10 isnt processed by the TextBox

control, so it’s not necessary to “kill” it before it reaches the control.

LISTING 5.1: HANDLING KEYSTROKES IN THE FORM’S KEYDOWN EVENT HANDLER

PubTic Sub Forml_KeyDown(ByVal sender As Object, _
ByVal e As System.WinForms.KeyEventArgs) Handles Forml.KeyUp
If e.Keycode = Keys.F10 Then
MsgBox("There are " & Contacts.Count.ToString & _
" contacts in the database")
e.Handled = True
End If
If e.KeyCode = Keys.Subtract And e.Modifiers = Keys.Alt Then
bttnPrevious_Click(sender, e)
End If
If e.KeyCode = Keys.Add And e.Modifiers = Keys.Alt Then
bttnNext_Click(sender, e)
End If
End Sub

The KeyDown event handler contains a little more code to capture the Alt+Plus and Alt+Minus
key combinations as shortcuts for the buttons that move to the next and previous contact respec-
tively. If the user has clicked the Plus button while holding down the Alt button, the code calls the
event handler of the Next button. Likewise, pressing Alt and the Minus key activates the event
handler of the Previous button.

The KeyCode property of the ¢ argument returns the code of the key that was pressed. All key
codes are members of the Keys enumeration, so you need not memorize them. The name of the but-
ton with the plus symbol is Keys.Add. The Modifiers property of the same argument returns the
modifier key(s) that were held down while the key was pressed. Also, all possible values of the Mod-
ifiers property are members of the Keys enumeration and will appear in a list as soon as you type the
equal sign. The name of the Alt modifier is Keys.ATt.

If you run the Contacts application, you’H see that it’s not trivial. To add or modify a record, you
must click the appropriate button, and while in edit mode, the navigational buttons disappear. The
reason is that data-entry operators want to know the state of the application at each moment. With
this design, you can’t move to another record while editing the current one, as discussed previously.

Another interesting part of the project is the handler of the KeyPress event. This event takes place
when a normal key <letter, digit, or punctuation symbol) is pressed. If the OK button is invisible at
the time, it means that the user can’t edit the current record and the program “chokes” the keystroke,
preventing it from reaching the control that has the focus. The form’s KeyPress event is handled by
the subroutine shown in Listing 5.2.
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LISTING 5.2: HANDLING KEYSTROKES IN THE FORM’S KEYPRESS EVENT HANDLER

Private Sub Forml_KeyPress(ByVal sender As Object, _
ByVal e As System.Windows.Forms.KeyPressEventArgs) _
Handles MyBase.KeyPress
If bttnOK.Visible = False Then
e.Handled = True
End If
End Sub

The Contacts project contains quite a bit of code, which will be discussed in more detail in Chap-
ter 11. It’s included in this chapter to demonstrate some useful techniques for designing intuitive
interfaces, and I've only discussed the sections of the application that relate to the behavior of the
form and the controls on it as a group.

Anchoring and Docking

One of the most tedious tasks in designing user interfaces with Visual Basic before VB.INET was
the proper arrangement of the controls on the form, especially on forms that users were allowed
to resize at runtime. You design a nice form for a given size, and when it’s resized at runtime, the
controls are all clustered in the top-left corner. A TextBox control that covered the entire width
of the form at design time suddenly “cringes” on the left when the user drags out the window.

If the user makes the form smaller than the default size, part of the TextBox is invisible, because
it’s outside the form. You can attach scroll bars to the form, but that doesn’t really help—who
wants to type text and have to scroll the form horizontally? It makes sense to scroll vertically,
because you get to see many lines at once, but if the TextBox control is wider than the form, you
can’t see an entire line.

Programmers had to be creative and resize and/or rearrange the controls on a form from within
the form’s Resize event. This event takes place every time the user resizes the form at runtime, and,
quite often, we had to insert code in this event to resize controls so that they would continue to take
up the entire form’s width. You may still have to insert a few lines of code in the Resize event’s han-
dler, but a lot of the work of keeping controls aligned is no longer needed. The Anchor and Dock
properties of the various controls allow you specify how they will be arranged with respect to the
edges of the form when the user resizes it.

The Anchor property lets you attach one or more edges of the control to corresponding edges of
the form. The anchored edges of the control maintain the same distance from the corresponding
edges of the form. Place a TextBox control on a new form and then open the control’s Anchor
property in the Properties window. You will see a little square within a larger square, like the one in
Figure 5.5, and four pegs that connect the small control to the sides of the larger box. The large box
is the form, and the small one is the control. The four pegs are the anchors, which can be either white
or gray. The gray anchors denote a fixed distance between the control and the form. By default, the
control is placed at a fixed distance from the top-left corner of the form. When the form is resized,
the control retains its size and its distance from the top-left corner of the form.
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Let’s say we want our control to fill the width of the form, be aligned to the top of the form, and
leave some space for a few buttons at the bottom. Make the TextBox control as wide as the control
(allowing, perhaps, a margin of a few pixels on either side). Then place a couple of buttons at the
bottom of the form and make the TextBox control tall enough that it stops above the buttons, as
shown in Figure 5.6. This is the form of the Anchor project on the CD.

FIGURE 5.6 il
This form is filled The anchor property lets you anchor one or more edges of the
control to corresponding edges of the Form. The anchored edges of
by three COHU‘OIS, the control maintain the same distance from the corresponding edges
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while the Form is resized, the control retains its size and its distance

Save Cancel

form’s size at
runtime.

Now open the TextBox control’s Anchor property and make the all four anchors gray by clicking
them. This action tells the Form Designer to resize the control accordingly at runtime, so that the
distances between the sides of the control and the corresponding sides of the form are the same as
you’ve set at design time.

Resize the form at design time, without running the project. The TextBox control is resized
according to the form, but the buttons remain fixed. Let’s do the same for the two buttons. The two
buttons must fit in the area between the TextBox control and the bottom of the form, so we must
anchor them to the bottom of the form. Select both controls on the form with the mouse and then
open their Anchor property. Make the anchor at the bottom gray and the other three anchors white;
this will anchor the two buttons to the bottom of the form. If you resize the form now, the TextBox
control will fill it, leaving just enough room for the two buttons at the bottom of the form.

We need to do something more about the buttons. They’re aligned Verticaﬂy, but their horizontal
location doesn’t change. Select the button to the left, open its Anchor property, and click the left
anchor. This will anchor the button to the left side of the form—which is the default behavior anyway.

Copyright ©2002 SYBEX, Inc., Alameda, CA www.sybex.com

199


http://www.sybex.com

200

CHAPTER5 WORKING WITH FORMS

o,
~

Now select the button to the right, open its Anchor property, and click the right anchor. This will
anchor the second button to the right side of the control. Resize the form again and see how all con-
trols are resized and rearranged on the form at all times. This is much better than the default behavior
of the controls on the form. Figure 5.7 shows the same form in two very different sizes, with the
TextBox taking up most of the space on the form and leaving room for the buttons, which in turn are
repositioned horizontally as the form is resized.

FIGURE 5.7 [Hanchorpemo1 =0l
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Yet, there’s a small problem: if you make the form very narrow, there will be no room for both
buttons across the form’s width. The simplest way to fix this problem Is to Impose a minimum size
for the form. To do so, you must first decide the form’s minimum width and height and then set the
MinimumSize property to these values.

In addition to the Anchor property, most controls provide the Dock property, which determines
how a control will dock on the form. The default value of this property 1s None. Create a new form,
place a TextBox control on it, and then open the control’'s Dock property. The various rectangular
shapes are the settings of the property. If you click the middle rectangle, the control will be docked
over the entire form: it will expand and shrink both horizontally and Vertically to cover the entire
form. This setting is appropriate for sirnple forms that contain a single control, usually a TextBox,
and sometimes a menu. Try it out.

Let’s create a more complicated form with two controls (it’s the Docking project on the CD).
The form shown in Figure 5.8 contains a TreeView control on the left and a ListView control on
the right. The two controls display generic data, but the form has the same structure as a Windows
Explorer window, with the directory structure in tree form on the left pane and the files of the
selected folder on the right pane.

Place a TreeView control on the left side of the form and a ListView control on the right side of
the form. Then dock the TreeView to the left and the ListView to the right. If you run the applica-
tion now, then as you resize the form, the two controls remain docked to the two sides of the form,
but their sizes don't cliange. If you make the form wider, there will be a gap between the two con-
trols. If you make the form narrower, one of the controls will overlap the other.

End the application, return to the Form Designer, select the ListView control, and anchor the
control on all four sides. This time, the ListView will change size to take up all the space to the right
of the TreeView.
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NOTE  When you anchor a control to the left side of the form, the distance between the control’s left side and the form’s
left edge remains the same. This is the default bebavior of the controls. If you dock the right side of the control to the right
side of the  form, then as you resize the width of the form, the control is moved so that its distance from the right side of the
form remains fixed—you can even push the control out of the left edge of the form. If you anchor two opposite sides of the
control (top and bottom, or lgft and rigbt), then the control is resized, so that the docking distances of both sides remain the
same. Finally, if you dock all four sides, the control is resized along with the form. Place a multiline TextBox control on
a form and try out all possible settings of the Dock property.

The form behaves better, but it’s not what you really expect from a Windows application. The
problem with the form of Figure 5.8 is that users can’t change the relative widths of the controls. In
other words, you can’t make one of the controls narrower to make room for the other, which is a
fairly common concept in the Windows interface. The narrow bar that allows users to control the
relative sizes of two controls is a splitter. When the cursor hovers over a splitter, it changes to a double
arrow to indicate that the bar can be moved. By moving the splitter, you can enlarge one of the two
controls while shrinking the other.

The Form Designer provides a special control for placing a splitter between pairs of controls,
and this is the Splitter control. We'll design a new form identical to that of Figure 5.8, only this
time we'll place a Splitter control between them, so that users can change the relative size of the
two controls. First, place a TextBox control on the form and set its Multiline property to True. You
don’t need to do anything about its size, because we'll dock it to the left side of the form. With the
TextBox control selected, locate its Dock property and set it to Left. The TextBox control will fill
the left side of the form, from top to bottom.

Then place an instance of the Splitter control on the form, by double-clicking its icon on the
Toolbox. The Splitter will be placed next to the TextBox control. The Form Designer will attempt
to dock the Splitter to the left side of the form. Since there’s a control docked on this side of the
form already, the Splitter will be docked left against the TextBox.

Now place another TextBox control on the form, to the right of the Splitter control. Set the
TextBox’s Multiline property to True and its Dock property to Fill. We want the second TextBox
to fill all the area to the right of the Splitter. Now run the project and check out the functionality of
the Splitter. Paste some text on the two controls and then change their relative size by sliding the
Splitter between them, as shown in Figure 5.9. You will find this project, called Splitter1, in this
chapter’s folder on the CD.
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FIGURE 5.9
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Splitter control on the Form, by ~|
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The Form Designer provides a special contial for |

placing spliter between paits of cantrals, and this s
the Spiter contrcl, el design 2 new Form identical
1o that of Figue 4.8, only this tine we'll place & Spliter
onlrol betwesn them, so thal users can change the
ielative size of the bwo controls. Fist plae & TestBox
onltal on the Form and set its Multline property to
True. You don't need to do anything about s size.
because we ll dock it to the left side of the Form. With
\he TextBox contiol selected. locale its Dock pioperty
and set it to Laft. The TestBox control wil fil the left
side of the Form, from top to boltom

Then place an instance of the Spliter control on the
Form, by double clicking the S pliter contral's icon on
the Toolbox. The Splitter conlral will be placed next to
the TextBox conltiol. The Form Designer will aitempt to
dock the Spitter contiol (o the eft side of the Form
Since there’s conirol docked on this side of the Form
slieady, the Spiter conlrol willbe docked left against
the TedBox

Mow place ancther TexBox cortiol on the Form,to

the right of the Spiter contial. Set the TeutBox
controls Muliing prapery to True and its Dock
propeity t Fil We want the second TeatBos contal |

[Bsplitter Control Demo
The Form Designer provides a special cortal for placing splitter

between pairs of contiols, and ths is the Spliter control. We'll
design 2 new Faim idenlical ta that of Figure 4.8, only ths tine
we I place a Spliter conirol between them. so that users can
change the relative size of the o coniroks. Fist plece a TextBax
conirol on the Form and set its Muliine propeity to True. You
don't need to do anything about s size. because we'l dack it to
the lelt side of the Foim. Wih the TextBox control selected.
locate its Dock property and set it to Lelt. The TextBox control wil
fillthe left sice of the Form. from (op to bottom

Then place an instance of the Spliter control on the Form, by
double clicking the Spliter conlrol's icon on the Toolbox. The
Spliter control wil be placed nex to the TextBox conirol. The
Form Designer wil aliempt to dock the Spliter conliol to the left

side of the Form. Since there's control docked on this side of the
Form alieady, the Spiter contol will be: docked left against the
TeuBox

MNow place another TextBos: cortiol on the Fom, to the right of
the Splitter control. Set the Tex(Box controks Muliine property to
True and its Dock property to Fill. We want the second TextBox
contiol to fil all the area ko the right of the Splitter contiol. Now run
the project and check out the functisnaiity of the Spltter cantiol
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The Form Designer «
provides a special
contral for placing
splitter between
pits of cortiols.
and this i the
Splter contral,
el design & new
Form identical to
that of Figure 4.5
arly this fime we 1l
place a Spitter
control betveen
them, so that users
can change the
relative size of the
two coniols. First
place a TestBox
control on the Form
and setits Multiine
property o True
"rou don't need to
do anything about

its size, because j

Let’s design a more elaborate form with two Splitter controls, like the one shown in Figure 5.10
(it’s the form of the Splitter2 project on the CD). This form is at the heart of the interface of Out-
look, and it consists of a TreeView control on the left (where the folders are displayed), a ListView
control (where the selected folder’s items are clisplayecl), and a TextBox control (Where the selected
item’s details are displayed}. Since we haven't discussed the ListView and TreeView controls yet, I'm
using three TextBox controls. The process of designing the form is identical, regardless of the con-
trols you put on it.

Before explaining the process in detail, let me explain how the form shown in Figure 5.10 is dif-
ferent from the one in Figure 5.9. The vertical Splitter allows you to change the size of the TextBox
on the left; the remaining space on the form must be taken by the other two controls. A Splitter con-
trol, however, must be placecl between two controls (no more, no less). By placing a Panel control on
the right side of the form, we use the vertical Splitter to separate the TextBox control to the left
and the Panel control to the right. The other two TextBox controls and the horizontal Splitter are
arranged on the Panel as you would arrange them on a form. Let’s build this form.

First, place a multiline TextBox control on the form and dock it to the right. Then place a Splitter
control, which will be docked to the left by default. Since there’s a control docked to the left of the
form alreacly, the Splitter control will be docked to the right side of that control. Then place a Panel
control to the left of the Splitter control and set its Dock property to Fill. So far, you've done
exactly what you did in the last example. If you run the application now, you’ll be able to resize the
two controls on the form.

Now we're going to place two TextBox controls on the Panel control, separated by a horizontal
Splitter control. Place the first multiline TextBox control and dock it to the top of the Panel. Then
place a Splitter control on the Panel. The Form Designer will attempt to dock it to the left of the
control, so there’s no point in trying to resize the Splitter control with the mouse. Just change its
Dock property from Left to Top. Finally, place the third TextBox on the Panel, and set its Multiline
property to True and its Dock property to Fill. The last TextBox will fill the available area of the
Panel below the Splitter. Run the application, paste some text on all three TextBox controls, and
then use the two Splitter controls to resize the TextBoxes any way you like. Any VBO programmer
will tell you that this is a very elaborate interface—they just can’t guess how many lines of code you
wrote.

So far, you’ve seen what the Form Designer and the Form object can do for your application.
Let’s switch our focus to programming forms.
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FIGURE 5.10

The Form Designer provides a special contral for placing
An elaborate form

splitter bitwesn pairs of controls, and this is the Gpliter
control. We'll design a new Form identical to that of Figure
4.8, only this time we'll place a Spltter contral between
them, s that users can change the relative size of the two
contrals. First place a TestBox contral on the Farm and set
its Multiing property to True. You dont need to do anpthing
about its size. becauss we'll dock it to the left side of the
Form. With the TextBox control selected, locate its Dock
property and set it to Left. The TextBox cantral wil fil the
Ieft side of the Form, from top to bottom.

Then place an instance of the Splitter contral on the Form,
by double clicking the Splitter control’s icon on the

Toolbax, The Spiitter control will be placed next to the
TextBox control. The Form Designer will attempt to dock
the Splitter contral to the left side of the Fommn. Since there's
control docked on this side of the Form already, the Splitter
control will be docked left against the TextBow.

Mow place another TextBox control on the Form, to the
right of the Splitter contral. Set the TextBox controls
Multiine property to True and its Dock property to Fil. W
want the second TextBox control to fill all the area to the
fight of the Splitter contral. Maow run the project and check
out the functionality of the Splitter contral. Paste some test
an the twa contrals and then change their relative size by
sliding the 5 plitter control between them. You will find this
project in this chapter’s folder on the CD and it's called
Splitter1

with two Splitter
controls.

THE APPEARANCE OF FORMS

P[] S |
The Form Designer provides a special contral for placing splitter between pairs of
controls, and this is the Spliter contral. We'll design & new Form identical b that of
Figure 4.8, only this time we'll place a Splitter control between them, so that users
can change the relative size of the two contrals. First place a TextBaox contral on
the Form and set its Multine property to True. You don't need to do anything
about its size, because we'll dock it to the left side of the Form. ‘with the TextBox
control selected, locate its Dock property and set it to Left. The TestBox control
will fill the left side of the Form, from top ta bottom,

Then place an instance of the Splitter control on the Form, by double clicking the
Splitter cantral’s icon an the Toolbox. The Splitter control will be placed next ta the
TextBox control. The Form Designer will attempt to dock the Splitter control to the
Ieft side of the Fom. Since there's control docked on this side of the Fom already.
the: Splitter control will be docked left against the TextBox.

Mow place another TextBox control on the Form, ta the right of the Spliter contral,
Set the TextBox controls Multiine property to True and its Dock. property to Fill We
want the second TextBox contral ta fil all the area ta the right of the Splitter
control. Now run the project and check out the functionality of the S plitter control
Paste some text on the two controls and then change their relative size by sliding
the Spitter contral between them, You will find this project in this chapter's folder
on the CD and it's called Splitter]

The Form Designer piovides  special control for placing splitter between pairs of
caritrols, and this is the Splitter control. We'll design a new Form identical ba that of
Figure 4.8, orily thiz time we'l place a Spiiter control between them, so that users
can change the relative size of the twa controls, First place a TextBox contral on
the: Form ard set its Multline property to True. You don't nesd to do anything
about its size, because we'll dock it to the left side of the Form. With the TextBox
control selected, locate its Dock property and set it to Left. The TextBox control
will fill the left side of the Form, from top to bottom,
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control selected, locate its Dock
property and set it to Left. The
TextBox control wil fil the ket side of
the Farm, fram top to bottomn,

Then place an instance of the
Splitter cantrol on the Form, by
double clicking the Splitter control’s
icon on the Toolbox. The Spliter
control will be placed next to the
TextBox contiol. The Form Designer
will attempt to dock the Splitter
contral to the left side of the Form.
Since there’s control docked on this
side of the Form already, the Splitter
control will be docked left against
the TextBox

Mows place another TestBox cantrol
on the Form, to the right of the
Splitter cantrol. Set the TextBox
controls Multiine property to True
and its Dock property ta Fill. ‘we
want the second TestBox control to
fill &ll the area ta the right of the:
Splitter control. Now run the project
and check out the functionality of
the Splitter control. Paste some test
on the two controls and then
change their relative size by sliding
the Splitter contral between them.
*ou will find thiz project in this
chapter's falder on the CO and it's
called Spltter]

The Form Designer provides a special control for placing splitter between pairs of contrals, and this is the
Splitter contral. ‘we'll design a new Form identical to that of Figure 4.8, only this time we'll place a Splitter
control between them, so that users can change the relative size of the bwo conbols | First place a
TextBox cantrol on the Farm and set its Multiine property to True. Yiou dan’t need ta do anything about its
size, because we'll dock it to the left side of the Form. With the TextBox control selected, locate its Dock
property and set it to Left. The TextBox contral wil fil the left side of the Form, fram top to bottom.

Then place an instance of the Splitter contol on the Form, by double clicking the Spliter control’s icon
oh the Taolbox. The Splitte